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1. 支持机型 

本文档中列出的 SCPI 指令可用于 SIGLENT 矢量网络分析仪的 SNA5000X 系列，SNA6000A 系

列，SHN900A 系列。各个系列机型的端口数和频率范围信息如下表所示： 

机型 端口数 频率范围 

SNA5052X 2 端口 9kHz-4.5GHz 

SNA5082X 2 端口 9kHz-8.5GHz 

SNA5054X 4 端口 9kHz-4.5GHz 

SNA5084X 4 端口 9kHz-8.5GHz 

SNA5022A 2 端口 100kHz-13.5GHz 

SNA5032A 2 端口 100kHz-26.5GHz 

SNA6022A 2 端口 100kHz-13.5GHz 

SNA6122A 2 端口，包含前面板跳线接口 100kHz-13.5GHz 

SNA6024A 4 端口，13.5G 矢量网络分析仪 100kHz-13.5GHz 

SNA6124A 4 端口，包含前面板跳线接口 100kHz-13.5GHz 

SNA6032A 2 端口 100kHz-26.5GHz 

SNA6132A 2 端口，包含前面板跳线接口 100kHz-26.5GHz 

SNA6034A 4 端口  100kHz-26.5GHz 

SNA6134A 4 端口，包含前面板跳线接口 100kHz-26.5GHz 

SNH914A 2 端口 30kHz-14GHz 

SNH920A 2 端口 30kHz-20GHz 

 



 

 

2. 文档概述 

分析仪支持通过 USB、LAN、GPIB-USB 接口与计算机进行通信。用户通过这些接口，结合相应的

编程语言或 NI-VISA，使用基于 SCPI（Standard Commands for Programmable Instruments）命令集，

可对仪器进行远程编程控制，以及和其他支持 SCPI 命令集的可编程仪器进行互操作。 

本章将介绍如何构建网络分析仪与电脑之间的远程通信。 

2.1 建立通信 

2.1.1 安装 NI-VISA 

NI-VISA 包含运行引擎版本和完整版本。运行引擎版本提供 NI 设备驱动程序，例如 USB-TMC，

VXI，GPIB 等。完整版包括运行引擎和名为 NI MAX 的软件工具，它提供用户界面来控制设备。 

您可以从以下网址获得 NI-VISA 完整版本： 

http://www.ni.com/download/. 

下载后，您可以按照以下步骤进行安装： 

a) 双击 visa_full.exe，出现如下对话框： 

 

b) 点击 Unzip，解压缩文件后安装过程会自动启动。如果您的计算机需要安装.NET 

Framework 4，则其安装过程将自动启动。 

 

c) 上面显示了 NI-VISA 安装对话框。单击下一步开始安装过程。 

http://www.ni.com/download/
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设置安装路径，默认路径是“C：\ Program Files \ National Instruments \”，您可以更改它。

点击 Next，对话框如上所示。 

 

d) 点击下一步两次，在许可协议对话框中选择“I accept the above 2 License 

Agreement(s)”，然后点击下一步，对话框如下图所示： 

 

e) 单击下一步运行安装。 



 

 

 

现在安装完成，重新启动您的电脑。 

2.1.2 连接设备 

2.1.2.1 使用 USB接口连接 

请参考以下步骤通过 USB 设备完成与 PC 的连接： 

1. 在 PC 上安装 NI-VISA 以获得 USB-TMC 驱动。 

2. 使用 USB A-B 电缆将分析仪的 USB Device 端口连接到 PC 的 USB Host 口。 

 

3. 打开分析仪。 

分析仪将被自动检测为新的 USB 设备。 

2.1.2.2 使用 LAN按接口连接 

请参考以下步骤通过 LAN 完成与 PC 的连接： 

1. 在 PC 上安装 NI-VISA 以获得 VXI 驱动。或者，在没有 NI-VISA 的情况下，使用 PC 操作

系统中的 Socket或 Telnet。 

2. 使用网络电缆将分析仪 LAN 端口连接到 PC 的 LAN 口。  

 

3. 打开分析仪。 

4. 按下前面板 System>LAN Status 上的按钮进入 LAN Status 功能菜单。 

5. 选择静态或动态的 IP 配置。 

◆ 动态：当前网络中的 DHCP 服务器将为分析仪自动分配网络参数（IP 地址，子网掩码，
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网关）。 

◆ 静态：您可以手动设置 IP 地址，子网掩码，网关方式。设置后按下应用按钮。 

 

分析仪将被自动或手动检测为新的 LAN 设备。 

 

2.1.2.3 使用 USB-GPIB适配器连接 

请参考以下步骤通过 USB-GPIB 完成与 PC 的连接： 

1. 在 PC 上安装 NI-VISA 以获取 GPIB 驱动。 

2. 使用 SIGLENT USB-GPIB 适配器将与 PC 的 USB Host 端口连接到 PC 的 GPIB 卡端口。 

 

3. 打开分析仪。 

4. 按下前面板 System  > GPIB 上的按钮，输入 GPIB 编号。 

分析仪将被自动检测为新的 GPIB 点。 

 

2.2 远程控制 

2.2.1 通过 NI MAX发送 SCPI指令 

NI-MAX 是由美国国家仪器公司创建和维护的一个程序。它提供了 VXI、LAN、USB、GPIB 和串行

通信的基本远程控制接口。它是一个实用程序，使您可以一次发送命令，也可以从连接的设备检索数据。

对于故障排除和测试命令序列，它是一个很好的工具。网络矢量分析可以通过 NI-MAX 发送 SCPI 命令

进行远程控制。 

2.2.1.1 使用 USB 接口 

运行 NI MAX： 



 

 

1. 点击软件左上角的“Device and interface”； 

2. 找到“USBTMC”设备符号； 

 

3. 点击“Open VISA Test Panel”选项按钮，将出现以下界面。 

4. 点击“Input/Output”选项按钮，然后点击“Query”选项按钮以查看操作信息。 

 

 

NOTE:* IDN? 命令（称为识别查询）应返回仪器制造商，仪器型号，序列号和其他识别信息。 

 

2.2.1.2 使用 LAN 接口 

如下所示，选择 Add Network Device，然后选择 VISA TCP / IP Resource： 

运行 NI MAX： 

⚫ 点击软件左上角的：“Device and interface”； 

⚫ 找到“Network Devices”设备符号，点击“Add Network Devices”； 
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⚫ 选择 LAN 仪器的手动输入，选择下一步，然后输入 IP 地址，如图所示。点击“Finish”

建立连接： 

 

NOTE：保留局域网设备名称空白连接将失败。 

 

⚫ 短暂扫描后，连接应显示在“Network Devices”下： 



 

 

 

⚫ 右键单击产品并选择打开 NI-VISA 测试面板： 

 

⚫ 点击“Input/Output”选项按钮，然后点击“Query”选项按钮以查看操作信息。 

 

 

2.2.2 通过 Telnet发送 SCPI指令 

Telnet 是一种通过连接局域网与网络分析仪进行通信的方法。Telnet协议从 PC 向网络分析仪发送

SCPI 指令，类似于通过 USB 与网络分析仪通信。它交互的发送和接收信息：一次发送一条指令。

Windows 操作系统为 Telnet 客户端使用命令提示符样式的界面。步骤如下： 

1. 在 PC 上，单击“开始”>所有程序>附件>命令提示符。 

2. 在命令提示符处，输入 telnet。 
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3. 按 Enter 键。进入 Telnet 显示界面。 

 

4. 在 Telnet 命令行中，输入：open XXX.XXX.XXX.XXX 5024 

其中 XXX.XXX.XXX.XXX 是仪器的 IP 地址，5024 是端口。用户会看到类似如下的响应： 

 

5. 在 SCPI>提示符下，输入 SCPI命令，如*IDN?返回公司名称、型号、序列号和固件版本号。 



 

 

 

2.2.3 通过 Sockets发送 SCPI指令 

Socket API 可用于通过 LAN 控制网络分析仪系列，而无需安装任何其他库。这可以降低编程的复

杂性。 

SOCKET 地址：  IP 地址 + 端口号 

IP 地址：    SDS IP 地址 

端口号：    5025 

2.2.4 通过Webserver发送 SCPI指令 

该分析仪可通过 PC 或移动终端的 Web 浏览器进行远程控制，且无需安装任何驱动程序。它模仿了

触摸屏/鼠标可点击的显示功能，就像物理仪器一样。浏览器也支持截屏（ScreenShot）和固件升级

（FirmWareUpdate）功能。 
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*推荐使用支持 HTML5 的 web浏览器，如 Chrome 或 Firefox。 

 

2.3 SCPI语言简介 

2.3.1 命令格式 

SCPI 命令为树状层次结构，包括多个子系统，每个子系统由一个根关键字和一个或数个层次关键

字构成。命令行通常以冒号“:”开始；关键字之间用冒号“:”分隔，关键字后面跟随可选的参数设置，



 

 

命令和参数以“空格”分开，多个参数的，参数之间用逗号“,”分隔。命令行后面添加问号“?”，表示

对此功能进行查询。 

例如： 

:SENSe:FREQuency:CENTer <freq> 

:SENSe:FREQuency:CENTer? 

SENSe 是命令的根关键字，FREQuency 和 CENTer 分别是第二级、第三级关键字。命令行以冒号

“ :”开始，同时将各级关键字分开，<freq>表示可设置的参数；问号“ ?”表示查询；命

令::SENSe:FREQuency:CENTer 和参数<freq>之间用“空格”分开。 

 

2.3.2 符号说明 

下面四种符号不是 SCPI 命令中的内容，不随命令发送，但是通常用于辅助说明命令中的参数。 

1、 大括号 { } 

大括号中的参数是可选项，可以不设置，也可以设置一次或多次。例如： 

:SENSe<cnum>:SEGMent:LIST:CONTrol:DATA <Boolean>{,<Boolean>}命令中，后面大括号中的

{,<Boolean>}可以省略，也可以设置一个或多个参数。 

2、 竖线 | 

竖线用于分隔多个参数选项，发送命令时必须选择其中一个参数。例如： 

:DISPlay:MAXimize ON|OFF|1|0 命令中，可选择的命令参数为“OFF”、“ON”、“0”或“1”。 

3、 方括号 [ ] 

方括号中的内容（命令关键字）是可省略的。如果省略参数，仪器将该参数设置为默认值。例如： 

对于:SENSe:CORRection:IMPedance[:INPut][:MAGNitude]?命令，发送下面四条命令的效果是一

样的： 

:SENSe:CORRection:IMPedance? 
:SENSe:CORRection:IMPedance:INPut? 
:SENSe:CORRection:IMPedance:MAGNitude? 
:SENSe:CORRection:IMPedance:INPut:MAGNitude? 

4、 三角括号 < > 

三角括号中的参数必须用一个有效值来替换。例如： 

以:SENSe1:SWEep:POINts 201 的形式发送:SENSe1:SWEep:POINts <value>命令。 

 

2.3.3 参数 

本手册介绍的命令中所含的参数可以分为以下 5 种类型：布尔型、枚举、整型、实型、ASCII 字符

串。 
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1、 布尔型 

参数取值为 OFF、ON、0或 1。例如： 

:SENSe1:AVERage:STATe <bool> 
:SENSe1:AVERage:STATe? 

其中： 

<bool>可设置为：ON|OFF|1|0 

查询返回 1或 0。 

2、 枚举 

参数取值为所列举的选项。例如： 

:SENSe1:SWEep:TYPE <type> 
:SENSe1:SWEep:TYPE? 

其中： 

<type>可设置为：LINear|LOGarithmic|POWer|CW|SEGMent 

查询返回缩写形式：LIN、LOG、POW、CW或 SEGM。 

3、 整型 

除非另有说明，参数在有效值范围内可以取任意整数值。注意：此时请不要设置参数为小数格式，

否则将出现异常。例如： 

:SYSTem:COMMunicate:GPIB:ADDRess <value> 
:SYSTem:COMMunicate:GPIB:ADDRess? 

其中： 

<value>可设置为：0到 30 之间的整数。 

查询返回 0至 30之间的整数。 

4、 实型 

参数在有效值范围内按精度要求（通常默认精度为小数点以后取九位有效值），可以任意进行取值。

该命令接受小数格式和科学计数格式的参数输入。例如： 

:CALCulate1:TRACe1:MARKer:FUNCtion:MULTi:THReshold <value> 
:CALCulate1:TRACe1:MARKer:FUNCtion:MULTi:THReshold? 

其中： 

<value>可设置为：-5E2（即-500dB）至 5E2（即 500dB）之间的实数。 

查询返回所设置的浮点数。 

5、 字符串 

参数取值为 ASCII 字符的组合。例如： 

:SYSTem:COMMunicate:LAN:IPADdress <“xxx.xxx.xxx.xxx”> 

参数为设定的 IP 格式字符串。 

 
 
 
 
 



 

 

2.3.4 返回值 

分析器根据查询的参数不同，发送不同的响应数据类型。共分为以下四种类型的数据：数值数据、

字符数据、字符串数据、块数据。 

 

1、 数值数据 

通过 GPIB 发送的所有数字数据都是 ASCII 字符数据。您的编程环境可能会将字符数据转换为数字

数据。布尔数据 (1 | 0 ) 是一种数字数据。 

 

2、 字符数据 

字符数据由以助记符形式组合在一起的 ASCII 字符组成，代表特定的分析器设置。 

 

3、 字符串数据 

字符串数据由 ASCII 字符组成。字符串参数几乎可以包含任何 ASCII 字符集。将字符串数据发送到

分析器时，字符串必须以单引号 ( ' ) 或双引号 ( " ) 开头，并以相同字符（称为分隔符）结尾。 

分析器返回字符串数据时总是将数据括在双引号中。 

 

4、 块数据 

块数据用于传输测量数据。尽管分析仪将接受有限长度块或无限长度块，但它始终会返回有限长度

块数据来响应查询，除非指定的格式为 ASCII。 

定义块数据示例：#212ABCDEF123456 

其中： 

⚫ # - 始终在定义的块数据之前发送 

⚫ 2 - 指定字节数为两位数 (2) 

⚫ 12 - 指定后面的数据字节数 

⚫ ABCDEF123456 - 12 位数据 
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2.3.5 命令缩写 

所有命令对大小写不敏感，可完整输入命令，包含所有大写或小写，也可以使用缩写，但是如果要

缩写，必须完整且仅仅输入命令格式中的大写字母，例如： 

:CALCulate1:TRACe1:BLIMit:MINimum? 

可缩写成： 

:CALC1:TRAC1:BLIM:MIN? 
 

2.4 文档的格式约定 

1. 按键 

使用“按键字符（加粗）+文本框”表示前面板功能按键，如平均/中频带宽表示前面版的“平均/中

频带宽”按键。 

2. 菜单 

用“菜单文字+字符底纹”表示一个菜单选项，如平滑百分比表示进入“平滑”功能的“平滑百分比”

菜单选项。 

3. 操作步骤 

用箭头“>”表示下一步操作，如平滑>平滑百分比表示通过导航进入“平滑”功能后，再点击平滑

百分比项。 

  



 

 

3. 命令系统 

本章将逐条介绍网络矢量分析命令集中各种命令的格式、功能、参数及使用说明等。 

本章主要内容： 

 IEEE488.2 通用 

 AVG BW 命令子系统 

 Cal 命令子系统 

 Display 命令子系统  

 Format 命令子系统 

 Frequency 命令子系统 

 Math 命令子系统 

 Marker 命令子系统 

 Meas 命令子系统 

 Power 命令子系统  

 SaveRecall 命令子系统 

 Scale 命令子系统 

 Search 命令子系统 

 Service 命令子系统 

 Sweep 命令子系统 

 System 命令子系统 

 Trigger 命令子系统 

 PM 命令子系统(Option，SHN900A 系列机型不支持) 

 SA 命令子系统(Option) 

 MIXER 命令子系统(Option，SHN900A 系列机型不支持) 

 TDR 命令子系统(Option)  

 CAT 命令子系统（仅 SHN900A 系列机型支持） 

 

3.1 IEEE488.2通用命令 

3.1.1 命令列表 

设备信息查询（*IDN） *IDN? 

复位（*RST） *RST 

清除状态（*CLS） *CLS 

标准事件状态使能（*ESE） *ESE 
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标准事件状态寄存器询问（*ESR） *ESR 

操作完成询问（*OPC） *OPC 

允许服务请求（*SRE） *SRE 

状态字节询问（*STB） *STB 

等待继续（*WAI） *WAI 

触发扫描（*TRG） *TRG 

 

3.1.2 设备信息查询（*IDN） 

命令格式 *IDN? 

说明 这里会返回一个包含设备信息的字符串。内容包括：厂商，设备型号，设备串号，

软件版本号。 

菜单项 无 

举例 *IDN? 

Return: Siglent Technologies,SNA5084X,1234567890,V1.0.0.1.5 

 

3.1.3 复位（*RST） 

命令格式 *RST 

说明 重新恢复设备的状态为初始状态 

菜单项 无 

举例 *RST 

 

3.1.4 清除状态（*CLS） 

命令格式 *CLS 

说明 将所有事件寄存器的值清零，同时清空错误列表 

菜单项 无 

举例 *CLS 

 



 

 

3.1.5 标准事件状态使能（*ESE） 

命令格式 *ESE <numeric> 

*ESE? 

说明 设定标准事件状态寄存器的使能值 

查询标准事件状态寄存器的使能值 

菜单项 无 

举例 *ESE 200 

 

3.1.6 标准事件状态寄存器询问（*ESR） 

命令格式 *ESR? 

说明 询问及清除标准事件状态寄存器的事件值 

菜单项 无 

举例 *ESR? 

 

3.1.7 操作完成询问（*OPC） 

命令格式 *OPC 

*OPC? 

说明 所有操作结束后，在标准事件状态寄存器中设置比特 0置 1 

查询当前操作是否完成 

菜单项 无 

举例 TRIG:SOUR BUS 

INIT:CONT ON 

TRIG:SING 

*OPC? 
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3.1.8 允许服务请求（*SRE） 

命令格式 *SRE <numeric> 

*SRE? 

说明 设置服务请求启动寄存器的值 

查询服务请求启动寄存器的值 

菜单项 无 

举例 *SRE 1 

 

3.1.9 状态字节询问（*STB） 

命令格式 *STB? 

说明 查询状态字节寄存器的事件值 

菜单项 无 

举例 *STB? 

 

3.1.10 等待继续（*WAI） 

命令格式 *WAI 

说明 等待命令完成之前所有对象的发送 

菜单项 无 

举例 *WAI 

 

3.1.11 触发扫描（*TRG） 

命令格式 *TRG 

说明 总线触发，重新触发一次扫描 

菜单项 无 

举例 *TRG 

  



 

 

3.2 AVG BW命令子系统 

3.2.1 命令列表 

平均开关 :SENSe<cnum>:AVERage[:STATe] 

平均次数 :SENSe<cnum>:AVERage:COUNt  

当前已平均的次数 :SENSe<cnum>:AVERage:CURRent? 

平均次数的完成状态 :SENSe<cnum>:AVERage:COMPlete? 

重置平均 :SENSe<cnum>:AVERage:CLEar 

中频带宽 :SENSe<cnum>:BANDwidth[:RESolution] 

平滑开关 :CALCulate<cnum>:TRACe<tnum>:SMOothing[:STATe] 

平滑百分比 :CALCulate<cnum>:TRACe<tnum>:SMOothing:APERture 

平滑点数 :CALCulate<cnum>:MEASure<tnum>:SMOothing:POINts 

 

3.2.2 平均开关 

命令格式 :SENSe<cnum>:AVERage[:STATe] <bool> 

:SENSe<cnum>:AVERage[:STATe]? 

说明 设置或获取选择通道的平均的开关状态 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<bool>:= ON|OFF|1|0 

返回类型 Boolean (1=ON,0=OFF) 

默认值 OFF 

菜单项 平均/中频带宽 > 平均 >平均 

举例 :SENSe1:AVERage 1 

:SENSe1:AVERage? 

Return: 1 

 

3.2.3 平均次数 

命令格式 :SENSe<cnum>:AVERage:COUNt <numeric> 

:SENSe<cnum>:AVERage:COUNt? 

说  明 设置或获取选择通道的平均次数。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<numeric>:表示平均次数，其范围是 2~999。 
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返回类型 整型 

默认值 16 

菜单项 平均/中频带宽 > 平均> 平均次数 

举例 :SENSe1:AVERage:COUNt 10 

:SENSe1:AVERage:COUNt? 

Return: 10 

3.2.4 当前已平均的次数 

命令格式 :SENSe<cnum>:AVERage:CURRent? 

说明 获取选择通道当前已经平均的次数 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

返回类型 整型 

默认值 无 

菜单项 无 

举例 :SENSe1:AVERage:CURRent? 

Return: 10 

 

3.2.5 平均次数的完成状态 

命令格式 :SENSe<cnum>:AVERage:COMPlete? 

说明 获取选择通道是否已完成设定的平均次数的布尔状态。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

返回类型 Boolean 

默认值 无 

菜单项 无 

举例 :SENSe1:AVERage:COMPlete? 

Return: 1 

 

3.2.6 重置平均 

命令格式 :SENSe<cnum>:AVERage:CLEar 



 

 

说  明 清除并重新平均所测量的数据。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

返回类型 无 

默认值 无 

菜单项 平均/中频带宽 > 平均> 重置平均 

举例 :SENSe1:AVERage:CLEar 

 

3.2.7 中频带宽 

命令格式 :SENSe<cnum>:BANDwidth[:RESolution] <numeric> 

:SENSe<cnum>:BANDwidth[:RESolution]? 

:SENSe<cnum>:BWIDth[:RESolution] <numeric> 

:SENSe<cnum>:BWIDth[:RESolution]? 

说明 设置或获取选择通道的中频带宽 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<numeric>:={1|2|3|4|5|6|7|10|15|20|30|40|50|70|100|150|200|300|400|500|700|1E3|1
.5E3|2E3|3E3|4E3|5E3|7E3|10E3|15E3|20E3|30E3|40E3|50E3|70E3|100E3|150E3|

200E3|300E3|400E3|500E3|700E3|1E6|1.5E6|2E6|3E6|4E6|5E6|7E6|10E6},单位是

Hz。 

返回类型 枚举型，单位 Hz 

默认值 10 kHz 

菜单项 平均/中频带宽 > 平均> 中频带宽 

举例 :SENSe1:BANDwidth 7e3 

:SENSe1:BANDwidth? 

Return: 7000 

 

3.2.8 平滑开关 

命令格式 :CALCulate<cnum>[:SELected]:SMOothing[:STATe] <bool> 

:CALCulate<cnum>[:SELected]:SMOothing[:STATe]? 

:CALCulate<cnum>:TRACe<tnum>:SMOothing[:STATe] <bool> 

:CALCulate<cnum>:TRACe<tnum>:SMOothing[:STATe]? 

说明 设置或获取激活迹线平滑开关状态 

设置或获取所选通道及迹线平滑开关状态 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 
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<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

<bool>:= ON|OFF|1|0 

返回类型 Boolean (1=ON,0=OFF) 

默认值 OFF 

菜单项 平均/中频带宽 > 平滑 > 平滑 

举例 :CALCulate1:SMOothing ON 

:CALCulate1:SMOothing? 

Return: 1 

 

:CALCulate1:TRACe1:SMOothing OFF 

:CALCulate1:TRACe1:SMOothing? 

Return: 0 

 

3.2.9 平滑百分比 

命令格式 :CALCulate<cnum>[:SELected]:SMOothing:APERture <numeric> 

:CALCulate<cnum>[:SELected]:SMOothing:APERture? 

:CALCulate<cnum>:TRACe<tnum>:SMOothing:APERture <numeric> 

:CALCulate<cnum>:TRACe<tnum>:SMOothing:APERture? 

说明 设置或获取激活迹线平滑百分比 

设置或获取所选通道及迹线平滑百分比 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

<numeric>:表示平滑百分比，其范围是 1~25。 

返回类型 浮点型，单位% 

默认值 2.49 

菜单项 平均/中频带宽 > 平滑 > 平滑百分比 

举例 :CALCulate1:SMOothing:APERture 14.43 

:CALCulate1:SMOothing:APERture? 

Return: 14.4278606965174 

 

:CALCulate1:TRACe1:SMOothing:APERture 20 

:CALCulate1:TRACe1:SMOothing:APERture? 

Return: 19.4029850746269 

 



 

 

3.2.10 平滑点数 

命令格式 :CALCulate<cnum>:MEASure<tnum>:SMOothing:POINts <numeric> 

:CALCulate<cnum>:MEASure<tnum>:SMOothing:POINts? 

说明 设置或获取激活迹线平滑点数 

设置或获取所选通道及迹线平滑点数 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

<numeric>: 表示平滑点数，其范围是 1至 4999。 

返回类型 整数 

默认值 5 

菜单项 平均/中频带宽 > 平滑 > 平滑点数 

举例 :CALCulate1:MEASure1:SMOothing:POINts 15 

:CALCulate1:MEASure1:SMOothing:POINts? 

Return: 15 

 

3.3 Cal 命令子系统 

3.3.1 校准 

3.3.1.1 基础校准 

3.3.1.1.1 命令列表 

取消校准测量 :SENSe<cnum>:CORRection:COLLect:CLEar 

保存校准数据 :SENSe<cnum>:CORRection:COLLect:SAVE 

设置开路响应校准 :SENSe<cnum>:CORRection:COLLect:METHod[:RESPonse]:OPEN 

设置短路响应校准 :SENSe<cnum>:CORRection:COLLect:METHod[:RESPonse]:SHORt 

设置直通响应校准 :SENSe<cnum>:CORRection:COLLect:METHod[:RESPonse]:THRU 

设置增强响应校准 :SENSe<cnum>:CORRection:COLLect:METHod:ERESponse 

设置全 1 端口 OSL 校准 :SENSe<cnum>:CORRection:COLLect:METHod:SOLT1 

设置全 2 端口 SOLT 校准 :SENSe<cnum>:CORRection:COLLect:METHod:SOLT2 

设置全 3 端口 SOLT 校准 :SENSe<cnum>:CORRection:COLLect:METHod:SOLT3 

设置全 4 端口 SOLT 校准 :SENSe<cnum>:CORRection:COLLect:METHod:SOLT4 
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设置 2 端口 TRL 校准 :SENSe<cnum>:CORRection:COLLect:METHod:TRL2 

设置 3 端口 TRL 校准 :SENSe<cnum>:CORRection:COLLect:METHod:TRL3 

设置 4 端口 TRL 校准 :SENSe<cnum>:CORRection:COLLect:METHod:TRL4 

测量开路校准数据 :SENSe<cnum>:CORRection:COLLect[:ACQuire]:OPEN 

测量短路校准数据 :SENSe<cnum>:CORRection:COLLect[:ACQuire]:SHORt 

测量负载校准数据 :SENSe<cnum>:CORRection:COLLect[:ACQuire]:LOAD 

测量直通校准数据 :SENSe<cnum>:CORRection:COLLect[:ACQuire]:THRU 

测量隔离校准数据 :SENSe<cnum>:CORRection:COLLect[:ACQuire]:ISOLation 

TRL 校准 Thru 测量 :SENSe<cnum>:CORRection:COLLect[:ACQuire]:TRLThru 

TRL 校准 Reflect 测量 :SENSe<cnum>:CORRection:COLLect[:ACQuire]:TRLReflect 

TRL 校准 Line 测量 :SENSe<cnum>:CORRection:COLLect[:ACQuire]:TRLLine 

清除校准误差系数 :SENSe<cnum>:CORRection:CLEar 

读写校准数据 :SENSe<cnum>:CORRection:COEFficient[:DATA] 

导入响应校准开路数据 :SENSe<cnum>:CORRection:COEFficient:METHod[:RESPonse]:OPEN 

导入响应校准短路数据 :SENSe<cnum>:CORRection:COEFficient:METHod[:RESPonse]:SHORt 

导入响应校准直通数据 :SENSe<cnum>:CORRection:COEFficient:METHod[:RESPonse]:THRU 

导入增强响应校准数据 :SENSe<cnum>:CORRection:COEFficient:METHod:ERESponse 

导入全 1 端口校准数据 :SENSe<cnum>:CORRection:COEFficient:METHod:SOLT1 

导入全 2 端口校准数据 :SENSe<cnum>:CORRection:COEFficient:METHod:SOLT2 

导入全 3 端口校准数据 :SENSe<cnum>:CORRection:COEFficient:METHod:SOLT3 

导入全 4 端口校准数据 :SENSe<cnum>:CORRection:COEFficient:METHod:SOLT4 

激活校准误差系数 :SENSe<cnum>:CORRection:COEFficient:SAVE 

保存部分重写校准数据 :SENSe<cnum>:CORRection:COLLect:PARTial:SAVE 

 

3.3.1.1.2 取消校准测量 

命令格式 :SENSe<cnum>:CORRection:COLLect:CLEar 

说明 清除选择通道的校准测量数据 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 



 

 

返回类型 无 

默认值 无 

菜单项 校准 > 基础校准 > Cancel 

校准 > 基础校准 > Next > Cancel 

举例 :SENSe1:CORRection:COLLect:CLEar 

 

3.3.1.1.3 保存校准数据 

命令格式 :SENSe<cnum>:CORRection:COLLect:SAVE 

说明 保存校准完成后的校准数据。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

返回类型 无 

默认值 无 

菜单项 校准 > 基础校准 > Finish 

举例 :SENSe1:CORRection:COLLect:SAVE 

 

3.3.1.1.4 设置开路响应校准 

命令格式 :SENSe<cnum>:CORRection:COLLect:METHod[:RESPonse]:OPEN <pnum> 

说明 对选择通道设置指定端口的开路响应校准。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<pnum>:={1|2|3|4}，表示测量端口号。 

返回类型 无 

默认值 无 

菜单项 校准 > 基础校准 > Response(Open) 

举例 :SENSe1:CORRection:COLLect:METHod:OPEN 2 

 

3.3.1.1.5 设置短路响应校准 

命令格式 :SENSe<cnum>:CORRection:COLLect:METHod[:RESPonse]:SHORt <pnum> 

说明 对选择通道设置指定端口的短路响应校准。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 
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<pnum>:={1|2|3|4}，表示测量端口号。 

返回类型 无 

默认值 无 

菜单项 校准 > 基础校准 > Response(Short) 

举例 :SENSe1:CORRection:COLLect:METHod:SHORt 3 

 

3.3.1.1.6 设置直通响应校准 

命令格式 :SENSe<cnum>:CORRection:COLLect:METHod[:RESPonse]:THRU 
<pnum1>,<pnum2> 

说明 对选择通道设置两个端口间的响应校准（直通）。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<pnum1>:={1|2|3|4}，指定响应校准端口 

<pnum2>:={1|2|3|4}，指定的另一个响应校准 

返回类型 无 

默认值 无 

菜单项 校准 > 基础校准 > Response(Thru) 

举例 :SENSe1:CORRection:COLLect:METHod:THRU 1,2 

 

3.3.1.1.7 设置增强响应校准 

命令格式 :SENSe<cnum>:CORRection:COLLect:METHod:ERESponse <pnum1>,<pnum2> 

说明 对选择通道设置两个端口间的增强效应校准。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<pnum1>：指定响应端口 

<pnum2>：指定激励端口 

返回类型 无 

默认值 无 

菜单项 校准 > 基础校准 > Enhanced Response 

举例 :SENSe1:CORRection:COLLect:METHod:ERESponse 1,2 

 



 

 

3.3.1.1.8 设置全 1 端口 OSL 校准 

命令格式 :SENSe<cnum>:CORRection:COLLect:METHod:SOLT1 <pnum> 

说明 对选择通道设置全 1端口校准，校准类型为 OSL。 

参数 
<cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<pnum>:={1|2|3|4}，表示端口号。 

返回类型 无 

默认值 无 

菜单项 校准 > 基础校准 > OSL 

举例 :SENSe1:CORRection:COLLect:METHod:SOLT1 3 

 

3.3.1.1.9 设置全 2 端口 SOLT 校准 

命令格式 :SENSe<cnum>:CORRection:COLLect:METHod:SOLT2 <pnum1>,<pnum2> 

说明 对选择通道设置全 2端口校准，校准类型为 SOLT。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<pnum1>:={1|2|3|4},表示全 2端口校准端口 

<pnum2>:={1|2|3|4},表示另一个全 2端口校准端口 

返回类型 无 

默认值 无 

菜单项 校准 > 基础校准> SOLT 

举例 :SENSe1:CORRection:COLLect:METHod:SOLT2 1,2 

3.3.1.1.10 设置全 3 端口 SOLT 校准 

命令格式 :SENSe<cnum>:CORRection:COLLect:METHod:SOLT3 
<pnum1>,<pnum2>,<pnum3> 

说明 对选择通道设置全 3端口校准，校准类型为 SOLT。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<pnum1>:={1|2|3|4}，全 3 端口校准端口 

<pnum2>:={1|2|3|4}，全 3 端口校准端口 

<pnum3>:={1|2|3|4}，全 3 端口校准端口 

各校准端口号不能重复。 

返回类型 无 
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默认值 无 

菜单项 校准 > 基础校准 > SOLT 

举例 :SENSe1:CORRection:COLLect:METHod:SOLT3 1,2,4 

 

3.3.1.1.11 设置全 4 端口 SOLT 校准 

命令格式 :SENSe<cnum>:CORRection:COLLect:METHod:SOLT4  
<pnum1>,<pnum2>,<pnum3>,<pnum4> 

说明 对选择通道设置全 4端口校准，校准类型为 SOLT。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<pnum1>:={1|2|3|4}，全 4 端口校准端口 

<pnum2>:={1|2|3|4}，全 4 端口校准端口 

<pnum3>:={1|2|3|4}，全 4 端口校准端口 

<pnum4>:={1|2|3|4}，全 4 端口校准端口 

各校准端口号不能重复。 

返回类型 无 

默认值 无 

菜单项 校准 > 基础校准 > SOLT 

举例 :SENSe1:CORRection:COLLect:METHod:SOLT4 1,2,3,4 

 

3.3.1.1.12 设置 2 端口 TRL 校准 

命令格式 :SENSe<cnum>:CORRection:COLLect:METHod:TRL2 <pnum1>,<pnum2> 

说明 对选择通道设置 2端口校准，校准类型为 TRL。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<pnum1>:={1|2|3|4}，TRL 2 端口校准端口 

<pnum2>:={1|2|3|4}，另一个 TRL 2端口校准端口 

返回类型 无 

默认值 无 

菜单项 校准 > 基础校准 > TRL 

举例 :SENSe1:CORRection:COLLect:METHod:TRL2 1,2 

 



 

 

3.3.1.1.13 设置 3 端口 TRL 校准 

命令格式 :SENSe<cnum>:CORRection:COLLect:METHod:TRL3  
<pnum1>,<pnum2>,<pnum3> 

说明 对选择通道设置 2端口校准，校准类型为 TRL。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<pnum1>:={1|2|3|4}，TRL3 端口校准端口 

<pnum2>:={1|2|3|4}，TRL3 端口校准端口 

<pnum3>:={1|2|3|4}，TRL3 端口校准端口 

各校准端口号不能重复。 

返回类型 无 

默认值 无 

菜单项 校准 > 基础校准 > TRL 

举例 :SENSe1:CORRection:COLLect:METHod:TRL3 1,2,3 

 

3.3.1.1.14 设置 4 端口 TRL 校准 

命令格式 :SENSe<cnum>:CORRection:COLLect:METHod:TRL4  
<pnum1>,<pnum2>,<pnum3>,<pnum4> 

说明 设置选择通道四个指定端口之间的校准类型为 4 端口 TRL校准。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<pnum1>:={1|2|3|4}，TRL4 端口校准端口 

<pnum2>:={1|2|3|4}，TRL4 端口校准端口 

<pnum3>:={1|2|3|4}，TRL4 端口校准端口 

<pnum4>:={1|2|3|4}，TRL4 端口校准端口 

各校准端口号不能重复。 

返回类型 无 

默认值 无 

菜单项 校准 > 基础校准 > TRL 

举例 :SENSe1:CORRection:COLLect:METHod:TRL4 1,2,3,4 

 

3.3.1.1.15 测量开路校准数据 

命令格式 :SENSe<cnum>:CORRection:COLLect[:ACQuire]:OPEN <pnum> 
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说明 设置所选通道，测量指定端口的开路标准的校准数据。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<pnum>:={1|2|3|4}，表示校准端口号。 

返回类型 无 

默认值 无 

菜单项 校准 > 基础校准 > Response(Open) > Open 

校准 > 基础校准 > OSL > Open 

校准 > 基础校准 > Enhanced Response > Open 

校准 > 基础校准 > SOLT > Open 

校准 > 基础校准 > SOLR > Open 

举例 :SENSe1:CORRection:COLLect:OPEN 1 

 

3.3.1.1.16 测量短路校准数据 

命令格式 :SENSe<cnum>:CORRection:COLLect[:ACQuire]:SHORt <pnum> 

说明 设置所选通道，测量指定端口的短路标准的校准数据 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<pnum>:={1|2|3|4}，表示测量的端口号。 

返回类型 无 

默认值 无 

菜单项 校准 > 基础校准 > Response(Short) > Short 

校准 > 基础校准> OSL > Short 

校准 > 基础校准> Enhanced Response > Short 

校准 > 基础校准> SOLT > Short 

校准 > 基础校准> SOLR > Short 

举例 :SENSe1:CORRection:COLLect:SHORt 1 

 

3.3.1.1.17 测量负载校准数据 

命令格式 :SENSe<cnum>:CORRection:COLLect[:ACQuire]:LOAD <pnum> 

说明 设置所选通道，测量指定端口的负载标准的校准数据 



 

 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<pnum>:={1|2|3|4}，表示测量的端口号。 

返回类型 无 

默认值 无 

菜单项 校准 > 基础校准 > Response(Open) > Load(Optional) 

校准 > 基础校准 > Response(Short) > Load(Optional) 

校准 > 基础校准 > OSL > Load 

校准 > 基础校准 > Enhanced Response > Load 

校准 > 基础校准 > SOLT > Load 

校准 > 基础校准 > SOLR > Load 

举例 :SENSe1:CORRection:COLLect:LOAD 1 

 

3.3.1.1.18 测量直通校准数据 

命令格式 :SENSe<cnum>:CORRection:COLLect[:ACQuire]:THRU <pnum1>,<pnum2> 

说明 设置所选通道，测量指定的激励端口和测量端口之间的直通校准数据 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<pnum1>:={1|2|3|4}：指定响应端口 

<pnum2>:={1|2|3|4}：指定激励端口 

激励端口和响应端口不能重合 

返回类型 无 

默认值 无 

菜单项 校准 > 基础校准 > Response(Thru) > Thru 

校准 > 基础校准 > Enhanced Response > Thru 

校准 > 基础校准 > SOLT > Thru 

校准 > 基础校准 > SOLR > Unknown Thru 

举例 :SENSe1:CORRection:COLLect:THRU 1,4 

 

3.3.1.1.19 测量隔离校准数据 

命令格式 :SENSe<cnum>:CORRection:COLLect[:ACQuire]:ISOLation <pnum1>,<pnum2> 

说  明 针对所选通道，测量指定的激励端口和响应端口之间的隔离校准数据 
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参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。

<pnum1>:={1|2|3|4}：指定响应端口 

<pnum2>:={1|2|3|4}：指定激励端口 

激励端口和响应端口不能重合 

返回类型 无 

默认值 无 

菜单项 校准 > 基础校准 > Response(Thru) > Isolation-Load(Optional) 

校准 > 基础校准 > Enhanced Response > Isolation-Load(Optional) 

校准 > 基础校准 > SOLT > Isolation-Load(Optional) 

校准 > 基础校准 > SOLR > Isolation-Load(Optional) 

举例 :SENSe1:CORRection:COLLect:ISOLation 1,2 

 

3.3.1.1.20 TRL 校准 Thru 测量 

命令格式 :SENSe<cnum>:CORRection:COLLect[:ACQuire]:TRLThru <pnum1>,<pnum2> 

说明 设置所选通道，测量指定的激励端口和测量端口之间的 TRL直通校准数据 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。

<pnum1>:={1|2|3|4}：指定响应端口号。 

<pnum2>:={1|2|3|4}：指定激励端口号。 

激励端口和响应端口不能重合 

返回类型 无 

默认值 无 

菜单项 校准 > 基础校准 > TRL > Thru 

举例 :SENSe1:CORRection:COLLect:TRLThru 1,2 

 

3.3.1.1.21 TRL 校准 Reflect 测量 

命令格式 :SENSe<cnum>:CORRection:COLLect[:ACQuire]:TRLReflect <pnum> 

说明 针对选择的通道执行选择校准套件 TRL 校准的反射测量 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。

<pnum>:={1|2|3|4}：指定反射测量端口号。 

返回类型 无 



 

 

默认值 无 

菜单项 校准 > 基础校准 > TRL > Reflect 

举例 :SENSe1:CORRection:COLLect:TRLReflect 1 

 

 

3.3.1.1.22 TRL 校准 Line 测量 

命令格式 :SENSe<cnum>:CORRection:COLLect[:ACQuire]:TRLLine <pnum1>,<pnum2> 

说明 针对选择的通道执行选择的校准套件 TRL 校准的线路或匹配测量 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<pnum1>:={1|2|3|4}：指定响应端口 

<pnum2>:={1|2|3|4}：指定激励端口 

激励端口和响应端口不能重合 

返回类型 无 

默认值 无 

菜单项 校准 > 基础校准 > TRL > Line 

举例 :SENSe1:CORRection:COLLect:TRLLine 3,4 

 

3.3.1.1.23 清除校准误差系数 

命令格式 :SENSe<cnum>:CORRection:CLEar 

说明 清除选择通道的校准误差系数。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

返回类型 无 

默认值 无 

菜单项 无 

举例 :SENSe1:CORRection:CLEar 

 

3.3.1.1.24 读写校准数据 

命令格式 :SENSe<cnum>:CORRection:COEFficient[:DATA] <type>,<numeric 1>,<numeric 
2>,<numeric 3>,...,<numeric 2+n*2> 

:SENSe<cnum>:CORRection:COEFficient[:DATA]? <type>,<numeric 
1>,<numeric 2> 
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说明 设置或获取选择通道的校准的误差系数 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<type>:={ES|ER|ED|EL|ET|EX}，表示校准类型。 

"ES"：源匹配 

"ER"：反射跟踪 

"ED"：方向性 

"EL"：负载匹配 

"ET"：传输跟踪 

"EX"：隔离 

 

<numeric 1>：响应端口 

整型，范围 1~4。 

如果使用 ES、ER 或 ED，响应端口和激励端口必须相同，而使用 EL、ET 或 EX，

响应端口和激励端口必须不同。 

<numeric 2>：激励端口 

整型，范围 1~4。 

<numeric 3>,...,<numeric 2+n*2>：误差系数数组 

表示 NOP（Numbers of point）*2的数组数据。n为 1 到 NOP 之间的整数。 

数据（n*2-2）：第 n个测量点的数据（实部）。 

数据（n*2-1）：第 n个测量点的数据（虚部）。 

数组索引从 0开始。 

返回类型 表示 NOP（Numbers of point）*2的数组数据。n为 1 到 NOP 之间的整数。 

数据（n*2-2）：第 n个测量点的数据（实部）。 

数据（n*2-1）：第 n个测量点的数据（虚部）。 

数组索引从 0开始。 

默认值 无 

菜单项 无 

举例 :SENSe1:CORRection:COEFficient:METHod:THRU 2,1 

:SENSe1:CORRection:COEFficient ET,2,1,-1,0,-0.5,0,0.5,0 

:SENSe1:CORRection:COEFficient:SAVE 

:SENSe1:CORRection:COEFficient? ET,2,1 

Return: -1.000000000000e+00,0.000000000000e+00, 
-5.000000000000e-01, 0.000000000000e+00, 
5.000000000000e-01,0.000000000000e+00 



 

 

 

3.3.1.1.25 导入响应校准开路数据 

命令格式 :SENSe<cnum>:CORRection:COEFficient:METHod[:RESPonse]:OPEN <pnum> 

说  明 当通过  SENSe<cnum>:CORRection:COEFficient:DATA 命令写下校准系数数组

时，此命令针对选择通道设置指定端口的开路响应校准。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<pnum>:={1|2|3|4}，表示端口号。 

返回类型 无 

默认值 无 

菜单项 无 

举例 :SENSe1:CORRection:COEFficient:METHod:OPEN 1 

 

3.3.1.1.26 导入响应校准短路数据 

命令格式 :SENSe<cnum>:CORRection:COEFficient:METHod[:RESPonse]:SHORt <pnum> 

说  明 当通过  SENSe<cnum>:CORRection:COEFficient:DATA 命令写下校准系数数组

时，此命令针对选择通道设置指定端口的短路响应校准。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<pnum>:={1|2|3|4}，表示指定端口号。 

返回类型 无 

默认值 无 

菜单项 无 

举例 :SENSe1:CORRection:COEFficient:METHod:SHORt 1 

 

3.3.1.1.27 导入响应校准直通数据 

命令格式 :SENSe<cnum>:CORRection:COEFficient:METHod[:RESPonse]:THRU 
<pnum1>,<pnum2> 

说  明 当通过 SENSe<cnum>:CORRection:COEFficient:DATA 命令写下校准系数数组

时，此命令针对选择通道的两个指定端口之间设置直通响应校准类型。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<pnum1>:={1|2|3|4}，表示指定响应校准端口。 

<pnum2>:={1|2|3|4}，表示指定的另一个响应校准端口。 
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返回值 无 

默认值 无 

菜单项 无 

举例 :SENSe1:CORRection:COEFficient:METHod:THRU 1,2 

 

3.3.1.1.28 导入增强响应校准数据 

命令格式 :SENSe<cnum>:CORRection:COEFficient:METHod:ERESponse 
<pnum1>,<pnum2> 

说  明 当通过 SENSe<cnum>:CORRection:COEFficient:DATA 命令写下校准系数数组

时，此命令针对选择通道的两个指定端口之间设置的增强响应校准类型。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<pnum1>:={1|2|3|4}：指定响应端口。 

<pnum2>:={1|2|3|4}：指定激励端口。 

返回类型 无 

默认值 无 

菜单项 无 

举例 :SENSe1:CORRection:COEFficient:METHod:ERESponse 1,2 

 

3.3.1.1.29 导入全 1 端口校准数据 

命令格式 :SENSe<cnum>:CORRection:COEFficient:METHod:SOLT1 <pnum> 

说  明 当通过 SENSe<cnum>:CORRection:COEFficient:DATA 命令写下校准系数数组

时，此命令针对选择通道为指定端口设置 1端口校准类型 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<pnum1>:={1|2|3|4}：指定端口 

返回类型 无 

默认值 无 

菜单项 无 

举例 :SENSe1:CORRection:COEFficient:METHod:SOLT1 1 

 



 

 

3.3.1.1.30 导入全 2 端口校准数据 

命令格式 :SENSe<cnum>:CORRection:COEFficient:METHod:SOLT2 <pnum1>,<pnum2> 

说  明 当通过 SENSe<cnum>:CORRection:COEFficient:DATA 命令写下校准系数数组

时，此命令针对选择通道为两个指定端口之间设置全 2端口校准类型 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<pnum1>:={1|2|3|4},表示全 2端口校准端口 

<pnum2>:={1|2|3|4},表示另一个全 2端口校准端口 

返回类型 无 

默认值 无 

菜单项 无 

举例 :SENSe1:CORRection:COEFficient:METHod:SOLT2 1,2 

 

3.3.1.1.31 导入全 3 端口校准数据 

命令格式 :SENSe<cnum>:CORRection:COEFficient:METHod:SOLT3 
<pnum1>,<pnum2>,<pnum3> 

说  明 当通过 SENSe<cnum>:CORRection:COEFficient:DATA 命令写下校准系数数组

时，此命令针对选择通道为三个指定端口之间设置全 3端口校准类型 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<pnum1>:={1|2|3|4}，全 3 端口校准端口 

<pnum2>:={1|2|3|4}，全 3 端口校准端口 

<pnum3>:={1|2|3|4}，全 3 端口校准端口 

各校准端口不能重复。 

返回类型 无 

默认值 无 

菜单项 无 

举例 :SENSe1:CORRection:COEFficient:METHod:SOLT3 1,2,4 

 

3.3.1.1.32 导入全 4 端口校准数据 

命令格式 :SENSe<cnum>:CORRection:COEFficient:METHod:SOLT4 
<pnum1>,<pnum2>,<pnum3>,<pnum4> 

说明 当通过 SENSe<cnum>:CORRection:COEFficient:DATA 命令写下校准系数数组

时，此命令针对选择通道 Ch为四个指定端口之间设置全 4端口校准类型 
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参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<pnum1>:={1|2|3|4}，全 4 端口校准端口 

<pnum2>:={1|2|3|4}，全 4 端口校准端口 

<pnum3>:={1|2|3|4}，全 4 端口校准端口 

<pnum4>:={1|2|3|4}，全 4 端口校准端口 

各校准端口不能重复。 

返回类型 无 

默认值 无 

菜单项 无 

举例 :SENSe1:CORRection:COEFficient:METHod:SOLT4 1,2,3,4 

 

3.3.1.1.33 激活校准误差系数 

命令格式 :SENSe<cnum>:CORRection:COEFficient:SAVE 

说  明 激活选择通道的校准误差系数。如果在写下用于计算校准系数的所有校准数据之前

执行这个命令，就会出错并忽略命令。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

返回类型 无 

默认值 无 

菜单项 无 

举例 :SENSe1:CORRection:COEFficient:SAVE 

 

3.3.1.1.34 保存部分重写校准数据 

命令格式 :SENSe<cnum>:CORRection:COLLect:PARTial:SAVE 

说明 保存部分重写校准完成后的校准数据。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

返回值 无 

默认值 无 

菜单项 校准 > 基础校准 > Overwrite 

举例 :SENSe1:CORRection:COLLect:PARTial:SAVE 

 



 

 

3.3.1.2 校准件管理 

3.3.1.2.1 命令列表 

校准套件名 :SENSe<cnum>:CORRection:COLLect:CKIT:LABel 

选择或查询开路测量的标准 :SENSe:CORRection:COLLect:CKIT:ORDer:OPEN 

选择或查询短路测量的标准 :SENSe:CORRection:COLLect:CKIT:ORDer:SHORt 

选择或查询负载测量的标准 :SENSe:CORRection:COLLect:CKIT:ORDer:LOAD 

选择或查询直通测量的标准 :SENSe:CORRection:COLLect:CKIT:ORDer:THRU 

选择或查询 TRL线缆测量的标准 :SENSe:CORRection:COLLect:CKIT:ORDer:TRLLine 

选择或查询 TRL反射测量的标准 :SENSe:CORRection:COLLect:CKIT:ORDer:TRLReflect 

选择或查询 TRL直通测量的标准 :SENSe:CORRection:COLLect:CKIT:ORDer:TRLThru 

校准套件恢复出厂 :SENSe:CORRection:COLLect:CKIT:RESet 

选择校准套件 :SENSe:CORRection:COLLect:CKIT[:SELect] 

标准类型 :SENSe:CORRection:COLLect:CKIT: STAN<snum>:TYPE 

标准 C0值 :SENSe:CORRection:COLLect:CKIT: STAN<snum>:C0 

标准 C1值 :SENSe:CORRection:COLLect:CKIT: STAN<snum>:C1 

标准 C2值 :SENSe:CORRection:COLLect:CKIT: STAN<snum>:C2 

标准 C3值 :SENSe:CORRection:COLLect:CKIT: STAN<snum>:C3 

标准 L0值 :SENSe:CORRection:COLLect:CKIT: STAN<snum>:L0 

标准 L1值 :SENSe:CORRection:COLLect:CKIT: STAN<snum>:L1 

标准 L2值 :SENSe:CORRection:COLLect:CKIT: STAN<snum>:L2 

标准 L3值 :SENSe:CORRection:COLLect:CKIT: STAN<snum>:L3 

校准套件标准名 :SENSe:CORRection:COLLect:CKIT: STAN<snum>:LABel 

标准偏置延迟 :SENSe:CORRection:COLLect:CKIT: STAN<snum>:DELay 

标准最小频率 :SENSe:CORRection:COLLect:CKIT: STAN<snum>:FMINimum 

标准最大频率 :SENSe:CORRection:COLLect:CKIT: STAN<snum>:FMAXimum 

标准件偏置损耗 :SENSe:CORRection:COLLect:CKIT: STAN<snum>:LOSS 

标准件偏置 Z0 值 :SENSe:CORRection:COLLect:CKIT: STAN<snum>:Z0 

TRL校准参考阻抗 :SENSe:CORRection:COLLect:CKIT:TRLoption:IMPedance 
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TRL校准平面 :SENSe:CORRection:COLLect:CKIT:TRLoption:RPLane 

 

3.3.1.2.2 校准套件名 

命令格式 :SENSe<cnum>:CORRection:COLLect:CKIT:LABel <string> 

:SENSe<cnum>:CORRection:COLLect:CKIT:LABel? 

说明 设置或获取选择校准套件的校准套件名 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<string>: 表示校准套件名。 

返回类型 字符串 

默认值 无 

菜单项 校准 > 校准件 > Edit > Cal Kit Name 

举例 :SENSe1:CORRection:COLLect:CKIT:LABel "F503ME_1" 

:SENSe1:CORRection:COLLect:CKIT:LABel? 

Return: F503ME_1 

 

3.3.1.2.3 选择或查询开路测量的标准 

命令格式 :SENSe:CORRection:COLLect:CKIT:ORDer:OPEN 
<numeric1>{,<numeric2>,…,<numeric n>} 

:SENSe:CORRection:COLLect:CKIT:ORDer:OPEN? 

说明 设置或获取所选校准套件的开路测量的标准 

参数 <numeric1>{,<numeric2>,…,<numeric n>}:表示标准套件序号，其范围是 1~21。 

返回类型 整型或数组 

默认值 无 

菜单项 校准 > 校准件 > Edit > SOLT > OPEN 

举例 :SENSe:CORRection:COLLect:CKIT:ORDer:OPEN 2,3 

:SENSe:CORRection:COLLect:CKIT:ORDer:OPEN? 

Return: 2,3 

 

3.3.1.2.4 选择或查询短路测量的标准 

命令格式 :SENSe:CORRection:COLLect:CKIT:ORDer:SHORt 
<numeric1>{,<numeric2>,…,<numeric n>} 

:SENSe:CORRection:COLLect:CKIT:ORDer:SHORt? 

说明 设置或获取所选校准套件的短路测量的标准 



 

 

参数 <numeric1>{,<numeric2>,…,<numeric n>}:表示标准套件序号，其范围是 1~21。 

返回类型 整型或数组 

默认值 无 

菜单项 校准 > 校准件 > Edit > SOLT > SHORT 

举例 :SENSe1:CORRection:COLLect:CKIT:ORDer:SHORt 3 

:SENSe1:CORRection:COLLect:CKIT:ORDer:SHORt? 

Return: 3 

 

3.3.1.2.5 选择或查询负载测量的标准 

命令格式 :SENSe:CORRection:COLLect:CKIT:ORDer:LOAD 
<numeric1>{,<numeric2>,…,<numeric n>} 

:SENSe:CORRection:COLLect:CKIT:ORDer:LOAD? 

说明 设置或获取所选校准套件的负载测量的标准 

参数 <numeric1>{,<numeric2>,…,<numeric n>}:表示标准套件序号，其范围是 1~21。 

返回类型 整型或数组 

默认值 无 

菜单项 校准 > 校准件 > Edit > SOLT > LOAD 

举例 :SENSe:CORRection:COLLect:CKIT:ORDer:LOAD 2 

:SENSe:CORRection:COLLect:CKIT:ORDer:LOAD? 

Return: 2 

 

3.3.1.2.6 选择或查询直通测量的标准 

命令格式 :SENSe:CORRection:COLLect:CKIT:ORDer:THRU 
<numeric1>{,<numeric2>,…,<numeric n>} 

:SENSe:CORRection:COLLect:CKIT:ORDer:THRU? 

说明 设置或获取所选校准套件的直通测量的标准 

参数 <numeric1>{,<numeric2>,…,<numeric n>}:表示标准套件序号，其范围是 1~21。 

返回类型 整型或数组 

默认值 无 

菜单项 校准 > 校准件 > Edit > SOLT > THRU 

举例 :SENSe1:CORRection:COLLect:CKIT:ORDer:THRU 4,2 

:SENSe1:CORRection:COLLect:CKIT:ORDer:THRU? 

Return: 4,2 
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3.3.1.2.7 选择或查询 TRL 线缆测量的标准 

命令格式 :SENSe:CORRection:COLLect:CKIT:ORDer:TRLLine 
<numeric1>{,<numeric2>,…,<numeric n>} 

:SENSe:CORRection:COLLect:CKIT:ORDer:TRLLine? 

说明 设置或获取所选校准套件的 TRL线路测量的标准 

参数 <numeric1>{,<numeric2>,…,<numeric n>}:表示标准套件序号，其范围是 1~21。 

返回类型 整型或数组 

默认值 无 

菜单项 校准 > 校准件 > Edit > TRL > LINE/MATCH 

举例 :SENSe1:CORRection:COLLect:CKIT:ORDer:TRLLine 2 

:SENSe1:CORRection:COLLect:CKIT:ORDer:TRLLine? 

Return: 2 

 

3.3.1.2.8 选择或查询 TRL 反射测量的标准 

命令格式 :SENSe:CORRection:COLLect:CKIT:ORDer:TRLReflect 
<numeric1>{,<numeric2>,…,<numeric n>} 

:SENSe:CORRection:COLLect:CKIT:ORDer:TRLReflect?  

说明 设置或获取所选校准套件的 TRL反射测量的标准 

参数 <numeric1>{,<numeric2>,…,<numeric n>}:表示标准套件序号，其范围是 1~21。 

返回类型 整型或数组 

默认值 无 

菜单项 校准 > 校准件 > Edit > TRL > REFLECT 

举例 :SENSe1:CORRection:COLLect:CKIT:ORDer:TRLReflect 3 

:SENSe1:CORRection:COLLect:CKIT:ORDer:TRLReflect? 

Return: 3 

 

3.3.1.2.9 选择或查询 TRL 直通测量的标准 

命令格式 :SENSe:CORRection:COLLect:CKIT:ORDer:TRLThru 
<numeric1>{,<numeric2>,…,<numeric n>} 

:SENSe:CORRection:COLLect:CKIT:ORDer:TRLThru? 

说明 设置或获取所选校准套件的 TRL直通测量的标准 

参数 <numeric1>{,<numeric2>,…,<numeric n>}:表示标准套件序号，其范围是 1~21。 

返回类型 整型或数组 



 

 

默认值 无 

菜单项 校准 > 校准件 > Edit > TRL > THRU 

举例 :SENSe1:CORRection:COLLect:CKIT:ORDer:TRLThru 3 

:SENSe1:CORRection:COLLect:CKIT:ORDer:TRLThru? 

Return: 3 

 

3.3.1.2.10 校准套件恢复出厂 

命令格式 :SENSe:CORRection:COLLect:CKIT:RESet 

说明 设置选择的校准套件重设为默认的出厂设置状态 

参数 无 

返回值 无 

默认值 无 

菜单项 无 

举例 :SENSe:CORRection:COLLect:CKIT 2 

:SENSe:CORRection:COLLect:CKIT:ORDer:OPEN 1,3 

:SENSe:CORRection:COLLect:CKIT:RESet 

:SENSe:CORRection:COLLect:CKIT:ORDer:OPEN? 

Return: 2 

 

3.3.1.2.11 选择校准套件 

命令格式 :SENSe:CORRection:COLLect:CKIT[:SELect] <numeric> 

:SENSe:CORRection:COLLect:CKIT[:SELect]? 

说明 设置或获取选择的校准套件号。 

参数 <numeric>:表示校准套件序号，其范围是 1~32 

返回类型 整数 

默认值 1 

菜单项 无 

举例 :SENSe:CORRection:COLLect:CKIT 2 

:SENSe:CORRection:COLLect:CKIT? 

Return: 2 

 

3.3.1.2.12 标准类型 

命令格式 :SENSe:CORRection:COLLect:CKIT:STAN<snum>:TYPE <type> 

:SENSe:CORRection:COLLect:CKIT:STAN<snum>:TYPE? 
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说明 设置或获取选择的校准套件标准的标准类型。 

参数 <snum>:= {[1]-30}：表示校准套件标准序号。 

<type>:= {OPEN|SHORt|LOAD|THRU} 

返回类型 枚举 

默认值 OPEN 

菜单项 校准 > 校准套件 > Edit Kit > Standards > Add > Add Standard 

举例 :SENSe:CORRection:COLLect:CKIT:STAN1:TYPE LOAD 

:SENSe:CORRection:COLLect:CKIT:STAN1:TYPE? 

Return: LOAD 

 

3.3.1.2.13 标准 C0 值 

命令格式 :SENSe:CORRection:COLLect:CKIT:STAN<snum>:C0 <numeric> 

:SENSe:CORRection:COLLect:CKIT:STAN<snum>:C0? 

说  明 设置或获取选择的校准套件标准的 C0值。 

参数 <snum>:= {[1]-30}：表示校准套件标准序号。 

<numeric>：表示 C0 值。 

返回类型 浮点型，单位 fF （1E-15 F（法拉）） 

默认值 无 

菜单项 校准 > 校准套件 > Edit Kit > Standards > Edit > Open Characteristics > C0 

举例 :SENSe:CORRection:COLLect:CKIT:STAN2:C0 100 

:SENSe:CORRection:COLLect:CKIT:STAN2:C0? 

Return: 100 

 

3.3.1.2.14 标准 C1 值 

命令格式 :SENSe:CORRection:COLLect:CKIT:STAN<snum>:C1 <numeric> 

:SENSe:CORRection:COLLect:CKIT:STAN<snum>:C1? 

说  明 设置或获取选择的校准套件标准的 C1值。 

参数 <snum>:= {[1]-30}：表示校准套件标准序号。 

<numeric>：表示 C1 值。 

返回类型 浮点型，单位 1E-27 F/Hz（1E-27法拉/赫兹） 

默认值 无 

菜单项 校准 > 校准套件 > Edit Kit > Standards > Edit > Open Characteristics > C1 



 

 

举例 :SENSe:CORRection:COLLect:CKIT:STAN2:C1 12.3 

:SENSe:CORRection:COLLect:CKIT:STAN2:C1? 

Return: 12.3 

 

3.3.1.2.15 标准 C2 值 

命令格式 :SENSe:CORRection:COLLect:CKIT:STAN<snum>:C2 <numeric> 

:SENSe:CORRection:COLLect:CKIT:STAN<snum>:C2? 

说明 设置或获取选择的校准套件标准的 C2值。 

参数 <snum>:= {[1]-30}：表示校准套件标准序号。 

<numeric>：表示 C2 值。 

返回类型 浮点型，单位 1E-36 F/Hz² （1E-36法拉/赫兹²） 

默认值 无 

菜单项 校准 > 校准套件 > Edit Kit > Standards > Edit > Open Characteristics > C2 

举例 :SENSe:CORRection:COLLect:CKIT:STAN2:C2 25 

:SENSe:CORRection:COLLect:CKIT:STAN2:C2? 

Return: 25 

 

3.3.1.2.16 标准 C3 值 

命令格式 :SENSe:CORRection:COLLect:CKIT:STAN<snum>:C3 <numeric> 

:SENSe:CORRection:COLLect:CKIT:STAN<snum>:C3? 

说明 设置或获取选择的校准套件标准的 C3值。 

参数 <snum>:= {[1]-30}：表示校准套件标准序号。 

<numeric>：表示 C3 值。 

返回类型 浮点型，单位 1E-45 F/Hz³（1E-45法拉/赫兹³） 

默认值 无 

菜单项 校准 > 校准套件 > Edit Kit > Standards > Edit > Open Characteristics > C3 

举例 :SENSe:CORRection:COLLect:CKIT:STAN2:C3 12.3 

:SENSe:CORRection:COLLect:CKIT:STAN2:C3? 

Return: 12.3 

 

3.3.1.2.17 标准 L0 值 

命令格式 :SENSe:CORRection:COLLect:CKIT:STAN<snum>:L0 <numeric> 

:SENSe:CORRection:COLLect:CKIT:STAN<snum>:L0? 
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说明 设置或获取选择的校准套件标准的 L0值。 

参数 <snum>:= {[1]-30}：表示校准套件标准序号。 

<numeric>：表示 L0值。 

返回类型 浮点型，单位 pH（兆分之一亨利） 

默认值 无 

菜单项 校准 > 校准套件 > Edit Kit > Standards > Edit > Short Characteristics > L0 

举例 :SENSe:CORRection:COLLect:CKIT:STAN3:L0 10 

:SENSe:CORRection:COLLect:CKIT:STAN3:L0? 

Return: 10 

 

 

3.3.1.2.18 标准 L1 值 

命令格式 :SENSe:CORRection:COLLect:CKIT:STAN<snum>:L1 <numeric> 

:SENSe:CORRection:COLLect:CKIT:STAN<snum>:L1? 

说明 设置或获取选择的校准套件标准的 L1值。 

参数 <snum>:= {[1]-30}：表示校准套件标准序号。 

<numeric>：表示 L1值。 

返回类型 浮点型，单位 1E-24 H/Hz （1E-24亨利/赫兹） 

默认值 无 

菜单项 校准 > 校准套件 > Edit Kit > Standards > Edit > Short Characteristics > L1 

举例 :SENSe:CORRection:COLLect:CKIT:STAN3:L1 12.3 

:SENSe:CORRection:COLLect:CKIT:STAN3:L1? 

Return: 12.3 

 

 

3.3.1.2.19 标准 L2 值 

命令格式 :SENSe:CORRection:COLLect:CKIT:STAN<snum>:L2 <numeric> 

:SENSe:CORRection:COLLect:CKIT:STAN<snum>:L2? 

说明 设置或获取选择的校准套件标准的 L2值。 

参数 <snum>:= {[1]-30}：表示校准套件标准序号。 

<numeric>：表示 L2值。 

返回类型 浮点型，单位 1E-33 H/Hz² （1E-33亨利/赫兹²） 

默认值 无 



 

 

菜单项 校准 > 校准套件 > Edit Kit > Standards > Edit > Short Characteristics > L2 

举例 :SENSe:CORRection:COLLect:CKIT:STAN3:L2 12.3 

:SENSe:CORRection:COLLect:CKIT:STAN3:L2? 

Return: 12.3 

 

3.3.1.2.20 标准 L3 值 

命令格式 :SENSe:CORRection:COLLect:CKIT:STAN<snum>:L3 <numeric> 

:SENSe:CORRection:COLLect:CKIT:STAN<snum>:L3? 

说明 设置或获取选择的校准套件标准的 L3值。 

参数 <snum>:= {[1]-30}：表示校准套件标准序号。 

<numeric>：表示 L3值。 

返回类型 浮点型，单位 1E-42 H/Hz³ （1E-42亨利/赫兹³） 

默认值 无 

菜单项 校准 > 校准套件 > Edit Kit > Standards > Edit > Short Characteristics > L3 

举例 :SENSe:CORRection:COLLect:CKIT:STAN3:L3 12.3 

:SENSe:CORRection:COLLect:CKIT:STAN3:L3? 

Return: 12.3 

 

3.3.1.2.21 校准套件标准名 

命令格式 :SENSe:CORRection:COLLect:CKIT:STAN<snum>:LABel <string> 

:SENSe:CORRection:COLLect:CKIT:STAN<snum>:LABel? 

说明 设置或获取选择校准套件的校准套件标准名。 

参数 <snum>:= {[1]-30}：表示校准套件标准序号。 

<string>: 表示标准名。 

返回类型 字符串 

默认值 无 

菜单项 校准 > 校准套件 > Edit Kit > Standard > Edit > Label 

举例 :SENSe:CORRection:COLLect:CKIT:STAN1:LABel "LOAD_1" 

:SENSe:CORRection:COLLect:CKIT:STAN1:LABel? 

Return: LOAD_1 

 

3.3.1.2.22 标准偏置延迟 

命令格式 :SENSe:CORRection:COLLect:CKIT:STAN<snum>:DELay <numeric> 

:SENSe:CORRection:COLLect:CKIT:STAN<snum>:DELay? 
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说明 设置或获取选择的校准套件标准的偏置延迟值。 

参数 <snum>:= {[1]-30}：表示校准套件标准序号。 

<numeric>: 表示偏置延迟值。 

返回类型 浮点型，单位 s（秒） 

默认值 无 

菜单项 校准 > 校准套件 > Edit Kit > Standards > Edit > Delay Characteristics > Delay 

举例 :SENSe:CORRection:COLLect:CKIT:STAN1:DELay 1 

:SENSe:CORRection:COLLect:CKIT:STAN1:DELay? 

Return: 1 

 

3.3.1.2.23 标准最小频率 

命令格式 :SENSe:CORRection:COLLect:CKIT:STAN<snum>:FMINimum <numeric> 

:SENSe:CORRection:COLLect:CKIT:STAN<snum>:FMINimum? 

说明 设置或获取选择的校准套件标准的开始频率值。 

参数 <snum>:= {[1]-30}：表示校准套件标准序号。 

<numeric>: 表示开始频率值。 

返回类型 浮点型，单位（赫兹） 

默认值 无 

菜单项 校准 > 校准套件 > Edit Kit > Standard > Edit > Freqquency Range > Min 

举例 :SENSe:CORRection:COLLect:CKIT:STAN1:FMINimum 500e6 

:SENSe:CORRection:COLLect:CKIT:STAN1:FMINimum? 

Return: 500000000 

 

3.3.1.2.24 标准最大频率 

命令格式 :SENSe:CORRection:COLLect:CKIT:STAN<snum>:FMAXimum <numeric> 

:SENSe:CORRection:COLLect:CKIT:STAN<snum>:FMAXimum? 

说明 设置或获取选择的校准套件标准的停止频率值。 

参数 <snum>:= {[1]-30}：表示校准套件标准序号。 

<numeric>: 表示停止频率值。 

返回类型 浮点型，单位（赫兹） 

默认值 无 



 

 

菜单项 校准 > 校准套件 > Edit Kit > Standards > Edit > Frequency Range > Max 

举例 :SENSe:CORRection:COLLect:CKIT:STAN1:FMAXimum 4.5e9 

:SENSe:CORRection:COLLect:CKIT:STAN1:FMAXimum? 

Return: 4500000000 

 

3.3.1.2.25 标准件偏置损耗 

命令格式 :SENSe:CORRection:COLLect:CKIT:STAN<snum>:LOSS <numeric> 

:SENSe:CORRection:COLLect:CKIT:STAN<snum>:LOSS? 

说明 设置或获取选择的校准套件标准的偏置损耗值。 

参数 <snum>:= {[1]-30}：表示校准套件标准序号。 

<numeric>: 表示偏置损耗值。 

返回类型 浮点型，单位欧姆/秒 

默认值 无 

菜单项 校准 > 校准套件 > Edit Kit > Standards > Edit > Delay Characteristics > Loss 

举例 :SENSe:CORRection:COLLect:CKIT:STAN1:LOSS 0.5 

:SENSe:CORRection:COLLect:CKIT:STAN1:LOSS? 

Return: 0.5 

 

3.3.1.2.26 标准件偏置 Z0 值 

命令格式 :SENSe:CORRection:COLLect:CKIT:STAN<snum>:Z0 <numeric> 

:SENSe:CORRection:COLLect:CKIT:STAN<snum>:Z0? 

说明 设置或获取选择的校准套件标准的偏置 Z0值。 

参数 <snum>:= {[1]-30}：表示校准套件标准序号。 

<numeric>: 表示偏置 Z0值。 

返回类型 浮点型，单位欧姆 

默认值 无 

菜单项 校准 > 校准套件 > Edit Kit > Standards > Edit > Delay Characteristics > Z0 

举例 :SENSe:CORRection:COLLect:CKIT:STAN1:Z0 75 

:SENSe:CORRection:COLLect:CKIT:STAN1:Z0? 

Return: 75 

3.3.1.2.27 TRL 校准参考阻抗 

命令格式 :SENSe:CORRection:COLLect:CKIT:TRLoption:IMPedance <type> 

:SENSe:CORRection:COLLect:CKIT:TRLoption:IMPedance? 
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说明 设置或获取选择的校准套件 TRL校准时的参考阻抗。 

参数 <type>:= {LINE|SYSTem} 

返回类型 枚举 

默认值 SYSTem 

菜单项 校准 > 校准套件 > Edit Kit > TRL > Calibration Reference Z0 

举例 :SENSe:CORRection:COLLect:CKIT:TRLoption:IMPedance LINE 

:SENSe:CORRection:COLLect:CKIT:TRLoption:IMPedance? 

Return: LINE 

 

3.3.1.2.28 TRL 校准平面 

命令格式 :SENSe:CORRection:COLLect:CKIT:TRLoption:RPLane <type> 

:SENSe:CORRection:COLLect:CKIT:TRLoption:RPLane? 

说明 设置或获取选择的校准套件 TRL校准平面的计算方法。 

参数 <type>:= {THRU|REFLect} 

返回类型 枚举 

默认值 THRU 

菜单项 校准 > 校准套件 > Edit Kit > TRL > Test Port reference Plane 

举例 :SENSe:CORRection:COLLect:CKIT:TRLoption:RPLane REFLect 

:SENSe:CORRection:COLLect:CKIT:TRLoption:RPLane? 

Return: REFL 

 

3.3.1.3 校准补偿 

3.3.1.3.1 命令列表 

校准补偿开关 :SENSe<cnum>:CORRection:STATe 

功率校准补偿开关 :SOURce<cnum>:POWer:PORT<pnum>:CORRection[:STATe] 

功率校准补偿数据 :SOURce<cnum>:POWer:PORT<pnum>:CORRection:DATA 

执行功率校准 :SOURce{<cnum>:POWer:PORT<pnum>:CORRection:COLLect[:ACQuire] 

最大迭代次数 :SOURce<cnum>:POWer:PORT<pnum>:CORRection:COLLect:ITERation[:COUNt] 

测量次数 :SOURce<cnum>:POWer:PORT<pnum>:CORRection:COLLect:AVERage[:COUNt] 

损耗补偿开关 :SOURce<cnum>:POWer:PORT<pnum>:CORRection:COLLect:TABLe:LOSS[:STATe]  

损耗补偿表数据 :SOURce<cnum>:POWer:PORT<pnum>:CORRection:COLLect:TABLe:LOSS:DATA 



 

 

 

3.3.1.3.2 校准补偿开关 

命令格式 :SENSe<cnum>:CORRection:STATe <bool> 

:SENSe<cnum>:CORRection:STATe? 

说明 设置或获取选择通道的校准补偿开关。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<bool>:= ON|OFF|1|0 

返回类型 Boolean (1=ON,0=OFF) 

默认值 OFF 

菜单项 校准 > 校准 > 校准补偿 

举例 :SENSe1:CORRection:STATe ON 

:SENSe1:CORRection:STATe? 

Return: 1 

 

3.3.1.3.3 功率校准补偿开关 

命令格式 :SOURce<cnum>:POWer:PORT<pnum>CORRection[:STATe] <bool> 

:SOURce<cnum>:POWer:PORT<pnum>:CORRection[:STATe]? 

说明 设置或获取选择通道及端口功率补偿开关状态。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<pnum>:={1|2|3|4}，表示端口号。 

<bool>:= ON|OFF|1|0 

返回类型 Boolean (1=ON,0=OFF) 

默认值 OFF 

菜单项 校准 > 校准 > 功率校准… 

举例 :SOURce1:POWer:PORT1:CORRection ON 

:SOURce1:POWer:PORT1:CORRection? 

Return: 1 

 

3.3.1.3.4 功率校准补偿数据 

命令格式 :SOURce<cnum>:POWer:PORT<pnum>:CORRection:DATA  
<numeric 1>, ..,<numeric NOP> 

 

:SOURce<cnum>:POWer:PORT<pnum>:CORRection:DATA? 

说明 设置或获取选择通道及端口功率校准补偿数据。 
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参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<pnum>:={1|2|3|4}，表示端口号。 

<numeric 1>, ..,<numeric NOP>: 

表示 NOP（Numbers of point）*1 的数组数据（功率校准数据数组）。n 为 1 到

NOP 之间的整数。 

数据（n-1）：第 n个数据点的补偿数据（-20~100dB）。 

数组索引从 0开始。 

返回类型 数据数组 

默认值 无 

菜单项 无 

举例 :SENSe1:SWEep:POINts 5 

:SOURce1:POWer:PORT2:CORRection:DATA 1,2,3,4,5 

:SOURce1:POWer:PORT2:CORRection:DATA? 

Return: 1,2,3,4,5 

 

3.3.1.3.5 执行功率校准 

命令格式 :SOURce<cnum>:POWer:PORT<pnum>:CORRection:COLLect[:ACQuire] 

说明 执行功率校准，校准完成后误差系数补偿将会自动打开。 

参数 
<cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<pnum>:={1|2|3|4}，表示端口号。 

返回类型 无 

默认值 无 

菜单项 校准 > 功率校准 > Take Cal Sweep 

举例 :SOURce1:POWer:PORT2:CORRection:COLLect 

 

3.3.1.3.6 最大迭代次数 

命令格式 :SOURce<cnum>:POWer:PORT<pnum>:CORRection:COLLect:ITERation[:COUNt] 
<numeric> 

 

:SOURce<cnum>:POWer:PORT<pnum>:CORRection:COLLect:ITERation[:COUNt]? 

说明 设置或获取功率校准的迭代次数。当执行一次功率校准完成后，若 测量的功率输出超

出容差范围，则重新执行功率校准，直到达到最大的迭代次数。 



 

 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<pnum>:={1|2}，表示端口号。 

<numeric>:表示迭代次数，其范围是 0~50。 

返回类型 整型 

默认值 0 

菜单项 校准 > 功率校准 > 最大迭代次数 

举例 :SOURce1:POWer:PORT2:CORRection:COLLect:ITERation 10 

:SOURce1:POWer:PORT2:CORRection:COLLect:ITERation? 

Return: 10 

 

3.3.1.3.7 测量次数 

命令格式 :SOURce<cnum>:POWer:PORT<pnum>:CORRection:COLLect:AVERage[:COUNt] 
<numeric> 

 

:SOURce<cnum>:POWer:PORT<pnum>:CORRection:COLLect:AVERage[:COUNt]? 

说明 设置或获取功率校准的各频点测量次数。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<pnum>:={1|2}，表示端口号。 

<numeric>:表示各频点测量次数，其范围是 1~50. 

返回类型 整型 

默认值 1 

菜单项 校准 > 功率校准 > 测量次数 

举例 :SOURce1:POWer:PORT2:CORRection:COLLect:AVERage 5 

:SOURce1:POWer:PORT2:CORRection:COLLect:AVERage? 

Return: 5 

 

3.3.1.3.8 损耗补偿开关 

 

命令格式 :SOURce<cnum>:POWer:PORT<pnum>:CORRection:COLLect:TABLe:LOSS 

[:STATe] <bool> 

 

:SOURce<cnum>:POWer:PORT<pnum>:CORRection:COLLect:TABLe:LOSS 

[:STATe]? 

说  明 设置或获取选择通道及端口功率损耗补偿状态。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 
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<pnum>:={1|2|3|4}，表示端口号。 

<bool>:= ON|OFF|1|0 

返回类型 布尔型 

默认值 Boolean (1=ON,0=OFF) 

菜单项 校准 > 功率校准 > 损耗补偿 > Power Loss Compensation > Compensation On  

举例 :SOURce1:POWer:PORT2:CORRection:COLLect:TABLe:LOSS ON 

:SOURce1:POWer:PORT2:CORRection:COLLect:TABLe:LOSS? 

Return: 1 

 

3.3.1.3.9 损耗补偿表数据 

命令格式 :SOURce<cnum>:POWer:PORT<pnum>:CORRection:COLLect:TABLe:LOSS: 

DATA <numeric 1>,...,<numeric 1+(Nx2)> 

 

:SOURce<cnum>:POWer:PORT<pnum>:CORRection:COLLect:TABLe:LOSS: 

DATA? 

说明 设置或获取选择通道及端口功率损耗补偿数据。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<pnum>:={1|2|3|4}，表示端口号。 

 

<numeric 1>,...,<numeric 1+(Nx2)>: 

表示 NOP（Numbers of point）*2的数组数据（损耗补偿数据数组）。n为 1到 NOP

之间的整数。 

数据（0）：想要设置的数据点个数。 

数据（n*2-1）：第 n个数据点的频率（矢量网络分析仪的频率范围）。 

数据（n*2）：第 n个数据点的损耗（-20~100dB）。 

数组索引从 0 开始。 

返回类型 数据数组 

默认值 无 

菜单项 校准 > 功率校准 > 损耗补偿 > Power Loss Compensation 

举例 :SOURce1:POWer:PORT2:CORRection:COLLect:TABLe:LOSS:DATA 
2,2e9,3,5e9,-0.5 

 

:SOURce1:POWer:PORT2:CORRection:COLLect:TABLe:LOSS:DATA? 

Return: 2,2e+09,3,5e+09,-0.5 

 



 

 

3.3.2 端口延伸 

3.3.2.1 命令列表 

端口延伸状态 :SENSe<cnum>:CORRection:EXTension[:STATe] 

端口延迟时间 :SENSe<cnum>:CORRection:EXTension:PORT<pnum>:TIME  

端口延迟距离 :SENSe<cnum>:CORRection:EXTension:PORT<pnum>:DISTance  

端口延迟距离单位 :SENSe<cnum>:CORRection:EXTension:PORT<pnum>:DISTANCE:UNIT 

端口延伸速度系数 :SENSe<cnum>:CORRection:EXTension:PORT<pnum>:VELFactor 

端口速度系数耦合状态 :SENSe<cnum>:CORRection:EXTension:PORT<pnum>:SYSVelocity 

端口延伸直流损耗值 :SENSe<cnum>:CORRection:EXTension:PORT<pnum>:LDC 

端口损耗和频率状态 :SENSe<cnum>:CORRection:EXTension:PORT<pnum>:INCLude<type> [:STATe] 

端口延伸端口损耗值 :SENSe<cnum>:CORRection:EXTension:PORT<pnum>:LOSS 

端口端口延伸频率的停止频率 :SENSe<cnum>:CORRection:EXTension:PORT<pnum>:FREQuency 

重置端口延伸参数 :SENSe<cnum>:CORRection:EXTension:AUTO:RESet 

损耗补偿计算方法 :SENSe<cnum>:CORRection:EXTension:AUTO:CONFig 

包括损耗状态 :SENSe<cnum>:CORRection:EXTension:AUTO:LOSS 

调整失配状态 :SENSe<cnum>:CORRection:EXTension:AUTO:DCOFfset 

跨距起始频率 :SENSe<cnum>:CORRection:EXTension:AUTO:STARt 

跨距终止频率 :SENSe<cnum>:CORRection:EXTension:AUTO:STOP 

 

 

3.3.2.2 端口延伸状态 

命令格式 :SENSe<cnum>:CORRection:EXTension[:STATe] <bool> 

:SENSe<cnum>:CORRection:EXTension[:STATe]? 

说明 设置或获取端口延伸开关状态。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<bool>:= ON|OFF|1|0 

返回类型 Boolean (1=ON,0=OFF) 

默认值 OFF 

菜单项 校准 > 端口延伸 > 端口延伸开关 

举例 :SENSe1:CORRection:EXTension ON 

:SENSe1:CORRection:EXTension? 

Return: 1 

 

3.3.2.3 端口延迟时间 

命令格式 :SENSe<cnum>:CORRection:EXTension:PORT<pnum>:TIME <numeric> 

:SENSe<cnum>:CORRection:EXTension:PORT<pnum>:TIME? 
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说明 设置或获取端口延伸延迟时间。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<pnum>:={1|2|3|4}，表示端口号 

<numeric>: 表示端口延伸延迟时间，其范围是 0~10s。 

返回类型 浮点型，单位 s（秒） 

默认值 0 

菜单项 校准 > 端口延伸 > Time 

举例 :SENSe1:CORRection:EXTension:PORT1:TIME 5 

:SENSe1:CORRection:EXTension:PORT1:TIME? 

Return: 5 

 

3.3.2.4 端口延迟距离 

命令格式 :SENSe<cnum>:CORRection:EXTension:PORT<pnum>:DISTance <numeric> 

 

:SENSe<cnum>:CORRection:EXTension:PORT<pnum>:DISTance? 

说  明 设置或获取端口延伸延迟距离。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<pnum>:={1|2|3|4}，表示端口号。 

<numeric>: 表示端口延伸延迟距离。 

返回类型 浮点型，单位 m（米），或 ft（英尺），或 in（英寸） 

默认值 0 

菜单项 校准 > 端口延伸 > 距离 

举例 :SENSe1:CORRection:EXTension:PORT1:DISTance 1 

:SENSe1:CORRection:EXTension:PORT1:DISTance? 

Return: 1 

 

3.3.2.5 端口延迟距离单位 

命令格式 :SENSe<cnum>:CORRection:EXTension:PORT<pnum>:DISTANCE:UNIT 
<type> 

 

:SENSe<cnum>:CORRection:EXTension:PORT<pnum>:DISTANCE:UNIT? 

说明 设置或获取端口延伸延迟距离 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<pnum>:={1|2|3|4}，表示端口号。 

<type>:={METers|FEET|INCHes} 



 

 

返回类型 枚举 

默认值 METer 

菜单项 校准 > 端口延伸 > 端口延伸… > Delay > Distance Units 

举例 :SENSe1:CORRection:EXTension:PORT1:DISTANCE:UNIT INCH 

:SENSe1:CORRection:EXTension:PORT1:DISTANCE:UNIT? 

Return: INCH 

 

3.3.2.6 端口延伸速度系数 

命令格式 :SENSe<cnum>:CORRection:EXTension:PORT<pnum>:VELFactor <numeric> 

 

:SENSe<cnum>:CORRection:EXTension:PORT<pnum>:VELFactor? 

说明 设置或获取端口插入的设备媒体的速度系数 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<pnum>:={1|2|3|4}，表示端口号。 

<numeric>:=表示速度系数，其范围是 0~1。 

返回类型 浮点型 

默认值 1 

菜单项 校准 > 端口延伸 > 速度系数 

举例 :SENSe1:CORRection:EXTension:PORT1:VELFactor 0.66 

:SENSe1:CORRection:EXTension:PORT1:VELFactor? 

Return: 0.66 

 

3.3.2.7 端口速度系数耦合状态 

命令格式 :SENSe<cnum>:CORRection:EXTension:PORT<pnum>:SYSVelocity <bool> 

 

:SENSe<cnum>:CORRection:EXTension:PORT<pnum>:SYSVelocity? 

说明 设置或获取端口系数耦合开关状态。如果取消选中，则仅对指定的端口和端口延伸

设置速度系数；如果选中，则对所有端口设置速度系数。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<pnum>:={[1]-4}，表示端口号。 

<bool>:= ON|OFF|1|0 

返回类型 Boolean (1=ON,0=OFF) 

默认值 ON 

菜单项 校准 > 端口延伸 > 端口延伸… > Velocity > Couple to system Velocity Factor 

举例 :SENSe1:CORRection:EXTension:PORT1:SYSVelocity 0 
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:SENSe1:CORRection:EXTension:PORT1:SYSVelocity? 

Return: 0 

 

3.3.2.8 端口延伸直流损耗值 

命令格式 :SENSe<cnum>:CORRection:EXTension:PORT<pnum>:LDC <numeric> 

:SENSe<cnum>:CORRection:EXTension:PORT<pnum>:LDC? 

说明 设置或获取端口延伸直流损耗值。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<pnum>:={1|2|3|4}，表示端口号。 

<numeric>:表示端口延伸直流损耗值，其范围是-90 ~ 90dB。 

返回类型 浮点型，单位 dB 

默认值 0dB 

菜单项 校准 > 端口延伸 > 直流损耗 

举例 :SENSe1:CORRection:EXTension:PORT2:LDC 10 

:SENSe1:CORRection:EXTension:PORT2:LDC? 

Return: 10 

 

3.3.2.9 端口损耗和频率状态 

命令格式 :SENSe<cnum>:CORRection:EXTension:PORT<pnum>:INCLude<type>[:STATe] 
<bool> 

 

:SENSe<cnum>:CORRection:EXTension:PORT<pnum>:INCLude<type>[:STATe] 

说明 设置或获取端口延伸频率和损耗设置状态。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<pnum>:={1|2|3|4}，表示端口号。 

<type>:={[1]|2} 

<bool>:= ON|OFF|1|0 

返回类型 Boolean (1=ON,0=OFF) 

默认值 OFF 

菜单项 校准 > 端口延伸 > 端口延伸… > Loss 

举例 :SENSe1:CORRection:EXTension:PORT1:INCLude1 ON 

:SENSe1:CORRection:EXTension:PORT1:INCLude1? 

Return: 1 

 

3.3.2.10 端口延伸端口损耗值 

命令格式 :SENSe<cnum>:CORRection:EXTension:PORT<pnum>:LOSS<type> <numeric> 

:SENSe<cnum>:CORRection:EXTension:PORT<pnum>:LOSS<type>? 



 

 

说明 设置或获取端口延伸损耗值。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<pnum>:={1|2|3|4}，表示端口号。 

<type>:={[1]|2} 

<numeric>:表示端口延伸损耗值，其范围是-90 ~ 90dB。 

返回类型 浮点型，单位 dB 

默认值 0dB 

菜单项 校准 > 端口延伸 > 端口延伸… > Loss > Loss1 or Loss2 

举例 :SENSe1:CORRection:EXTension:PORT1:LOSS1 2 

:SENSe1:CORRection:EXTension:PORT1:LOSS1? 

Return: 2 

 

3.3.2.11 端口延伸频率的停止频率 

命令格式 :SENSe<cnum>:CORRection:EXTension:PORT<pnum>:FREQuency<type> 
<numeric> 

 

:SENSe<cnum>:CORRection:EXTension:PORT<pnum>:FREQuency<type>? 

说明 针对选择的通道设置/获取用户指定自动端口扩展频率范围内的停止频率。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<pnum>:={1|2|3|4}，表示端口号。 

<type>:={[1]|2} 

<numeric>:表示停止频率。 

返回类型 双精度浮点型，单位 Hz 

默认值 1GHz 

菜单项 校准 > 端口延伸 > 端口延伸… > Loss > Freq1 or Freq2 

举例 :SENSe1:CORRection:EXTension:PORT2:FREQuency2 2e9 

:SENSe1:CORRection:EXTension:PORT2:FREQuency2? 

Return: 2000000000 

 

 

3.3.2.12 重置端口延伸参数 

命令格式 :SENSe<cnum>:CORRection:EXTension:AUTO:RESet 

说明 将所有端口延伸设置更改为预设值。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 
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返回类型 无 

默认值 无 

菜单项 校准 > 端口延伸 > 端口延伸… > 重置 

举例 :SENSe1:CORRection:EXTension:AUTO:RESet 

 

3.3.2.13 损耗补偿计算方法 

命令格式 :SENSe<cnum>:CORRection:EXTension:AUTO:CONFig <type> 

 

:SENSe<cnum>:CORRection:EXTension:AUTO:CONFig? 

说明 设置或获取计算损耗补偿的方法。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<type>:={CSPN|AMKR|USPN} 

返回类型 枚举 

默认值 CSPN 

菜单项 校准 > 端口延伸 > Automatic Port Extension > Method 

举例 :SENSe1:CORRection:EXTension:AUTO:CONFig USPN 

:SENSe1:CORRection:EXTension:AUTO:CONFig? 

Return: USPN 

 

3.3.2.14 包括损耗状态 

命令格式 :SENSe<cnum>:CORRection:EXTension:AUTO:LOSS <bool> 

:SENSe<cnum>:CORRection:EXTension:AUTO:LOSS? 

说明 设置或获取包含线损开关状态。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<bool>:= ON|OFF|1|0 

返回类型 Boolean (1=ON,0=OFF) 

默认值 ON 

菜单项 校准 > 端口延伸 > Automatic Port Extension > Setting > Include Loss 

举例 :SENSe1:CORRection:EXTension:AUTO:LOSS OFF 

:SENSe1:CORRection:EXTension:AUTO:LOSS? 

Return: 0 

 

3.3.2.15 调整失配状态 

命令格式 :SENSe<cnum>:CORRection:EXTension:AUTO:DCOFfset <bool> 

:SENSe<cnum>:CORRection:EXTension:AUTO:DCOFfset? 



 

 

说明 设置或获取使用自动端口扩展结果直流损耗值的状态。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<bool>:= ON|OFF|1|0 

返回类型 Boolean (1=ON,0=OFF) 

默认值 ON 

菜单项 校准 > 端口延伸 > Automatic Port Extension > Setting > Adjust for Mismatch 

举例 :SENSe1:CORRection:EXTension:AUTO:DCOFfset 0 

:SENSe1:CORRection:EXTension:AUTO:DCOFfset? 

Return: 0 

 

3.3.2.16 跨距起始频率 

命令格式 :SENSe<cnum>:CORRection:EXTension:AUTO:STARt <numeric> 

:SENSe<cnum>:CORRection:EXTension:AUTO:STARt? 

说明 设置或获取用户跨距起始频率。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<numeric>:表示用户跨距起始频率。 

返回类型 浮点型，单位 Hz 

默认值 100 kHz 

菜单项 校准 > 端口延伸 > Automatic Port Extension > Setting > User Span > Start 

举例 :SENSe1:CORRection:EXTension:AUTO:STARt 1e6 

:SENSe1:CORRection:EXTension:AUTO:STARt? 

Return: 1000000 

 

3.3.2.17 跨距终止频率 

命令格式 :SENSe<cnum>:CORRection:EXTension:AUTO:STOP <numeric> 

:SENSe<cnum>:CORRection:EXTension:AUTO:STOP? 

说明 设置或获取用户跨距终止频率。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<numeric>:表示用户跨距终止频率。 

返回类型 浮点型，单位 Hz 

默认值 矢量网络分析仪的最大频率 

菜单项 校准 > 端口延伸 > Automatic Port Extension > Setting >User Span > Stop 

举例 :SENSe1:CORRection:EXTension:AUTO:STOP 1e9 

:SENSe1:CORRection:EXTension:AUTO:STOP?  

Return: 1000000000 
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3.3.3 夹具仿真 

3.3.3.1 端口匹配 

3.3.3.1.1 命令列表 

夹具仿真功能开

关 
:CALCulate<cnum>:FSIMulator:STATe 

匹配电路嵌入功

能开关 
:CALCulate<cnum>:FSIMulator:SENDed:PMCircuit:STATe 

匹配电路标准文

件名  
:CALCulate<cnum>:FSIMulator:SENDed:PMCircuit:PORT<pnum>:USER:FILename 

匹配电路类型 :CALCulate<cnum>:FSIMulator:SENDed:PMCircuit:PORT<pnum> [:TYPE] 

匹配电路 C 值 :CALCulate<cnum>:FSIMulator:SENDed:PMCircuit:PORT<pnum>:PARameters:C<type> 

匹配电路 L值  :CALCulate<cnum>:FSIMulator:SENDed:PMCircuit:PORT<pnum>:PARameters:L<type> 

匹配电路 R 值 :CALCulate<cnum>:FSIMulator:SENDed:PMCircuit:PORT<pnum>:PARameters:R<type> 

匹配电路 G值 :CALCulate<cnum>:FSIMulator:SENDed:PMCircuit:PORT<pnum>:PARameters:G<type> 

3.3.3.1.2 夹具仿真功能开关 

命令格式 :CALCulate<cnum>:FSIMulator:STATe <bool> 

:CALCulate<cnum>:FSIMulator:STATe? 

说明 设置或获取所选通道夹具模拟器的开关状态。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<bool>:= ON|OFF|1|0 

返回类型 Boolean (1=ON,0=OFF) 

默认值 OFF 

菜单项 校准 > 夹具仿真 > 夹具仿真应用 

举例 :CALCulate1:FSIMulator:STATe ON 

:CALCulate1:FSIMulator:STATe? 

Return: 1 

 

3.3.3.1.3 匹配电路嵌入功能开关 

命令格式 :CALCulate<cnum>:FSIMulator:SENDed:PMCircuit:STATe <bool> 



 

 

:CALCulate<cnum>:FSIMulator:SENDed:PMCircuit:STATe? 

说明 设置或获取所选通道所有端口匹配电路嵌入功能的开关状态。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<bool>:= ON|OFF|1|0 

返回类型 Boolean (1=ON,0=OFF) 

默认值 OFF 

菜单项 校准 > 夹具仿真 > 夹具仿真设置 > Port Match… 

举例 :CALCulate1:FSIMulator:SENDed:PMCircuit:STATe ON 

:CALCulate1:FSIMulator:SENDed:PMCircuit:STATe? 

Return: 1 

 

3.3.3.1.4 匹配电路标准文件名 

命令格式 :CALCulate<cnum>:FSIMulator:SENDed:PMCircuit:PORT<pnum>:USER: 

FILename <string> 

 

:CALCulate<cnum>:FSIMulator:SENDed:PMCircuit:PORT<pnum>:USER: 

FILename? 

说明 设置或获取所选通道和指定端口的 2端口标准文件。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<pnum>:={[1]-4}，表示端口号。 

<string>:表示 2端口 SNP 文件。 

返回类型 无 

默认值 无 

菜单项 校准 > 夹具仿真 > 夹具仿真设置 > Port Matching > Match S2P File 

举例 :CALCulate1:FSIMulator:SENDed:PMCircuit:PORT1:USER:FILename 
"local/test.s2p" 

:CALCulate1:FSIMulator:SENDed:PMCircuit:PORT1:USER:FILename? 

Return: local/test.s2p 

 

3.3.3.1.5 匹配电路类型 

命令格式 :CALCulate<cnum>:FSIMulator:SENDed:PMCircuit:PORT<pnum>[:TYPE] 
<type> 

:CALCulate<cnum>:FSIMulator:SENDed:PMCircuit:PORT<pnum>[:TYPE]? 

说明 设置或获取所选通道和端口匹配电路类型。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 
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<pnum>:={[1]-4}，表示端口号。 

<type>:={NONE|SLPC|PCSL|PLSC|SCPL|PLPC|SCPC|PCSC|SLPL| 

PLSL|USER}。 

"NONE"：指定无电路。 

"SLPC"：指定由串联分路 L 和分路 C 组成的电路。 

"PCSL"：指定由分路 C 和串联分路 L组成的电路。 

"PLSC"：指定由分路 L和串联分路 C 组成的电路。 

"SCPL"：指定由串联分路 C 和分路 L组成的电路。 

"PLPC"：指定由分路 L和分路 C 组成的电路。 

"SCPC"：指定由串联分路 C 和分路 C 组成的电路。 

"PCSC"：指定由分路 C 和串联分路 C 组成的电路。 

"SLPL"：指定由串联分路 L 和分路 L组成的电路。 

"PLSL"：指定由分路 L和串联分路 L组成的电路。 

"USER"：指定用户定义电路。 

返回类型 枚举 

默认值 SLPC 

菜单项 校准 > 夹具仿真 > 夹具仿真设置 > Port Matching > Circuit Model 

举例 :CALCulate1:FSIMulator:SENDed:PMCircuit:PORT PLSL 

:CALCulate1:FSIMulator:SENDed:PMCircuit:PORT1? 

Return: PLSL 

 

3.3.3.1.6 匹配电路 C 值 

命令格式 :CALCulate<cnum>:FSIMulator:SENDed:PMCircuit:PORT<pnum>:PARameters: 

C<type> <numeric> 

 

:CALCulate<cnum>:FSIMulator:SENDed:PMCircuit:PORT<pnum>:PARameters: 

C<type>? 

说明 设置或获取所选通道和端口匹配电路 C 值。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<pnum>:={[1]-4}，表示端口号。 

<type>:={[1]-2} 

<numeric>:表示匹配电路 C 值。 

返回类型 浮点数，单位 F（法拉） 

默认值 0 



 

 

菜单项 校准 > 夹具仿真 > 夹具仿真设置 > Port Matching > Circuit Model 

举例 :CALCulate1:FSIMulator:SENDed:PMCircuit:PORT1:PARameters:C 10e-9 

:CALCulate1:FSIMulator:SENDed:PMCircuit:PORT1:PARameters:C? 

Return: 1e-08 

 

3.3.3.1.7 匹配电路 L 值 

命令格式 :CALCulate<cnum>:FSIMulator:SENDed:PMCircuit:PORT<pnum>:PARameters: 

L<type> <numeric> 

 

:CALCulate<cnum>:FSIMulator:SENDed:PMCircuit:PORT<pnum>:PARameters: 

L<type>? 

说明 设置或获取所选通道和端口匹配电路 L值。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<pnum>:={[1]-4}，表示端口号。 

<type>:={[1]-2} 

<numeric>:表示匹配电路 L 值。 

返回类型 浮点数，单位 H（亨利） 

默认值 0 

菜单项 校准 > 夹具仿真 > 夹具仿真设置 > Port Matching > Circuit Model 

举例 :CALCulate1:FSIMulator:SENDed:PMCircuit:PORT1:PARameters:L1 5 

:CALCulate1:FSIMulator:SENDed:PMCircuit:PORT1:PARameters:L1? 

Return: 5 

 

3.3.3.1.8 匹配电路 R 值 

命令格式 :CALCulate<cnum>:FSIMulator:SENDed:PMCircuit:PORT<pnum>:PARameters: 

R<type> <numeric> 

 

:CALCulate<cnum>:FSIMulator:SENDed:PMCircuit:PORT<pnum>:PARameters: 

R<type>? 

说明 设置或获取所选通道和端口匹配电路 R 值。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<pnum>:={[1]-4}，表示端口号。 

<type>:={[1]-2} 

<numeric>:表示匹配电路 R 值。 

返回类型 浮点数，单位欧姆 

默认值 0 
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菜单项 校准 > 夹具仿真 > 夹具仿真设置 > Port Matching > Circuit Model 

举例 :CALCulate1:FSIMulator:SENDed:PMCircuit:PORT1:PARameters:R2 25 

:CALCulate1:FSIMulator:SENDed:PMCircuit:PORT1:PARameters:R2? 

Return: 25 

 

3.3.3.1.9 匹配电路 G 值 

命令格式 :CALCulate<cnum>:FSIMulator:SENDed:PMCircuit:PORT<pnum>:PARameters: 

G<type> <numeric> 

 

:CALCulate<cnum>:FSIMulator:SENDed:PMCircuit:PORT<pnum>:PARameters: 

G<type>? 

说明 设置或获取所选通道和端口匹配电路 G 值。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<pnum>:={[1]-4}，表示端口号。 

<type>:={[1]-2} 

<numeric>:表示匹配电路 G 值。 

返回类型 浮点数，单位 S（西门子） 

默认值 0 

菜单项 校准 > 夹具仿真 > 夹具仿真设置 > Port Matching > Circuit Model 

举例 :CALCulate1:FSIMulator:SENDed:PMCircuit:PORT1:PARameters:G1 10 

:CALCulate1:FSIMulator:SENDed:PMCircuit:PORT1:PARameters:G1? 

Return: 10 

 

3.3.3.2 端口阻抗 

3.3.3.2.1 命令列表 

端口阻抗转换功能开

关 

:CALCulate<cnum>:FSIMulator:SENDed:ZCONversion:STATe 

端口阻抗转换阻抗值 :CALCulate<cnum>:FSIMulator:SENDed:ZCONversion:PORT<pnum>:Z0[:R] 

端口阻抗转换阻抗值

实部 

:CALCulate<cnum>:FSIMulator:SENDed:ZCONversion:PORT<pnum>:REAL 

端口阻抗转换阻抗值

虚部 

:CALCulate<cnum>:FSIMulator:SENDed:ZCONversion:PORT<pnum>:IMAGinary 

 



 

 

3.3.3.2.2 端口阻抗转换功能开关 

命令格式 :CALCulate<cnum>:FSIMulator:SENDed:ZCONversion:STATe <bool> 

:CALCulate<cnum>:FSIMulator:SENDed:ZCONversion:STATe? 

说明 设置或获取所选通道端口阻抗转换功能的开关状态。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<bool>:= ON|OFF|1|0 

返回类型 Boolean (1=ON,0=OFF) 

默认值 OFF 

菜单项 校准 > 夹具仿真 > 夹具仿真设置 > Port Z Conversion 

举例 :CALCulate1:FSIMulator:SENDed:ZCONversion:STATe ON 

:CALCulate1:FSIMulator:SENDed:ZCONversion:STATe? 

Return: 1 

 

3.3.3.2.3 端口阻抗转换阻抗值 

命令格式 :CALCulate<cnum>:FSIMulator:SENDed:ZCONversion:PORT<pnum>:Z0[:R] 
<numeric> 

:CALCulate<cnum>:FSIMulator:SENDed:ZCONversion:PORT<pnum>:Z0[:R]? 

说明 设置或获取所选通道端口阻抗转换函数的阻抗值。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<pnum>:={[1]-4}，表示端口号。 

<numeric>:表示阻抗值,其范围是 0.001 to 1E7。 

返回类型 浮点数，单位欧姆 

默认值 50  

菜单项 校准 > 夹具仿真 > 夹具仿真设置 > Port Z Conversion  > R 

举例 :CALCulate1:FSIMulator:SENDed:ZCONversion:PORT1:Z0 100 

:CALCulate1:FSIMulator:SENDed:ZCONversion:PORT1:Z0? 

Return: 100 

 

3.3.3.2.4 端口阻抗转换阻抗值实部 

命令格式 :CALCulate<cnum>:FSIMulator:SENDed:ZCONversion:PORT<pnum>:REAL 
<numeric> 

:CALCulate<cnum>:FSIMulator:SENDed:ZCONversion:PORT<pnum>:REAL? 

说明 设置或获取所选通道所选端口的阻抗转换函数的阻抗值（实部）。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 
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<pnum>:={[1]-4}，表示端口号。 

<numeric>:表示阻抗值（实部）,其范围是 0.001 to 1E7。 

返回类型 浮点数，单位欧姆 

默认值 50 

菜单项 校准 > 夹具仿真 > 夹具仿真设置 > Port Z Conversion > R 

举例 :CALCulate1:FSIMulator:SENDed:ZCONversion:PORT1:REAL 75 

:CALCulate1:FSIMulator:SENDed:ZCONversion:PORT1:REAL? 

Return: 75 

 

3.3.3.2.5 端口阻抗转换阻抗值虚部 

命令格式 :CALCulate<cnum>:FSIMulator:SENDed:ZCONversion:PORT<pnum>:IMAGinary 
<numeric> 

:CALCulate<cnum>:FSIMulator:SENDed:ZCONversion:PORT<pnum>:IMAGinary? 

说明 设置或获取所选通道所选端口的阻抗转换函数的阻抗值（虚部）。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<pnum>:={[1]-4}，表示端口号。 

<numeric>:表示阻抗值（虚部）,其范围是 -1E+18 ~ 1E+18。 

返回类型 浮点数，单位欧姆 

默认值 0 

菜单项 校准 > 夹具仿真 > 夹具仿真设置 > Port Z Conversion > jX 

举例 :CALCulate1:FSIMulator:SENDed:ZCONversion:PORT1:IMAGinary 100 

:CALCulate1:FSIMulator:SENDed:ZCONversion:PORT1:IMAGinary? 

Return: 100 

 

3.3.3.3 两端口去嵌 

3.3.3.3.1 命令列表 

两端口去嵌入开关 :CALCulate<cnum>:FSIMulator:SENDed:DEEMbed:STATe 

去嵌入功能类型 :CALCulate<cnum>:FSIMulator:SENDed:DEEMbed:PORT<pnum>[:TYPE] 

去嵌入功能标准文

件名 
:CALCulate<cnum>:FSIMulator:SENDed:DEEMbed:PORT<pnum>:USER:FILename 

适配器端口翻转的

开关 
:CALCulate<cnum>:FSIMulator:SENDed:DEEMbed:PORT<pnum>:SNP:REVerse 



 

 

 

3.3.3.3.2 两端口去嵌入开关 

命令格式 :CALCulate<cnum>:FSIMulator:SENDed:DEEMbed:STATe <bool> 

:CALCulate<cnum>:FSIMulator:SENDed:DEEMbed:STATe? 

说明 设置或获取所选通道所有端口网络反嵌入功能的开关状态。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<bool>:= ON|OFF|1|0 

返回类型 Boolean (1=ON,0=OFF) 

默认值 OFF 

菜单项 校准 > 夹具仿真 > 夹具仿真设置 > 2Port De-embedding 

举例 :CALCulate1:FSIMulator:SENDed:DEEMbed:STATe ON 

:CALCulate1:FSIMulator:SENDed:DEEMbed:STATe? 

Return: 1 

 

3.3.3.3.3 去嵌入功能类型 

命令格式 :CALCulate<cnum>:FSIMulator:SENDed:DEEMbed:PORT<pnum>[:TYPE] 
<type> 

:CALCulate<cnum>:FSIMulator:SENDed:DEEMbed:PORT<pnum>[:TYPE]? 

说明 设置或获取所选通道和端口网络反嵌入功能的类型。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<pnum>:={[1]-4}，表示端口号。 

<type>:={NONE|USER} 

NONE:指定无网络反嵌入 

USER:指定用户定义网络去嵌入 

返回类型 枚举 

默认值 NONE 

菜单项 校准 > 夹具仿真 > 夹具仿真设置 > 2Port De-embedding > De-embedding Type 

举例 :CALCulate1:FSIMulator:SENDed:DEEMbed:PORT1 USER 

:CALCulate1:FSIMulator:SENDed:DEEMbed:PORT1? 

Return: USER 

 

3.3.3.3.4 去嵌入功能标准文件名 

命令格式 :CALCulate<cnum>:FSIMulator:SENDed:DEEMbed:PORT<pnum>:USER 

:FILename <string> 
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:CALCulate<cnum>:FSIMulator:SENDed:DEEMbed:PORT<pnum>:USER: 

FILename? 

说明 设置或获取所选通道和端口选定的保存网络反嵌入功能的用户定义网络信息的文

件。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<pnum>:={[1]-4}，表示端口号。 

<string>:表示 SNP 文件。 

返回类型 无 

默认值 无 

菜单项 校准 > 夹具仿真 > 夹具仿真设置 > 2Port De-embedding > Select De-embedding 

举例 :CALCulate1:FSIMulator:SENDed:DEEMbed:PORT1:USER:FILename 
"local/test.s2p" 

:CALCulate1:FSIMulator:SENDed:DEEMbed:PORT1:USER:FILename? 

Return: local/test.s2p 

 

3.3.3.3.5 适配器端口翻转的开关 

命令格式 :CALCulate<cnum>:FSIMulator:SENDed:DEEMbed:PORT<pnum>:SNP:REVerse 
<bool> 

:CALCulate<cnum>:FSIMulator:SENDed:DEEMbed:PORT<pnum>:SNP:REVerse? 

说明 设置或获取所选通道适配器端口翻转的开关状态。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<pnum>:={[1]-4}，表示端口号。 

<bool>:= ON|OFF|1|0 

返回类型 Boolean (1=ON,0=OFF) 

默认值 OFF 

菜单项 校准 > 夹具仿真 > 夹具仿真设置 > 2Port De-embedding > Reverse Adapter Ports 

举例 :CALCulate1:FSIMulator:SENDed:DEEMbed:PORT1:SNP:REVerse ON 

:CALCulate1:FSIMulator:SENDed:DEEMbed:PORT1:SNP:REVerse? 

Return: 1 

 

3.3.3.4 N端口嵌入/去嵌 

3.3.3.4.1 命令列表 

端口网络嵌入/去嵌入功能开关 :CALCulate<cnum>:FSIMulator:EMBed:STATe 



 

 

端口网络拓扑类型 :CALCulate<cnum>:FSIMulator:EMBed:TYPE 

指定 A 类型端口连接方式 :CALCulate<cnum>:FSIMulator:EMBed:TOPology:A:PORTs 

指定 B 类型端口连接方式 :CALCulate<cnum>:FSIMulator:EMBed:TOPology:B:PORTs 

指定 C 类型端口连接方式 :CALCulate<cnum>:FSIMulator:EMBed:TOPology:C:PORTs 

端口网络处理类型 :CALCulate<cnum>:FSIMulator:EMBed:NETWork<pnum>:TYPE 

端口标准文件名 :CALCulate<cnum>:FSIMulator:EMBed:NETWork<pnum>:FILename 

 

3.3.3.4.2 端口网络嵌入/去嵌入功能开关 

命令格式 :CALCulate<cnum>:FSIMulator:EMBed:STATe <bool> 

:CALCulate<cnum>:FSIMulator:EMBed:STATe? 

说明 设置或获取所选通道所有端口网络反嵌入功能的开关状态。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<bool>:= ON|OFF|1|0 

返回类型 布尔型 

默认值 Boolean (1=ON,0=OFF) 

菜单项 校准 > 夹具仿真 > 夹具仿真设置 > 4/6/8-Port Embed/De-embed 

举例 :CALCulate1:FSIMulator:EMBed:STATe ON 

:CALCulate1:FSIMulator:EMBed:STATe?  

Return: 1 

 

3.3.3.4.3 端口网络拓扑类型 

命令格式 :CALCulate<cnum>:FSIMulator:EMBed:TYPE <type> 

:CALCulate<cnum>:FSIMulator:EMBed:TYPE? 

说明 设置或获取所选通道的 4端口网络反嵌入功能的拓扑类型。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<type>:={A|B|C} 

"A"：指定连接类型 A。 

"B"：指定连接类型 B。 

"C"：指定连接类型 C。 

返回类型 枚举 

默认值 A 

菜单项 校准 > 夹具仿真 > 夹具仿真设置 > 4/6/8-Port Embed/De-embed > Topology 



 

82                                                                                                                   矢量网络分析仪编程手册 

举例 :CALCulate1:FSIMulator:EMBed:TYPE B 

:CALCulate1:FSIMulator:EMBed:TYPE? 

Return: B 

 

3.3.3.4.4 指定 A 类型端口连接方式 

SNA NetWork1 DUT
1

2 4

3a

b

 

命令格式 :CALCulate<cnum>:FSIMulator:EMBed:TOPology:A:PORTs 
<numeric1>,<numeric 2> 

:CALCulate<cnum>:FSIMulator:EMBed:TOPology:A:PORTs? 

说明 设置或获取所选通道的 4端口网络反嵌入功能拓扑 A 的端口连接方式。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<numeric1>：图中 a代表的端口 

<numeric2>：图中 b代表的端口 

返回类型 数据数组 

默认值 1，2 

菜单项 校准 > 夹具仿真 > 夹具仿真设置 > 4/6/8-Port Embed/De-embed 

举例 :CALCulate1:FSIMulator:EMBed:TOPology:A:PORTs 2,1 

:CALCulate1:FSIMulator:EMBed:TOPology:A:PORTs? 

Return: 2,1 

 

3.3.3.4.5 指定 B 类型端口连接方式 

SNA NetWork1 DUT
1

2 4

3a

b

SNA
c

 

命令格式 :CALCulate<cnum>:FSIMulator:EMBed:TOPology:B:PORTs 
<numeric1>,<numeric2>,<numeric3> 

:CALCulate<cnum>:FSIMulator:EMBed:TOPology:B:PORTs? 

说明 设置或获取所选通道的 4端口网络反嵌入功能拓扑 B 的端口连接方式。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<numeric1>：图中 a代表的端口 



 

 

<numeric2>：图中 b代表的端口 

<numeric3>：图中 c代表的端口 

返回类型 数据数组 

默认值 1，2，3 

菜单项 校准 > 夹具仿真 > 夹具仿真设置 > 4/6/8-Port Embed/De-embed 

举例 :CALCulate1:FSIMulator:EMBed:TOPology:B:PORTs 2,1,3 

:CALCulate1:FSIMulator:EMBed:TOPology:B:PORTs? 

Return: 2,1,3 

 

3.3.3.4.6 指定 C 类型端口连接方式 

SNA NetWork1 DUT
1

2 4

3a

b

SNANetWork2
3

4 2

1 c

d

 

命令格式 :CALCulate<cnum>:FSIMulator:EMBed:TOPology:C:PORTs 
<numeric1>,<numeric 2>,<numeric3>,<numeric4> 

:CALCulate<cnum>:FSIMulator:EMBed:TOPology:C:PORTs? 

说  明 设置或获取所选通道的 4端口网络反嵌入功能拓扑 C 的端口连接方式。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<numeric1>：图中 a代表的端口 

<numeric2>：图中 b代表的端口 

<numeric3>：图中 c代表的端口 

<numeric4>：图中 d代表的端口 

返回类型 数据数组 

默认值 1，2，3，4 

菜单项 校准 > 夹具仿真 > 夹具仿真设置 > 4/6/8-Port Embed/De-embed 

举例 :CALCulate1:FSIMulator:EMBed:TOPology:C:PORTs 2,1,3,4 

:CALCulate1:FSIMulator:EMBed:TOPology:C:PORTs? 

Return: 2,1,3,4 

 

3.3.3.4.7 端口网络处理类型 

命令格式 :CALCulate<cnum>:FSIMulator:EMBed:NETWork<pnum>:TYPE <type> 

:CALCulate<cnum>:FSIMulator:EMBed:NETWork<pnum>:TYPE? 

说明 设置或获取所选通道的 4端口网络反嵌入功能的类型。 
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参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<pnum>:={[1]-4}，表示网络端口号。 

<type>:={NONE|EMBed|DEEMbed} 

"NONE"：指定无处理。 

"EMBed"：指定嵌入。 

"DEEMbed"：指定反嵌入。 

返回类型 枚举 

默认值 NONE 

菜单项 校准 > 夹具仿真 > 夹具仿真设置 > 4/6/8-Port Embed/De-embed 

举例 :CALCulate1:FSIMulator:EMBed:NETWork1:TYPE DEEMbed 

:CALCulate1:FSIMulator:EMBed:NETWork1:TYPE? 

Return: DEEM 

 

3.3.3.4.8 端口标准文件名 

命令格式 :CALCulate<cnum>:FSIMulator:EMBed:NETWork<pnum>:FILename <string> 

:CALCulate<cnum>:FSIMulator:EMBed:NETWork<pnum>}:FILename? 

说明 设置或获取所选通道和指定端口的 4端口标准文件。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<pnum>:={[1]-4}，表示网络端口号。 

<string>:表示 SNP 文件。 

返回类型 无 

默认值 无 

菜单项 校准 > 夹具仿真 > 夹具仿真设置 > 4/6/8-Port Embed/De-embed 

举例 :CALCulate1:FSIMulator:EMBed:NETWork1:FILename "local/test.s4p" 

:CALCulate1:FSIMulator:EMBed:NETWork1:FILename? 

Return: local/test.s4p 

 

3.3.3.5 差分端口匹配 

3.3.3.5.1 命令列表 

差分端口匹配功能

开关 

:CALCulate<cnum>:FSIMulator:BALun:DMCircuit:STATe 

差分端口匹配电路 :CALCulate<cnum>:FSIMulator:BALun:DMCircuit:BPORt<pnum>[:TYPE] 



 

 

类型 

差分端口匹配电路

文件名 

:CALCulate<cnum>:FSIMulator:BALun:DMCircuit:BPORt<pnum>:USER:FILename 

差分端口匹配电路

C 值 

:CALCulate<cnum>:FSIMulator:BALun:DMCircuit:BPORt<pnum>:PARameters:C 

差分端口匹配电路

L 值 

:CALCulate<cnum>:FSIMulator:BALun:DMCircuit:BPORt<pnum>:PARameters:L 

差分端口匹配电路

R 值 

:CALCulate<cnum>:FSIMulator:BALun:DMCircuit:BPORt<pnum>:PARameters:R 

差分端口匹配电路

G 值 

:CALCulate<cnum>:FSIMulator:BALun:DMCircuit:BPORt<pnum>:PARameters:G 

 

3.3.3.5.2 差分端口匹配功能开关 

命令格式 :CALCulate<cnum>:FSIMulator:BALun:DMCircuit:STATe <bool> 

:CALCulate<cnum>:FSIMulator:BALun:DMCircuit:STATe? 

说明 设置或获取所选通道差分端口匹配功能的开关状态。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<bool>:= ON|OFF|1|0 

返回类型 Boolean (1=ON,0=OFF) 

默认值 OFF 

菜单项 校准 > 夹具仿真 > 夹具仿真应用 > 差分端口匹配 > 启用差分端口匹配 

举例 :CALCulate1:FSIMulator:BALun:DMCircuit:STATe ON 

:CALCulate1:FSIMulator:BALun:DMCircuit:STATe? 

Return: 1 

 

3.3.3.5.3 差分端口匹配电路类型 

命令格式 :CALCulate<cnum>:FSIMulator:BALun:DMCircuit:BPORt<pnum>[:TYPE] <type> 

:CALCulate<cnum>:FSIMulator:BALun:DMCircuit:BPORt<pnum>[:TYPE]? 

说  明 设置或获取所选通道和逻辑端口差分端口匹配电路类型。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<pnum>:={[1]-2}，表示逻辑端口号。 

<type>:={NONE|PLPC|USER} 

NONE：指定无电路。 



 

86                                                                                                                   矢量网络分析仪编程手册 

PLPC：指定由分路 L和分路 C 组成的电路。 

USER：指定用户定义电路。 

返回类型 枚举 

默认值 NONE 

菜单项 校准 > 夹具仿真 > 夹具仿真应用 > 差分端口匹配 > 选择电路 

举例 :CALCulate1:FSIMulator:BALun:DMCircuit:BPORt1 PLPC 

:CALCulate1:FSIMulator:BALun:DMCircuit:BPORt1? 

Return: PLPC 

 

3.3.3.5.4 差分端口匹配电路文件名 

命令格式 :CALCulate<cnum>:FSIMulator:BALun:DMCircuit:BPORt<pnum>:USER:FILename 
<string> 

 

:CALCulate<cnum>:FSIMulator:BALun:DMCircuit:BPORt<pnum>:USER:FILename? 

说  明 设置或获取所选通道和逻辑端口差分端口自定义匹配网络 SNP 文件。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<pnum>:={[1]-2}，表示逻辑端口号。 

<string>:表示 SNP 文件。 

返回类型 字符串 

默认值 无 

菜单项 校准 > 夹具仿真 > 夹具仿真应用 > 差分端口匹配 > 浏览... 

举例 :CALCulate1:FSIMulator:BALun:DMCircuit:BPORt1:USER:FILename 
"local/sample.s2p" 

:CALCulate1:FSIMulator:BALun:DMCircuit:BPORt1:USER:FILename? 

Return: local/sample.s2p 

 

3.3.3.5.5 差分端口匹配电路 C 值 

命令格式 :CALCulate<cnum>:FSIMulator:BALun:DMCircuit:BPORt<pnum>:PARameters:C 
<numeric> 

:CALCulate<cnum>:FSIMulator:BALun:DMCircuit:BPORt<pnum>:PARameters:C? 

说  明 设置或获取所选通道和逻辑端口匹配电路 C 值。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<pnum>:={[1]-2}，表示逻辑端口号。 

<numeric>:表示逻辑端口匹配电路 C 值。 



 

 

返回类型 浮点数，单位 F（法拉） 

默认值 0 

菜单项 校准 > 夹具仿真 > 夹具仿真设置 >差分端口匹配> Shunt L - Shunt C 

举例 :CALCulate1:FSIMulator:BALun:DMCircuit:BPORt1:PARameters:C 10e-9 

:CALCulate1:FSIMulator:BALun:DMCircuit:BPORt1:PARameters:C? 

Return: 1e-08 

 

3.3.3.5.6 差分端口匹配电路 L 值 

命令格式 :CALCulate<cnum>:FSIMulator:BALun:DMCircuit:BPORt<pnum>:PARameters:L 
<numeric> 

:CALCulate<cnum>:FSIMulator:BALun:DMCircuit:BPORt<pnum>:PARameters:L? 

说明 设置或获取所选通道和逻辑端口匹配电路 L值。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<pnum>:={[1]-2}，表示逻辑端口号。 

<numeric>:表示逻辑端口匹配电路 L值。 

返回类型 浮点数，单位 H（亨利） 

默认值 0 

菜单项 校准 > 夹具仿真 > 夹具仿真设置 >差分端口匹配> Shunt L - Shunt C 

举例 :CALCulate1:FSIMulator:BALun:DMCircuit:BPORt1:PARameters:L 1e-8 

:CALCulate1:FSIMulator:BALun:DMCircuit:BPORt1:PARameters:L? 

Return: 1e-8 

 

3.3.3.5.7 差分端口匹配电路 R 值 

命令格式 :CALCulate<cnum>:FSIMulator:BALun:DMCircuit:BPORt<pnum>:PARameters:R 
<numeric> 

:CALCulate<cnum>:FSIMulator:BALun:DMCircuit:BPORt<pnum>:PARameters:R? 

说明 设置或获取所选通道和逻辑端口匹配电路 R 值。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<pnum>:={[1]-2}，表示逻辑端口号。 

<numeric>:表示逻辑端口匹配电路 R 值。 

返回类型 浮点数，单位欧姆 

默认值 0 

菜单项 校准 > 夹具仿真 > 夹具仿真设置 >差分端口匹配> Shunt L - Shunt C 
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举例 :CALCulate1:FSIMulator:BALun:DMCircuit:BPORt1:PARameters:R 1e2 

:CALCulate1:FSIMulator:BALun:DMCircuit:BPORt1:PARameters:R? 

Return: 1e2 

 

3.3.3.5.8 差分端口匹配电路 G 值 

命令格式 :CALCulate<cnum>:FSIMulator:BALun:DMCircuit:BPORt<pnum>:PARameters:G 
<numeric> 

:CALCulate<cnum>:FSIMulator:BALun:DMCircuit:BPORt<pnum>:PARameters:G? 

说  明 设置或获取所选通道和逻辑端口匹配电路 G值。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<pnum>:={[1]-2}，表示逻辑端口号。 

<numeric>:表示逻辑端口匹配电路 G值。 

返回类型 浮点数，单位 S（西门子） 

默认值 0 

菜单项 校准 > 夹具仿真 > 夹具仿真设置 >差分端口匹配> Shunt L - Shunt C 

举例 :CALCulate1:FSIMulator:BALun:DMCircuit:BPORt1:PARameters:G 5e-2 

:CALCulate1:FSIMulator:BALun:DMCircuit:BPORt1:PARameters:G? 

Return: 5e-2 

 

3.3.3.6 差分阻抗 

3.3.3.6.1 命令列表 

差模端口阻抗转换

开关 

:CALCulate<cnum>:FSIMulator:BALun:DZConversion:STATe 

差模端口阻抗值 :CALCulate<cnum>:FSIMulator:BALun:DZConversion:BPORt<pnum>:Z0[:R] 

差模端口阻抗值实

部 

:CALCulate<cnum>:FSIMulator:BALun:DZConversion:BPORt<pnum>:REAL 

差模端口阻抗值虚

部 

:CALCulate<cnum>:FSIMulator:BALun:DZConversion:BPORt<pnum>:IMAGinary 

 

3.3.3.6.2 差模端口阻抗转换开关 

命令格式 :CALCulate<cnum>:FSIMulator:BALun:DZConversion:STATe <bool> 

:CALCulate<cnum>:FSIMulator:BALun:DZConversion:STATe? 

说明 设置或获取所选通道差模端口阻抗转换功能的开关状态。 



 

 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<bool>:= ON|OFF|1|0 

返回类型 Boolean (1=ON,0=OFF) 

默认值 OFF 

菜单项 校准 > 夹具仿真 > 夹具仿真应用 > 差模端口阻抗转换 > 启用差模端口阻抗转换 

举例 :CALCulate1:FSIMulator:BALun:DZConversion:STATe ON 

:CALCulate1:FSIMulator:BALun:DZConversion:STATe? 

Return: 1 

 

3.3.3.6.3 差模端口阻抗值 

命令格式 :CALCulate<cnum>:FSIMulator:BALun:DZConversion:BPORt<pnum>:Z0[:R] 
<numeric> 

:CALCulate<cnum>:FSIMulator:BALun:DZConversion:BPORt<pnum>:Z0[:R]? 

说明 设置或获取所选通道差分端口阻抗转换功能的阻抗值。设置该单一值或者分别设置

实部和虚部。使用此命令将虚部设置为 0. 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<pnum>:={[1]-2}，表示逻辑端口号。 

<numeric>:表示差分端口阻抗转换功能的阻抗值，其范围是 0.001~1E7。 

返回类型 浮点数，单位欧姆 

默认值 100 

菜单项 校准> 夹具仿真 > 夹具仿真设置 > 差模端口阻抗转换 > R 

举例 :CALCulate1:FSIMulator:BALun:DZConversion:BPORt1:Z0 75 

:CALCulate1:FSIMulator:BALun:DZConversion:BPORt1:Z0? 

Return: 75 

 

3.3.3.6.4 差模端口阻抗值实部 

命令格式 :CALCulate<cnum>:FSIMulator:BALun:DZConversion:BPORt<pnum>:REAL 
<numeric> 

:CALCulate<cnum>:FSIMulator:BALun:DZConversion:BPORt<pnum>:REAL? 

说明 设置或获取所选通道和逻辑端口差模阻抗值的实部。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<pnum>:={[1]-2}，表示逻辑端口号。 

<numeric>:表示差模阻抗值(实部)，其范围是 0.001~1E7。 

返回类型 浮点数，单位欧姆 
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默认值 100 

菜单项 校准> 夹具仿真 > 夹具仿真设置 > 差模端口阻抗转换 > R 

举例 :CALCulate1:FSIMulator:BALun:DZConversion:BPORt1:REAL 75 

:CALCulate1:FSIMulator:BALun:DZConversion:BPORt1:REAL? 

Return: 75 

 

3.3.3.6.5 差模端口阻抗值虚部 

命令格式 :CALCulate<cnum>:FSIMulator:BALun:DZConversion:BPORt<pnum>:IMAGinary 
<numeric> 

:CALCulate<cnum>:FSIMulator:BALun:DZConversion:BPORt<pnum>:IMAGinary? 

说明 设置或获取所选通道和逻辑端口差模阻抗值的虚部。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<pnum>:={[1]-2}，表示逻辑端口号。 

<numeric>:表示差模阻抗值(虚部)，其范围是 -1E+18 ~ 1E+18。 

返回类型 浮点数，单位欧姆 

默认值 0 

菜单项 校准> 夹具仿真 > 夹具仿真设置 > 差模端口阻抗转换 > jX 

举例 :CALCulate1:FSIMulator:BALun:DZConversion:BPORt1:IMAGinary 75 

:CALCulate1:FSIMulator:BALun:DZConversion:BPORt1:IMAGinary? 

Return: 75 

 

 

3.3.3.7 共模阻抗 

3.3.3.7.1 命令列表 

共模端口阻抗转换

开关 

:CALCulate<cnum>:FSIMulator:BALun:CZConversion:STATe 

共模端口阻抗值 :CALCulate<cnum>:FSIMulator:BALun:CZConversion:BPORt<pnum>:Z0[:R] 

共模端口阻抗值实

部 

:CALCulate<cnum>:FSIMulator:BALun:CZConversion:BPORt<pnum>:REAL 

共模端口阻抗值虚

部 

:CALCulate<cnum>:FSIMulator:BALun:CZConversion:BPORt<pnum>:IMAGinary 

 



 

 

3.3.3.7.2 共模端口阻抗转换开关 

命令格式 :CALCulate<cnum>:FSIMulator:BALun:CZConversion:STATe <bool> 

:CALCulate<cnum>:FSIMulator:BALun:CZConversion:STATe? 

说明 设置或获取所选通道共模端口阻抗转换功能的开关状态。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<bool>:= ON|OFF|1|0 

返回类型 Boolean (1=ON,0=OFF) 

默认值 OFF 

菜单项 校准 > 夹具仿真 > 夹具仿真应用 > 共模端口阻抗转换 > 启用共模端口阻抗转换 

举例 :CALCulate1:FSIMulator:BALun:CZConversion:STATe ON 

:CALCulate1:FSIMulator:BALun:CZConversion:STATe? 

Return: 1 

 

3.3.3.7.3 共模端口阻抗值 

命令格式 :CALCulate<cnum>:FSIMulator:BALun:CZConversion:BPORt<pnum>:Z0[:R] 
<numeric> 

:CALCulate<cnum>:FSIMulator:BALun:CZConversion:BPORt<pnum>:Z0[:R]? 

说明 设置或获取所选通道共模端口阻抗转换功能的阻抗值。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<pnum>:={[1]-2}，表示逻辑端口号。 

<numeric>:表示共模端口阻抗转换功能的阻抗值，其范围是 0.001~1E7。 

返回类型 浮点数，单位欧姆 

默认值 25 

菜单项 校准> 夹具仿真 > 夹具仿真设置 > 共模端口阻抗转换 > R 

举例 :CALCulate1:FSIMulator:BALun:CZConversion:BPORt1:Z0 75 

:CALCulate1:FSIMulator:BALun:CZConversion:BPORt1:Z0? 

Return: 75 

 

3.3.3.7.4 共模端口阻抗值实部 

命令格式 :CALCulate<cnum>:FSIMulator:BALun:CZConversion:BPORt<pnum>:REAL 
<numeric> 

:CALCulate<cnum>:FSIMulator:BALun:CZConversion:BPORt<pnum>:REAL? 

说明 设置或获取所选通道和逻辑端口共模阻抗值的实部。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 
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<pnum>:={[1]-2}，表示逻辑端口号。 

<numeric>:表示共模阻抗值(实部)，其范围是 0.001~1E7。 

返回类型 浮点数，单位欧姆 

默认值 25 

菜单项 校准> 夹具仿真 > 夹具仿真设置 > 共模端口阻抗转换 > R 

举例 :CALCulate1:FSIMulator:BALun:CZConversion:BPORt1:REAL 75 

:CALCulate1:FSIMulator:BALun:CZConversion:BPORt1:REAL? 

Return: 75 

 

3.3.3.7.5 共模端口阻抗值虚部 

命令格式 :CALCulate<cnum>:FSIMulator:BALun:CZConversion:BPORt<pnum>:IMAGinary 
<numeric> 

 

:CALCulate<cnum>:FSIMulator:BALun:CZConversion:BPORt<pnum>:IMAGinary? 

说明 设置或获取所选通道和逻辑端口共模阻抗值的虚部。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<pnum>:={[1]-2}，表示逻辑端口号。 

<numeric>:表示共模阻抗值(虚部)，其范围是 -1E+18 ~ 1E+18。 

返回类型 浮点数，单位欧姆 

默认值 0 

菜单项 校准> 夹具仿真 > 夹具仿真设置 > 共模端口阻抗转换 > jX 

举例 :CALCulate1:FSIMulator:BALun:CZConversion:BPORt1:IMAGinary 75 

:CALCulate1:FSIMulator:BALun:CZConversion:BPORt1:IMAGinary? 

Return: 75 

 

3.3.4 电子校准 

3.3.4.1 命令列表 

查询校准类型 :SENSe<cnum>:CORRection:COLLect:METHod:TYPE? 

ECal 执行全 1端口校准 :SENSe<cnum>:CORRection:COLLect:ECal:SOLT1 

ECal 执行全 2端口校准 :SENSe<cnum>:CORRection:COLLect:ECal:SOLT2 

ECal 执行全 3端口校准 :SENSe<cnum>:CORRection:COLLect:ECal:SOLT3 

ECal 执行全 4端口校准 :SENSe<cnum>:CORRection:COLLect:ECal:SOLT4 



 

 

ECal 执行响应校准 :SENSe<cnum>:CORRection:COLLect:ECal:THRU 

ECal 执行增强响应校准 :SENSe<cnum>:CORRection:COLLect:ECal:ERESponse 

ECal 未知直通状态 :SENSe<cnum>:CORRection:COLLect:ECal:UTHRU[:STATe] 

ECal 置信度检查 :SENSe<cnum>:CORRection:COLLect:ECal:CCHeck[:ACQuire] 

ECal 自动检测 :SENSe<cnum>:CORRection:COLLect:ECal:IORIentation[:STATe] 

ECal 表征信息 :SENSe:CORRection:COLLect:ECal:INFormation? 

 

3.3.4.2 查询校准类型 

命令格式 :SENSe<cnum>:CORRection:COLLect:METHod:TYPE? 

说明 获取选择通道选择的校准类型。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

返回类型 无 

默认值 无 

菜单项 无 

举例 :SENSe1:CORRection:COLLect:METHod:TRL4 1,2,3,4 

:SENSe1:CORRection:COLLect:METHod:TYPE? 

Return: TRL4 

 

3.3.4.3 ECal执行全 1端口校准 

命令格式 :SENSe<cnum>:CORRection:COLLect:ECal:SOLT1 <pnum> 

说明 使用 ECal 对选择的通道执行指定端口的 1端口校准 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<pnum>:={1|2|3|4}，表示端口号。 

返回类型 无 

默认值 无 

菜单项 校准 > 电子校准 > 电子校准… > Cal Type 

举例 :SENSe1:CORRection:COLLect:ECal:SOLT1 1 

 

3.3.4.4 ECal执行全 2端口校准 

命令格式 :SENSe<cnum>:CORRection:COLLect:ECal:SOLT2 <pnum1>,<pnum2> 
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说明 使用 ECal 对选择的通道执行指定的 2端口之间的全 2 端口校准 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<pnum1>:={1|2|3|4},表示全 2端口校准端口。 

<pnum2>:={1|2|3|4},表示另一个全 2端口校准端口。 

返回类型 无 

默认值 无 

菜单项 校准 > 电子校准 > 电子校准… > Cal Type 

举例 :SENSe1:CORRection:COLLect:ECal:SOLT2 1,2 

 

3.3.4.5 ECal执行全 3端口校准 

命令格式 :SENSe<cnum>:CORRection:COLLect:ECal:SOLT3  
<pnum1>,<pnum2>,<pnum3> 

说明 使用 ECal 对选择的通道执行指定的 3端口之间的全 3 端口校准 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<pnum1>:={1|2|3|4}，全 3 端口校准端口 

<pnum2>:={1|2|3|4}，全 3 端口校准端口 

<pnum3>:={1|2|3|4}，全 3 端口校准端口 

各校准端口不能重复。 

返回类型 无 

默认值 无 

菜单项 校准 > 电子校准 > 电子校准… > Cal Type 

举例 :SENSe1:CORRection:COLLect:ECal:SOLT3 1,2,3 

 

3.3.4.6 ECal执行全 4端口校准 

命令格式 :SENSe<cnum>:CORRection:COLLect:ECal:SOLT4  
<pnum1>,<pnum2>,<pnum3>,<pnum4> 

说明 使用 ECal 对选择的通道执行指定的 4端口之间的全 4 端口校准 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<pnum1>:={1|2|3|4}，全 4 端口校准端口 

<pnum2>:={1|2|3|4}，全 4 端口校准端口 

<pnum3>:={1|2|3|4}，全 4 端口校准端口 



 

 

<pnum4>:={1|2|3|4}，全 4 端口校准端口 

各校准端口不能重复。 

返回类型 无 

默认值 无 

菜单项 校准 > 电子校准 > 电子校准… >Cal Type 

举例 :SENSe1:CORRection:COLLect:ECal:SOLT4 1,2,3,4 

 

3.3.4.7 ECal执行响应校准 

命令格式 :SENSe<cnum>:CORRection:COLLect:ECal:THRU <pnum1>,<pnum2> 

说明 使用 ECal 模块执行选择通道两个指定端口之间的响应校准（直通） 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<pnum1>:={1|2|3|4}：指定响应端口。 

<pnum2>:={1|2|3|4}：指定激励端口。 

返回类型 无 

默认值 无 

菜单项 校准 > 电子校准 > 电子校准… > Cal Type 

举例 :SENSe1:CORRection:COLLect:ECal:THRU 1,2 

 

3.3.4.8 ECal执行增强响应校准 

命令格式 :SENSe<cnum>:CORRection:COLLect:ECal:ERESponse <pnum1>,<pnum2> 

说明 使用 ECal 模块执行选择通道两个指定端口之间的增强响应校准 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<pnum1>:={1|2|3|4}：指定响应端口。 

<pnum2>:={1|2|3|4}：指定激励端口。 

返回值 无 

默认值 无 

菜单项 校准 > 电子校准 > 电子校准… > Cal Type 

举例 :SENSe1:CORRection:COLLect:ECal:ERESponse 1,2 
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3.3.4.9 ECal未知直通状态 

命令格式 :SENSe<cnum>:CORRection:COLLect:ECal:UTHRU[:STATe] <bool> 
:SENSe<cnum>:CORRection:COLLect:ECal:UTHRU[:STATe]? 

说明 设置未知直通的开启与关闭，或查询未知直通的开关状态。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<bool>:= ON|OFF|1|0 

返回类型 Boolean (1=ON,0=OFF) 

默认值 0 

菜单项 校准 > 电子校准 > 电子校准… > Cal Type > Unknown Thru 

举例 

:SENSe1:CORRection:COLLect:ECal:UTHRU 1 

:SENSe1:CORRection:COLLect:ECal:UTHRU? 

Return:1 

 

3.3.4.10 ECal置信度检查 

命令格式 :SENSe<cnum>:CORRection:COLLect:ECal:CCHeck[:ACQuire] 

说明 使用 ECal 对选择通道的校准系数进行置信度检查。即比较数据迹线和存储迹线，并

检验测量是否正确。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

返回类型 无 

默认值 无 

菜单项 校准 > 电子校准 > 置信度检查… 

举例 :SENSe1:CORRection:COLLect:ECal:CCHeck 

 

3.3.4.11 ECal自动检测 

命令格式 :SENSe<cnum>:CORRection:COLLect:ECal:IORIentation[:STATe] <bool> 

:SENSe<cnum>:CORRection:COLLect:ECal:IORIentation[:STATe]? 

说明 打开/关闭 ECal 自动检测功能，或查询当前自动检测功能的开关状态。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<bool>:= ON|OFF|1|0 

返回类型 Boolean (1=ON,0=OFF) 

默认值 1 

菜单项 校准 > 电子校准 > 定位 

举例 :SENSe1:CORRection:COLLect:ECal:ORIentation 1 



 

 

:SENSe1:CORRection:COLLect:ECal:ORIentation? 

Return:1 

 

3.3.4.12 ECal表征信息 

命令格式 :SENSe:CORRection:COLLect:ECal:INFormation? 

说明 读取所识别的 ECal 模块的特性信息 

参数 无 

返回类型 无 

默认值 无 

菜单项 校准 > 电子校准 > 表征… 

举例 :SENSe:CORRection:COLLect:ECal:INFormation? 

 

 

3.4 Display 命令子系统 

3.4.1 迹线设置 

3.4.1.1 命令列表 

查询所有迹线列表 :DISPlay:TRACe:LIST? 

选择工作迹线 :DISPlay:TRACe<tnum>:ACTivate 

设置/查询活动迹线 :DISPlay:WINDow<wnum>:TRACe<tnum>:SELect 

设置迹线标题 :DISPlay:TRACe<tnum>:TITLe:DATA 

迹线标题显示开关 :DISPlay:TRACe<tnum>:TITLe[:STATe] 

添加迹线 :DISPlay:ADD:FUNCtion:EXECute TRC 

新建通道+迹线 :DISPlay:ADD:FUNCtion:EXECute CH_TRC 

新建窗口+迹线 :DISPlay:ADD:FUNCtion:EXECute WIN_TRC 

新建窗口+通道+迹线 :DISPlay:ADD:FUNCtion:EXECute WIN_CH_TRC 

迹线显示开关 :DISPlay:WINDow<wnum>:TRACe<tnum> 

移动迹线至窗口 :DISPlay:MEASure<tnum>:MOVE 

迹线保持类型 :CALCulate<cnum>:TRACe<tnum>:HOLD[:TYPE] 

重置迹线 :CALCulate<cnum>:TRACe<tnum>:HOLD:CLEar 
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活动迹线最大化 :DISPlay:WINDow<wnum>:MAXimize 

 

3.4.1.2 查询所有迹线列表 

命令格式 :DISPlay:TRACe:LIST? 

说明 查询 VNA 所有迹线列表。 

参数 无 

返回类型 整型 

默认值 1 

菜单项 显示 > 通道设置 > 选择 

举例 :DISPlay:TRACe:LIST? 

Return:1,2,3,4,5 

 

3.4.1.3 选择工作迹线 

命令格式 :DISPlay:TRACe<tnum>:ACTivate 

说  明 指定选择的迹线为工作迹线。 

参数 <tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

返回类型 无 

默认值 1 

菜单项 显示 > 迹线设置 > 选择 

举例 选择迹线 2 为工作迹线。 

:DISPlay:TRACe2:ACTivate 

 

3.4.1.4 设置/查询活动迹线 

命令格式 :DISPlay:WINDow<wnum>:TRACe<tnum>:SELect 

:DISPlay:WINDow:TRACe:SELect? 

:DISPlay:TRACe<tnum>:SELect 

:DISPlay:TRACe:SELect? 

说明 设置或查询当前活动迹线。 

参数 <wnum>:={[1]-36}，表示测量窗口号，如果未指定，则<wnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

返回类型 整型 

默认值 1 



 

 

菜单项 显示 > 迹线设置 > 选择 

举例 :DISPlay:WINDow2:TRACe3:SELect 

:DISPlay:WINDow2:TRACe3:SELect? 

Return: 2 

 

:DISPlay:TRACe2:SELect 

:DISPlay:TRACe:SELect? 

Return:2 

 

3.4.1.5 设置迹线标题 

命令格式 :DISPlay:TRACe<tnum>:TITLe:DATA <string> 

:DISPlay:TRACe<tnum>:TITLe:DATA? 

说明 设置或查询迹线标题。 

参数 <tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

<string>: 表示迹线标题，其范围是 1-256个字符。 

返回类型 字符串 

默认值 1 

菜单项 显示 > 迹线设置 > 迹线标题… 

举例 :DISPlay:TRACe 1:TITLe:DATA siglent 

:DISPlay:TRACe1:TITLe:DATA? 

Return :"siglent" 

 

3.4.1.6 迹线标题显示开关 

命令格式 :DISPlay:TRACe<tnum>:TITLe[:STATe] <bool> 

:DISPlay:TRACe<tnum>:TITLe[:STATe]? 

说明 打开或关闭迹线标题字符串的显示。或查询迹线标题字符串的显示状态。 

参数 <tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

<bool>:= ON|OFF|1|0 

返回类型 Boolean (1=ON,0=OFF) 

默认值 0 

菜单项 显示 > 迹线设置 > 迹线标题… > Enabled 

举例 打开通道 1 的标题显示。 

:DISPlay:TRACe1:TITLe:STATe 1 

:DISPlay:TRACe1:TITLe:STATe? 

Return :1 
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3.4.1.7 添加迹线 

命令格式 :DISPlay:ADD:FUNCtion:EXECute TRC 

说明 在当前工作窗口和通道中添加新迹线。 

参数 无 

返回类型 无 

默认值 无 

菜单项 显示 > 迹线设置 > 添加迹线 > 新建迹线 

举例 :DISPlay:ADD:FUNCtion:EXECute TRC 

 

3.4.1.8 新建通道+迹线 

命令格式 :DISPlay:ADD:FUNCtion:EXECute CH_TRC 

说明 在当前工作窗口中新建通道和迹线。 

参数 无 

返回类型 无 

默认值 无 

菜单项 显示 > 迹线设置 > 添加迹线 > 新建 迹线+通道 

举例 :DISPlay:ADD:FUNCtion:EXECute CH_TRC 

 

3.4.1.9 新建窗口+迹线 

命令格式 :DISPlay:ADD:FUNCtion:EXECute WIN_TRC 

说明 在当前工作通道中新建迹线和窗口。 

参数 无 

返回类型 无 

默认值 无 

菜单项 显示 > 迹线设置 > 添加迹线 > 新建 迹线+窗口 

举例 :DISPlay:ADD:FUNCtion:EXECute WIN_TRC 

 

3.4.1.10 新建窗口+通道+迹线 

命令格式 :DISPlay:ADD:FUNCtion:EXECute WIN_CH_TRC 

说明 新建窗口+通道+迹线。 



 

 

参数 无 

返回类型 无 

默认值 无 

菜单项 显示 > 迹线设置 > 添加迹线 > 新建 迹线+通道+窗口 

举例 :DISPlay:ADD:FUNCtion:EXECute WIN_CH_TRC 

 

3.4.1.11 迹线显示开关 

命令格式 :DISPlay:WINDow<wnum>:TRACe<tnum> <bool> 

:DISPlay:WINDow<wnum>:TRACe<tnum>? 

说明 设置或查询指定通道指定迹线的显示状态 

参数 <wnum>:={[1]-36}，表示测量窗口号，如果未指定，则<wnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

<bool>:= ON|OFF|1|0 

返回类型 Boolean (1=ON,0=OFF) 

默认值 无 

菜单项 显示 > 迹线设置 > 添加迹线 / 删除迹线 

举例 :DISPlay:WINDow1:TRACe5 1 

:DISPlay:WINDow1:TRACe5? 

Return: 1 

 

3.4.1.12 移动迹线至窗口 

命令格式 DISPlay:MEASure<tnum>:MOVE <numeric> 

说明 移动选择迹线到指定窗口 

参数 
<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

<numeric>:表示指定窗口编号，其范围是 1~200。 

返回类型 无 

默认值 无 

菜单项 显示 > 迹线设置 > 移动迹线 

举例 DISPlay:MEASure2:MOVE 4 

 

3.4.1.13 迹线保持类型 

命令格式 :CALCulate<cnum>:TRACe<tnum>:HOLD[:TYPE] <type> 

:CALCulate<cnum>:TRACe<tnum>:HOLD[:TYPE]? 
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说明 设置或获取所选通道及迹线的迹线保持类型 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

<type>:={OFF|MAXimum|MINimum} 

返回类型 枚举 

默认值 OFF 

菜单项 显示 > 迹线设置 > 迹线保持 

举例 :CALCulate1:TRACe1:HOLD MAXimum 

:CALCulate1:TRACe1:HOLD? 

Return: MAX 

 

3.4.1.14 重置迹线 

命令格式 :CALCulate<cnum>:TRACe<tnum>:HOLD:CLEar 

说明 重置迹线 

参数 
<cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

返回类型 None 

默认值 None 

菜单项 显示 > 迹线设置 > 迹线保持 > 重置 

举例 :CALCulate1:TRACe1:HOLD:CLEar  

 

3.4.1.15 活动迹线最大化 

命令格式 :DISPlay:WINDow<wnum>:MAXimize <bool> 

:DISPlay:WINDow<wnum>:MAXimize? 

说明 设置或获取所选通道的激活迹线的最大化显示状态 

参数 <wnum>:={[1]-36}，表示测量窗口号，如果未指定，则<wnum>默认设置 1。 

<bool>:= ON|OFF|1|0 

返回类型 布尔型 

默认值 无 

菜单项 显示 > 迹线设置 > 迹线最大化 

举例 :DISPlay:WINDow1:MAXimize 1 

:DISPlay:WINDow1:MAXimize? 

Return: 1 



 

 

 

3.4.2 通道设置 

3.4.2.1 命令列表 

查询所有通道列表 :DISPlay:CHANnel:LIST? 

选择工作通道 :DISPlay:CHANnel<cnum>:ACTivate 

设置/查询活动通道 :DISPlay:CHANnel<cnum>:SELect 

查询某通道的迹线列表 :DISPlay:CHANnel<cnum>:TRACe:LIST? 

设置通道标题 :DISPlay:CHANnel<cnum>:TITLe:DATA 

通道标题显示开关 :DISPlay:CHANnel<cnum>:TITLe[:STATe] 

 

3.4.2.2 查询所有通道列表 

命令格式 :DISPlay:CHANnel:LIST? 

说明 查询 VNA 所有通道列表。 

参数 无 

返回类型 整型 

默认值 1 

菜单项 显示 > 通道设置 > 选择 

举例 VNA 存在多个窗口，多条通道时，查询 VNA 所有通道列表。 

:DISPlay:CHANnel:LIST? 

Return:1,2,3,4 

 

3.4.2.3 选择工作通道 

命令格式 :DISPlay:CHANnel<cnum>:ACTivate 

说明 指定选择的通道为工作通道。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

返回类型 无 

默认值 1 

菜单项 显示 > 通道设置 > 选择 

举例 选择通道 2 为工作窗口 

:DISPlay:CHANnel2:ACTivate 
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3.4.2.4 设置/查询活动通道 

命令格式 :DISPlay:CHANnel<cnum>:SELect 

:DISPlay:CHANnel:SELect? 

说明 设置或查询当前活动通道。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

返回类型 整型 

默认值 1 

菜单项 显示 > 通道设置 > 选择 

举例 :DISPlay:CHANnel2:SELect 

:DISPlay:CHANnel:SELect? 

 

Return: 2 

 

3.4.2.5 查询某通道的迹线列表 

命令格式 :DISPlay:CHANnel<cnum>:TRACe:LIST? 

说明 查询指定通道的迹线列表。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

返回类型 整型 

默认值 1 

菜单项 显示 > 通道设置 > 选择 

举例 某通道存在多条迹线时，查询该通道的迹线列表。 

:DISPlay:CHANnel1:TRACe:LIST? 

Return:1,2 

 

3.4.2.6 设置通道标题 

命令格式 :DISPlay:CHANnel<cnum>:TITLe:DATA <string> 

:DISPlay:CHANnel<cnum>:TITLe:DATA? 

说明 设置或查询通道标题。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<string>: 表示通道标题，其范围是 1-256个字符。 

返回类型 字符串 

默认值 1 



 

 

菜单项 显示 > 通道设置 > 通道标题… 

举例 :DISPlay:CHANnel1:TITLe:DATA siglent 

:DISPlay:CHANnel1:TITLe:DATA? 

Return :"siglent" 

 

3.4.2.7 通道标题显示开关 

命令格式 :DISPlay:CHANnel<cnum>:TITLe[:STATe] <bool> 

:DISPlay:CHANnel<cnum>:TITLe[:STATe]? 

说明 打开或关闭窗口标题字符串的显示。或查询窗口标题字符串的显示状态。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<bool>:= ON|OFF|1|0 

返回类型 Boolean (1=ON,0=OFF) 

默认值 0 

菜单项 显示 > 通道设置 > 通道标题… > Enabled 

举例 打开通道 1 的标题显示。 

:DISPlay:CHANnel1:TITLe:STATe 1 

:DISPlay:CHANnel1:TITLe:STATe? 

Return :1 

 

3.4.3 窗口设置 

3.4.3.1 命令列表 

查询所有窗口列表 :DISPlay:WINDow:LIST? 

打开/关闭指定窗口 :DISPlay:WINDow<wnum>:STATe 

选择工作窗口 :DISPlay:WINDow<wnum>:ACTivate 

选择/查询活动窗口 :DISPlay:WINDow<wnum>:SELect 

查询某窗口的迹线列表 :DISPlay:WINDow<wnum>:TRACe:LIST? 

查询某窗口的通道列表 :DISPlay:WINDow<wnum>:CHANnel:LIST? 

设置窗口标题 :DISPlay:WINDow<wnum>:TITLe:DATA 

窗口标题显示开关 :DISPlay:WINDow<wnum>:TITLe[:STATe] 

设置屏幕窗口布局 :DISPlay:ARRange 

活动窗口最大化 :DISPlay:MAXimize 

清除状态栏错误信息 :DISPlay:CCLear 
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3.4.3.2 查询所有窗口列表 

命令格式 :DISPlay:WINDow:LIST? 

说明 查询 VNA 所有窗口列表 

参数 无 

返回类型 整型 

默认值 1 

菜单项 显示 > 窗口设置 > 选择 

举例 当 UI 存在 3个窗口时，查询窗口列表。 

:DISPlay:WINDow:LIST? 

Return:1,2,3 

 

3.4.3.3 打开/关闭指定窗口 

命令格式 :DISPlay:WINDow<wnum>:STATe <bool> 

:DISPlay:WINDow<wnum>:STATe? 

说明 设置/查询指定窗口的状态 

参数 <wnum>:={[1]-36}，表示测量窗口号，如果未指定，则<wnum>默认设置 1。 

<bool>:= ON|OFF|1|0 

返回类型 Boolean (1=ON,0=OFF) 

默认值 无 

菜单项 无 

举例 :DISPlay:WINDow4:STATe 1 

:DISPlay:WINDow4:STATe? 

Return: 1 

 

3.4.3.4 选择工作窗口 

命令格式 :DISPlay:WINDow<wnum>:ACTivate 

说明 指定选择的窗口为工作窗口。 

参数 <wnum>:={[1]-36}，表示测量窗口号，如果未指定，则<wnum>默认设置 1。 

返回类型 无 

默认值 1 

菜单项 显示 > 窗口设置 > 选择 



 

 

举例 选择窗口 2 为工作窗口 

:DISPlay:WINDow2:ACTivate 

 

3.4.3.5 选择/查询活动窗口 

命令格式 :DISPlay:WINDow<wnum>:SELect 

:DISPlay:WINDow:SELect? 

说明 设置或查询当前活动窗口 

参数 <wnum>:={[1]-36}，表示测量窗口号，如果未指定，则<wnum>默认设置 1。 

返回类型 整型 

默认值 1 

菜单项 显示 > 窗口设置 > 选择 

举例 :DISPlay:WINDow2:SELect 

:DISPlay:WINDow:SELect? 

 

Return: 2 

 

3.4.3.6 查询某窗口的迹线列表 

命令格式 :DISPlay:WINDow<wnum>:TRACe:LIST? 

说明 查询指定窗口的迹线列表。 

参数 <wnum>:={[1]-36}，表示测量窗口号，如果未指定，则<wnum>默认设置 1。 

返回类型 整型 

默认值 1 

菜单项 显示 > 迹线设置 > 选择 

举例 窗口 1存在 Tr1，Tr2,和 Tr4 三个迹线时，查询窗口 1的迹线列表。 

:DISPlay:WINDow1:TRACe:LIST? 

Return:1,2,4 

 

3.4.3.7 查询某窗口的通道列表 

命令格式 :DISPlay:WINDow<wnum>:CHANnel:LIST? 

说明 查询指定窗口的通道列表。 

参数 <wnum>:={[1]-36}，表示测量窗口号，如果未指定，则<wnum>默认设置 1。 

返回类型 整型 
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默认值 1 

菜单项 显示 > 通道设置 > 选择 

举例 窗口 1存在 CH1和 CH3两个通道，查询窗口 1 的通道列表。 

:DISPlay:WINDow1:CHANnel:LIST? 

Return:1,3 

 

3.4.3.8 设置窗口标题 

命令格式 :DISPlay:WINDow<wnum>:TITLe:DATA <string> 

:DISPlay:WINDow<wnum>:TITLe:DATA? 

说明 设置或查询窗口标题。 

参数 <wnum>:={[1]-36}，表示测量窗口号，如果未指定，则<wnum>默认设置 1。 

<string>: 表示窗口标题，其范围是 1-256个字符。 

返回类型 字符串 

默认值 1 

菜单项 显示 > 窗口设置 > 窗口标题… 

举例 :DISPlay:WINDow1:TITLe:DATA siglent 

:DISPlay:WINDow1:TITLe:DATA? 

Return : "siglent" 

 

3.4.3.9 窗口标题显示开关 

命令格式 :DISPlay:WINDow<wnum>:TITLe[:STATe] <bool> 

:DISPlay:WINDow<wnum>:TITLe[:STATe]? 

说明 打开或关闭窗口标题字符串的显示。或查询窗口标题字符串的显示状态。 

参数 <wnum>:={[1]-36}，表示测量窗口号，如果未指定，则<wnum>默认设置 1。 

<bool>:= ON|OFF|1|0 

返回类型 Boolean (1=ON,0=OFF) 

默认值 0 

菜单项 显示 > 窗口设置 > 窗口标题… > Enabled 

举例 打开窗口 1 的标题显示。 

:DISPlay:WINDow1:TITLe:STATe 1 

:DISPlay:WINDow1:TITLe:STATe? 

Return :1 

 



 

 

3.4.3.10 设置屏幕窗口布局 

命令格式 :DISPlay:ARRange <type> 

说明 设置窗口布局格式 

参数 <type>:={TILE|OVERlay|STACk|SPLIt|QUAD|MEASure|CHANnel} 

返回类型 枚举 

默认值 OVERlat 

菜单项 显示 > 窗口设置 > 窗口布局 

举例 :DISPlay:ARRange TILE 

 

3.4.3.11 活动窗口最大化 

命令格式 :DISPlay:MAXimize <bool> 

:DISPlay:MAXimize? 

说明 设置或获取激活通道窗口最大化状态 

参数 <bool>:= ON|OFF|1|0 

返回类型 Boolean (1=ON,0=OFF) 

默认值 1 

菜单项 显示 > 窗口设置 > 窗口最大化 

举例 :DISPlay:MAXimize ON 

:DISPlay:MAXimize? 

Return: 1 

 

3.4.3.12 清除状态栏错误信息 

命令格式 :DISPlay:CCLear 

说明 这个命令清除状态栏（在 LCD 显示器的底端）显示的错误消息。 

参数 无 

返回类型 无 

默认值 无 

菜单项 无 

举例 :DISPlay:CCLear 
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3.5 Format 命令子系统 

3.5.1 格式 

3.5.1.1 命令列表 

数据传输格式 :FORMat:DATA 

迹线数据格式 :CALCulate<cnum>:TRACe<tnum>:FORMat 

 

3.5.1.2 数据传输格式 

命令格式 :FORMat:DATA <type> 

:FORMat:DATA? 

说明 设置或获取测量数据的传输格式。 

参数 <type> ={ASCii|REAL|REAL32} 

ASCii：指定 ASCII 传输格式。 

REAL：指定 IEEE 64 位浮点型二进制传输格式。 

REAL32：指定 IEEE 32 位浮点型二进制传输格式。 

返回类型 枚举 

默认值 ASCii 

菜单项 无 

举例 :FORMat:DATA REAL 

:FORMat:DATA? 

Return: REAL 

 

3.5.1.3 迹线数据格式 

命令格式 :CALCulate<cnum>[:SELected]:FORMat <type> 

:CALCulate<cnum>[:SELected]:FORMat? 

 

:CALCulate<cnum>:TRACe<tnum>:FORMat <type> 

:CALCulate<cnum>:TRACe<tnum>:FORMat? 

说明 设置或获取激活迹线数据显示格式 

设置或获取选择通道及迹线数据显示格式 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

<type>=:{MLOGarithmic|PHASe|GDELay| 
SLINear|SLOGarithmic|SCOMplex|SMITh|SADMittance|PLINear|PLOGarithmic|
POLar|MLINear|SWR|REAL| IMAGinary|UPHase|PPHase} 



 

 

返回类型 枚举 

默认值 MLOGarithmic 

菜单项 格式 > 格式 1/格式 2 

举例 :CALCulate1:FORMat PHASe 

:CALCulate1:FORMat? 

Return: PHAS 

 

:CALCulate1:TRACe1:FORMat GDELay 

:CALCulate1:TRACe1:FORMat? 

Return: GDEL 

 

3.5.2 获取数据 

3.5.2.1 命令列表 

格式化数据数组 :CALCulate<cnum>:TRACe<tnum>:DATA:FDATa 

修正的数据数组 :CALCulate<cnum>:TRACe<tnum>:DATA:SDATa 

读取通道频率数组 :SENSe<cnum>:FREQuency:DATA? 

测量点 X 轴数据 :CALCulate<cnum>:TRACe<tnum>:DATA:XAXis? 

查询多条迹线的格式化数据 :CALCulate<cnum>:DATA:MFData <numeric>? 

查询多条迹线的误差修正数据 :CALCulate<cnum>:DATA:MSData <numeric>? 

查询 snp数据 :CALCulate<cnum>:DATA:SNP? 

获取 S 参数数据 :SENSe<cnum>:DATA:CORRdata? S<XY> 

获取原始数据 :SENSe<cnum>:DATA:RAWData? S<XY> 

 

3.5.2.2 格式化数据数组 

命令格式 :CALCulate<cnum>[:SELected]:DATA:FDATa <numeric1>,… ,<numeric NOP*2> 

:CALCulate<cnum>[:SELected]:DATA:FDATa? 

:CALCulate<cnum>:TRACe<tnum>:DATA:FDATa <numeric1>,… ,<numeric 
NOP*2> 

:CALCulate<cnum>:TRACe<tnum>:DATA:FDATa? 

说明 设置所选通道激活迹线的格式化数据数组 

设置所选通道及所选迹线的格式化数据数组 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

<numeric1>,… ,<numeric NOP*2>:表示 NOP（Numbers of point）*2的数组数据
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（格式化数据数组）。n为 1到 NOP 之间的整数。 

数据（n*2-2）：第 n个测量点的数据（实部）。 

数据（n*2-1）：第 n个测量点的数据（虚部）。当数据格式不是 Smith图形格式或

极性格式时其值通常为 0。 

数组索引从 0开始。 

返回类型 数据数组 

默认值 无 

菜单项 无 

举例 :CALCulate1:DATA:FDATa a1,b1,……,an,bn 

:CALCulate1:DATA:FDATa? 

:CALCulate1:TRACe1:DATA:FDATa a1,b1,……,an,bn 

:CALCulate1:TRACe1:DATA:FDATa? 

 

3.5.2.3 修正的数据数组 

命令格式 :CALCulate<cnum>[:SELected]:DATA:SDATa <numeric1>,… ,<numeric NOP*2> 

:CALCulate<cnum>[:SELected]:DATA:SDATa? 

:CALCulate<cnum>:TRACe<tnum>:DATA:SDATa <numeric1>,… ,<numeric 
NOP*2> 

:CALCulate<cnum>:TRACe<tnum>:DATA:SDATa? 

说明 设置所选通道激活迹线的修正的数据数组 

设置所选通道及所选迹线的修正的数据数组 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

<numeric1>,… ,<numeric NOP*2>:表示 NOP（Numbers of point）*2的数组数据

（格式化数据数组）。n为 1到 NOP 之间的整数。 

数据（n*2-2）：第 n个测量点的数据（实部）。 

数据（n*2-1）：第 n个测量点的数据（虚部）。当数据格式不是 Smith图形格式或

极性格式时其值通常为 0。 

数组索引从 0开始。 

返回类型 数据数组 

默认值 无 

菜单项 无 

举例 :CALCulate1:DATA:SDATa a1,b1,……,an,bn 

:CALCulate1:DATA:SDATa? 

:CALCulate1:TRACe1:DATA:SDATa a1,b1,……,an,bn 

:CALCulate1:TRACe1:DATA:SDATa? 



 

 

 

3.5.2.4 读取通道频率数组 

命令格式 :SENSe<cnum>:FREQuency:DATA? 

说明 获取选择通道的所有测量点的频率 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

返回类型 数组数据 

默认值 无 

菜单项 无 

举例 :SENSe1:FREQuency:DATA? 

 

3.5.2.5 测量点 X轴数据 

命令格式 :CALCulate<cnum>[:SELected]:DATA:XAXis? 

:CALCulate<cnum>:TRACe<tnum>:DATA:XAXis? 

说  明 设置或获取激活迹线的测量点的 X 轴数据数组 

设置或获取选择通道及迹线的测量点的 X 轴数据数组 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

返回类型 数据数组, 单位随扫频类型变化 

默认值 无 

菜单项 无 

举例 :CALCulate1:DATA:XAXis? 

:CALCulate1:TRACe1:DATA:XAXis? 

 

3.5.2.6 查询多条迹线的格式化数据 

命令格式 :CALCulate<cnum>:DATA:MFData <numeric>? 

说明 获取同一个通道的多条迹线的格式化数据。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<numeric>:表示迹线编号，其范围是 1 至迹线号的最大值。多条迹线号间用逗号隔

开。 

返回类型 数据数组 

默认值 无 

菜单项 无 

举例 :CALC:DATA:MFData? "1,2,3" 
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Return：8.457302793195e-02,0.000000000000e+00, 

-1.426901425958e-01,0.000000000000e+00, 
-2.635991012650e-01,0.000000000000e+00, 
-2.839929320553e-01,0.000000000000e+00, 
-3.315815592045e-01,0.000000000000e+00, 
- 3.528884698654e-01,0.000000000000e+00, 
-3.937646932011e-01,0.000000000000e+00,-4.517490965595e-01… 

 

3.5.2.7 查询多条迹线的误差修正数据 

命令格式 :CALCulate<cnum>:DATA:MSData <numeric>? 

说明 获取同一个通道的多条迹线的误差修正数据。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<numeric>:表示迹线编号，其范围是 1 至迹线号的最大值。多条迹线号间用逗号隔

开。 

返回类型 数组数据 

默认值 无 

菜单项 无 

举例 :CALC:DATA:MSData? "1,2,3" 

Return：1.010376816410e+00,-8.191833528689e-03,-6.960549382249e-01, 

-6.946841837980e-01,6.925621007541e-03,9.700560127871e-01, 
6.967893184358e-01,-6.718442699877e-01,-9.629746082335e-01, 
-1.534994428298e-02,6.515030755121e-01,7.056409245766e-01, 
4.932709557852e-02,-9.543263693213e-01,-7.007103025244e-01,… 

 

3.5.2.8 查询 snp数据 

命令格式 :CALCulate<cnum>:DATA:SNP? <numeric> 

说明 查询 SNP 数据。此命令仅用于对 S 参数测量。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<numeric>:表示 SNP 文件“N”的个数，其范围 1到 4。 

返回类型 字符串 

默认值 无 

菜单项 无 

举例 :CALC:DATA:SNP? 1 

Return : 1.000000000000e+05,4.259950000000e+07,8.509900000000e+07, 
1.275985000000e+08,1.700980000000e+08,2.125975000000e+08, 

2.550970000000e+08,2.975965000000e+08,3.400960000000e+08, 

3.825955000000e+08, 

 



 

 

3.5.2.9 获取 S参数数据 

命令格式 :SENSe<cnum>:DATA:CORRdata? S<XY> 

说明 设置当前激活通道对应 S 参数的数据。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

字符串"S<XY>": 

X：1~4 

Y：1~4 

返回类型 表示 NOP（Numbers of point）*2 的数组数据（未格式化的 S 参数数据数组）。n

为 1到 NOP 之间的整数。 

数据（n*2-2）：第 n个测量点的数据（实部）。 

数据（n*2-1）：第 n个测量点的数据（虚部）。 

数组索引从 0开始。 

默认值 无 

菜单项 无 

举例 :SENSe1:DATA:CORRdata? S11 

 

3.5.2.10 获取原始数据 

命令格式 :SENSe<cnum>:DATA:RAWData? S<XY> 

说明 设置当前激活通道原始测量数据。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

字符串"S<XY>": 

X：1~4 

Y：1~4 

返回类型 表示 NOP（Numbers of point）*2的数组数据。n为 1 到 NOP 之间的整数。 

数据（n*2-2）：第 n个测量点的数据（实部）。 

数据（n*2-1）：第 n个测量点的数据（虚部）。 

数组索引从 0开始。 

默认值 无 

菜单项 无 

举例 :SENSe1:DATA:RAWData? S11 
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3.6 Frequency 命令子系统 

3.6.1 扫频设置 

3.6.1.1 命令列表 

起始频率 :SENSe<cnum>:FREQuency:STARt 

终止频率 :SENSe<cnum>:FREQuency:STOP 

中心频率 :SENSe<cnum>:FREQuency:CENTer 

频率跨距 :SENSe<cnum>:FREQuency:SPAN 

CW频率 :SENSe<cnum>:FREQuency:CW 

 

3.6.1.2 起始频率 

命令格式 :SENSe<cnum>:FREQuency:STARt <numeric> 

:SENSe<cnum>:FREQuency:STARt? 

说明 设置或获取选择通道的起始频率。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<numeric>:表示起始频率。 

返回类型 浮点型，单位 Hz 

默认值 矢量网络分析仪的最小频率 

菜单项 频率 > 起始频率 

举例 :SENSe1:FREQuency:STARt 100e3 

:SENSe1:FREQuency:STARt? 

Return: 100000 

 

3.6.1.3 终止频率 

命令格式 :SENSe<cnum>:FREQuency:STOP <numeric> 

:SENSe<cnum>:FREQuency:STOP? 

说明 设置或获取选择通道的终止频率。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<numeric>:表示终止频率。 

返回类型 浮点型，单位 Hz 

默认值 矢量网络分析仪的最大频率 



 

 

菜单项 频率 > 终止频率 

举例 :SENSe1:FREQuency:STOP 1e9 

:SENSe1:FREQuency:STOP? 

Return: 1000000000 

 

3.6.1.4 中心频率 

命令格式 :SENSe<cnum>:FREQuency:CENTer <numeric> 

:SENSe<cnum>:FREQuency:CENTer? 

说  明 设置或获取选择通道的中心频率。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<numeric>:表示中心频率。 

返回类型 浮点型，单位 Hz 

默认值 矢量网络分析仪频率范围的中心值 

菜单项 频率> 中心频率 

举例 :SENSe1:FREQuency:CENTer 1e9 

:SENSe1:FREQuency:CENTer? 

Return: 1000000000 

 

3.6.1.5 频率跨距 

命令格式 :SENSe<cnum>:FREQuency:SPAN <numeric> 

:SENSe<cnum>:FREQuency:SPAN? 

说明 设置或获取选择通道的扫宽。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<numeric>:表示扫宽。 

返回类型 浮点型，单位 Hz 

默认值 矢量网络分析仪的最大频率 

菜单项 频率 > 频率跨距 

举例 :SENSe1:FREQuency:SPAN 1e6 

:SENSe1:FREQuency:SPAN? 

Return: 1000000 

 

3.6.1.6 CW频率 

命令格式 :SENSe<cnum>:FREQuency:CW <numeric> 

:SENSe<cnum>:FREQuency:CW? 
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:SENSe<cnum>:FREQuency:FIXed <numeric> 

:SENSe<cnum>:FREQuency:FIXed? 

说  明 设置或获取选择通道的 CW 频率。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<numeric>:表示 CW频率。 

返回类型 浮点型，单位 Hz 

默认值 1 GHz 

菜单项 频率 > CW频率 

举例 :SENSe1:FREQuency:CW 2e9 

:SENSe1:FREQuency:CW? 

Return: 2000000000 

 

:SENSe1:FREQuency:FIXed 3e9 

:SENSe1:FREQuency:FIXed? 

Return: 3000000000 

 

3.6.2 频偏模式 

3.6.2.1 命令列表 

频偏测量开关 :SENSe<cnum>:FOM[:STATe] 

频偏控制设备数量 :SENSe<cnum>:FOM:COUNt? 

频偏控制设备名称列表 :SENSe<cnum>:FOM:CATalog? 

频偏控制设备编号 :SENSe<cnum>:FOM:RNUM? 

频偏控制设备名称 :SENSe<cnum>:FOM:RANGe<rnum>:NAME? 

数据显示轴对应设备名称 :SENSe<cnum>:FOM:DISPlay:SELect 

频偏扫描类型 :SENSe{chnum}:FOM:RANGe<rnum>:SWEep:TYPE 

频偏扫描起始频率 :SENSe<cnum>:FOM:RANGe<rnum>:FREQuency:STARt 

 

频偏扫描终止频率 

:SENSe<cnum>:FOM:RANGe<rnum>:FREQuency:STOP 

频偏扫描 CW频率 :SENSe<cnum>:FOM:RANGe<rnum>:FREQuency:CW 

添加频偏段扫描表项 :SENSe<cnum>:FOM:RANGe<rnum>:SEGMent<segnum>:ADD 

删除频偏段扫描表项 :SENSe<cnum>:FOM:RANGe<rnum>:SEGMent<segnum>:DELete 

频偏段扫描表项数量 :SENSe<cnum>:FOM:RANGe<rnum>:SEGMent:COUNt? 



 

 

清空频偏段扫描表项 :SENSe<cnum>:FOM:RANGe<rnum>:SEGMent:DELete:ALL 

频偏段扫描表项启用状态 :SENSe<cnum>:FOM:RANGe<rnum>:SEGMent<segnum>[:STATe] 

频偏段扫描表项起始频率 :SENSe<cnum>:FOM:RANGe<rnum>:SEGMent<segnum>:FREQuency:STARt 

频偏段扫描表项终止频率 :SENSe<cnum>:FOM:RANGe<rnum>:SEGMent<segnum>:FREQuency:STOP 

频偏段扫描表项中心频率 :SENSe<cnum>:FOM:RANGe<rnum>:SEGMent<segnum>:FREQuency:CENTer 

频偏段扫描表项频率跨距 :SENSe<cnum>:FOM:RANGe<rnum>:SEGMent<segnum>:FREQuency:SPAN 

 

频偏段扫描表项扫描点数 

:SENSe<cnum>:FOM:RANGe<rnum>:SEGMent<segnum>:SWEep:POINts 

频偏段扫描表功率电平控制 :SENSe<cnum>:FOM:RANGe<rnum>:SEGMent:POWer[:LEVel]:CONTrol 

频偏段扫描表项功率电平 :SENSe<cnum>:FOM:RANGe<rnum>:SEGMent<segnum>:POWer[:LEVel] 

频偏段扫描表扫描时间控制 :SENSe<cnum>:FOM:RANGe<rnum>:SEGMent:SWEep:TIME:CONTrol 

频偏段扫描表项扫描时间 :SENSe<cnum>:FOM:RANGe<rnum>:SEGMent<segnum>:SWEep:TIME 

频偏段扫描表扫描延时控制 :SENSe<cnum>:FOM:RANGe<rnum>:SEGMent:SWEep:DELay:CONTrol 

频偏段扫描表项扫描延时 :SENSe<cnum>:FOM:RANGe<rnum>:SEGMent<segnum>:SWEep:DELay 

频偏段扫描表中频带宽控制 :SENSe<cnum>:FOM:RANGe<rnum>:SEGMent:BWIDth[:RESolution]:CONTrol 

频偏段扫描表项中频带宽 :SENSe<cnum>:FOM:RANGe<rnum>:SEGMent<segnum>:BWIDth[:RESolution] 

频偏耦合状态 :SENSe<cnum>:FOM:RANGe<rnum>:COUPled 

频偏倍频因子 :SENSe<cnum>:FOM:RANGe<rnum>:FREQuency:MULTiplier 

频偏分频因子 :SENSe<cnum>:FOM:RANGe<rnum>:FREQuency:DIVisor 

频率偏移量 :SENSe<cnum>:FOM:RANGe<rnum>:FREQuency:OFFSet 

 

3.6.2.2 频偏测量开关 

命令格式 :SENSe<cnum>:FOM[:STATe] <bool> 

:SENSe<cnum>:FOM[:STATe]? 

说明 设置或获取通道频偏扫描功能启用状态。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<bool>:= ON|OFF|1|0 

返回类型 Boolean (1=ON,0=OFF) 

默认值 OFF 

菜单项 频率 > 频偏... > Freq Offset Enable 
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举例 :SENS:FOM ON 

:SENS:FOM? 

Return: 1 

 

3.6.2.3 频偏控制设备数量 

命令格式 :SENSe<cnum>:FOM:COUNt? 

说明 获取通道频偏控制设备数量。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

返回类型 整型 

默认值 无 

菜单项 无 

举例 
:SENS:FOM:COUN? 

Return: 3 

 

3.6.2.4 频偏控制设备名称列表 

命令格式 :SENSe<cnum>:FOM:CATalog? 

说明 获取通道频偏控制设备名称列表。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

返回类型 字符串 

默认值 无 

菜单项 频率 > 频偏... > Annotation 

举例 :SENS:FOM:CAT? 

Return: “Primary,Source,Receivers” 

 

3.6.2.5 频偏控制设备编号 

命令格式 :SENSe<cnum>:FOM:RNUM? <string> 

说明 获取频偏控制设备编号。通常频偏控制设备命名及编号如下: 

1.Primary 

2.Source 

3.Receivers 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<string>: 表示可用的频偏控制设备名称。 

返回类型 整型 



 

 

默认值 无 

菜单项 无 

举例 :SENS:FOM:RNUM? "Source" 

Return: 2 

 

3.6.2.6 频偏控制设备名称 

命令格式 :SENSe<cnum>:FOM:RANGe<rnum>:NAME? 

说  明 获取频偏控制设备名称。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<rnum>: 表示频偏设备编号，如果未指定，则<rnum>默认设置 1。 

返回类型 字符串 

默认值 无 

菜单项 频率 > 频偏... >Annotation 

举例 :SENS:FOM:RANG:NAME? 

Return: "Primary" 

 

3.6.2.7 数据显示轴对应设备名称 

命令格式 :SENSe<cnum>:FOM:DISPlay:SELect <string> 

:SENSe<cnum>:FOM:DISPlay:SELect? 

说明 设置或获取通道数据显示轴对应的频偏控制设备名称。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<string>: 表示可用的频偏控制设备名称。 

可用 SENSe:FOM:CAT? 进行查看可用设备的名称列表。 

返回类型 字符串 

默认值 "Source" 

菜单项 频率 > 频偏... > Annotation 

举例 :SENS:FOM:DISP:SEL "Source" 

:SENS:FOM:DISP:SEL? 

Return: "Source" 

 

3.6.2.8 频偏扫描类型 

命令格式 :SENSe<cnum>:FOM:RANGe<rnum>:SWEep:TYPE <type> 

:SENSe<cnum>:FOM:RANGe<rnum>:SWEep:TYPE? 

说  明 设置或获取设备频偏独立扫描类型。 
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参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<rnum>: 表示频偏设备编号，如果未指定，则<rnum>默认设置 1。 

<type>:= {LINear|LOGarithmic|SEGMent|POWer|CW} 

返回类型 枚举 

默认值 LINear 

菜单项 频率 > 频偏... > Sweep Type 

举例 :SENS:FOM:RANG2:SWE:TYPE CW 

:SENS:FOM:RANG2:SWE:TYPE? 

Return: CW 

 

3.6.2.9 频偏扫描起始频率 

命令格式 :SENSe<cnum>:FOM:RANGe<rnum>:FREQuency:STARt <numeric> 

:SENSe<cnum>:FOM:RANGe<rnum>:FREQuency:STARt? 

说明 设置或获取设备频偏扫描起始频率。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<rnum>: 表示频偏设备编号，如果未指定，则<rnum>默认设置 1。 

<numeric>:表示起始频率。 

返回类型 浮点型，单位 Hz（赫兹） 

默认值 无 

菜单项 频率 > 频偏... > Settings > Start Freq 

举例 :SENS:FOM:RANG:FREQ:STAR 1E9 

:SENS:FOM:RANG:FREQ:STAR? 

Return: 1000000000 

 

3.6.2.10 频偏扫描终止频率 

命令格式 :SENSe<cnum>:FOM:RANGe<rnum>:FREQuency:STOP <numeric> 

:SENSe<cnum>:FOM:RANGe<rnum>:FREQuency:STOP? 

说明 设置或获取设备频偏扫描终止频率。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<rnum>: 表示频偏设备编号，如果未指定，则<rnum>默认设置 1。 

<numeric>:表示终止频率。 

返回类型 浮点型，单位 Hz（赫兹） 

默认值 无 

菜单项 频率 > 频偏... > Settings > Stop Freq 



 

 

举例 :SENS:FOM:RANG2:FREQ:STOP 1E9 

:SENS:FOM:RANG2:FREQ:STOP? 

Return: 1000000000 

 

3.6.2.11 频偏扫描 CW频率 

命令格式 :SENSe<cnum>:FOM:RANGe<rnum>:FREQuency:CW <numeric> 

:SENSe<cnum>:FOM:RANGe<rnum>:FREQuency:CW? 

说明 设置或获取设备频偏扫描 CW频率。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<rnum>: 表示频偏设备编号，如果未指定，则<rnum>默认设置 1。 

<numeric>:表示 CW频率。 

返回类型 浮点型，单位 Hz（赫兹） 

默认值 无 

菜单项 频率 > 频偏... > Sweep Type > CW Freq 

举例 :SENS:FOM:RANG2:FREQ:CW 1E9 

:SENS:FOM:RANG2:FREQ:CW? 

Return: 1000000000 

 

3.6.2.12 添加频偏段扫描表项 

命令格式 :SENSe<cnum>:FOM:RANGe<rnum>:SEGMent<segnum>:ADD 

说明 添加设备频偏段扫描表项。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<rnum>: 表示频偏设备编号，如果未指定，则<rnum>默认设置 1。 

<segnum>: 表示段扫描编号，如果未指定，则<segnum>默认设置 1。段号必须是

连续的。如果在当前存在一个数字的地方添加一个新数字，则现有的段和后面的段

都加 1。 

返回类型 无 

默认值 无 

菜单项 频率 > 频偏... > Sweep Type > Segment > Add Segment 

举例 :SENS:FOM:RANG:SEGM:ADD 

 

3.6.2.13 删除频偏段扫描表项 

命令格式 :SENSe<cnum>:FOM:RANGe<rnum>:SEGMent<segnum>:DELete 
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说明 删除设备频偏段扫描表项。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<rnum>: 表示频偏设备编号，如果未指定，则<rnum>默认设置 1。 

<segnum>: 表示段扫描编号，如果未指定，则<segnum>默认设置 1。 

返回类型 无 

默认值 无 

菜单项 频率 > 频偏... > Sweep Type > Segment > Delete Segment 

举例 :SENS:FOM:RANG:SEGM:DEL 

 

3.6.2.14 频偏段扫描表项数量 

命令格式 :SENSe<cnum>:FOM:RANGe<rnum>:SEGMent:COUNt? 

说明 获取设备频偏段扫描表项数量。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<rnum>: 表示频偏设备编号，如果未指定，则<rnum>默认设置 1。 

返回类型 整型 

默认值 1 

菜单项 无 

举例 :SENS:FOM:RANG:SEGM:COUN? 

 

3.6.2.15 清空频偏段扫描表项 

命令格式 :SENSe<cnum>:FOM:RANGe<rnum>:SEGMent:DELete:ALL 

说明 清空设备频偏段扫描表项。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<rnum>: 表示频偏设备编号，如果未指定，则<rnum>默认设置 1。 

返回类型 无 

默认值 无 

菜单项 扫描 > 段扫描表 > 删除所有段 

举例 :SENS:FOM:RANG:SEGM:DEL:ALL 

 



 

 

3.6.2.16 频偏段扫描表项启用状态 

命令格式 :SENSe<cnum>:FOM:RANGe<rnum>:SEGMent<segnum>[:STATe] <bool> 

:SENSe<cnum>:FOM:RANGe<rnum>:SEGMent<segnum>[:STATe]? 

说明 设置或获取设备频偏段扫描表项启用状态。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<rnum>: 表示频偏设备编号，如果未指定，则<rnum>默认设置 1。 

<segnum>:表示段扫描表编号，如果未指定，则<segnum>默认设置 1。 

<bool>:= ON|OFF|1|0 

返回类型 Boolean (1=ON,0=OFF) 

默认值 无 

菜单项 频率 > 频偏... > Sweep Type > Segment 

举例 :SENS:FOM:RANG:SEGM OFF 

:SENS:FOM:RANG:SEGM? 

Return: 0 

 

3.6.2.17 频偏段扫描表项起始频率 

命令格式 :SENSe<cnum>:FOM:RANGe<rnum>:SEGMent<segnum>:FREQuency:STARt 
<numeric> 

:SENSe<cnum>:FOM:RANGe<rnum>:SEGMent<segnum>:FREQuency:STARt? 

说明 设置或获取设备频偏段扫描表项起始频率。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<rnum>: 表示频偏设备编号，如果未指定，则<rnum>默认设置 1。 

<segnum>: 表示段扫描编号，如果未指定，则<segnum>默认设置 1。 

<numeric> : 表示起始频率。 

返回类型 浮点型，单位 Hz（赫兹） 

默认值 无 

菜单项 频率 > 频偏... > Sweep Type > Segment > Segment Table > start 

举例 :SENS:FOM:RANG:SEGM:FREQ:STAR 1E9 

:SENS:FOM:RANG:SEGM:FREQ:STAR? 

Return: 1000000000 

 

3.6.2.18 频偏段扫描表项终止频率 

命令格式 :SENSe<cnum>:FOM:RANGe<rnum>:SEGMent<segnum>:FREQuency:STOP 
<numeric> 

:SENSe<cnum>:FOM:RANGe<rnum>:SEGMent<segnum>:FREQuency:STOP? 

说明 设置或获取设备频偏段扫描表项终止频率。 
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参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<rnum>: 表示频偏设备编号，如果未指定，则<rnum>默认设置 1。 

<segnum>: 表示段扫描编号，如果未指定，则<segnum>默认设置 1。 

<numeric> : 表示终止频率。 

返回类型 浮点型，单位 Hz（赫兹） 

默认值 无 

菜单项 频率 > 频偏... > Sweep Type > Segment > Segment Table > stop 

举例 :SENS:FOM:RANG:SEGM:FREQ:STOP 1E9 

:SENS:FOM:RANG:SEGM:FREQ:STOP? 

Return: 1000000000 

 

3.6.2.19 频偏段扫描表项中心频率 

命令格式 :SENSe<cnum>:FOM:RANGe<rnum>:SEGMent<segnum>:FREQuency:CENTer 
<numeric> 

:SENSe<cnum>:FOM:RANGe<rnum>:SEGMent<segnum>:FREQuency:CENTer? 

说明 设置或获取设备频偏段扫描表项中心频率。。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<rnum>: 表示频偏设备编号，如果未指定，则<rnum>默认设置 1。 

<segnum>: 表示段扫描编号，如果未指定，则<segnum>默认设置 1。 

<numeric> : 表示中心频率。 

返回类型 浮点型，单位 Hz（赫兹） 

默认值 无 

菜单项 无 

举例 :SENS:FOM:RANG:SEGM:FREQ:CENT 1E9 

:SENS:FOM:RANG:SEGM:FREQ:CENT? 

Return: 1000000000 

 

3.6.2.20 频偏段扫描表项频率跨距 

命令格式 :SENSe<cnum>:FOM:RANGe<rnum>:SEGMent<segnum>:FREQuency:SPAN 
<numeric> 

 

:SENSe<cnum>:FOM:RANGe<rnum>:SEGMent<segnum>:FREQuency:SPAN? 

说明 设置或获取设备频偏段扫描表项频率跨距。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<rnum>: 表示频偏设备编号，如果未指定，则<rnum>默认设置 1。 



 

 

<segnum>: 表示段扫描编号，如果未指定，则<segnum>默认设置 1。 

<numeric> : 表示频率跨距。 

返回类型 浮点型，单位 Hz（赫兹） 

默认值 无 

菜单项 无 

举例 :SENS:FOM:RANG:SEGM:FREQ:SPAN 1E9 

:SENS:FOM:RANG:SEGM:FREQ:SPAN? 

Return: 1000000000 

 

3.6.2.21 频偏段扫描表项扫描点数 

命令格式 :SENSe<cnum>:FOM:RANGe<rnum>:SEGMent<segnum>:SWEep:POINts 
<numeric> 

:SENSe<cnum>:FOM:RANGe<rnum>:SEGMent<segnum>:SWEep:POINts? 

说明 设置或获取设备频偏段扫描表项扫描点数。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<rnum>: 表示频偏设备编号，如果未指定，则<rnum>默认设置 1。 

<segnum>: 表示段扫描编号，如果未指定，则<segnum>默认设置 1。 

<numeric>: 表示段扫描点数，所有分段的点数总和不能超过 20001。一个段最少可

以只有 2个点。 

返回类型 整型 

默认值 无 

菜单项 频率 > 频偏... > Sweep Type > Segment > Segment Table > Points 

举例 :SENS:FOM:RANG:SEGM:SWE:POIN 300 

:SENS:FOM:RANG:SEGM:SWE:POIN? 

Return: 300 

 

3.6.2.22 频偏段扫描表功率电平控制 

命令格式 :SENSe<cnum>:FOM:RANGe<rnum>:SEGMent:POWer[:LEVel]:CONTrol 
<bool> 

:SENSe<cnum>:FOM:RANGe<rnum>:SEGMent:POWer[:LEVel]:CONTrol? 

说明 设置或获取设备频偏段扫描表功率电平控制状态。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<rnum>:  表示频偏设备编号，如果未指定，则<rnum>默认设置 1。 

<bool>:= ON|OFF|1|0 

返回类型 Boolean (1=ON,0=OFF) 
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默认值 OFF 

菜单项 频率 > 频偏... > Sweep Type > Segment > Sweep Properties > Independent 

Power Levels 

举例 :SENS:FOM:RANG:SEGM:POW:CONT ON 

:SENS:FOM:RANG:SEGM:POW:CONT? 

Return: 1 

 

3.6.2.23 频偏段扫描表项功率电平 

命令格式 :SENSe<cnum>:FOM:RANGe<rnum>:SEGMent<segnum>:POWer[:LEVel] 
<numeric> 

:SENSe<cnum>:FOM:RANGe<rnum>:SEGMent<segnum>:POWer[:LEVel]? 

说明 设置或获取设备频偏段扫描表项功率电平。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<rnum>:  表示频偏设备编号，如果未指定，则<rnum>默认设置 1。 

<segnum>:  表示段扫描表编号，如果未指定，则<segnum>默认设置 1。 

<numeric>:表示功率电平值，其范围是: -55dBm~20dBm。 

返回类型 浮点型，单位 dBm 

默认值 无 

菜单项 频率 > 频偏... > Sweep Type > Segment > Sweep Properties > Independent 

Power Levels > Power Level 

举例 :SENS:FOM:RANG:SEGM:POW -10 

:SENS:FOM:RANG:SEGM:POW? 

Return: -10 

 

3.6.2.24 频偏段扫描表扫描时间控制 

命令格式 :SENSe<cnum>:FOM:RANGe<rnum>:SEGMent:SWEep:TIME:CONTrol <bool> 

:SENSe<cnum>:FOM:RANGe<rnum>:SEGMent:SWEep:TIME:CONTrol? 

说明 设置或获取设备频偏段扫描表扫描时间控制状态。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<rnum>:  表示频偏设备编号，如果未指定，则<rnum>默认设置 1。 

<bool>:= ON|OFF|1|0 

返回类型 Boolean (1=ON,0=OFF) 

默认值 OFF 

菜单项 频率 > 频偏... > Sweep Type > Segment > Sweep Properties > Independent 

Sweep Time 



 

 

举例 :SENS:FOM:RANG:SEGM:SWE:TIME:CONT ON 

:SENS:FOM:RANG:SEGM:SWE:TIME:CONT? 

Return: 1 

 

3.6.2.25 频偏段扫描表项扫描时间 

命令格式 :SENSe<cnum>:FOM:RANGe<rnum>:SEGMent<segnum>:SWEep:TIME 
<numeric> 

 

:SENSe<cnum>:FOM:RANGe<rnum>:SEGMent<segnum>:SWEep:TIME? 

说明 设置或获取设备频偏段扫描表项扫描时间。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<rnum>:  表示频偏设备编号，如果未指定，则<rnum>默认设置 1。 

<segnum>:  表示段扫描表编号，如果未指定，则<segnum>默认设置 1。 

<numeric>:表示扫描时间。 

返回类型 浮点型，单位 s（秒） 

默认值 无 

菜单项 频率 > 频偏... > Sweep Type > Segment > Sweep Properties > Independent 

Sweep Time > Sweep Time 

举例 :SENS:FOM:RANG:SEGM:SWE:TIME 5 

:SENS:FOM:RANG:SEGM:SWE:TIME? 

Return: 5 

 

3.6.2.26 频偏段扫描表扫描延时控制 

命令格式 :SENSe<cnum>:FOM:RANGe<rnum>:SEGMent:SWEep:DELay:CONTrol <bool> 

 

:SENSe<cnum>:FOM:RANGe<rnum>:SEGMent:SWEep:DELay:CONTrol? 

说明 设置或获取设备频偏段扫描表扫描延时控制状态。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<rnum>:  表示频偏设备编号，如果未指定，则<rnum>默认设置 1。 

<bool>:= ON|OFF|1|0 

返回类型 Boolean (1=ON,0=OFF) 

默认值 OFF 

菜单项 频率 > 频偏... > Sweep Type > Segment > Sweep Properties > Independent 

Sweep Delay 

举例 :SENS:FOM:RANG:SEGM:SWE:DEL:CONT ON 

:SENS:FOM:RANG:SEGM:SWE:DEL:CONT? 

Return: 1 
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3.6.2.27 频偏段扫描表项扫描延时 

命令格式 :SENSe<cnum>:FOM:RANGe<rnum>:SEGMent<segnum>:SWEep:DELay 
<numeric> 

 

:SENSe<cnum>:FOM:RANGe<rnum>:SEGMent<segnum>:SWEep:DELay? 

说明 设置或获取设备频偏段扫描表项扫描延时。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<rnum>:  表示频偏设备编号，如果未指定，则<rnum>默认设置 1。 

<segnum>:  表示段扫描表编号，如果未指定，则<segnum>默认设置 1。 

<numeric>:表示扫描延时。 

返回类型 浮点型，单位 s（秒） 

默认值 无 

菜单项 频率 > 频偏... > Sweep Type > Segment > Sweep Properties > Independent 

Sweep Delay > Delay 

举例 :SENS:FOM:RANG:SEGM:SWE:DEL 5 

:SENS:FOM:RANG:SEGM:SWE:DEL? 

Return: 5 

 

3.6.2.28 频偏段扫描表中频带宽控制 

命令格式 :SENSe<cnum>:FOM:RANGe<rnum>:SEGMent:BWIDth[:RESolution]:CONTrol 
<bool> 

 

:SENSe<cnum>:FOM:RANGe<rnum>:SEGMent:BWIDth[:RESolution]:CONTrol? 

说明 设置或获取设备频偏段扫描表中频带宽控制状态。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<rnum>:  表示频偏设备编号，如果未指定，则<rnum>默认设置 1。 

<bool>:= ON|OFF|1|0 

返回类型 Boolean (1=ON,0=OFF) 

默认值 OFF 

菜单项 频率 > 频偏... > Sweep Type > Segment > Sweep Properties > Independent IF 

Bandwidth 

举例 :SENS:FOM:RANG:SEGM:BWID:CONT ON 

:SENS:FOM:RANG:SEGM:BWID:CONT? 

Return: 1 

 



 

 

3.6.2.29 频偏段扫描表项中频带宽 

命令格式 :SENSe<cnum>:FOM:RANGe<rnum>:SEGMent<segnum>:BWIDth[:RESolution] 
<numeric> 

 

:SENSe<cnum>:FOM:RANGe<rnum>:SEGMent<segnum>:BWIDth[:RESolution]? 

说明 设置或获取设备频偏段扫描表项中频带宽。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<rnum>:  表示频偏设备编号，如果未指定，则<rnum>默认设置 1。 

<segnum>:  表示段扫描表编号，如果未指定，则<segnum>默认设置 1。 

<numeric>:={1|2|3|4|5|6|7|10|15|20|30|40|50|70|100|150|200|300|400|500 

|700|1E3|1.5E3|2E3|3E3|4E3|5E3|7E3|10E3|15E3|20E3|30E3|40E3|50E3 

|70E3|100E3|150E3|200E3|300E3|400E3|500E3|700E3|1E6|1.5E6|2E6 

|3E6|4E6|5E6|7E6|10E6},表示中频带宽。 

返回类型 浮点型，单位 Hz（赫兹） 

默认值 无 

菜单项 频率 > 频偏... > Sweep Type > Segment > Sweep Properties > Independent IF 

Bandwidth > IF Bandwidth 

举例 :SENS:FOM:RANG:SEGM:BWID 1E4 

:SENS:FOM:RANG:SEGM:BWID? 

Return: 10000 

 

3.6.2.30 频偏耦合状态 

命令格式 :SENSe<cnum>:FOM:RANGe<rnum>:COUPled <bool> 

:SENSe<cnum>:FOM:RANGe<rnum>:COUPled? 

说  明 设置或获取设备频偏扫描耦合状态。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<rnum>:  表示频偏设备编号，如果未指定，则<rnum>默认设置 1。 

<bool>:= ON|OFF|1|0 

返回类型 Boolean (1=ON,0=OFF) 

默认值 ON 

菜单项 频率 > 频偏... > Mode > Coupled 

举例 :SENS:FOM:RANG2:COUP OFF 

:SENS:FOM:RANG2:COUP? 

Return: 0 
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3.6.2.31 频偏倍频因子 

命令格式 :SENSe<cnum>:FOM:RANGe<rnum>:FREQuency:MULTiplier <numeric> 

:SENSe<cnum>:FOM:RANGe<rnum>:FREQuency:MULTiplier? 

说  明 设置或获取设备频偏倍频因子。 

<rnum> 频偏设备编号，如果没有指定编号，则默认值为 1。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<rnum>:  表示频偏设备编号，如果未指定，则<rnum>默认设置 1。 

<numeric>:表示频偏倍频因子，其范围为 1~100。 

返回类型 整型 

默认值 1 

菜单项 频率 > 频偏... > Couped > Multiplier 

举例 :SENS:FOM:RANG2:FREQ:MULT 2 

:SENS:FOM:RANG2:FREQ:MULT? 

Return: 2 

 

3.6.2.32 频偏分频因子 

命令格式 :SENSe<cnum>:FOM:RANGe<rnum>:FREQuency:DIVisor <numeric> 

:SENSe<cnum>:FOM:RANGe<rnum>:FREQuency:DIVisor? 

说  明 设置或获取设备频偏分频因子。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<rnum>:  表示频偏设备编号，如果未指定，则<rnum>默认设置 1。 

<numeric>:表示频偏分频因子，其范围为 1~100。 

返回类型 整型 

默认值 1 

菜单项 频率 > 频偏... > Couped > Divisor 

举例 :SENS:FOM:RANG2:FREQ:DIV 2 

:SENS:FOM:RANG2:FREQ:DIV? 

Return: 2 

 

3.6.2.33 频率偏移量 

命令格式 :SENSe<cnum>:FOM:RANGe<rnum>:FREQuency:OFFSet <numeric> 

:SENSe<cnum>:FOM:RANGe<rnum>:FREQuency:OFFSet? 

说  明 设置或获取设备频率偏移量。只有与 Primary耦合时此设置才有效。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 



 

 

<rnum>:  表示频偏设备编号，如果未指定，则<rnum>默认设置 1。 

<numeric>: 表示频率偏移量。 

返回类型 浮点型，单位 Hz（赫兹） 

默认值 0 

菜单项 频率 > 频偏... > Couped > Offset 

举例 :SENS:FOM:RANG2:FREQ:OFFS 1E9 

:SENS:FOM:RANG2:FREQ:OFFS? 

Return: 1000000000 

 

3.7 Math 命令子系统 

3.7.1 内存 

3.7.1.1 命令列表 

数据存入内存 :CALCulate<cnum>:TRACe<tnum>:MATH:MEMorize 

归一化 :CALCulate<cnum>:TRACe<tnum>:MATH:NORMalize 

迹线数学方法 :CALCulate<cnum>:TRACe<tnum>:MATH:FUNCtion 

打开/关闭数据迹线 :DISPlay:WINDow<wnum>:TRACe<tnum>:STATe 

打开/关闭内存迹线 :DISPlay:WINDow<wnum>:TRACe<tnum>:MEMory[:STATe] 

 

 

3.7.1.2 数据存入内存 

命令格式 :CALCulate<cnum>[:SELected]:MATH:MEMorize 

:CALCulate<cnum>:TRACe<tnum>:MATH:MEMorize 

说  明 将工作数据迹线放在内存中，可以针对显示的每条迹线存储一条内存迹线 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

返回类型 无 

默认值 无 

菜单项 数学 > 内存 > 数据 → 内存 

举例 :CALCulate1:MATH:MEMorize 

:CALCulate1:TRACe1:MATH:MEMorize 
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3.7.1.3 归一化 

命令格式 :CALCulate<cnum>[:SELected]:MATH:NORMalize 

:CALCulate<cnum>:TRACe<tnum>:MATH:NORMalize 

说  明 设置迹线数据归一化，相当于执行 Data->Memory和 Data / Memory 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

返回类型 无 

默认值 OFF 

菜单项 数学 > 内存 > 归一化  

举例 :CALCulate1:MATH:NORMalize 

:CALCulate1:TRACe1:MATH:NORMalize 

 

3.7.1.4 迹线数学方法 

命令格式 :CALCulate<cnum>[:SELected]:MATH:FUNCtion <type> 

:CALCulate<cnum>[:SELected]:MATH:FUNCtion? 

:CALCulate<cnum>:TRACe<tnum>:MATH:FUNCtion <type> 

:CALCulate<cnum>:TRACe<tnum>:MATH:FUNCtion? 

说明 设置或获取激活迹线数据运算方法 

设置或获取选择通道及迹线数据运算方法 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

<type>:={NORMal|SUBTract|DIVide|ADD|MULTiply} 

返回类型 枚举 

默认值 无 

菜单项 数学 > 内存 > 数学 

举例 :CALCulate1:MATH:MEMorize 

:CALCulate1:MATH:FUNCtion SUBTract 

:CALCulate1:MATH:FUNCtion? 

Return: SUBT 

 

:CALCulate1:TRACe1:MATH:FUNCtion DIVide 

:CALCulate1:TRACe1:MATH:FUNCtion? 

Return: DIV 

 



 

 

3.7.1.5 打开/关闭数据迹线 

命令格式 :DISPlay:WINDow<wnum>:TRACe<tnum>:STATe <bool> 

:DISPlay:WINDow<wnum>:TRACe<tnum>:STATe? 

说明 设置或查询指定数据迹线的显示状态 

参数 <wnum>:={[1]-36}，表示测量窗口号，如果未指定，则<wnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

<bool>:= ON|OFF|1|0 

返回类型 Boolean (1=ON,0=OFF) 

默认值 无 

菜单项 数学 > 内存 > 显示 > 数据（内存迹线关闭时） 

数学 > 内存 >显示 > 数据&内存（内存迹线打开时） 

举例 :DISPlay:WINDow1:TRACe5:STATe 0 

:DISPlay:WINDow1:TRACe5:STATe? 

Return: 0 

3.7.1.6 打开/关闭内存迹线 

命令格式 :DISPlay:WINDow<wnum>:TRACe<tnum>:MEMory[:STATe] <bool> 

:DISPlay:WINDow<wnum>:TRACe<tnum>:MEMory[:STATe]? 

说明 设置或查询指定内存数据迹线的显示状态 

参数 <wnum>:={[1]-36}，表示测量窗口号，如果未指定，则<wnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

<bool>:= ON|OFF|1|0 

返回类型 Boolean (1=ON,0=OFF) 

默认值 无 

菜单项 数学 > 内存 >显示 > 内存（数据迹线关闭时） 

数学 > 内存 >显示 > 数据&内存（数据迹线打开时） 

举例 :DISPlay:WINDow1:TRACe5:MEMory ON 

:DISPlay:WINDow1:TRACe5:MEMory? 

Return: 1 

 

3.7.2 分析 

3.7.2.1 命令列表 

参数转换开关 :CALCulate<cnum>:TRACe<tnum>:CONVersion[:STATe] 

参数变换 :CALCulate<cnum>:TRACe<tnum>:CONVersion:FUNCtion 
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公式编辑器输入公式 :CALCulate<cnum>:TRACe<tnum>:EQUation:TEXT 

获取公式表达式有效性 :CALCulate<cnum>:TRACe<tnum>:EQUation:VALID? 

公式编辑器状态 :CALCulate<cnum>:TRACe<tnum>:EQUation:STATE 

迹线统计状态 :CALCulate<cnum>:TRACe<tnum>:MSTatistics[:STATe] 

统计数据类型 :CALCulate<cnum>:MEASure<tnum>:FUNCtion:TYPE 

获取统计数据 :CALCulate<cnum>:TRACe<tnum>:MSTatistics:DATA? 

自定义统计跨距状态 :CALCulate<cnum>:MEASure<tnum>:FUNCtion:USER:RANGe:STATe 

自定义统计跨距起始频率 :CALCulate<cnum>:MEASure<tnum>:FUNCtion:USER:RANGe:STARt 

自定义统计跨距终止频率 :CALCulate<cnum>:MEASure<tnum>:FUNCtion:USER:RANGe:STOP 

极限测试状态 :CALCulate<cnum>:TRACe<tnum>:LIMit[:STATe] 

极限线显示状态 :CALCulate<cnum>:TRACe<tnum>:LIMit:DISPlay[:STATe] 

极限测试警报 :CALCulate<cnum>:MEASure<tnum>:LIMit:SOUNd[:STATe] 

极限测试失败点的显示 SYSTem:PREFerences:ITEM:RTOF 

不合格标记显示 :DISPlay:FSIGn 

获取极限测试失败结果 :CALCulate<cnum>:TRACe<tnum>:LIMit:FAIL? 

极限测试极限表 :CALCulate<cnum>:TRACe<tnum>:LIMit:DATA 

获取极限测量结果 :CALCulate<cnum>:TRACe<tnum>:LIMit:REPort:ALL? 

获取极限测试失败点数 :CALCulate<cnum>:TRACe<tnum>:LIMit:REPort:POINts? 

获取极限测试失败数据 :CALCulate<cnum>:TRACe<tnum>:LIMit:REPort[:DATA] 

显示表格类型 :DISPlay:WINDow<wnum>:TABLe 

加载极限测试表 :MMEMory:LOAD:LIMit 

存储极限测试表 :MMEMory:STORE:LIMit 

点极限测试状态 :CALCulate<cnum>:TRACe<tnum>:PLIMit[:STATe] 

点极限线状态 :CALCulate<cnum>:TRACe<tnum>:PLIMit:DISPlay:LINE 

点极限测试提示音状态 :CALCulate<cnum>:MEASure<tnum>:PLIMit:SOUNd 

获取点极限测试结果 :CALCulate<cnum>:TRACe<tnum>:PLIMit:FAIL? 

获取点极限测试报告 :CALCulate<cnum>[:SELected]:PLIMit:REPort[:DATA]? 

设置或获取点极限表 :CALCulate<cnum>[:SELected]:PLIMit:DATA 



 

 

加载点极限测试表 :MMEMory:LOAD:PLIMit 

存储点极限测试表 :MMEMory:STORE:PLIMit 

纹波极限测试开关状态 :CALCulate<cnum>:TRACe<tnum>:RLIMit[:STATe] 

纹波极限线状态 :CALCulate<cnum>:TRACe<tnum>:RLIMit:DISPlay:LINE 

测试失败提示音状态 :CALCulate<cnum>:MEASure<tnum>:RLIMit:SOUNd 

获取纹波极限测试结果 :CALCulate<cnum>:TRACe<tnum>:RLIMit:FAIL? 

设置或获取纹波极限表 :CALCulate<cnum>:TRACe<tnum>:RLIMit:DATA 

获取纹波极限测试结果 :CALCulate<cnum>:TRACe<tnum>:RLIMit:REPort[:DATA]? 

加载纹波测试表 :MMEMory:LOAD:RLIMit 

存储纹波测试表 :MMEMory:STORE:RLIMit 

带宽测试开关 :CALCulate<cnum>:TRACe<tnum>:BLIMit[:STATe] 

带宽测试值显示开关 :CALCulate<cnum>:TRACe<tnum>:BLIMit:DISPlay:VALue 

带宽测试标记显示开关 :CALCulate<cnum>:TRACe<tnum>:BLIMit:DISPlay:MARKer 

带宽测试阀值 :CALCulate<cnum>:TRACe<tnum>:BLIMit:DB 

带宽测试最小值 :CALCulate<cnum>:TRACe<tnum>:BLIMit:MINimum 

带宽测试最大值 :CALCulate<cnum>:TRACe<tnum>:BLIMit:MAXimum 

带宽测试失败显示开关 :CALCulate<cnum>:TRACe<tnum>:BLIMit:FAIL? 

获取带宽测试结果数据 :CALCulate<cnum>:TRACe<tnum>:BLIMit:REPort[:DATA]? 

 

3.7.2.2 参数转换开关 

命令格式 :CALCulate<cnum>[:SELected]:CONVersion[:STATe] <bool> 

:CALCulate<cnum>[:SELected]:CONVersion[:STATe]? 

 

:CALCulate<cnum>:TRACe<tnum>:CONVersion[:STATe] <bool> 

:CALCulate<cnum>:TRACe<tnum>:CONVersion[:STATe]? 

说明 设置或查询所选激活迹线参数变换的开关状态 

设置或查询所选通道及迹线参数变换的开关状态 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

<bool>:= ON|OFF|1|0 

返回类型 布尔型 

默认值 OFF 
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菜单项 数学 > 分析 > 转换 

举例 :CALCulate1:CONVersion:STATe 1 

:CALCulate1:CONVersion:STATe? 

Return: 1 

:CALCulate1:TRACe1:CONVersion:STATe 1 

:CALCulate1:TRACe1:CONVersion:STATe? 

Return: 1 

 

3.7.2.3 参数变换 

命令格式 :CALCulate<cnum>[:SELected]:CONVersion:FUNCtion <type> 

:CALCulate<cnum>[:SELected]:CONVersion:FUNCtion? 

 

:CALCulate<cnum>:TRACe<tnum>:CONVersion:FUNCtion <type> 

:CALCulate<cnum>:TRACe<tnum>:CONVersion:FUNCtion? 

说明 设置或查询所选激活迹线变换后的参数 

设置或查询所选通道及迹线变换后的参数 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

<type>:={ZREFlection|ZTRansmit|YREFlection|YTRansmit|INVersion|ZTSHunt|Y
TSHunt|CONJugation} 

返回类型 枚举 

默认值 ZREFlection 

菜单项 数学 > 分析 > 转换 

举例 :CALCulate1:CONVersion:STATe 1 

:CALCulate1:CONVersion:FUNCtion ZTSHunt 

:CALCulate1:CONVersion:FUNCtion? 

Return: ZTSH 

:CALCulate1:TRACe1:CONVersion:STATe 1 

:CALCulate1:TRACe1:CONVersion:FUNCtion YREFlection 

:CALCulate1:TRACe1:CONVersion:FUNCtion? 

Return: YREF 

 

3.7.2.4 公式编辑器输入公式 

命令格式 :CALCulate<cnum> [:SELected]:EQUation:TEXT <string> 

:CALCulate<cnum> [:SELected]:EQUation:TEXT? 

:CALCulate<cnum>:TRACe<tnum>:EQUation:TEXT <string> 

:CALCulate<cnum>:TRACe<tnum>:EQUation:TEXT? 

说明 设置或获取激活迹线公式编辑器待运算的公式 



 

 

设置或获取选择通道及迹线公式编辑器待运算的公式 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

<string>: 表示公式编辑器待运算的公式。 

返回类型 字符串 

默认值 无 

菜单项 数学 > 分析 > 公式编辑器 

举例 :CALCulate1:EQUation:TEXT ‘S11/S22’ 

:CALCulate1:EQUation:TEXT? 

Return: S11/S22 

 

:CALCulate1:TRACe1:EQUation:TEXT "S11/S22" 

:CALCulate1:TRACe1:EQUation:TEXT? 

Return: S11/S22 

 

3.7.2.5 获取公式表达式有效性 

命令格式 :CALCulate<cnum>[:SELected]:EQUation:VALID? 

:CALCulate<cnum>:TRACe<tnum>:EQUation:VALID? 

说明 获取激活迹线输入公式表达式结果的有效性 

获取所选通道及迹线输入公式表达式结果的有效性 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

返回类型 布尔型 

1：有效 

0：无效 

默认值 OFF 

菜单项 数学 > 分析 > 公式编辑器 

举例 :CALCulate1:EQUation:VALID? 

:CALCulate1:TRACe1:EQUation:VALID? 

 

3.7.2.6 公式编辑器状态 

命令格式 :CALCulate<cnum> [:SELected]:EQUation:STATE <bool> 

:CALCulate<cnum> [:SELected]:EQUation:STATE? 

:CALCulate<cnum>:TRACe<tnum>:EQUation:STATE <bool> 

:CALCulate<cnum>:TRACe<tnum>:EQUation:STATE? 
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说明 设置或获取激活迹线公式编辑器状态 

设置或获取选择通道及迹线公式编辑器状态 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

<bool>:= ON|OFF|1|0 

返回类型 Boolean (1=ON,0=OFF) 

默认值 OFF 

菜单项 数学 > 分析 > 公式编辑器 

举例 :CALCulate1:EQUation:TEXT ‘S11/S22’ 

:CALCulate1:EQUation:STATE ON 

:CALCulate1:EQUation:STATE? 

Return: 1 

:CALCulate1:TRACe1:EQUation:STATE ON 

:CALCulate1:TRACe1:EQUation:STATE? 

Return: 1 

 

3.7.2.7 迹线统计状态 

命令格式 :CALCulate<cnum>[:SELected]:MSTatistics[:STATe] <bool> 

:CALCulate<cnum>[:SELected]:MSTatistics[:STATe]? 

:CALCulate<cnum>:TRACe<tnum>:MSTatistics[:STATe] <bool> 

:CALCulate<cnum>:TRACe<tnum>:MSTatistics[:STATe]? 

说明 设置或获取激活迹线统计数据（极限均值、标准差及峰峰值）的状态 

设置或获取选择通道及迹线的统计数据（极限均值、标准差及峰峰值）的状态 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

<bool>:= ON|OFF|1|0 

返回类型 Boolean (1=ON,0=OFF) 

默认值 OFF 

菜单项 数学 > 分析 > 统计数据 

举例 :CALCulate1:MSTatistics:STATe 1 

:CALCulate1:MSTatistics:STATe? 

Return: 1 

 

:CALCulate1:TRACe1:MSTatistics:STATe 0 

:CALCulate1:TRACe1:MSTatistics:STATe? 

Return: 0 



 

 

3.7.2.8 统计数据类型 

命令格式 :CALCulate<cnum>:MEASure<tnum>:FUNCtion:TYPE <type> 

:CALCulate<cnum>:MEASure<tnum>:FUNCtion:TYPE? 

说明 设置或获取统计数据的类型 

参数 

<cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

<type>:={PTPeak|STDEV|MEAN} 

返回类型 枚举 

默认值 PTPeak 

菜单项 无 

举例 :CALCulate1:MEASure1:FUNCtion:TYPE MEAN 

:CALCulate1:MEASure1:FUNCtion:TYPE? 

Return: MEAN 

 

3.7.2.9 获取统计数据 

命令格式 :CALCulate<cnum>[:SELected]:MSTatistics:DATA? 

:CALCulate<cnum>:TRACe<tnum>:MSTatistics:DATA? 

说明 设置或获取激活迹线的统计数据 

设置或获取选择通道及迹线的统计数据 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

返回类型 无 

默认值 无 

菜单项 无 

举例 :CALCulate1:TRACe1:MSTatistics:STATe 1 

:CALCulate1:MEASure1:FUNCtion:TYPE MEAN 

:CALCulate1:TRACe1:MSTatistics:DATA? 

:CALCulate1:MSTatistics:DATA? 

 

3.7.2.10 自定义统计跨距状态 

命令格式 :CALCulate<cnum>:MEASure<tnum>:FUNCtion:USER:RANGe:STATe <bool> 

:CALCulate<cnum>:MEASure<tnum>:FUNCtion:USER:RANGe:STATe? 

说明 设置或获取统计范围中用户自定义统计跨距的状态 

参数 
<cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 
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<bool>:= ON|OFF|1|0 

返回类型 Boolean (1=ON,0=OFF) 

默认值 OFF 

菜单项 数学 > 分析 > 统计范围… > User Span 

举例 :CALCulate1:MEASure1:FUNCtion:USER:RANGe:STATe 1 

:CALCulate1:MEASure1:FUNCtion:USER:RANGe:STATe? 

Return: 1 

 

3.7.2.11 自定义统计跨距起始频率 

命令格式 :CALCulate<cnum>:MEASure<tnum>:FUNCtion:USER:RANGe:STARt 
<numeric> 

:CALCulate<cnum>:MEASure<tnum>:FUNCtion:USER:RANGe:STARt?  

说明 设置或获取统计范围中用户自定义统计跨距的起始频率 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

<numeric>:表示起始频率。 

返回类型 浮点型，单位 Hz（赫兹） 

默认值 矢量网络分析仪的最小频率 

菜单项 数学 > 分析 > 统计范围… > User Span > Start 

举例 :CALCulate1:MEASure1:FUNCtion:USER:RANGe:STARt 10000 

:CALCulate1:MEASure1:FUNCtion:USER:RANGe:STARt? 

Return: 10000 

 

3.7.2.12 自定义统计跨距终止频率 

命令格式 :CALCulate<cnum>:MEASure<tnum>:FUNCtion:USER:RANGe:STOP 
<numeric> 

:CALCulate<cnum>:MEASure<tnum>:FUNCtion:USER:RANGe:STOP?  

说明 设置或获取统计范围中用户自定义统计跨距的终止频率 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

<numeric>:表示终止频率。 

返回类型 浮点型，单位 Hz（赫兹） 

默认值 矢量网络分析仪的最大频率 

菜单项 数学 > 分析 > 统计范围… > User Span > Stop 



 

 

举例 :CALCulate1:MEASure1:FUNCtion:USER:RANGe:STOP 10000 

:CALCulate1:MEASure1:FUNCtion:USER:RANGe:STOP? 

Return: 10000 

 

3.7.2.13 极限测试状态 

命令格式 :CALCulate<cnum>[:SELected]:LIMit[:STATe] <bool> 

:CALCulate<cnum>[:SELected]:LIMit[:STATe]? 

:CALCulate<cnum>:TRACe<tnum>:LIMit[:STATe] <bool> 

:CALCulate<cnum>:TRACe<tnum>:LIMit[:STATe]? 

说明 设置或获取激活迹线极限测试功能状态 

设置或获取所选通道及迹线极限测试功能状态 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

<bool>:= ON|OFF|1|0 

返回类型 Boolean (1=ON,0=OFF) 

默认值 OFF 

菜单项 数学 > 分析 > 极限… > Limit Test ON 

举例 :CALCulate1:LIMit ON 

:CALCulate1:LIMit? 

Return: 1 

 

:CALCulate1:TRACe1:LIMit OFF 

:CALCulate1:TRACe1:LIMit? 

Return: 0 

 

3.7.2.14 极限线显示状态 

命令格式 :CALCulate<cnum>[:SELected]:LIMit:DISPlay[:STATe] <bool> 

:CALCulate<cnum>[:SELected]:LIMit:DISPlay[:STATe]? 

:CALCulate<cnum>:TRACe<tnum>:LIMit:DISPlay[:STATe] <bool> 

:CALCulate<cnum>:TRACe<tnum>:LIMit:DISPlay[:STATe]? 

说明 设置或获取激活迹线极限线开启或关闭的状态 

设置或获取所选通道及迹线极限线开启或关闭的状态 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

<bool>:= ON|OFF|1|0 

返回类型 Boolean (1=ON,0=OFF) 

默认值 OFF 
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菜单项 数学 > 分析 > 极限… > Limit Line ON 

举例 :CALCulate1:LIMit:DISPlay ON 

:CALCulate1:LIMit:DISPlay? 

Return: 1 

 

:CALCulate1:TRACe1:LIMit:DISPlay OFF 

:CALCulate1:TRACe1:LIMit:DISPlay? 

Return: 0 

 

3.7.2.15 极限测试警报 

命令格式 :CALCulate<cnum>:MEASure<tnum>:LIMit:SOUNd[:STATe] <bool> 

:CALCulate<cnum>:MEASure<tnum>:LIMit:SOUNd[:STATe]? 

说明 设置或获取激活迹线测试失败警告开关的状态 

设置或获取所选通道及迹线测试失败警告开关的状态开启时，当数据迹线上的点在

极限测试中失败时，VNA 将发出蜂鸣声 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

<bool>:= ON|OFF|1|0 

返回类型 Boolean (1=ON,0=OFF) 

默认值 OFF 

菜单项 数学 > 分析 > 极限… > Test Sound ON 

举例 :CALCulate1:MEASure:LIMit:SOUNd ON 

:CALCulate1:MEASure:LIMit:SOUNd? 

Return: 1 

 

3.7.2.16 极限测试失败点的显示 

命令格式 SYSTem:PREFerences:ITEM:RTOF <bool> 

SYSTem:PREFerences:ITEM:RTOF? 

说明 设置或查询极限测试失败点的显示方式。 

参数 <bool>:= ON|OFF|1|0 

On：表示将失败点显示为线显； 

OFF：表示将失败点显示为点显。 

返回类型 Boolean (1=ON,0=OFF) 

默认值 1 

菜单项 数学 > 分析 > 极限… > Display 



 

 

举例 SYSTem:PREFerences:ITEM:RTOF 0 

SYSTem:PREFerences:ITEM:RTOF? 

Return :0 

 

3.7.2.17 不合格标记显示 

命令格式 :DISPlay:FSIGn <bool> 

:DISPlay:FSIGn? 

说  明 设置或获取全局显示测试结果的状态 

参数 <bool>:= ON|OFF|1|0 

返回类型 Boolean (1=ON,0=OFF) 

默认值 OFF 

菜单项 数学 > 分析 > 极限… > Global Pass/Fail ON 

举例 :DISPlay:FSIGn 1 

:DISPlay:FSIGn? 

Return: 1 

 

3.7.2.18 获取极限测试失败结果 

命令格式 :CALCulate<cnum>[:SELected]:LIMit:FAIL? 

:CALCulate<cnum>:TRACe<tnum>:LIMit:FAIL? 

说明 获取激活迹线极限测试结果 

获取所选通道及迹线极限测试结果 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

返回类型 布尔型 

1：失败 

0：通过 

默认值 无 

菜单项 无 

举例 :CALCulate1:LIMit:FAIL? 

:CALCulate1:TRACe1:LIMit:FAIL? 

 

3.7.2.19 极限测试极限表 

命令格式 :CALCulate<cnum>[:SELected]:LIMit:DATA <numeric 1>, ... ,<numeric 1+(N*5)> 

:CALCulate<cnum>[:SELected]:LIMit:DATA? 

:CALCulate<cnum>:TRACe<tnum>:LIMit:DATA <numeric 1>, ... ,<numeric 
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1+(N*5)> 

:CALCulate<cnum>:TRACe<tnum>:LIMit:DATA? 

说明 设置或获取激活迹线极限测试的极限表 

设置或获取所选通道及迹线极限测试的极限表 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

<numeric 1>, ... ,<numeric 1+(N*5)>:表示 1 + Num（极限线条数）*5的数组数据

（针对极限线）。n是 1到 Num 之间的整数。 

数据（0）：要设置的极限线条数。指定整数范围为 0 到 100。当极限线条数设置为

0（清除极限表）时，仅数据（0）需要变量数据。 

数据（n*5-4）：第 n条线的类型。 

指定 0至 2的整数，如下所示。 

0:关闭 

1:上限线 

2:下限线 

数据（n*5-3）：第 n条线起点的水平轴（频率/功率/时间）上的值。 

数据（n*5-2）：第 n条线终点的水平轴（频率/功率/时间）上的值。 

数据（n*5-1）：第 n条线起点的垂直轴上的值。 

数据（n*5）：第 n条线终点的垂直轴上的值。 

数组索引从 0开始 

返回类型 数据数组 

默认值 无 

菜单项 数学 > 分析 > 极限表 

举例 :CALCulate1:LIMit:DATA 2,1,1E9,3E9,0,0,2,1E9,3E9,-3,-3 

:CALCulate1:LIMit:DATA? 

Return: 2,1,1000000000,3000000000,0,0,2,1000000000,3000000000,-3,-3 

 

:CALCulate1:TRACe1:LIMit:DATA 2,2,2E9,3E9,-3,0,1,2E9,3E9,-5,-3 

:CALCulate1:TRACe1:LIMit:DATA? 

Return: 2,2,2000000000,3000000000,-3,0,1,2000000000,3000000000,-5,-3 

 

3.7.2.20 获取极限测量结果 

命令格式 :CALCulate<cnum>[:SELected]:LIMit:REPort:ALL? 

:CALCulate<cnum>:TRACe<tnum>:LIMit:REPort:ALL? 

说明 获取激活迹线极限测试的极限测量结果 



 

 

设置或获取所选通道及迹线极限测试测量结果 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

返回类型 数据数组 

 

表示 NOP（测量点个数）x4 的数组数据（极限线）。n为 1到 NOP 之间的整数。 

数据（nx4-3）测量点的激励值。 

数据（nx4-2）极限测试结果。 

指定-1到 1的整数，如下所示。 

-1:无限制 

0:失败 

1:成功 

数据（nx4-1）测量点的上限值。（如果此测量点没有限制，读出 0） 

数据（nx4）测量点的下限值。（如果此测量点没有限制，读出 0） 

数组索引从 0开始。 

默认值 无 

菜单项 无 

举例 :CALCulate1:LIMit:REPort:ALL? 

:CALCulate1:TRACe1:LIMit:REPort:ALL? 

 

3.7.2.21 获取极限测试失败点数 

命令格式 :CALCulate<cnum>[:SELected]:LIMit:REPort:POINts? 

:CALCulate<cnum>:TRACe<tnum>:LIMit:REPort:POINts? 

说明 获取激活迹线极限测试失败的所有测量点的个数 

获取所选通道及迹线极限测试失败的所有测量点的个数 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

返回类型 整型 

默认值 无 

菜单项 无 

举例 :CALCulate1:LIMit:REPort:POINts? 

:CALCulate1:TRACe1:LIMit:REPort:POINts? 
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3.7.2.22 获取极限测试失败数据 

命令格式 :CALCulate<cnum>[:SELected]:LIMit:REPort[:DATA]? 

:CALCulate<cnum>:TRACe<tnum>:LIMit:REPort[:DATA]? 

说明 获取激活迹线极限测试失败的所有测量点的激励值（频率、功率电平或时间） 

获取所选通道及迹线极限测试失败的所有测量点的激励值（频率、功率电平或时

间） 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

返回类型 数据数组， 

表示失败测量的点的数组数据 

默认值 无 

菜单项 无 

举例 :CALCulate1:LIMit:REPort? 

:CALCulate1:TRACe1:LIMit:REPort? 

 

3.7.2.23 显示表格类型 

命令格式 :DISPlay:WINDow<wnum>:TABLe <type> 

:DISPlay:WINDow<wnum>:TABLe? 

说  明 设置选择窗口的出现在窗口下端的窗口类型。 

参数 <wnum>:={[1]-36}，表示测量窗口号，如果未指定，则<wnum>默认设置 1。 

<type>:={MARKer|LIMit|SEGMent|RLIMit|PLIMit|OFF} 

返回类型 枚举 

默认值 OFF 

菜单项 光标 > 光标设置 > 光标表格 

数学 > 分析 > 极限表 > 极限 

数学 > 分析 > 极限表 > 纹波 

数学 > 分析 > 极限表 > 点极限 

扫描 > 段扫描表 > 显示表格 

举例 :DISPlay:WINDow2:TABLe RLIMit 

:DISPlay:WINDow2:TABLe? 

Return: RLIM 

 



 

 

3.7.2.24 加载极限测试表 

命令格式 :MMEMory:LOAD:LIMit <string> 

说明 将指定的极限表格文件加载到活动迹线的极限测试表中 

参数 <string>:表示极限表格文件，其范围是少于 255个字符。 

返回类型 无 

默认值 无 

菜单项 数学 > 分析 > 极限… > Load Table 

举例 :MMEMory:LOAD:LIMit "local/test.csv" 

 

3.7.2.25 存储极限测试表 

命令格式 :MMEMory:STORE:LIMit <string> 

说明 将活动迹线的极限测试表存储到指定的 csv 文件中。如果已经存在与指定文件名相

同的文件，则会重写其内容。 

参数 <string>:表示极限表格文件，其范围是少于 255个字符。 

返回类型 无 

默认值 无 

菜单项 数学 > 分析 > 极限… > Save Table 

举例 :MMEMory:STORE:LIMit "local/test.csv" 

 

3.7.2.26 点极限测试状态 

命令格式 :CALCulate<cnum>[:SELected]:PLIMit[:STATe] <bool> 

:CALCulate<cnum>[:SELected]:PLIMit[:STATe]? 

:CALCulate<cnum>:TRACe<tnum>:PLIMit[:STATe] <bool> 

:CALCulate<cnum>:TRACe<tnum>:PLIMit[:STATe]? 

说明 设置激活迹线点极限测试开关状态 

设置所选通道及迹线点极限测试开关状态 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

<bool>:= ON|OFF|1|0 

返回类型 Boolean (1=ON,0=OFF) 

默认值 OFF 
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菜单项 数学 > 分析 > 极限… > Point Limit 

举例 :CALCulate1:PLIMit ON 

:CALCulate1:PLIMit? 

Return: 1 

:CALCulate1:TRACe1:PLIMit OFF 

:CALCulate1:TRACe1:PLIMit? 

Return: 0 

 

3.7.2.27 点极限线状态 

命令格式 :CALCulate<cnum>[:SELected]:PLIMit:DISPlay:LINE <bool> 

:CALCulate<cnum>[:SELected]:PLIMit:DISPlay:LINE? 

:CALCulate<cnum>:TRACe<tnum>:PLIMit:DISPlay:LINE <bool> 

:CALCulate<cnum>:TRACe<tnum>:PLIMit:DISPlay:LINE? 

说明 设置和查询迹线点极限测试线状态 

设置和查询所选通道及迹线点极限测试线状态 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

<bool>:= ON|OFF|1|0 

返回类型 Boolean (1=ON,0=OFF) 

默认值 OFF 

菜单项 数学 > 分析 > 极限… > Point Limit 

举例 :CALCulate1:PLIMit:DISPlay:LINE ON 

:CALCulate1:PLIMit:DISPlay:LINE? 

Return: 1 

:CALCulate1:TRACe1:PLIMit:DISPlay:LINE OFF 

:CALCulate1:TRACe1:PLIMit:DISPlay:LINE? 

Return: 0 

 

3.7.2.28 点极限测试提示音状态 

命令格式 :CALCulate<cnum>:MEASure<tnum>:PLIMit:SOUNd <bool> 

:CALCulate<cnum>:MEASure<tnum>:PLIMit:SOUNd? 

说明 设置和查询点极限测试失败提示音的状态 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

<bool>:= ON|OFF|1|0 

返回类型 Boolean (1=ON,0=OFF) 



 

 

默认值 OFF 

菜单项 数学 > 分析 > 极限… > Point Limit 

举例 :CALCulate1:MEASure1:PLIMit:SOUNd ON 

:CALCulate1:MEASure1:PLIMit:SOUNd? 

Return: 1 

 

3.7.2.29 获取点极限测试结果 

命令格式 :CALCulate<cnum>[:SELected]:PLIMit:FAIL? 

:CALCulate<cnum>:TRACe<tnum>:PLIMit:FAIL? 

说明 获取点极限测试结果 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

返回类型 布尔型 

1：失败 

0：通过 

默认值 无 

菜单项 无 

举例 :CALCulate1:PLIMit:FAIL? 

:CALCulate1:TRACe1:PLIMit:FAIL? 

 

3.7.2.30 获取点极限测试结果报告 

命令格式 :CALCulate<cnum>[:SELected]:PLIMit:REPort[:DATA]? 

:CALCulate<cnum>:TRACe<tnum>:PLIMit:REPort[:DATA]? 

说明 获取每一个有效点极限的测试结果 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

返回值 表示 1 + Num（有效点极限个数）* 2 的数组数据。首个数据为有效极限的个数。

随后两个数据中的前一个为极限下标，后一个为极限测试结果。 

返回每个测试点的结果: 

({有效极限个数},1,结果(通过:0 失败:1),2,结果,,,,{点 no},结果 

默认值 0 

菜单项 数学 > 分析 > 极限… > Point Limit 

举例 :CALCulate1:PLIMit:REPort? 

:CALCulate1:TRACe1:PLIMit:REPort? 
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3.7.2.31 设置或获取点极限表 

命令格式 :CALCulate<cnum>[:SELected]:PLIMit:DATA <string> 

:CALCulate<cnum>[:SELected]:PLIMit:DATA? 

:CALCulate<cnum>:TRACe<tnum>:PLIMit:DATA <string> 

:CALCulate<cnum>:TRACe<tnum>:PLIMit:DATA? 

说明 设置或获取点极限测试表数据 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

<string>:当前迹线的点极限测试表。 

返回每个点的测试点的信息，如下所示： 

{极限数},{点 1状态(0：未使用 1：开启 2：关闭)},{点 1激励},{点 1 下限},{点 1 上

限},,,,{点 n 状态},{点 n激励},{点 n下限},{点 n上限} 

返回类型 数据数组 

默认值 无 

菜单项 数学 > 分析 > 极限… > Point Limit 

举例 :CALC1:PLIM:DATA 2,1,1E9,-2,3,1,4E9,2,5 

:CALC1:PLIM:DATA? 

Return: 2,1,1000000000,-2,3,1,4000000000,2,5 

 

:CALCulate1:TRACe1:PLIMit:DATA 2,1,1E9,-2,3,0,4E9,-5,-3 

:CALCulate1:TRACe1:PLIMit:DATA? 

Return: 2,1,1000000000,-2,3,0,4000000000,-5,-3 

 

3.7.2.32 加载点极限测试表 

命令格式 :MMEMory:LOAD:PLIMit <string> 

说明 将指定的点极限测试表格文件加载到活动迹线的点极限测试表中 

参数 <string>:表示点极限表格文件，其范围是少于 255个字符。 

返回类型 无 

默认值 无 

菜单项 数学 > 分析 > 极限… > Point Limit > Load Table 

举例 :MMEMory:LOAD:PLIMit "local/test.csv" 

 



 

 

3.7.2.33 存储点极限测试表 

命令格式 :MMEMory:STORE:PLIMit <string> 

说明 将活动迹线的点极限测试表存储到指定的 csv 文件中。如果已经存在与指定文件名

相同的文件，则会重写其内容。 

参数 <string>:表示点极限表格文件，其范围是少于 255个字符。 

返回类型 无 

默认值 无 

菜单项 数学 > 分析 > 极限… > Point Limit > Save Table 

举例 :MMEMory:STORE:PLIMit "local/test.csv" 

 

3.7.2.34 纹波极限测试开关状态 

命令格式 :CALCulate<cnum>[:SELected]:RLIMit[:STATe] <bool> 

:CALCulate<cnum>[:SELected]:RLIMit[:STATe]? 

:CALCulate<cnum>:TRACe<tnum>:RLIMit[:STATe] <bool> 

:CALCulate<cnum>:TRACe<tnum>:RLIMit[:STATe]? 

说明 设置激活迹线纹波极限测试开关状态 

设置所选通道及迹线纹波极限测试开关状态 

参数 

<cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

<bool>:= ON|OFF|1|0 

返回类型 Boolean (1=ON,0=OFF) 

默认值 OFF 

菜单项 数学 > 分析 > 极限… > Ripple 

举例 :CALCulate1:RLIMit ON 

:CALCulate1:RLIMit? 

Return: 1 

 

:CALCulate1:TRACe1:RLIMit OFF 

:CALCulate1:TRACe1:RLIMit? 

Return: 0 

 

3.7.2.35 纹波极限线状态 

命令格式 :CALCulate<cnum>[:SELected]:RLIMit:DISPlay:LINE <bool> 

:CALCulate<cnum>[:SELected]:RLIMit:DISPlay:LINE? 

:CALCulate<cnum>:TRACe<tnum>:RLIMit:DISPlay:LINE <bool> 

:CALCulate<cnum>:TRACe<tnum>:RLIMit:DISPlay:LINE? 
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说明 设置激活迹线纹波极限测试纹波极限线状态 

设置所选通道及迹线纹波极限测试纹波极限线状态 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

<bool>:= ON|OFF|1|0 

返回类型 Boolean (1=ON,0=OFF) 

默认值 OFF 

菜单项 数学 > 分析 > 极限… > Ripple 

举例 :CALCulate1:RLIMit:DISPlay:LINE ON 

:CALCulate1:RLIMit:DISPlay:LINE? 

Return: 1 

 

:CALCulate1:TRACe1:RLIMit:DISPlay:LINE OFF 

:CALCulate1:TRACe1:RLIMit:DISPlay:LINE? 

Return: 0 

 

3.7.2.36 测试失败提示音状态 

命令格式 :CALCulate<cnum>:MEASure<tnum>:RLIMit:SOUNd <bool> 

:CALCulate<cnum>:MEASure<tnum>:RLIMit:SOUNd? 

说明 设置和查询所选通道及迹线纹波极限测试提示音的状态 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

<bool>:= ON|OFF|1|0 

返回类型 Boolean (1=ON,0=OFF) 

默认值 OFF 

菜单项 数学 > 分析 > 极限… > Ripple 

举例 :CALCulate1:MEASure1:RLIMit:SOUNd ON 

:CALCulate1:MEASure1:RLIMit:SOUNd? 

Return: 1 

 

3.7.2.37 获取纹波极限测试结果 

命令格式 :CALCulate<cnum>[:SELected]:RLIMit:FAIL? 

:CALCulate<cnum>:TRACe<tnum>:RLIMit:FAIL? 

说明 获取纹波极限测试结果数据 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 



 

 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

返回类型 布尔型 

1：失败 

0：通过 

默认值 无 

菜单项 无 

举例 :CALCulate1:RLIMit:FAIL? 

:CALCulate1:TRACe1:RLIMit:FAIL? 

 

3.7.2.38 设置或获取纹波极限表 

命令格式 :CALCulate<cnum>[:SELected]:RLIMit:DATA <string> 

:CALCulate<cnum>[:SELected]:RLIMit:DATA? 

:CALCulate<cnum>:TRACe<tnum>:RLIMit:DATA <string> 

:CALCulate<cnum>:TRACe<tnum>:RLIMit:DATA? 

说明 设置或获取纹波测试极限表数据 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

<string>:表示 1 + Num（迹线线条数）\ 4 的数组数据（波动线）。此处 n 为 1 到

Num 之间的整数。 

数据（0）：想设置的极限线条数。指定 0 到 12 的整数范围。当极限线条数设置为

0（清除极限表）时，仅数据（0）需要变量数据。 

数据（nx4-3）：第 n条线的类型。 

指定 0到 2的整数，如下所示： 

0：未使用 

1：开启 

2：关闭 

数据（nx4-2）：第 n条线起点水平轴（频率/功率/时间）上的值。  

数据（nx4-1）：第 n条线终点水平轴（频率/功率/时间）上的值。 

数据（nx4）：第 n条线波动线的值（dB）。 

数组索引从 0开始。 

返回类型 数据数组 

默认值 无 

菜单项 数学 > 分析 > 极限… > Ripple 
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举例 :CALC1:RLIM:DATA 2,1,1E9,3E9,3,1,5E9,7E9,3 

:CALC1:RLIM:DATA? 

Return: 2,1,1000000000,3000000000,3,1,5000000000,7000000000,3 

 

:CALCulate1:TRACe1:RLIMit:DATA 2,1,1E9,2E9,3,0,5E9,6E9,-3 

:CALCulate1:TRACe1:RLIMit:DATA? 

Return: 2,1,1000000000,2000000000,3,0,5000000000,6000000000,-3 

 

3.7.2.39 获取纹波极限测试结果 

命令格式 :CALCulate<cnum>[:SELected]:RLIMit:REPort[:DATA]? 

:CALCulate<cnum>:TRACe<tnum>:RLIMit:REPort[:DATA]? 

说明 获取纹波极限测试结果 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

返回类型 表示 1 + Num（极限线条数）\ 3 的数组数据（波动线）。此处 n 为 1到 12之间的

整数。 

 

数据（0）：波动极限线条数。 

数据（nx3-2）：波动极限带的数量。 

数据（nx3-1）：波动值。 

数据（nx3）：波动测试结果。 

从下列各项中选择。 

0:成功  

1:失败 

 

数组索引从 0开始。 

默认值 0 

菜单项 数学 > 分析 > 极限… > Ripple 

举例 :CALCulate1:RLIMit:REPort? 

:CALCulate1:TRACe1:RLIMit:REPort? 

 

3.7.2.40 加载纹波测试表 

命令格式 :MMEMory:LOAD:RLIMit <string> 

说明 将指定的纹波测试表格文件加载到活动迹线的纹波测试表中 

参数 <string>:表示纹波测试表格文件，其范围是少于 255 个字符。 



 

 

返回类型 无 

默认值 无 

菜单项 数学 > 分析 > 极限… > Ripple > Load Table 

举例 :MMEMory:LOAD:RLIMit "local/test.csv" 

 

3.7.2.41 存储纹波测试表 

命令格式 :MMEMory:STORE:RLIMit <string> 

说明 将活动迹线的纹波测试表存储到指定的 csv 文件中。如果已经存在与指定文件名相

同的文件，则会重写其内容。 

参数 <string>:表示纹波测试表格文件，其范围是少于 255 个字符。 

返回类型 无 

默认值 无 

菜单项 数学 > 分析 > 极限… > Ripple > Save Table 

举例 :MMEMory:STORE:RLIMit "local/test.csv" 

 

3.7.2.42 带宽测试开关 

命令格式 :CALCulate<cnum>[:SELected]:BLIMit[:STATe] <bool> 

:CALCulate<cnum>[:SELected]:BLIMit[:STATe]? 

:CALCulate<cnum>:TRACe<tnum>:BLIMit[:STATe] <bool> 

:CALCulate<cnum>:TRACe<tnum>:BLIMit[:STATe]? 

说明 设置或获取选择通道激活迹线带宽极限测试的开启或关闭状态 

设置或获取选择通道及迹线带宽极限测试的开启或关闭状态 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

<bool>:= ON|OFF|1|0 

返回类型 Boolean (1=ON,0=OFF) 

默认值 OFF 

菜单项 数学 > 分析 > 极限… > 带宽测试 

举例 :CALCulate1:BLIMit ON 

:CALCulate1:BLIMit? 

Return: 1 

:CALCulate1:TRACe1:BLIMit ON 

:CALCulate1:TRACe1:BLIMit? 
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Return: 1 

 

3.7.2.43 带宽测试值显示开关 

命令格式 :CALCulate<cnum>[:SELected]:BLIMit:DISPlay:VALue <bool> 

:CALCulate<cnum>[:SELected]:BLIMit:DISPlay:VALue? 

:CALCulate<cnum>:TRACe<tnum>:BLIMit:DISPlay:VALue <bool> 

:CALCulate<cnum>:TRACe<tnum>:BLIMit:DISPlay:VALue?  

说明 设置或获取选择通道激活迹线带宽极限测试值的开启或关闭状态 

设置或获取选择通道及迹线带宽极限测试值的开启或关闭状态 

参数 

<cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

<bool>:= ON|OFF|1|0 

返回类型 Boolean (1=ON,0=OFF) 

默认值 OFF 

菜单项 无 

举例 :CALCulate1:BLIMit:DISPlay:VALue ON 

:CALCulate1:BLIMit:DISPlay:VALue? 

Return: 1 

:CALCulate1:TRACe1:BLIMit:DISPlay:VALue ON 

:CALCulate1:TRACe1:BLIMit:DISPlay:VALue? 

Return: 1 

 

3.7.2.44 带宽测试标记显示开关 

命令格式 :CALCulate<cnum>[:SELected]:BLIMit:DISPlay:MARKer <bool> 

:CALCulate<cnum>[:SELected]:BLIMit:DISPlay:MARKer? 

:CALCulate<cnum>:TRACe<tnum>:BLIMit:DISPlay:MARKer <bool> 

:CALCulate<cnum>:TRACe<tnum>:BLIMit:DISPlay:MARKer?  

说明 设置或获取选择通道激活迹线带宽极限测试标记显示的开启或关闭状态 

设置或获取选择通道及迹线带宽极限测试标记显示的开启或关闭状态 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

<bool>:= ON|OFF|1|0 

返回类型 Boolean (1=ON,0=OFF) 

默认值 OFF 

菜单项 数学 > 分析 > 极限… > 带宽测试 > 标记显示设置 



 

 

举例 :CALCulate1:BLIMit:DISPlay:MARKer ON 

:CALCulate1:BLIMit:DISPlay:MARKer? 

Return: 1 

:CALCulate1:TRACe1:BLIMit:DISPlay:MARKer ON 

:CALCulate1:TRACe1:BLIMit:DISPlay:MARKer? 

Return: 1 

 

3.7.2.45 带宽测试阀值 

命令格式 :CALCulate<cnum>[:SELected]:BLIMit:DB <numeric> 

:CALCulate<cnum>[:SELected]:BLIMit:DB?  

:CALCulate<cnum>:TRACe<tnum>:BLIMit:DB <numeric> 

:CALCulate<cnum>:TRACe<tnum>:BLIMit:DB? 

说明 设置或获取选择通道激活迹线带宽极限测试阀值 

设置或获取选择通道及迹线带宽极限测试阀值 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

<numeric>:表示带宽极限测试阀值，其范围是 0~500MdB。 

返回类型 浮点型 

默认值 3 

菜单项 数学 > 分析 > 极限… > 带宽测试 > N dB Points 

举例 :CALCulate1:BLIMit:DB 6 

:CALCulate1:BLIMit:DB? 

Return: 6 

:CALCulate1:TRACe1:BLIMit:DB 6 

:CALCulate1:TRACe1:BLIMit:DB? 

Return: 6 

 

3.7.2.46 带宽测试最小值 

命令格式 :CALCulate<cnum>[:SELected]:BLIMit:MINimum <numeric> 

:CALCulate<cnum>[:SELected]:BLIMit:MINimum?  

:CALCulate<cnum>:TRACe<tnum>:BLIMit:MINimum <numeric> 

:CALCulate<cnum>:TRACe<tnum>:BLIMit:MINimum? 

说明 设置或获取选择通道激活迹线带宽极限测试最小带宽值 

设置或获取选择通道及迹线带宽极限测试最小带宽值 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

<numeric>:表示带宽值。 
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返回类型 浮点型 

默认值 无 

菜单项 数学 > 分析 > 极限… > 带宽测试 > Min Bandwidth 

举例 :CALCulate1:BLIMit:MINimum 2000000 

:CALCulate1:BLIMit:MINimum? 

Return: 2000000 

:CALCulate1:TRACe1:BLIMit:MINimum 1000000 

:CALCulate1:TRACe1:BLIMit:MINimum? 

Return: 1000000 

 

3.7.2.47 带宽测试最大值 

命令格式 :CALCulate<cnum>[:SELected]:BLIMit:MAXimum <numeric> 

:CALCulate<cnum>[:SELected]:BLIMit:MAXimum?  

:CALCulate<cnum>:TRACe<tnum>:BLIMit:MAXimum <numeric> 

:CALCulate<cnum>:TRACe<tnum>:BLIMit:MAXimum? 

说明 设置或获取选择通道激活迹线带宽极限测试最大带宽值 

设置或获取选择通道及迹线带宽极限测试最大带宽值 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

<numeric>:表示带宽值。 

返回类型 浮点型 

默认值 300kHz 

菜单项 数学 > 分析 > 极限… > 带宽测试 > Max Bandwidth 

举例 :CALCulate1:BLIMit:MAXimum 3500000 

:CALCulate1:BLIMit:MAXimum? 

Return: 3500000 

:CALCulate1:TRACe1:BLIMit:MAXimum 4000000 

:CALCulate1:TRACe1:BLIMit:MAXimum? 

Return: 4000000 

 

3.7.2.48 带宽测试失败显示开关 

命令格式 :CALCulate<cnum>[:SELected]:BLIMit:FAIL? 

:CALCulate<cnum>:TRACe<tnum>:BLIMit:FAIL? 

说明 设置或获取选择通道激活迹线带宽极限测试结果 

设置或获取选择通道及迹线带宽极限测试结果 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 



 

 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

返回类型 布尔型 

0:通过 

1:失败 

默认值 无 

菜单项 无 

举例 :CALCulate1:BLIMit:FAIL? 

:CALCulate1:TRACe1:BLIMit:FAIL? 

 

3.7.2.49 获取带宽测试结果数据 

命令格式 :CALCulate<cnum>[:SELected]:BLIMit:REPort[:DATA]? 

:CALCulate<cnum>:TRACe<tnum>:BLIMit:REPort[:DATA]? 

说明 获取选择通道激活迹线带宽极限测试满足要求的带宽值 

获取选择通道及迹线带宽极限测试满足要求的带宽值 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

返回类型 浮点型 

默认值 无 

菜单项 无 

举例 :CALCulate1:BLIMit:REPort? 

:CALCulate1:TRACe1:BLIMit:REPort? 

 

3.7.3 时域 

3.7.3.1 命令列表 

时域转换状态 :CALCulate<cnum>:TRACe<tnum>:TRANsform:TIME:STATe 

时域转换开始值 :CALCulate<cnum>:TRACe<tnum>:TRANsform:TIME:STARt 

时域转换停止值 :CALCulate<cnum>:TRACe<tnum>:TRANsform:TIME:STOP 

时域转换中心值 :CALCulate<cnum>:TRACe<tnum>:TRANsform:TIME:CENTer 

时域转换跨距值 :CALCulate<cnum>:TRACe<tnum>:TRANsform:TIME:SPAN 

时域转换类型 :CALCulate<cnum>:TRACe<tnum>:TRANsform:TIME[:TYPE] 

时域转换激励类型 :CALCulate<cnum>:TRACe<tnum>:TRANsform:TIME:STIMulus 
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时域转换设置低通频率 :CALCulate<cnum>:TRACe<tnum>:TRANsform:LPFRequency 

时域转换自动直流外推模式 :CALCulate<cnum>:TRACe<tnum>:TRANsform:TIME:LPASs:DCS
Param:AUTO 

时域转换自定义直流外推值 :CALCulate<cnum>:TRACe<tnum>:TRANsform:TIME:LPASs:DCS
Param 

将直流外推值配置为手动值 :CALCulate<cnum>:TRACe<tnum>:TRANsform:TIME:LPASs:DCS
Param:EXTRapolate 

 

3.7.3.2 时域转换状态 

命令格式 :CALCulate<cnum>[:SELected]:TRANsform:TIME:STATe <bool> 

:CALCulate<cnum>[:SELected]:TRANsform:TIME:STATe? 

:CALCulate<cnum>:TRACe<tnum>:TRANsform:TIME:STATe <bool> 

:CALCulate<cnum>:TRACe<tnum>:TRANsform:TIME:STATe? 

说明 设置或获取激活迹线时域转换打开或关闭状态 

设置所选通道及迹线时域转换打开或关闭状态 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

<bool>:= ON|OFF|1|0 

返回类型 Boolean (1=ON,0=OFF) 

默认值 OFF 

菜单项 数学 > 时域 > 转换 

举例 :CALCulate1:TRANsform:TIME:STATe ON 

:CALCulate1:TRANsform:TIME:STATe? 

Return: 1 

 

:CALCulate1:TRACe1:TRANsform:TIME:STATe OFF 

:CALCulate1:TRACe1:TRANsform:TIME:STATe? 

Return: 0 

 

3.7.3.3 时域转换开始值 

命令格式 :CALCulate<cnum>[:SELected]:TRANsform:TIME:STARt <numeric> 

:CALCulate<cnum>[:SELected]:TRANsform:TIME:STARt? 

:CALCulate<cnum>:TRACe<tnum>:TRANsform:TIME:STARt <numeric> 

:CALCulate<cnum>:TRACe<tnum>:TRANsform:TIME:STARt? 

说明 设置或获取激活迹线时域转换开始值 

设置所选通道及迹线时域转换开始值 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 



 

 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

<numeric>:表示开始时间。 

返回类型 浮点型，单位 s（秒） 

默认值 无 

菜单项 数学 > 时域 > 开始时间 

举例 :CALCulate1:TRANsform:TIME:STARt -1e-9 

:CALCulate1:TRANsform:TIME:STARt? 

Return: -1e-09 

 

:CALCulate1:TRACe1:TRANsform:TIME:STARt 1e-9 

:CALCulate1:TRACe1:TRANsform:TIME:STARt? 

Return: 1e-09 

 

3.7.3.4 时域转换停止值 

命令格式 :CALCulate<cnum>[:SELected]:TRANsform:TIME:STOP <numeric> 

:CALCulate<cnum>[:SELected]:TRANsform:TIME:STOP? 

:CALCulate<cnum>:TRACe<tnum>:TRANsform:TIME:STOP <numeric> 

:CALCulate<cnum>:TRACe<tnum>:TRANsform:TIME:STOP? 

说明 设置或获取激活迹线时域转换停止值 

设置所选通道及迹线时域转换停止值 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

<numeric>:表示停止时间。 

返回类型 浮点型，单位 s（秒） 

默认值 无 

菜单项 数学 > 时域 > 停止时间 

举例 :CALCulate1:TRANsform:TIME:STOP 20e-9 

:CALCulate1:TRANsform:TIME:STOP? 

Return: 2e-08 

 

:CALCulate1:TRACe1:TRANsform:TIME:STOP 15e-9 

:CALCulate1:TRACe1:TRANsform:TIME:STOP? 

Return: 1.5e-08 

 

3.7.3.5 时域转换中心值 

命令格式 :CALCulate<cnum>[:SELected]:TRANsform:TIME:CENTer <numeric> 

:CALCulate<cnum>[:SELected]:TRANsform:TIME:CENTer? 
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:CALCulate<cnum>:TRACe<tnum>:TRANsform:TIME:CENTer <numeric> 

:CALCulate<cnum>:TRACe<tnum>:TRANsform:TIME:CENTer? 

说明 设置或获取激活迹线时域转换中心值 

设置所选通道及迹线时域转换中心值 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

<numeric>:表示中心时间。 

返回类型 浮点型，单位 s（秒） 

默认值 无 

菜单项 数学 > 时域 > 中心时间 

举例 :CALCulate1:TRANsform:TIME:CENTer 12e-9 

:CALCulate1:TRANsform:TIME:CENTer? 

Return: 1.2e-08 

 

:CALCulate1:TRACe1:TRANsform:TIME:CENTer 15e-9 

:CALCulate1:TRACe1:TRANsform:TIME:CENTer? 

Return: 1.5e-08 

 

3.7.3.6 时域转换跨距值 

命令格式 :CALCulate<cnum>[:SELected]:TRANsform:TIME:SPAN <numeric> 

:CALCulate<cnum>[:SELected]:TRANsform:TIME:SPAN? 

:CALCulate<cnum>:TRACe<tnum>:TRANsform:TIME:SPAN <numeric> 

:CALCulate<cnum>:TRACe<tnum>:TRANsform:TIME:SPAN? 

说明 1.设置或获取激活迹线时域转换跨距时间 

2.设置所选通道及迹线时域转换跨距时间 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

<numeric>:表示跨距时间。 

返回类型 浮点型，单位 s（秒） 

默认值 无 

菜单项 数学 > 时域 > 跨距时间 

举例 :CALCulate1:TRANsform:TIME:SPAN 10e-9 

:CALCulate1:TRANsform:TIME:SPAN? 

Return: 1e-08 

 

:CALCulate1:TRACe1:TRANsform:TIME:SPAN 15e-9 



 

 

:CALCulate1:TRACe1:TRANsform:TIME:SPAN? 

Return: 1.5e-08 

 

3.7.3.7 时域转换类型 

命令格式 :CALCulate<cnum>[:SELected]:TRANsform:TIME[:TYPE] <type> 

:CALCulate<cnum>[:SELected]:TRANsform:TIME[:TYPE]? 

:CALCulate<cnum>:TRACe<tnum>:TRANsform:TIME[:TYPE] <type> 

:CALCulate<cnum>:TRACe<tnum>:TRANsform:TIME[:TYPE]? 

说明 1.设置或获取激活迹线时域转换的变化类型 

2.设置所选通道及迹线时域转换的变化类型 

变换类型是有关如何将时域变换应用到频域测量的算法 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

<type>:={BPASs|LPASs} 

返回类型 枚举 

默认值 BPASs 

菜单项 数学 > 时域 > 变换模式 

举例 :CALCulate1:TRANsform:TIME LPASs 

:CALCulate1:TRANsform:TIME? 

Return: LPAS 

 

:CALCulate1:TRACe1:TRANsform:TIME BPASs 

:CALCulate1:TRACe1:TRANsform:TIME? 

Return: BPAS 

 

3.7.3.8 时域转换激励类型 

命令格式 :CALCulate<cnum>[:SELected]:TRANsform:TIME:STIMulus <type> 

:CALCulate<cnum>[:SELected]:TRANsform:TIME:STIMulus? 

:CALCulate<cnum>:TRACe<tnum>:TRANsform:TIME:STIMulus <type> 

:CALCulate<cnum>:TRACe<tnum>:TRANsform:TIME:STIMulus? 

说明 1.设置或获取激活迹线时域转换激励类型 

2.设置所选通道及迹线时域转换激励类型 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

<type>:={IMPulse|STEP} 

返回类型 枚举 

默认值 IMPulse 
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菜单项 数学 > 时域 > 变换模式 

举例 :CALCulate1:TRANsform:TIME LPASs 

:CALCulate1:TRANsform:TIME:STIMulus STEP 

:CALCulate1:TRANsform:TIME:STIMulus? 

Return: STEP 

 

:CALCulate1:TRACe1:TRANsform:TIME LPASs 

:CALCulate1:TRACe1:TRANsform:TIME:STIMulus IMPulse 

:CALCulate1:TRACe1:TRANsform:TIME:STIMulus? 

Return: IMP 

 

3.7.3.9 时域转换设置低通频率 

命令格式 :CALCulate<cnum>[:SELected]:TRANsform:TIME:LPFRequency 

:CALCulate<cnum>:TRACe<tnum>:TRANsform:LPFRequency 

说明 改变激活迹线的起始频率，即低通模式时域转换时的起始频率匹配 

改变所选择通道及迹线的起始频率，即低通模式时域转换时的起始频率匹配 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

返回类型 无 

默认值 无 

菜单项 数学 > 时域 > 时域设置 > Transform > Set Low Pass Frequencies 

举例 :CALCulate1:TRANsform:TIME:LPFRequency 

:CALCulate1:TRACe1:TRANsform:TIME:LPFRequency 

 

3.7.3.10 时域转换自动直流外推模式 

命令格式 :CALCulate<cnum> [:SELected]:TRANsform:TIME:LPASs:DCSParam:AUTO 
<bool> 

:CALCulate<cnum> [:SELected]:TRANsform:TIME:LPASs:DCSParam:AUTO? 

:CALCulate<cnum>:TRACe<tnum>:TRANsform:TIME:LPASs:DCSParam:AUTO 
<bool> 

:CALCulate<cnum>:TRACe<tnum>:TRANsform:TIME:LPASs:DCSParam:AUTO? 

说明 1. 设置或获取激活迹线低通模式时域转换自动直流外推模式。 

2. 设置或获取所选通道及迹线低通模式时域转换自动直流外推模式。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

<bool>:= ON|OFF|1|0 

返回类型 Boolean (1=ON,0=OFF) 



 

 

默认值 On 

菜单项 数学 > 时域 > 时域设置 > Transform > Advance>Auto Extrapolate 

举例 :CALCulate1:SELected1:TRANsform:TIME:LPASs:DCSParam:AUTO OFF 

:CALCulate1:SELected1:TRANsform:TIME:LPASs:DCSParam:AUTO? 

Return:0 

 

:CALCulate1:TRACe1:TRANsform:TIME:LPASs:DCSParam:AUTO ON 

:CALCulate1:TRACe1:TRANsform:TIME:LPASs:DCSParam:AUTO? 

Return:1 

3.7.3.11 时域转换自定义直流外推值 

命令格式 :CALCulate<cnum> [:SELected]:TRANsform:TIME:LPASs:DCSParam <numeric> 

:CALCulate<cnum> [:SELected]:TRANsform:TIME:LPASs:DCSParam? 

:CALCulate<cnum>:TRACe<tnum>:TRANsform:TIME:LPASs:DCSParam 
<numeric> 

:CALCulate<cnum>:TRACe<tnum>:TRANsform:TIME:LPASs:DCSParam? 

说明 1. 设置或获取激活迹线低通模式时域转换自定义直流外推值。 

2. 设置或获取所选通道及迹线低通模式时域转换自定义直流外推值。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

<numeric>:表示直流外推值，其范围是-1E15~1E15。 

返回类型 Float 

默认值 1 

菜单项 数学 > 时域 > 时域设置 > Transform > Advance > Manual Entry 

举例 :CALCulate1:SELected1:TRANsform:TIME:LPASs:DCSParam 9 

:CALCulate1:SELected1:TRANsform:TIME:LPASs:DCSParam? 

Return:9 

 

:CALCulate1:TRACe1:TRANsform:TIME:LPASs:DCSParam 11 

:CALCulate1:TRACe1:TRANsform:TIME:LPASs:DCSParam? 

Return:11 

 

3.7.3.12 将直流外推值配置为手动值 

命令格式 :CALCulate<cnum>[:SELected]:TRANsform:TIME:LPASs:DCSParam:EXTRapolate 

:CALCulate<cnum>:TRACe<tnum>:TRANsform:TIME:LPASs:DCSParam:EXTRapola
te 

说明 1.设置激活迹线低通模式时域转换时，关闭自动外推,获取最近一次数据的外推计算值,

将外推值配置到手动值。 

2.设置所选通道及迹线低通模式时域时，关闭自动外推,获取最近一次数据的外推计算值,

将外推值配置到手动值。 



 

168                                                                                                                   矢量网络分析仪编程手册 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

返回类型 无 

默认值 无 

菜单项 数学 > 时域 > 时域设置 > Transform > Advance > Extrapolate 

举例 :CALCulate1:SELected:TRANsform:TIME:LPASs:DCSParam:EXTRapolate 

 

 

3.7.4 时域门控 

3.7.4.1 命令列表 

时域选通状态 :CALCulate<cnum>:TRACe<tnum>:FILTer[:GATE]:TIME:STATe 

时域选通开始值 :CALCulate<cnum>:TRACe<tnum>:FILTer[:GATE]:TIME:STARt 

时域选通停止值 :CALCulate<cnum>:TRACe<tnum>:FILTer[:GATE]:TIME:STOP 

时域选通中心值 :CALCulate<cnum>:TRACe<tnum>:FILTer[:GATE]:TIME:CENTer 

时域选通跨距值 :CALCulate<cnum>:TRACe<tnum>:FILTer[:GATE]:TIME:SPAN 

时域选通类型 :CALCulate<cnum>:TRACe<tnum>:FILTer[:GATE]:TIME:TYPE 

时域选通形状 :CALCulate<cnum>:TRACe<tnum>:FILTer[:GATE]:TIME:SHAPE 

时域窗口脉冲宽度 :CALCulate<cnum>:TRACe<tnum>:TRANsform:TIME:IMPulse:WIDTh 

时域窗口 Kaiser Beta 值 :CALCulate<cnum>:TRACe<tnum>:TRANsform:TIME:KBESsel 

 

3.7.4.2 时域选通状态 

命令格式 :CALCulate<cnum>[:SELected]:FILTer[:GATE]:TIME:STATe <bool> 

:CALCulate<cnum>[:SELected]:FILTer[:GATE]:TIME:STATe? 

:CALCulate<cnum>:TRACe<tnum>:FILTer[:GATE]:TIME:STATe <bool> 

:CALCulate<cnum>:TRACe<tnum>:FILTer[:GATE]:TIME:STATe? 

说明 设置或获取激活迹线时域功能选通状态 

设置或获取选择通道及迹线时域功能选通状态 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

<bool>:= ON|OFF|1|0 

返回类型 Boolean (1=ON,0=OFF) 



 

 

默认值 OFF 

菜单项 数学 > 时域门控 > 门控 

举例 :CALCulate1:FILTer:TIME:STATe ON 

:CALCulate1:FILTer:TIME:STATe? 

Return: 1 

:CALCulate1:TRACe1:FILTer:TIME:STATe OFF 

:CALCulate1:TRACe1:FILTer:TIME:STATe? 

Return: 0 

 

3.7.4.3 时域选通开始值 

命令格式 :CALCulate<cnum>[:SELected]:FILTer[:GATE]:TIME:STARt <numeric> 

:CALCulate<cnum>[:SELected]:FILTer[:GATE]:TIME:STARt? 

:CALCulate<cnum>:TRACe<tnum>:FILTer[:GATE]:TIME:STARt <numeric> 

:CALCulate<cnum>:TRACe<tnum>:FILTer[:GATE]:TIME:STARt? 

说明 设置或获取激活迹线时域功能选通开始值 

设置或获取选择通道及迹线时域功能选通开始值 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

<numeric>:表示开始时间，其范围是-250e-9, 250e-9。 

返回类型 浮点型，单位 s 

默认值 -250e-9 

菜单项 数学 > 时域门控 > 起始 

举例 :CALCulate1:FILTer:TIME:STARt -1e-9 

:CALCulate1:FILTer:TIME:STARt? 

Return: -1e-09 

 

:CALCulate1:TRACe1:FILTer:TIME:STARt -2e-9 

:CALCulate1:TRACe1:FILTer:TIME:STARt? 

Return: -2e-09 

 

3.7.4.4 时域选通停止值 

命令格式 :CALCulate<cnum>[:SELected]:FILTer[:GATE]:TIME:STOP <numeric> 

:CALCulate<cnum>[:SELected]:FILTer[:GATE]:TIME:STOP? 

:CALCulate<cnum>:TRACe<tnum>:FILTer[:GATE]:TIME:STOP <numeric> 

:CALCulate<cnum>:TRACe<tnum>:FILTer[:GATE]:TIME:STOP? 

说明 设置或获取激活迹线时域功能选通停止值 

设置或获取选择通道及迹线时域功能选通停止值 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 
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<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

<numeric>:表示停止时间，其范围是-250e-9, 250e-9。 

返回类型 浮点型，单位 s 

默认值 250e-9 

菜单项 数学 > 时域门控 > 终止 

举例 :CALCulate1:FILTer:TIME:STOP 10e-9 

:CALCulate1:FILTer:TIME:STOP? 

Return: 1e-08 

 

:CALCulate1:TRACe1:FILTer:TIME:STOP 15e-9 

:CALCulate1:TRACe1:FILTer:TIME:STOP? 

Return: 1.5e-08 

 

3.7.4.5 时域选通中心值 

命令格式 :CALCulate<cnum>[:SELected]:FILTer[:GATE]:TIME:CENTer <numeric> 

:CALCulate<cnum>[:SELected]:FILTer[:GATE]:TIME:CENTer? 

:CALCulate<cnum>:TRACe<tnum>:FILTer[:GATE]:TIME:CENTer <numeric> 

:CALCulate<cnum>:TRACe<tnum>:FILTer[:GATE]:TIME:CENTer? 

说明 设置或获取激活迹线时域功能选通中心值 

设置或获取选择通道及迹线时域功能选通中心值 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

<numeric>:表示中心时间。 

返回类型 浮点型，单位 s 

默认值 0 

菜单项 数学 > 时域门控 > 中心 

举例 :CALCulate1:FILTer:TIME:CENTer 10e-9 

:CALCulate1:FILTer:TIME:CENTer? 

Return: 1e-08 

 

:CALCulate1:TRACe1:FILTer:TIME:CENTer 12e-9 

:CALCulate1:TRACe1:FILTer:TIME:CENTer? 

Return: 1.2e-08 

 

3.7.4.6 时域选通跨距值 

命令格式 :CALCulate<cnum>[:SELected]:FILTer[:GATE]:TIME:SPAN <numeric> 

:CALCulate<cnum>[:SELected]:FILTer[:GATE]:TIME:SPAN? 

:CALCulate<cnum>:TRACe<tnum>:FILTer[:GATE]:TIME:SPAN <numeric> 



 

 

:CALCulate<cnum>:TRACe<tnum>:FILTer[:GATE]:TIME:SPAN? 

说明 设置或获取激活迹线时域功能选通宽度值 

设置或获取选择通道及迹线时域功能选通宽度值 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

<numeric>:表示跨距时间。 

返回类型 浮点型，单位 s 

默认值 500e-9 

菜单项 数学 > 时域门控 > 跨距 

举例 :CALCulate1:FILTer:TIME:SPAN 10e-9 

:CALCulate1:FILTer:TIME:SPAN? 

Return: 1e-08 

:CALCulate1:TRACe1:FILTer:TIME:SPAN 15e-9 

:CALCulate1:TRACe1:FILTer:TIME:SPAN? 

Return: 1.5e-08 

 

3.7.4.7 时域选通类型 

命令格式 :CALCulate<cnum>[:SELected]:FILTer[:GATE]:TIME:TYPE <type> 

:CALCulate<cnum>[:SELected]:FILTer[:GATE]:TIME:TYPE? 

:CALCulate<cnum>:TRACe<tnum>:FILTer[:GATE]:TIME:TYPE <type> 

:CALCulate<cnum>:TRACe<tnum>:FILTer[:GATE]:TIME:TYPE? 

说明 设置或获取激活迹线时域功能选通类型 

设置或获取选择通道及迹线时域功能选通类型 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

<type>:={BPASs| NOTCh} 

返回类型 枚举 

默认值 BPASs 

菜单项 数学 > 时域门控 > 类型 

举例 :CALCulate1:FILTer:TIME:TYPE NOTCh 

:CALCulate1:FILTer:TIME:TYPE? 

Return: NOTC 

:CALCulate1:TRACe1:FILTer:TIME:TYPE BPASs 

:CALCulate1:TRACe1:FILTer:TIME:TYPE? 

Return: BPAS 
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3.7.4.8 时域选通形状 

命令格式 :CALCulate<cnum>[:SELected]:FILTer[:GATE]:TIME:SHAPe <type> 

:CALCulate<cnum>[:SELected]:FILTer[:GATE]:TIME:SHAPe? 

:CALCulate<cnum>:TRACe<tnum>:FILTer[:GATE]:TIME:SHAPE <type> 

:CALCulate<cnum>:TRACe<tnum>:FILTer[:GATE]:TIME:SHAPE? 

说明 设置或获取激活迹线时域功能选通形状 

设置或获取选择通道及迹线时域功能选通形状 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

<type>:={MAXimum|WIDE|NORMal|MINimum} 

返回类型 枚举 

默认值 NORMal 

菜单项 数学 > 时域门控 > 门控形状 

举例 :CALCulate1:FILTer:TIME:SHAPe MINimum 

:CALCulate1:FILTer:TIME:SHAPe? 

Return: MIN 

:CALCulate1:TRACe1:FILTer:TIME:SHAPe WIDE 

:CALCulate1:TRACe1:FILTer:TIME:SHAPe? 

Return: WIDE 

 

3.7.4.9 时域窗口脉冲宽度 

命令格式 :CALCulate<cnum>[:SELected]:TRANsform:TIME:IMPulse:WIDTh <numeric> 

:CALCulate<cnum>[:SELected]:TRANsform:TIME:IMPulse:WIDTh? 

:CALCulate<cnum>:TRACe<tnum>:TRANsform:TIME:IMPulse:WIDTh <numeric> 
:CALCulate<cnum>:TRACe<tnum>:TRANsform:TIME:IMPulse:WIDTh? 

说明 设置或获取激活迹线时域窗口脉冲宽度 

设置或获取选择通道及迹线时域窗口脉冲宽度 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

<numeric>:表示窗口脉冲宽度，其范围是 141.965927ps~326.518527ps。 

返回类型 浮点型，单位 s 

默认值 229.934230ps 

菜单项 数学 > 时域 > 时域设置 > Window > Impulse Width 

举例 :CALCulate1:TRANsform:TIME:IMPulse:WIDTh 1.77344558e-10 

:CALCulate1:TRANsform:TIME:IMPulse:WIDTh? 

Return: 1.77344558187784e-10 

 



 

 

:CALCulate1:TRACe1:TRANsform:TIME:IMPulse:WIDTh 1.77344558e-10 

:CALCulate1:TRACe1:TRANsform:TIME:IMPulse:WIDTh? 
Return: 1.77344558187784e-10 

 

3.7.4.10 时域窗口 Kaiser Beta值 

命令格式 :CALCulate<cnum>[:SELected]:TRANsform:TIME:KBESsel <numeric> 

:CALCulate<cnum>[:SELected]:TRANsform:TIME:KBESsel? 

:CALCulate<cnum>:TRACe<tnum>:TRANsform:TIME:KBESsel <numeric> 

:CALCulate<cnum>:TRACe<tnum>:TRANsform:TIME:KBESsel? 

说明 设置或获取激活迹线时域窗口 Kaiser Beta 值 

设置或获取选择通道及迹线时域窗口 Kaiser Beta 值 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

<numeric>:表示窗口 Kaiser Beta 值，其范围是 0~13。 

返回类型 浮点型 

默认值 6 

菜单项 数学 > 时域 > 时域设置 > Window > Kaiser Beta 

举例 :CALCulate1:TRANsform:TIME:KBESsel 3.4 

:CALCulate1:TRANsform:TIME:KBESsel? 

Return: 3.4 

 

:CALCulate1:TRACe1:TRANsform:TIME:KBESsel 3.4 

:CALCulate1:TRACe1:TRANsform:TIME:KBESsel? 
Return: 3.4 

 
 

3.8 Marker 命令子系统 

3.8.1 光标 

3.8.1.1 命令列表 

设置激活标记 :CALCulate<cnum>:TRACe<tnum>:MARKer<mnum>:ACTivate 

光标状态设置 :CALCulate<cnum>:TRACe<tnum>:MARKer<mnum>[:STATe] 

光标 X 值 :CALCulate<cnum>:TRACe<tnum>:MARKer:X 

获取光标的激励和响应数据 :CALCulate<cnum>:TRACe<tnum>:MARKer<mnum>:DATA? 

获取光标 Y 值 :CALCulate<cnum>:TRACe<tnum>:MARKer<mnum>:Y? 

参考光标状态设置 :CALCulate<cnum>:TRACe<tnum>:MARKer:REFerence[:STATe] 



 

174                                                                                                                   矢量网络分析仪编程手册 

关闭显示所有光标 :CALCulate<cnum>:MEASure<tnum>:MARKer:AOFF 

 

3.8.1.2 设置激活标记 

命令格式 :CALCulate<cnum>[:SELected]:MARKer<mnum>:ACTivate 

:CALCulate<cnum>:TRACe<tnum>:MARKer<mnum>:ACTivate 

说明 设置激活迹线激活标记 

设置所选通道及迹线激活标记 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

<mnum>:={[1]-10}，表示光标编号，如果未指定，则<mnum>默认设置 1。其范围

是 1到 10（10为参考标记）。 

默认值 无 

菜单项 光标 > 光标 > 选择光标 

举例 :CALCulate1:MARKer3:ACTivate 

:CALCulate1:TRACe1:MARKer3:ACTivate 

 

3.8.1.3 光标状态设置 

命令格式 :CALCulate<cnum>[:SELected]:MARKer<mnum>[:STATe] <bool> 

:CALCulate<cnum>[:SELected]:MARKer<mnum>[:STATe]? 

:CALCulate<cnum>:TRACe<tnum>:MARKer<mnum>[:STATe] <bool> 

:CALCulate<cnum>:TRACe<tnum>:MARKer<mnum>[:STATe]? 

:CALCulate<cnum>:MEASure<tnum>:MARKer<mnum> [:STATe] <bool> 

:CALCulate<cnum>:MEASure<tnum>:MARKer<mnum> [:STATe]? 

说明 设置或获取激活迹线光标显示开关状态 

设置或获取选择通道及迹线光标显示开关状态 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

<mnum>:={[1]-10}，表示光标编号，如果未指定，则<mnum>默认设置 1。 

<bool>:= ON|OFF|1|0 

返回类型 Boolean (1=ON,0=OFF) 

默认值 OFF 

菜单项 无 

举例 :CALCulate1:MARKer3 ON 

:CALCulate1:MARKer3? 

Return: 1 



 

 

 

:CALCulate1:TRACe1:MARKer3 OFF 

:CALCulate1:TRACe1:MARKer3? 

Return: 0 

 

:CALCulate1:MEASure1:MARKer5 ON 

:CALCulate1:MEASure1:MARKer5? 

Return: 1 

 

3.8.1.4 光标 X值 

命令格式 :CALCulate<cnum>[:SELected]:MARKer:X <numeric>   

:CALCulate<cnum>[:SELected]:MARKer:X? 

:CALCulate<cnum>:TRACe<tnum>:MARKer:X <numeric>  

:CALCulate<cnum>:TRACe<tnum>:MARKer:X? 

说  明 设置或获取激活迹线光标 X 轴激励值 

设置或获取选择通道光标 X 轴激励值 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

<numeric>:表示光标 X 轴激励值。 

返回类型 浮点型 

默认值 无 

菜单项 光标 > 光标 > 光标 x（x：1-9 或者 R） 

举例 :CALCulate1:MARKer1:X 1e9 

:CALCulate1:MARKer1:X? 

Return: 1000000000 

 

:CALCulate1:TRACe1:MARKer:X 2e9 

:CALCulate1:TRACe1:MARKer:X? 

Return: 2000000000 

 

3.8.1.5 获取光标的激励和响应数据 

命令格式 :CALCulate<cnum>[:SELected]:MARKer<mnum>:DATA? 

:CALCulate<cnum>:TRACe<tnum>:MARKer<mnum>:DATA? 

说明 获取标记 1~9 和参考光标的激励和响应数据 

获取所选通道、迹线及光标 1~9和参考光标的激励和响应数据 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

<mnum>:={[1]-10}，表示光标编号，如果未指定，则<mnum>默认设置 1。 
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返回类型 数据数组 

 

表示 NOP（Numbers of point）*3 的数组数据（格式化数据数组）。n 为 1 到

NOP 之间的整数 

数据（n*3-3）：第 n个测量点的响应数据（实部） 

数据（n*3-2）：第 n个测量点的响应数据（虚部） 

数据（n*3-1）：第 n个测量点的激励数据 

数组索引从 0开始。 

默认值 无 

菜单项 无 

举例 :CALCulate1:MARKer3:DATA? 

:CALCulate1:TRACe1:MARKer3:DATA? 

 

3.8.1.6 获取光标 Y值 

命令格式 :CALCulate<cnum>[:SELected]:MARKer<mnum>:Y? 

:CALCulate<cnum>:TRACe<tnum>:MARKer<mnum>:Y? 

说  明 获取迹线光标 Y 轴响应值。返回类型的格式取决于光标的设置，如果光标设置为差

值光标时，则数据是相对于参考光标，查询总是返回两个数值。 

当迹线显示格式为史密斯或者极坐标格式时，返回响应值（虚部，实部），其它显

示格式返回 （响应值，0） 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

<mnum>:={[1]-10}，表示光标编号，如果未指定，则<mnum>默认设置 1。 

返回类型 数据数组 

默认值 无 

菜单项 无 

举例 迹线显示为史密斯圆图格式时： 

:CALCulate1:MARKer1:Y? 

:CALCulate1:TRACe1:MARKer1:Y? 

Return：39.3147784266,12.8101028317 

 

非史密斯圆图或极坐标迹线显示格式时： 

:CALCulate1:MARKer1:Y? 

:CALCulate1:TRACe1:MARKer1:Y? 



 

 

Return：-14.6367454451,0 

 

3.8.1.7 参考光标状态设置 

命令格式 :CALCulate<cnum>[:SELected]:MARKer:REFerence[:STATe] <bool> 

:CALCulate<cnum>[:SELected]:MARKer:REFerence[:STATe]? 

:CALCulate<cnum>:TRACe<tnum>:MARKer:REFerence[:STATe] <bool> 

:CALCulate<cnum>:TRACe<tnum>:MARKer:REFerence[:STATe]? 

说明 设置或获取激活迹线参考光标显示开关状态 

设置或获取选择通道及迹线参考光标显示开关状态 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

<bool>:= ON|OFF|1|0 

返回类型 Boolean (1=ON,0=OFF) 

默认值 OFF 

菜单项 光标 > 光标 > 参考光标 

举例 :CALCulate1:MARKer:REFerence ON 

:CALCulate1:MARKer:REFerence? 

Return: 1 

 

:CALCulate1:TRACe1:MARKer:REFerence OFF 

:CALCulate1:TRACe1:MARKer:REFerence? 

Return: 0 

 

3.8.1.8 关闭显示所有光标 

命令格式 :CALCulate<cnum>:MEASure<tnum>:MARKer:AOFF 

说明 设置关闭选择通道及迹线的所有光标 

参数 
<cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

返回类型 布尔型 

默认值 无 

菜单项 光标 > 光标 > 全部关闭 

举例 :CALCulate1:TRACe1:MARKer3 ON 

:CALCulate1:MEASure1:MARKer:AOFF 
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3.8.2 光标设置 

3.8.2.1 命令列表 

光标差值状态 :CALCulate<cnum>:MEASure<tnum>:MARKer<mnum>:DELTa 

 光标离散状态 :CALCulate<cnum>:TRACe<tnum>:MARKer<mnum>:DISCrete 

光标固定状态 :CALCulate<cnum>:MEASure<tnum>:MARKer<mnum>:TYPE 

光标格式 :CALCulate<cnum>:MEASure<tnum>:MARKer<mnum>:FORMAT 

光标耦合状态 :CALCulate:MARKer:COUPle 

 

3.8.2.2 光标差值状态 

命令格式 :CALCulate<cnum>:MEASure<tnum>:MARKer<mnum>:DELTa <bool> 

:CALCulate<cnum>:MEASure<tnum>:MARKer<mnum>:DELTa? 

说明 设置或获取所选通道及迹线所选光标差值游标状态 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

<mnum>:={[1]-9}，表示光标编号，如果未指定，则<mnum>默认设置 1。 

<bool>:= ON|OFF|1|0 

返回类型 Boolean (1=ON,0=OFF) 

默认值 OFF 

菜单项 光标 > 光标设置 > 差值光标 

举例 :CALCulate1:MEASure:MARKer3:DELTa ON 

:CALCulate1:MEASure:MARKer3:DELTa? 

Return: 1 

 

3.8.2.3 光标离散状态 

命令格式 :CALCulate<cnum>[:SELected]:MARKer<mnum>:DISCrete <bool> 

:CALCulate<cnum>[:SELected]:MARKer<mnum>:DISCrete? 

:CALCulate<cnum>:TRACe<tnum>:MARKer<mnum>:DISCrete <bool> 

:CALCulate<cnum>:TRACe<tnum>:MARKer<mnum>:DISCrete? 

说明 设置或获取激活迹线所选光标离散模式的状态 

设置或获取所选通道及迹线所选光标离散模式的状态 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 



 

 

<mnum>:={[1]-10}，表示光标编号，如果未指定，则<mnum>默认设置 1。 

<bool>:= ON|OFF|1|0 

返回类型 Boolean (1=ON,0=OFF) 

默认值 OFF 

菜单项 光标 > 光标设置 > 离散光标 

举例 :CALCulate1:MARKer2:DISCrete ON 

:CALCulate1:MARKer2:DISCrete? 

Return: 1 

:CALCulate1:TRACe1:MARKer3:DISCrete OFF 

:CALCulate1:TRACe1:MARKer3:DISCrete? 

Return: 0 

 

3.8.2.4 光标固定状态 

命令格式 :CALCulate<cnum>:MEASure<tnum>:MARKer<mnum>:TYPE <type> 

:CALCulate<cnum>:MEASure<tnum>:MARKer<mnum>:TYPE? 

说明 设置或获取所选通道及迹线所选光标固定状态 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

<mnum>:={[1]-10}，表示光标编号，如果未指定，则<mnum>默认设置 1。 

<type>:={NORMal|FIXed} 

返回类型 枚举 

默认值 NORM 

菜单项 光标 > 光标设置 > 类型 

举例 :CALCulate1:MEASure:MARKer3:TYPE FIXed 

:CALCulate1:MEASure:MARKer3:TYPE? 

Return: FIX 

 

3.8.2.5 光标格式 

命令格式 :CALCulate<cnum>:MEASure<tnum>:MARKer<mnum>:FORMAT <type> 

:CALCulate<cnum>:MEASure<tnum>:MARKer<mnum>:FORMAT? 

说  明 设置或获取所选通道及迹线所选光标显示格式 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

<mnum>:={[1]-10}，表示光标编号，如果未指定，则<mnum>默认设置 1。 

<type>:={DEFault|MLINear|MLOGarithmic|IMPedance|ADMittance|PHASe|IMAG
inary|REAL|POLar|GDELay|LINPhase|LOGPhase|SWR} 
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返回类型 枚举 

默认值 DEF 

菜单项 光标 > 光标设置 > 标记 

举例 :CALCulate1:MEASure1:MARKer3:FORMAT MLINear 

:CALCulate1:MEASure1:MARKer3:FORMAT? 

Return: MLIN 

 

3.8.2.6 光标耦合状态 

命令格式 :CALCulate:MARKer:COUPle <type> 

:CALCulate:MARKer:COUPle? 

说  明 设置或获取光标耦合的状态 

参数 <type>:={ALL|CHANnel|OFF} 

返回类型 枚举 

默认值 OFF 

菜单项 光标 > 光标设置 > 耦合 

举例 :CALCulate:MARKer:COUPle ALL 

:CALCulate:MARKer:COUPle? 

Return: ALL 

 

3.8.3 光标显示 

3.8.3.1 命令列表 

显示或隐藏光标读数 :DISPlay:WINDow<wnum>:ANNotation:MARKer:ALIGn[:STATe] 

只显激活迹线光标读数 :DISPlay:WINDow<wnum>:ANNotation:MARKer:SINGle[:STATe] 

单条迹线光标读数的 X 轴位置 :DISPlay:CHANnel<cnum>:TRACe<tnum>:ANNotation:MARKer:POSition:X 

单条迹线光标读数的 Y 轴位置 :DISPlay:CHANnel<cnum>:TRACe<tnum>:ANNotation:MARKer:POSition:Y 

窗口整体光标信息在 X 轴位置 :DISPlay:WINDow<wnum>:ANNotation:MARKer:POSition:X 

窗口整体光标信息在 Y 轴位置 :DISPlay:WINDow<wnum>:ANNotation:MARKer:POSition:Y 

光标精度模式 :DISPlay:WINDow<wnum>:ANNotation:MARKer:DECimal:PLACes:AUTO 

光标激励值的精度 :DISPlay:WINDow<wnum>:ANNotation:MARKer:STIMulus:DECimal:PLACes 

光标响应值的精度 :DISPlay:WINDow<wnum>:ANNotation:MARKer:RESPonse:DECimal:PLACes 



 

 

 

3.8.3.2 显示或隐藏光标读数 

命令格式 :DISPlay:WINDow<wnum>:ANNotation:MARKer:ALIGn[:STATe] <bool> 

:DISPlay:WINDow<wnum>:ANNotation:MARKer:ALIGn[:STATe]? 

说明 打开光标时，指定所选窗口的光标读数的显示与关闭。 

参数 <wnum>:={[1]-36}，表示测量窗口号，如果未指定，则<wnum>默认设置 1。 

<bool>:= ON|OFF|1|0 

返回类型 Boolean (1=ON,0=OFF) 

默认值 1 

菜单项 光标 > 光标显示 > 显示读数 

举例 :DISPlay:WINDow1:ANNotation:MARKer:ALIGn:STAT 0? 

:DISPlay:WINDow1:ANNotation:MARKer:ALIGn:STAT? 

Return :0 

 

3.8.3.3 只显激活迹线光标读数 

命令格式 :DISPlay:WINDow<wnum>:ANNotation:MARKer:SINGle[:STATe] <bool> 

:DISPlay:WINDow<wnum>:ANNotation:MARKer:SINGle[:STATe]? 

说明 打开光标时，打开或关闭只显示激活迹线的光标读数的功能。 

参数 <wnum>:={[1]-36}，表示测量窗口号，如果未指定，则<wnum>默认设置 1。 

<bool>:= ON|OFF|1|0 

返回类型 Boolean (1=ON,0=OFF) 

默认值 1 

菜单项 光标 > 光标显示 > 仅工作迹线 

举例 :DISPlay:WINDow1:ANNotation:MARKer:SINGle:STAT 1? 

:DISPlay:WINDow1:ANNotation:MARKer:SINGle:STAT? 

Return :1 

 

3.8.3.4 单条迹线光标读数的 X轴位置 

命令格式 :DISPlay:CHANnel<cnum>:TRACe<tnum>:ANNotation:MARKer:POSition:X 
<numeric> 

:DISPlay:CHANnel<cnum>:TRACe<tnum>:ANNotation:MARKer:POSition:X? 

说  明 设置或获取单条迹线的光标信息栏在窗口的 X 轴显示位置。 

参数 

<cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

<numeric>:表示 X 轴显示位置，其范围是 1-10。 
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返回类型 Float 

默认值 10 

菜单项 光标 > 光标显示 > 显示读数 > X 位置 

举例 :DISPlay:CHANnel1:TRACe1:ANNotation:MARKer:POSition:X 5 

:DISPlay:CHANnel1:TRACe1:ANNotation:MARKer:POSition:X? 

Return: 5 

 

3.8.3.5 单条迹线光标读数的 Y轴位置 

命令格式 :DISPlay:CHANnel<cnum>:TRACe<tnum>:ANNotation:MARKer:POSition:Y 
<numeric> 

:DISPlay:CHANnel<cnum>:TRACe<tnum>:ANNotation:MARKer:POSition:Y? 

说  明 设置或获取单条迹线的光标信息栏在窗口的 Y 轴显示位置。 

参数 

<cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

<numeric>:表示 Y 轴显示位置，其范围是 1-10。 

返回类型 Float 

默认值 10 

菜单项 光标 > 光标显示 > 显示读数 > Y 位置 

举例 :DISPlay:CHANnel1:TRACe1:ANNotation:MARKer:POSition:Y 7 

:DISPlay:CHANnel1:TRACe1:ANNotation:MARKer:POSition:Y? 

Return: 7 

 

3.8.3.6 窗口整体光标信息在 X轴位置 

命令格式 :DISPlay:WINDow<wnum>:ANNotation:MARKer:POSition:X <numeric> 

:DISPlay:WINDow<wnum>:ANNotation:MARKer:POSition:X? 

说明 光标读数右对齐时。设置或获取窗口的整体光标信息在 X 轴位置。 

参数 
<wnum>:={[1]-36}，表示测量窗口号，如果未指定，则<wnum>默认设置 1。 

<numeric>:表示 X 轴位置，其范围是 1-10。 

返回类型 Float 

默认值 10 

菜单项 光标 > 光标显示 > 显示读数 > X 位置 

举例 :DISPlay:WINDow1:ANNotation:MARKer:POSition:X 6 

:DISPlay:WINDow1:ANNotation:MARKer:POSition:X? 

Return: 6 

 



 

 

3.8.3.7 窗口整体光标信息在 Y轴位置 

命令格式 :DISPlay:WINDow<wnum>:ANNotation:MARKer:POSition:Y <numeric> 

:DISPlay:WINDow<wnum>:ANNotation:MARKer:POSition:Y? 

说  明 光标读数右对齐时。设置或获取光标读数的 Y 轴位置。 

参数 <wnum>:={[1]-36}，表示测量窗口号，如果未指定，则<wnum>默认设置 1。 

<numeric>:表示 Y 轴位置，其范围是 1-10。 

返回类型 Float 

默认值 10 

菜单项 光标 > 光标显示 > 显示读数 > Y 位置 

举例 :DISPlay:WINDow1:ANNotation:MARKer:POSition:Y 8 

:DISPlay:WINDow1:ANNotation:MARKer:POSition:Y? 

Return: 8 

 

3.8.3.8 光标精度模式 

命令格式 :DISPlay:WINDow<wnum>:ANNotation:MARKer:DECimal:PLACes:AUTO <bool> 

:DISPlay:WINDow<wnum>:ANNotation:MARKer:DECimal:PLACes:AUTO? 

说明 打开或关闭指定窗口光标精度的自动模式。 

参数 
<wnum>:={[1]-36}，表示测量窗口号，如果未指定，则<wnum>默认设置 1。 

<bool>:= ON|OFF|1|0 

返回类型 Boolean (1=ON,0=OFF) 

默认值 On 

菜单项 光标 > 光标显示 > 小数位数… 

举例 :DISPlay:WINDow1:ANNotation:MARKer:DECimal:PLACes:AUTO OFF 

:DISPlay:WINDow1:ANNotation:MARKer:DECimal:PLACes:AUTO? 

 

Retuen:0 

 

3.8.3.9 光标激励值的精度 

命令格式 :DISPlay:WINDow<wnum>:ANNotation:MARKer:STIMulus:DECimal:PLACes 
<numeric> 

:DISPlay:WINDow<wnum>:ANNotation:MARKer:STIMulus:DECimal:PLACes? 

说明 设置或读取指定窗口光标激励值的精度。 

参数 
<wnum>:={[1]-36}，表示测量窗口号，如果未指定，则<wnum>默认设置 1。 

<numeric>:表示光标激励值的精度，其范围是 2-9。 

返回类型 Float 
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默认值 6 

菜单项 光标 > 光标显示 > 小数位数… > Marker Decimal Places Setting > Stimulus 

举例 :DISPlay:WINDow1:ANNotation:MARKer:STIMulus:DECimal:PLACes 3 

:DISPlay:WINDow1:ANNotation:MARKer:STIMulus:DECimal:PLACes? 

 

Retuen:3 

 

3.8.3.10 光标响应值的精度 

命令格式 :DISPlay:WINDow<wnum>:ANNotation:MARKer:RESPonse:DECimal:PLACes 
<numeric> 

:DISPlay:WINDow<wnum>:ANNotation:MARKer:RESPonse:DECimal:PLACes? 

说明 设置或读取指定窗口光标响应值的精度。 

参数 
<wnum>:={[1]-36}，表示测量窗口号，如果未指定，则<wnum>默认设置 1。 

<numeric>:表示光标响应值的精度，其范围是 2-6。 

返回类型 Float 

默认值 6 

菜单项 光标 > 光标显示 > 小数位数… > Marker Decimal Places Setting > Response 

举例 :DISPlay:WINDow1:ANNotation:MARKer:RESPonse:DECimal:PLACes 5 

:DISPlay:WINDow1:ANNotation:MARKer:RESPonse:DECimal:PLACes 5 

 

Retuen:5 

 

3.8.4 光标功能 

3.8.4.1 命令列表 

光标→功能 :CALCulate<cnum>[:SELected]:MARKer<mnum>:SET 

噪声光标状态设置 (仅 SA 模式支持) :CALCulate<cnum>:TRACe<tnum>:SA:MARKer<mnum>:
NOISe:STATe 

N dB 带宽状态设置 (仅 SA 模式支持) :CALCulate<cnum>:TRACe<tnum>:SA:MARKer<mnum>:
NDB:STATe 

N dB 带宽参考值 (仅 SA 模式支持) :CALCulate<cnum>:TRACe<tnum>:SA:MARKer<mnum>:
NDB:THReshold 

获取 N dB 带宽结果（仅 SA 模式支

持） 

:CALCulate<cnum>:TRACe<tnum>:SA:MARKer<mnum>:
NDB:BWIDth? 

 

3.8.4.2 光标→功能 

命令格式 :CALCulate<cnum>[:SELected]:MARKer<mnum>:SET <type> 



 

 

:CALCulate<cnum>:TRACe<tnum>:MARKer<mnum>:SET <type> 

说明 设置或获取激活迹线光标位置 

设置或获取选择通道及迹线光标位置 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

<mnum>:={[1]-10}，表示光标编号，如果未指定，则<mnum>默认设置 1。 

<type>:={STARt|STOP|CENTer|RLEVel|DELay|RMARker|SPAN|SA} 

返回类型 无 

默认值 无 

菜单项 光标 > 光标 → 功能 

举例 :CALCulate1:MARKer1:SET RLEVel 

:CALCulate1:TRACe1:MARKer1:SET STARt 

 

3.8.4.3 噪声光标状态设置 (仅 SA 模式支持) 

命令格式 :CALCulate<cnum>:SELected:SA:MARKer<mnum>:NOISe:STATe <bool> 

:CALCulate<cnum>:SELected:SA:MARKer<mnum>:NOISe:STATe? 

 

:CALCulate<cnum>:TRACe<tnum>:SA:MARKer<mnum>:NOISe:STATe <bool> 

:CALCulate<cnum>:TRACe<tnum>:SA:MARKer<mnum>:NOISe:STATe? 

说明 设置或获取激活迹线噪声光标显示开关状态 

设置或获取选择通道及迹线噪声光标显示开关状态 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

<mnum>:={[1]-10}，表示光标编号，如果未指定，则<mnum>默认设置 1。 

<bool>:= ON|OFF|1|0 

返回类型 Boolean (1=ON,0=OFF) 

默认值 OFF 

菜单项 Marker > 光标功能 > 噪声光标 

举例 :CALCulate1:SELected:SA:MARKer1:NOISe:STATe 1 

:CALCulate1:SELected:SA:MARKer1:NOISe:STATe? 

Return 1 

 

:CALCulate1:TRACe1:SA:MARKer1:NOISe:STATe OFF 

:CALCulate1:TRACe1:SA:MARKer1:NOISe:STATe? 

Return 0 
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3.8.4.4 N dB带宽状态设置 (仅 SA 模式支持) 

命令格式 :CALCulate<cnum>:SELected:SA:MARKer<mnum>:NDB:STATe <bool> 

:CALCulate<cnum>:SELected:SA:MARKer<mnum>:NDB:STATe? 

:CALCulate<cnum>:TRACe<tnum>:SA:MARKer<mnum>:NDB:STATe <bool> 

:CALCulate<cnum>:TRACe<tnum>:SA:MARKer<mnum>:NDB:STATe? 

说明 设置或获取激活迹线 N dB 带宽显示开关状态。 

设置或获取选择通道及迹线噪声 N dB 带宽显示开关状态。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

<mnum>:={[1]-10}，表示光标编号，如果未指定，则<mnum>默认设置 1。 

<bool>:= ON|OFF|1|0 

返回类型 Boolean (1=ON,0=OFF) 

默认值 OFF 

菜单项 Marker > 光标功能 > N dB 带宽 

举例 :CALCulate1:SELected:SA:MARKer1:NDB:STATe 1 

:CALCulate1:SELected:SA:MARKer1:NDB:STATe? 

Return 1 

 

:CALCulate1:TRACe1:SA:MARKer1:NDB:STATe 0 

:CALCulate1:TRACe1:SA:MARKer1:NDB:STATe? 

Return 0 

 

3.8.4.5 N dB 带宽参考值 (仅 SA 模式支持) 

命令格式 :CALCulate<cnum>:SELected:SA:MARKer<mnum>:NDB:THReshold <val> 

:CALCulate<cnum>:SELected:SA:MARKer<mnum>:NDB:THReshold? 

 

:CALCulate<cnum>:TRACe<tnum>:SA:MARKer<mnum>:NDB:THReshold <val> 

:CALCulate<cnum>:TRACe<tnum>:SA:MARKer<mnum>:NDB:THReshold? 

说明 设置或获取激活迹线 N dB 带宽的阈值。 

设置或获取选择通道及迹线噪声 N dB 带宽的阈值。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

<mnum>:={[1]-10}，表示光标编号，如果未指定，则<mnum>默认设置 1。 

<val>:=  -500dB~500dB 范围内的任意浮点数。 

返回类型 浮点数，单位是 dB。 

默认值 -3dB 



 

 

菜单项 Marker > 光标功能 > N dB 

举例 :CALCulate1:SELected:SA:MARKer1:NDB:THReshold -5 

:CALCulate1:SELected:SA:MARKer1:NDB:THReshold? 

Return -5 

 

:CALCulate1:TRACe1:SA:MARKer1:NDB:THReshold -2 

:CALCulate1:TRACe1:SA:MARKer1:NDB:THReshold? 

Return -2 

 

3.8.4.6 获取 N dB带宽结果（仅 SA模式支持） 

命令格式 :CALCulate<cnum>:SELected:SA:MARKer<mnum>:NDB:BWIDth? 

:CALCulate<cnum>:TRACe<tnum>:SA:MARKer<mnum>:NDB:BWIDth? 

说明 设置或获取激活迹线 N dB 带宽的结果。 

设置或获取选择通道及迹线噪声 N dB 带宽的结果。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

<mnum>:={[1]-10}，表示光标编号，如果未指定，则<mnum>默认设置 1。 

返回类型 浮点型,单位 Hz 

默认值 无 

菜单项 Marker > 光标功能 > 噪声光标 >N dB 带宽 

举例 :CALCulate1:TRACe1:SA:MARKer1:NDB:STATe 1 

:CALCulate1:SELected:SA:MARKer1:NDB:BWIDth? 

Return 2778220.80323839 

 

3.9 Meas 命令子系统 

3.9.1 命令列表 

设置测量模式 :CALCulate<cnum>:INSTrument 

设置测量参数 :CALCulate<cnum>:PARameter<tnum>:DEFine 

设置平衡测量拓扑 :CALCulate<cnum>:DTOPology 

 

3.9.2 设置测量模式 

命令格式 :CALCulate<cnum>:INSTrument <type> 

:CALCulate<cnum>:INSTrument? 
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说明 设置或获取通道的测量模式。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<type>:={VNA|SA|SMM|MT|CAT} 

VNA ：矢量网络分析测量模式 

SA ：频谱分析测量模式 

SMM ：混频器测量模式 

MT：材料测量模式 

CAT:天线测量模式（仅 SHN900A 机型支持） 

返回类型 枚举 

默认值 VNA 

菜单项 测量 > S 参数 > 模式 

举例 :CALCulate1:INSTrument SMM 

:CALCulate1:INSTrument? 

Return :SMM 

 

3.9.3 设置测量参数 

命令格式 :CALCulate<cnum>:PARameter<tnum>:DEFine <string> 

:CALCulate<cnum>:PARameter<tnum>:DEFine? 

说明 设置所选通道及迹线的测量参数 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1 

<string>:={S11|S21|S31|S41|S12|S22|S32|S42|S13|S23|S33|S43|S14|S24|S34|
S44|A|B|C|D|R1|R2|R3|R4} 

<string>参数的范围如下： 

 设置 S 参数：<meas>="S<XY>", X=1到 4,Y=1到 4； 

 设置比例测量参数：<meas>="𝑏𝑁/𝑎𝑁,N"或者<meas>="𝑏𝑁/𝑎𝑁_N"，N=1到 4； 

 设置非比例测量参数：<meas>=任何 VNA 物理接收机后跟逗号和源端口，例如

"A,1"; 

 设置平衡 S 参数：<meas>="𝑆𝑎𝑏𝑥𝑦" 

        对于单端口平衡测量，"𝑆𝑎𝑏𝑥𝑦"=Sdd11|Scd11|Sdc11|Scc11 

        对于单端-平衡测量， 

"𝑆𝑎𝑏𝑥𝑦"=Sdd11|Scd11|Sdc11|Scc11|Ssd21|Ssc21|Sds12|Scs12|Sss22|ImBal|Sds

21/Scs21|Ssd12/Ssc12 

 



 

 

        对于平衡-平衡测量， 

"𝑆𝑎𝑏𝑥𝑦"=Sdd11|Sdd21|Sdd12|Sdd22|Scd11|Scd21|Scd12|Scd22|Sdc11|Sdc21|Sd

c12|Sdc22|Scc11|Scc21|Scc12|Scc22|ImBal1|ImBal2|Sdd21/Scc21 

 

        对于单端-单端-平衡测量， 

"𝑆𝑎𝑏𝑥𝑦"=Sss11|Sss21|Sss12|Sss22|Sds31|Scs31|Sds32|Scs32|Ssd13|Ssd23|Ssc

13|Ssc23|Sdd33|Scd33|Sdc33|Scc33|ImBal1|ImBal2|ImBal3|ImBal|Sds31/Scs31|S
ds32/Scs32 

 

返回类型 字符串 

默认值 S11 

菜单项 测量 > S 参数/平衡测量/接收测量/Wave/比例测量 

举例 设置 S 参数 

:CALCulate1:PARameter1:DEFine S12 

设置平衡测量参数 

:CALCulate1:PARameter1:DEFine Sdd11 

设置接收机测量参数 

:CALCulate1:PARameter1:DEFine "A,1" 

:CALCulate1:PARameter1:DEFine "R1,1" 

设置 Wave 测量参数 

:CALCulate1:PARameter1:DEFine "a1,2" 

设置比例测量参数 

:CALCulate1:PARameter1:DEFine "b2/a1,1" 

 

查询测量参数 

:CALCulate1:PARameter1:DEFine? 

Return: S12 

 

3.9.4 设置平衡测量拓扑 

命令格式 :CALCulate<cnum>:DTOPology <TopologyType>,<PortTopologyList> 

:CALCulate<cnum>:DTOPology? 

说明 设置所选通道平衡测量时的端口拓扑 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<TopologyType>: 表示拓扑类型： 

B：        Balance（2 Ports） 

SB：      Single – Balance（3 Ports） 

SSB:      Single – Single – Balance（4 Ports） 
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BB：      Balance – Balance（4 Ports） 

<PortTopologyList>:表示端口拓扑列表： 

以整型代表对应的端口编号，依次标识拓扑中从上至下、从左至右的端口。 

返回类型 字符串 

默认值 B，1，2 

菜单项 测量 > 平衡测量 > 端口拓扑 

举例 :CALCulate1:DTOPology SB,1,2,3 

:CALCulate1:DTOPology? 

Return: SB,1,2,3 

 

3.10 Power 命令子系统 

3.10.1 功率 

3.10.1.1 命令列表 

RF激励信号输出开关 :OUTPut[:STATe] 

通道功率电平 :SOURce<cnum>:POWer[:LEVel][:IMMediate][:AMPLitude] 

功率扫描起始功率 :SOURce<cnum>:POWer:STARt 

功率扫描终止功率 :SOURce<cnum>:POWer:STOP 

 

3.10.1.2 RF激励信号输出开关 

命令格式 :OUTPut[:STATe] <bool> 

:OUTPut[:STATe]? 

说明 设置/获取激励信号输出的状态。 

参数 <bool>:= ON|OFF|1|0 

返回类型 Boolean (1=ON,0=OFF) 

默认值 ON 

菜单项 功率 > RF 功率 

举例 :OUTPut 0 

:OUTPut? 

Return: 0 

 



 

 

3.10.1.3 通道功率电平 

命令格式 :SOURce<cnum>:POWer[:LEVel][:IMMediate][:AMPLitude] <numeric> 

:SOURce<cnum>:POWer[:LEVel][:IMMediate][:AMPLitude]? 

说明 设置或获取当前通道功率电平值。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<numeric>:表示功率电平值。 

返回类型 浮点型，单位 dBm 

默认值 0 

菜单项 功率 > 功率 > 功率电平 

举例 :SOURce1:POWer -5 

:SOURce1:POWer? 

Return: -5 

 

3.10.1.4 功率扫描起始功率 

命令格式 :SOURce<cnum>:POWer:STARt <numeric> 

:SOURce<cnum>:POWer:STARt? 

说明 设置或获取功率扫描的起始功率值。 

参数 
<cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<numeric>:表示起始功率值。 

返回类型 浮点型，单位 dBm 

默认值 0 

菜单项 功率 > 端口功率 > 起始功率 

举例 :SOURce1:POWer:STARt 5 

:SOURce1:POWer:STARt? 

Return: 5 

 

3.10.1.5 功率扫描终止功率 

命令格式 :SOURce<cnum>:POWer:STOP <numeric> 

:SOURce<cnum>:POWer:STOP? 

说明 设置或获取功率扫描的终止功率值。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<numeric>:表示终止功率值。 

返回类型 浮点型，单位 dBm 

默认值 0 
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菜单项 功率 > 端口功率 > 终止功率 

举例 :SOURce1:POWer:STOP -5 

:SOURce1:POWer:STOP? 

Return: -5 

 

3.10.2 端口功率 

3.10.2.1 命令列表 

功率耦合状态 :SOURce<cnum>:POWer:PORT:COUPle 

端口功率电平 :SOURce<cnum>:POWer:PORT<pnum>[:LEVel][:IMMediate][:AMPLitude] 

 

3.10.2.2 功率耦合状态 

命令格式 :SOURce<cnum>:POWer:PORT:COUPle <bool> 

:SOURce<cnum>:POWer:PORT:COUPle? 

说明 设置或获取选择通道功率耦合开关状态。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<bool>:= ON|OFF|1|0 

返回类型 Boolean (1=ON,0=OFF) 

默认值 ON 

菜单项 功率 > 端口功率> 端口功率耦合 

举例 :SOURce1:POWer:PORT:COUPle OFF 

:SOURce1:POWer:PORT:COUPle? 

Return: 0 

 

3.10.2.3 端口功率电平 

命令格式 :SOURce<cnum>:POWer:PORT<pnum>[:LEVel][:IMMediate][:AMPLitude] 
<numeric> 

 

:SOURce<cnum>:POWer:PORT<pnum>[:LEVel][:IMMediate][:AMPLitude]? 

说明 设置或获取所选通道和端口的功率电平值。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<pnum>:={[1]-4}，表示端口号。 

<numeric>:表示功率电平值。 

返回类型 浮点型，单位 dBm 



 

 

默认值 0 

菜单项 功率 > 端口功率 > 功率电平 

举例 :SOURce1:POWer:PORT1 -5 

:SOURce1:POWer:PORT1? 

Return: -5 

 

3.10.3 偏移/限制 

3.10.3.1 命令列表 

通道斜率开关 :SOURce<cnum>:POWer[:LEVel]:SLOPe:STATe 

通道功率斜率 :SOURce<cnum>:POWer[:LEVel]:SLOPe[:DATA] 

功率极限测试状态设置 :SYSTem:POWer<pnum>:LIMit:STATe 

功率极限测试值 :SYSTem:POWer<pnum>:LIMit 

 

3.10.3.2 通道斜率开关 

命令格式 :SOURce<cnum>:POWer[:LEVel]:SLOPe:STATe <bool> 

:SOURce<cnum>:POWer[:LEVel]:SLOPe:STATe? 

说  明 设置或获取当前通道功率变化开关。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<bool>:= ON|OFF|1|0 

返回类型 Boolean (1=ON,0=OFF) 

默认值 OFF 

菜单项 功率 > 偏移/限制 > 斜率开关 

举例 :SOURce1:POWer:SLOPe:STATe ON 

:SOURce1:POWer:SLOPe:STATe? 

Return: 1 

 

3.10.3.3 通道功率斜率 

命令格式 :SOURce<cnum>:POWer[:LEVel]:SLOPe[:DATA] <numeric> 

:SOURce<cnum>:POWer[:LEVel]:SLOPe[:DATA]? 

说明 设置或获取当前通道功率斜率。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<numeric>:表示功率斜率，其范围是-2dB~2dB。 

返回类型 浮点型，单位 dB/GHz 
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默认值 0 

菜单项 功率 > 偏移/限制 > 坡度 

举例 :SOURce1:POWer:SLOPe -1 

:SOURce1:POWer:SLOPe? 

Return: -1 

 

3.10.3.4 功率极限测试状态设置 

命令格式 :SYSTem:POWer<pnum>:LIMit:STATe <bool> 

:SYSTem:POWer<pnum>:LIMit:STATe? 

说明 设置或获取指定端口功率极限测试的状态。 

参数 <pnum>:={[1]|2|3|4}，表示端口号。 

<bool>:= ON|OFF|1|0 

返回类型 Boolean (1=ON,0=OFF) 

默认值 OFF 

菜单项 功率 > 电平及偏移 > 极限使能 

举例 :SYSTem:POWer1:LIMit:STATe ON 

:SYSTem:POWer1:LIMit:STATe? 

Return: 1 

 

3.10.3.5 功率极限测试值 

命令格式 :SYSTem:POWer<pnum>:LIMit <numeric> 

:SYSTem:POWer<pnum>:LIMit? 

说明 设置或获取指定端口功率极限测试的极限值。 

参数 
<pnum>:={[1]|2|3|4}，表示端口号。 

<numeric>:表示极限值，其范围是-1000~1000dB。 

返回类型 浮点型，单位 dB 

默认值 0 

菜单项 功率 > 电平及偏移 > 极限 

举例 :SYSTem:POWer1:LIMit 10 

:SYSTem:POWer1:LIMit? 

Return: 10 

 



 

 

3.11 SaveRecall 命令子系统 

3.11.1 调用 

3.11.1.1 命令列表 

调用.cal 文件 :MMEMory:LOAD:CORRection 

调用.csa文件 :MMEMory:LOAD:CSARchive 

调用指定文件 :MMEMory:LOAD[:STATe] 

 

3.11.1.2 调用.cal文件 

命令格式 :MMEMory:LOAD:CORRection <string> 

说明 调用指定的 Cal 文件。 

参数 <string>:表示校准文件，其范围少于 255 个字符。 

返回类型 无 

默认值 无 

菜单项 保存/调用 > 调用 > 调用校准数据… 

举例 :MMEMory:LOAD:CORRection "local/test.cal" 

 

3.11.1.3 调用.csa文件 

命令格式 :MMEMory:LOAD:CSARchive <string> 

说明 调用指定的状态+校准数据文件（即*.csa文件）。 

参数 <string>:表示状态+校准数据文件，其范围少于 255个字符。 

返回类型 无 

默认值 无 

菜单项 保存/调用 > 调用 > 调用状态+校准数据… 

举例 :MMEMory:LOAD "local/test.csa" 

 

3.11.1.4 调用指定文件 

命令格式 :MMEMory:LOAD[:STATe] <string> 

说明 调用指定的系统状态文件。支持调用*.sta，*.csa和*.cal 状态文件。 

参数 <string>:表示系统状态文件，其范围少于 255个字符。 
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返回类型 无 

默认值 无 

菜单项 保存/调用 > 调用 >文件浏览 

举例 

:MMEMory:LOAD "local/test.sta" 

:MMEMory:LOAD "local/test.csa" 

:MMEMory:LOAD "local/test.cal" 

 

3.11.2 保存状态 

3.11.2.1 命令列表 

存储.csa文件 :MMEMory:STORe:CSARchive 

存储指定文件 :MMEMory:STORE[:STATe] 

 

3.11.2.2 存储.csa文件 

命令格式 :MMEMory:STORe:CSARchive <string> 

说明 保存指定的状态+校准数据文件（即*.csa文件）。 

参数 <string>:表示状态+校准数据文件，其范围少于 255个字符。 

返回类型 无 

默认值 无 

菜单项 保存/调用 > 保存状态 > 保存状态为… 

举例 :MMEMory:STORe:CSARchive "local/test.csa" 

 

 

3.11.2.3 存储指定文件 

命令格式 :MMEMory:STORE[:STATe] <string> 

说明 存储指定的系统状态文件。支持存储.sta，.csa 和.cal 状态文件。如果已经存在与指

定文件名相同的文件，则会重写其内容。 

参数 <string>:表示系统状态文件，其范围少于 255个字符。 

返回类型 无 

默认值 无 

菜单项 保存/调用 > 保存其他 > 保存校准数据… 



 

 

保存/调用 > 保存状态 > 保存状态为… 

举例 

:MMEMory:STORE "local/test.cal" 

:MMEMory:STORE "local/test.csa" 

:MMEMory:STORE "local/test.sta"  

 

3.11.3 调用迹线数据 

3.11.3.1 命令列表 

使用 CSV 文件加载极限数据 :MMEMory:LOAD:CSV 

使用 SNP 文件加载极限数据 :MMEMory:LOAD:SNP 

将 CSV 文件加载到特定迹线 :MMEMory:LOAD:CSV:TRACe 

将 SNP 文件加载到特定迹线 :MMEMory:LOAD:SNP:TRACe<tnum> 

调用迹线数据差值状态 :MMEMory:LOAD:DATA:INTerpolate[:STATe] 

 

3.11.3.2 使用 CSV文件加载极限数据 

命令格式 :MMEMory:LOAD:CSV <string> 

说明 将 CSV 文件加载到当前通道 

参数 <string>表示文件名称 

返回类型 无 

默认值 无 

菜单项 保存调用 >调用数据 >调用数据 

举例 :MMEMory:LOAD:CSV "local/ trace3.csv" 

 

3.11.3.3 使用 SNP文件加载极限数据 

命令格式 :MMEMory:LOAD:SNP <string> 

说明 将 SNP 文件加载到当前通道 

参数 <string>表示文件名称 

返回类型 无 

默认值 无 

菜单项 保存调用 >调用数据 >调用数据 

举例 :MMEMory:LOAD:SNP "local/01.s2p" 
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3.11.3.4 将 CSV文件加载到特定迹线 

命令格式 :MMEMory:LOAD:CSV:TRACe<tnum> <string> 

说明 将 CSV 文件加载到特定迹线 

参数 <tnum>表示选中的迹线 

<string>表示文件名称 

返回类型 无 

默认值 无 

菜单项 保存调用 >调用数据 >调用数据 

举例 :MMEMory:LOAD:CSV:TRACe2 "local/trace3.csv" 

 

3.11.3.5 将 SNP文件加载到特定迹线 

命令格式 :MMEMory:LOAD:SNP:TRACe<tnum> <string> 

说明 将 SNP 文件加载到特定迹线 

参数 <tnum>表示特定迹线编号 

<string>表示文件名称 

返回类型 无 

默认值 无 

菜单项 保存调用 >调用数据 >调用数据 

举例 :MMEMory:LOAD:SNP:TRACe2 "local/01.s2p" 

 

3.11.3.6 调用迹线数据差值状态 

命令格式 
:MMEMory:LOAD:DATA:INTerpolate[:STATe] <bool> 

:MMEMory:LOAD:DATA:INTerpolate[:STATe]? 

说明 设置文件调用功能是否进行插值 

参数 <bool>:= ON|OFF|1|0 

返回类型 Boolean (1=ON,0=OFF) 

默认值 ON 

菜单项 保存调用 >调用数据 > Interpolation 

举例 

:MMEMory:LOAD:DATA:INTerpolate OFF 

:MMEMory:LOAD:DATA:INTerpolate:STATe? 

Return 0  

 



 

 

3.11.4 保存迹线数据 

3.11.4.1 命令列表 

设置或获取数据格式 :MMEMory:STORe:CSV:FORMat 

保存当前选中迹线数据 :MMEMory:STORe:CSV [:DATA] 

根据迹线编号保存数据 :MMEMory:STORe:CSV:TRACes[:DATA] 

查询 SNP 数据 :CALCulate<cnum>[:MEASure]:DATA:SNP 

S 参数查询 SNP 数据 :CALCulate<cnum>[:MEASure]:DATA:SNP:PORTs 

保存 SNP 数据 :CALCulate<cnum>[:MEASure]:DATA:SNP:PORTs:SAVE 

 

3.11.4.2 设置或获取数据格式 

命令格式 
:MMEMory:STORe:CSV:FORMat <type> 

:MMEMory:STORe:CSV:FORMat? 

说明 此命令用于设置/获取数据格式，将工作通道的测量数据保存到 CSV 格式的文件中。 

注，对应的 SNP 命令将 MA 修改为线性幅度，DB 修改为对数幅度。 

参数 <type>:={AUTO|MA|DB|RI|DISPlayed} 

"AUTO" ：根据活动迹线的显示格式自动指定数据格式。 

"MA" ：指定数据格式"线性幅度 > 角度"。 

"DB" ：指定数据格式"对数幅度 > 角度"。 

"RI" ：指定数据格式"实部 > 虚部"。 

" DISPlayed ":根据当前数据格式保存数据。 

返回类型 字符串 

默认值 AUTO 

菜单项 保存/调用  > 保存数据 >CSV 格式 

举例 

:MMEMory:STORe:CSV:FORMat MA 

:MMEMory:STORe:CSV:FORMat? 

Return: MA  

 

3.11.4.3 保存当前选中迹线数据 

命令格式 :MMEMory:STORe:CSV [:DATA] <string> 

说明 保存当前选中迹线数据。 

参数 <string>表示文件名称 

返回类型 无 
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默认值 无 

菜单项 保存调用 >保存数据 >保存迹线数据 

举例 :MMEMory:STORe:CSV "local/tmp.csv"  

 

 

3.11.4.4 根据迹线编号保存数据 

命令格式 :MMEMory:STORe:CSV:TRACes[:DATA] <string1>,<string2> 

说明 根据迹线编号保存数据 

参数 <string1>表示迹线编号列表 

<string2>表示文件路径 

返回类型 无 

默认值 无 

菜单项 保存调用 >保存数据 >保存多条迹线 

举例 :MMEMory:STORe:CSV:TRACes "2,3","local/tmp.csv" 

 

3.11.4.5 查询 SNP数据 

命令格式 :CALCulate<cnum>[:MEASure]:DATA:SNP?<num> 

说明 查询 SNP 数据。 

参数 <cnum>通道编号 

<num>,参数范围为 1~4 

返回类型 字符串 

默认值 无 

菜单项 无 

举例 

:CALCulate1:MEASure:DATA:SNP? 1 

Return: 1.000000000000e+05,8.500000000000e+09,-2.517962752291e-01,-
8.413169797246e+00,-1.795121308191e+02,-1.373235865870e+02 

 

3.11.4.6 S参数查询 SNP数据 

命令格式 :CALCulate<cnum>[:MEASure]:DATA:SNP:PORTs?<string> 

说明 查询 SNP 数据。此命令仅用于对 S 参数测量。 

参数 <cnum>,通道编号 



 

 

<string>,端口编号 

返回类型 字符串 

默认值 无 

菜单项 无 

举例 

:CALCulate1:MEASure:DATA:SNP:PORTs? "1" 

Return: 1.000000000000e+05,8.500000000000e+09,-2.245324021131e-01,-
8.419927767910e+00,-1.795215338430e+02,-1.376447999678e+02 

 

3.11.4.7 保存 SNP数据 

命令格式 :CALCulate<cnum>[:MEASure]:DATA:SNP:PORTs:SAVE<string1>,<string2>{,type} 

说明 保存 SNP 数据。 

参数 <cnum>通道编号 

<string1>,端口编号 

<string2>,保存文件名 

<type>:={AUTO|MA|DB|RI} 

"AUTO" ：根据活动迹线的显示格式自动指定数据格式。 

"MA" ：指定数据格式"线性幅度 > 角度"。 

"DB" ：指定数据格式"对数幅度 > 角度"。 

"RI" ：指定数据格式"实部 > 虚部"。 

返回类型 无 

默认值 无 

菜单项 保存/调用  > 保存数据 >保存 SnP 

举例 :CALCulate1:DATA:SNP:PORTs:SAVE "1","local/sdh.s1p",DB 

 

 

3.11.5 保存其它 

3.11.5.1 命令列表 

屏幕截图 :MMEMory:STORe:IMAGe 

存储.cal 文件 :MMEMory:STORe:CORRection 

存储格式化数据 :MMEMory:STORe:FDATa 

读写文件数据 :MMEMory:TRANsfer 
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SNP 文件格式 :MMEMory:STORe:SNP:FORMat 

保存 SNP 文件 :MMEMory:STORe:SNP[:DATA] 

S1P 文件保存的端口号 :MMEMory:STORe:SNP:TYPE:S1P 

S2P 文件保存的端口号 :MMEMory:STORe:SNP:TYPE:S2P 

S3P 文件保存的端口号 :MMEMory:STORe:SNP:TYPE:S3P 

S4P 文件保存的端口号 :MMEMory:STORe:SNP:TYPE:S4P 

 

3.11.5.2 屏幕截图 

命令格式 :MMEMory:STORe:IMAGe <string> 

说明 将 LCD 屏幕上的显示图像保存到位图格式（扩展名为".bmp"）或便携网络图形格式

（扩展名为".png"）或 JPEG 文件交换格式（扩展名为".jpg"）的文件中。 

参数 <string>:表示图像格式文件，其范围 255 个字符或更少。 

返回类型 无 

默认值 无 

菜单项 保存/调用  > 保存其它 > 截屏… 

举例 :MMEMory:STORe:IMAGe "local/test.bmp" 

 

3.11.5.3 存储.cal文件 

命令格式 :MMEMory:STORe:CORRection <string> 

说明 保存校准数据到文件。 

参数 <string>:表示校准文件，其范围少于 255 个字符。 

返回类型 无 

默认值 无 

菜单项   保存/调用  > 保存其它 > 保存校准数据… 

举例 :MMEMory:STORe:CORRection "local/test.cal" 

 

3.11.5.4 存储格式化数据 

命令格式 :MMEMory:STORe:FDATa <string> 

说明 存储活动迹线的格式化数据阵列。如果已经存在与指定文件名相同的文件，则会重

写其内容。 



 

 

参数 <string>:表示格式化数据文件(*.CSV)。 

返回类型 无 

默认值 无 

菜单项 保存/调用  > 保存其它> 保存迹线数据 

举例 :MMEMory:STORe:FDATa "local/test.csv" 

3.11.5.5 读写文件数据 

命令格式 :MMEMory:TRANsfer <string>,<block> 

:MMEMory:TRANsfer? 

说明 将数据写入文件或从文件读取数据。 

参数 <string>:表示文件名。 

<block>:表示文件内容。（块数据的格式举例：#212ABCDEF123456，数据以#开

头，紧接着的 2 指定字节数为两位数， 12 指定后面的数据字节数，

ABCDEF123456 代表 12 位数据。） 

返回类型 文件内容 

默认值 无 

菜单项 无 

举例 :MMEMory:TRANsfer? "local/test.csv" 

Return: #592939"# Channel\s1" "#\sTrace 2" Frequency,Formatted 
Data,Formatted Data 1.000000000000e+05, 

-7.710605710955e-02,2.403043541994e-01 2.912437500000e+06, 

 

3.11.5.6 SNP文件格式 

命令格式 :MMEMory:STORe:SNP:FORMat <type> 

:MMEMory:STORe:SNP:FORMat? 

说明 此命令用于设置/获取数据格式，然后将工作通道的测量数据保存到标准格式的文件

中。 

参数 <type>:={AUTO|MA|DB|RI} 

"AUTO" ：根据活动迹线的显示格式自动指定数据格式。 

"MA" ：指定数据格式"对数幅度 > 角度"。 

"DB" ：指定数据格式"线性幅度 > 角度"。 

"RI" ：指定数据格式"实部 > 虚部"。 

返回类型 字符串 

默认值 AUTO 
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菜单项 保存/调用  > 保存其它 > SnP 格式 

举例 :MMEMory:STORe:SNP:FORMat MA 

:MMEMory:STORe:SNP:FORMat? 

Return: MA 

 

3.11.5.7 保存 SNP文件 

命令格式 :MMEMory:STORe:SNP[:DATA] <string> 

说明 将工作通道的测量数据保存到标准格式的文件。在保存文件之前，您需要指定文件

格式和文件类型。文件类型不同扩展名也不同，如下所示： 

.s1p:指定 1 个端口 

.s2p:指定 2 个端口 

.s3p:指定 3 个端口 

.s4p:指定 4 个端口 

参数 <string>:表示 SNP 文件，其范围 255 个字符或更少。 

返回类型 无 

默认值 无 

菜单项 保存/调用> 保存其它 > 保存 SnP 文件 

举例 :MMEMory:STORe:SNP:TYPE:S2P 2,3 

:MMEMory:STORe:SNP "local/test.s2p" 

 

3.11.5.8 S1P文件保存的端口号 

命令格式 :MMEMory:STORe:SNP:TYPE:S1P <pnum> 

:MMEMory:STORe:SNP:TYPE:S1P? 

说明 此命令用于当把工作通道的测量数据保存到标准格式的文件中时，此命令为该文件

类型设置/获取指定的端口（1端口）。 

参数 <pnum>:={1~4}，表示端口号。 

返回类型 整型 

默认值 1 

菜单项 无 

举例 :MMEMory:STORe:SNP:TYPE:S1P 2 

:MMEMory:STORe:SNP:TYPE:S1P? 

Return: 2 

 



 

 

3.11.5.9 S2P文件保存的端口号 

命令格式 :MMEMory:STORe:SNP:TYPE:S2P <pnum1>,<pnum2> 

:MMEMory:STORe:SNP:TYPE:S2P? 

说明 此命令用于当把工作通道的测量数据保存到标准格式的文件中时，此命令为该文件

类型设置/获取指定的端口（2端口）。 

参数 <pnum1>:={1~4}，表示端口号。 

<pnum2>:={1~4}，表示另一个端口号。 

返回类型 数据数组 

默认值 1，2 

菜单项 无 

举例 :MMEMory:STORe:SNP:TYPE:S2P 2,3 

:MMEMory:STORe:SNP:TYPE:S2P? 

Return: 2,3 

 

3.11.5.10 S3P文件保存的端口号 

命令格式 :MMEMory:STORe:SNP:TYPE:S3P <pnum1>,<pnum2>,<pnum3> 

:MMEMory:STORe:SNP:TYPE:S3P? 

说明 此命令用于当把工作通道的测量数据保存到标准格式的文件中时，此命令为该文件

类型设置/获取指定的端口（3端口）。 

参数 <pnum1>:={1~4}，表示端口号。 

<pnum2>:={1~4}，表示端口号。 

<pnum3>:={1~4}，表示端口号。 

各端口不能重复。 

返回类型 数据数组 

默认值 1，2，3 

菜单项 无 

举例 :MMEMory:STORe:SNP:TYPE:S3P 2,3,4 

:MMEMory:STORe:SNP:TYPE:S3P? 

Return: 2,3,4 

 

3.11.5.11 S4P文件保存的端口号 

命令格式 :MMEMory:STORe:SNP:TYPE:S4P <pnum1>,<pnum2>,<pnum3>,<pnum4> 

:MMEMory:STORe:SNP:TYPE:S4P? 

说明 此命令用于当把工作通道的测量数据保存到标准格式的文件中时，此命令为该文件
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类型设置/获取指定的端口（4端口）。 

参数 <pnum1>:={1~4}，表示端口号。 

<pnum2>:={1~4}，表示端口号。 

<pnum3>:={1~4}，表示端口号。 

<pnum4>:={1~4}，表示端口号。 

各端口不能重复。 

返回类型 数据数组 

默认值 1，2，3，4 

菜单项 无 

举例 :MMEMory:STORe:SNP:TYPE:S4P 1,2,3,4 

:MMEMory:STORe:SNP:TYPE:S4P? 

Return: 1,2,3,4 

 

3.11.6 文件浏览 

3.11.6.1 命令列表 

切换当前工作目录 :MMEMory:CDIRectory 

创建文件夹 :MMEMory:MDIRectory 

删除文件夹 :MMEMory:RDIRectory 

重命名文件 :MMEMory:MOVE 

查询目录中的文件 :MMEMory:CATalog[:<type>]? [<string >] 

复制文件 :MMEMory:COPY 

删除文件 :MMEMory:DELete 

查询文件保存日期 :MMEMory:DATE? 

查询文件保存时间 :MMEMory:TIME? 

 

3.11.6.2 切换当前工作目录 

命令格式 :MMEMory:CDIRectory <string> 

:MMEMory:CDIRectory? 

说明 切换或查询当前工作目录。默认工作目录为"/",常用工作目录为"/local"。如果要切换

的工作目录文件夹与默认工作目录不在同层级，请在文件夹名称前使用斜杆(/)并用



 

 

双引号括起来，例如"/local/NewFolder" 

参数 <string>:表示工作目录，其范围少于 255 个字符。 

返回类型 字符串 

默认值 "/" 

菜单项 保存/调用 > 文件浏览器...  

举例 没有插入外部 U 盘时，只有常用的"/local"目录，进入 local 目录下的某个文件夹的

示例如下： 

:MMEMory:CDIRectory "/local/NewFolder" 

:MMEMory:CDIRectory? 

Return :"/local/NewFolder" 

 

当有外部 U 盘插入时，工作目录会有"/local"，"/U-disk0"，进入 U 盘目录某个文件

夹的示例如下： 

:MMEMory:CDIRectory "/U-disk0/NewFolder" 

:MMEMory:CDIRectory? 

Return :"/ U-disk0/NewFolder" 

 

3.11.6.3 创建文件夹 

命令格式 :MMEMory:MDIRectory <string> 

说明 创建文件夹 

参数 <string>:表示文件夹目录，其范围少于 255 个字符。 

返回类型 无 

默认值 无 

菜单项 保存/调用 > 文件浏览器...  

举例 在 local 目录下创建一个文件夹名称为"123"的文件夹。 

:MMEMory:MDIRectory "/local/123" 

 

当插外部 U 盘时，在 U 盘目录下创建一个文件夹名称为"456"的文件夹。 

:MMEMory:MDIRectory "/U-disk0/456" 

 

3.11.6.4 删除文件夹 

命令格式 :MMEMory:RDIRectory <string> 

说明 删除文件夹 

参数 <string>:表示文件夹目录，其范围少于 255 个字符。 
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返回类型 无 

默认值 无 

菜单项 保存/调用 > 文件浏览器...  

举例 在 local 目录下删除一个文件夹名称为"123"的文件夹。 

:MMEMory:RDIRectory "/local/123" 

 

当插外部 U 盘时，在 U 盘目录下删除一个文件夹名称为"456"的文件夹。 

:MMEMory:RDIRectory "/U-disk0/456" 

 

3.11.6.5 重命名文件 

命令格式 :MMEMory:MOVE <string1>,<string2> 

说明 重命名文件名称，文件名称要指定扩展名。 

参数 <string1>,<string2>:表示文件名称，其范围少于 255 个字符。 

返回类型 无 

默认值 无 

菜单项 保存/调用  > 文件浏览... > 重命名 

举例 在 local 目录下把"12.csv"文件重命名为"34.csv" 

:MMEMory: MOVE "/local/123.csv",/local/789.csv" 

 

当插外部 U 盘时，在 U 盘目录下把"11.csv"文件重命名为"22.csv" 

:MMEMory:MOVE "/U-disk0/11.csv",/local/22.csv" 

 

3.11.6.6 查询目录中的文件 

命令格式 :MMEMory:CATalog[:<type>]? [<string>] 

说明 查询指定目录下的文件，如果未指定文件类型和文件夹名称，表示查询当前目录下

所有文件 

参数 <type>:字符串,表示指定文件类型，可选类型参数有： 

STATe|STA 查询目录中的*.sta 文件 

CORRection|CAL  查询目录中的*.cal 文件 

CSARchive|CSA 查询目录中的*.csa文件 

CSV 查询目录中的*.csv文件 

DIRectory 查询目录中的文件夹 



 

 

<string>:表示带有双引号括起来的文件夹路径字符串，其范围少于 255个字符。 

返回类型 字符串（以逗号隔开的文件列表） 

默认值 无 

菜单项 保存/调用 > 文件浏览器...  

举例 1、查询 local 根目录下所有文件； 

:MMEMory:CATalog? "/local" 

2、查询 U 盘根目录下所有文件； 

:MMEMory:CATalog? "/U-disk0" 

3、查询 local 下"Test"文件夹里头".CSV"格式的所有文件。 

:MMEMory:CATalog:CSV? "/local/Test" 

 

3.11.6.7 复制文件 

命令格式 :MMEMory:COPY <string1>,<string2> 

说明 这个命令用于复制文件。如果指定的复制源文件不存在，执行时就会出错，并忽略

对象。注意，如果存在与指定的复制目的文件名相同的文件，重写其内容。 

参数 <string1>,<string2>:表示文件名称，其范围少于 255 个字符。 

返回类型 无 

默认值 无 

菜单项 无 

举例 :MMEMory:COPY "local/test1.csv","local/test2.csv" 

 

3.11.6.8 删除文件 

命令格式 :MMEMory:DELete <string> 

说明 这个命令删除当前文件或目录（文件夹）。如果指定的文件或目录不存在，执行时

就会出错，并忽略对象。 

参数 <string>:表示文件名称，其范围少于 255 个字符。 

返回类型 无 

默认值 无 

菜单项 无 

举例 :MMEMory:DELete "local/test1.csv" 
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3.11.6.9 查询文件保存日期 

命令格式 :MMEMory:DATE? <string> 

说明 查询文件最后的保存日期，返回"年，月，日"。 

参数 <string>:字符串，表示带有双引号括起来的文件路径名称。 

返回类型 逗号隔开的整数 

默认值 无 

菜单项 保存/调用 > 文件浏览器...  

举例 查询 local 目录下文件名为"123.csv"的保存日期。 

:MMEM:DATE? "/local/123.csv" 

Return : 2022,11,5 

 

3.11.6.10 查询文件保存时间 

命令格式 :MMEMory:TIME? <string> 

说明 查询文件最后的保存日期，返回"时，分，秒"。 

参数 <string>:字符串，表示带有双引号括起来的文件路径名称。 

返回类型 逗号隔开的整数 

默认值 无 

菜单项 保存/调用 > 文件浏览器...  

举例 查询 local 目录下文件名为"123.csv"的保存时间。 

:MMEM:TIME? "/local/123.csv" 

Return : 15,55,34 

 

3.12 Scale 命令子系统 

3.12.1 刻度 

3.12.1.1 命令列表 

打开迹线刻度自动调整功能 :DISPlay:WINDow<wnum>:TRACe<tnum>:Y[:SCALe]:AUTO 

打开所有迹线自动调整功能 :DISPlay:WINDow<wnum>:Y:AUTO 

刻度值 :DISPlay:WINDow<wnum>:TRACe<tnum>:Y[:SCALe]:PDIVision 

参考值 :DISPlay:WINDow<wnum>:TRACe<tnum>:Y[:SCALe]:RLEVel 



 

 

参考位置 :DISPlay:WINDow<wnum>:TRACe<tnum>:Y[:SCALe]:RPOSition 

 

3.12.1.2 打开迹线刻度自动调整功能 

命令格式 :DISPlay:WINDow<wnum>:TRACe<tnum>:Y[:SCALe]:AUTO 

说明 打开指定迹线的刻度自动调整功能 

参数 <wnum>:={[1]-36}，表示测量窗口号，如果未指定，则<wnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

返回类型 无 

默认值 无 

菜单项 刻度 > 自动调整 

举例 :DISPlay:WINDow1:TRACe2:Y:AUTO 

 

3.12.1.3 打开所有迹线自动调整功能 

命令格式 :DISPlay:WINDow<wnum>:Y:AUTO 

说明 打开全部迹线的自动调整功能 

参数 <wnum>:={[1]-36}，表示测量窗口号，如果未指定，则<wnum>默认设置 1。 

返回类型 无 

默认值 无 

菜单项 刻度 > 自动调整所有迹线 

举例 :DISPlay:WINDow1:Y:AUTO 

 

3.12.1.4 刻度值 

命令格式 :DISPlay:WINDow<wnum>:TRACe<tnum>:Y[:SCALe]:PDIVision <numeric> 

:DISPlay:WINDow<wnum>:TRACe<tnum>:Y[:SCALe]:PDIVision? 

说  明 设置或获取迹线每格的刻度(数据的大小及单位随设置的数据格式而变化) 

参数 <wnum>:={[1]-36}，表示测量窗口号，如果未指定，则<wnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

<numeric>:表示迹线每格的刻度，浮点型，单位随数据格式变化。 

对数幅值：dB（十进制） 

相位、扩展相位或正相位：°（度） 
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群延迟：s（秒） 

其它：无单位 

返回类型 浮点型 

默认值 随数据格式变化。 

对数幅度：10 

相位、扩展相位或正相位：90 

群延迟：1E-8 

Smith图表或极坐标或驻波比：1 

线性幅度：0.1 

实或虚：0.2 

菜单项 刻度 > 刻度/格 

举例 :DISPlay:WINDow1:TRACe1:Y:PDIVision 10 

:DISPlay:WINDow1:TRACe1:Y:PDIVision? 

Return: 10 

 

3.12.1.5 参考值 

命令格式 :DISPlay:WINDow<wnum>:TRACe<tnum>:Y[:SCALe]:RLEVel <numeric> 

:DISPlay:WINDow<wnum>:TRACe<tnum>:Y[:SCALe]:RLEVel? 

说  明 设置或获取迹线参考格线的值(数据的大小及单位随设置的数据格式而变化) 

参数 <wnum>:={[1]-36}，表示测量窗口号，如果未指定，则<wnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

<numeric>:表示迹线参考格线的值，浮点型，单位随数据格式变化。 

对数幅度(MLOG)：dB (十进制) 

相位(PHAS)、扩展相位(UPH)或正相位(PPH)：°(度) 

群延迟(GDEL)：s(秒) 

其它：无单位 

返回类型 浮点型 

默认值 0 

菜单项 刻度> 参考值 

举例 :DISPlay:WINDow1:TRACe1:Y:RLEVel 5 

:DISPlay:WINDow1:TRACe1:Y:RLEVel?  

Return: 5 

 



 

 

3.12.1.6 参考位置 

命令格式 :DISPlay:WINDow<wnum>:TRACe<tnum>:Y[:SCALe]:RPOSition <numeric> 

:DISPlay:WINDow<wnum>:TRACe<tnum>:Y[:SCALe]:RPOSition? 

说  明 设置或获取迹线参考位置的值 

参数 <wnum>:={[1]-36}，表示测量窗口号，如果未指定，则<wnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

<numeric>:表示迹线参考位置的值，其范围为 0 到指定的格数。 

返回类型 整型 

默认值 5 

菜单项 刻度> 参考位置 

举例 :DISPlay:WINDow1:TRACe1:Y:RPOSition 6 

:DISPlay:WINDow1:TRACe1:Y:RPOSition? 

Return: 6 

 

3.12.2 电延时 

3.12.2.1 命令列表 

电时延 :CALCulate<cnum>:TRACe<tnum>:CORRection:EDELay:TIME 

电时延距离 :CALCulate<cnum>:MEASure<tnum>:CORRection:EDELay:DISTance 

电时延距离单位 :CALCulate<cnum>:MEASure<tnum>:CORRection:EDELay:UNIT 

速度因数 :SENSe<cnum>:CORRection:RVELocity:COAX 

 

3.12.2.2 电时延 

命令格式 :CALCulate<cnum>[:SELected]:CORRection:EDELay:TIME <numeric> 

:CALCulate<cnum>[:SELected]:CORRection:EDELay:TIME? 

:CALCulate<cnum>:TRACe<tnum>:CORRection:EDELay:TIME <numeric> 

:CALCulate<cnum>:TRACe<tnum>:CORRection:EDELay:TIME? 

说明 设置或获取激活迹线的时延值 

设置或获取选择通道及迹线的时延值 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1 

<numeric>:表示时延值，其范围是-10~10。 

返回类型 浮点型，单位 s（秒） 
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默认值 0 

菜单项 刻度 > 电时延 > 时间 

举例 :CALCulate1:CORRection:EDELay:TIME 1 

:CALCulate1:CORRection:EDELay:TIME? 

Return: 1 

 

:CALCulate1:TRACe1:CORRection:EDELay:TIME 2 

:CALCulate1:TRACe1:CORRection:EDELay:TIME? 

Return: 2 

 

3.12.2.3 电时延距离 

命令格式 :CALCulate<cnum>:MEASure<tnum>:CORRection:EDELay:DISTance 
<numeric> 

:CALCulate<cnum>:MEASure<tnum>:CORRection:EDELay:DISTance? 

说明 设置或获取选择通道及迹线的时延距离 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1 

<numeric>:表示时延距离。 

返回类型 浮点型，单位米、英寸或英尺 

默认值 0 

菜单项 刻度 > 电时延 > 电时延距离 

举例 :CALCulate1:MEASure1:CORRection:EDELay:DISTance 1 

:CALCulate1:MEASure1:CORRection:EDELay:DISTance? 

Return: 1 

 

3.12.2.4 电时延距离单位 

命令格式 :CALCulate<cnum>:MEASure<tnum>:CORRection:EDELay:UNIT <type> 

:CALCulate<cnum>:MEASure<tnum>:CORRection:EDELay:UNIT? 

说明 设置或获取选择通道及迹线的时延距离单位 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1 

<type>: {METer|FEET|INCH} 

返回类型 枚举 

默认值 METer 

菜单项 刻度 > 电时延 > 电时延距离单位 



 

 

举例 :CALCulate1:MEASure1:CORRection:EDELay:UNIT INCH 

:CALCulate1:MEASure1:CORRection:EDELay:UNIT? 

Return: INCH 

 

3.12.2.5 速度因数 

命令格式 :SENSe<cnum>:CORRection:RVELocity:COAX <numeric> 

:SENSe<cnum>:CORRection:RVELocity:COAX? 

说明 设置或获取插入设备的电时延速度系数。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。

<numeric>:表示电时延速度系数，其范围是 0~1。 

返回类型 浮点型 

默认值 1 

菜单项 刻度 > 电时延 > 速度系数 

举例 :SENSe1:CORRection:RVELocity:COAX 0.5 

:SENSe1:CORRection:RVELocity:COAX? 

Return: 0.5 

 

3.12.3 常数 

3.12.3.1 命令列表 

系统阻抗 :SENSe:CORRection:IMPedance[:INPut][:MAGNitude] 

相位偏移 :CALCulate<cnum>:TRACe<tnum>:CORRection:OFFSet:PHASe 

激活迹线幅度偏移 :CALCulate<cnum>:MEASure<tnum>:OFFSet:MAGNitude 

幅度坡度 :CALCulate<cnum>:MEASure<tnum>:OFFSet:MAGNitude:SLOPe 

 

3.12.3.2 系统阻抗 

命令格式 :SENSe:CORRection:IMPedance[:INPut][:MAGNitude] <numeric> 

:SENSe:CORRection:IMPedance[:INPut][:MAGNitude]? 

说明 设置或获取系统阻抗。 

参数 <numeric>:表示系统阻抗，其范围是 0~1000。 

返回类型 浮点型 

默认值 50 

菜单项 刻度> 常量 > 系统阻抗 
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举例 :SENSe:CORRection:IMPedance 75 

:SENSe:CORRection:IMPedance? 

Return: 75 

 

3.12.3.3 相位偏移 

命令格式 :CALCulate<cnum>[:SELected]:CORRection:OFFSet:PHASe <numeric> 

:CALCulate<cnum>[:SELected]:CORRection:OFFSet:PHASe? 

:CALCulate<cnum>:TRACe<tnum>:CORRection:OFFSet:PHASe <numeric> 

:CALCulate<cnum>:TRACe<tnum>:CORRection:OFFSet:PHASe? 

说明 设置或获取激活迹线的相位偏移值 

设置或获取选择通道及迹线的相位偏移值 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1 

<numeric>:表示相位偏移值，其范围是-200~200。 

返回类型 浮点型，单位°(度) 

默认值 0 

菜单项 刻度> 常量 > 相位偏移 

举例 :CALCulate1:CORRection:OFFSet:PHASe 25 

:CALCulate1:CORRection:OFFSet:PHASe? 

Return: 25 

 

:CALCulate1:TRACe1:CORRection:OFFSet:PHASe 90 

:CALCulate1:TRACe1:CORRection:OFFSet:PHASe? 

Return: 90 

 

3.12.3.4 激活迹线幅度偏移 

命令格式 :CALCulate<cnum>:MEASure<tnum>:OFFSet:MAGNitude <numeric> 

:CALCulate<cnum>:MEASure<tnum>:OFFSet:MAGNitude? 

说明 设置或获取选择通道及迹线的幅度偏移值 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1 

<numeric>:表示幅度偏移值，其范围是-1000~1000。 

返回类型 浮点型，单位 dB 

默认值 0 

菜单项 刻度> 常量 > 幅度偏移 



 

 

举例 :CALCulate1:MEASure1:OFFSet:MAGNitude 90 

:CALCulate1:MEASure1:OFFSet:MAGNitude? 

Return: 90 

 

3.12.3.5 幅度坡度 

命令格式 :CALCulate<cnum>:MEASure<tnum>:OFFSet:MAGNitude:SLOPe <numeric> 

:CALCulate<cnum>:MEASure<tnum>:OFFSet:MAGNitude:SLOPe? 

说  明 设置或获取选择通道及迹线的幅度坡度值 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1 

<numeric>:表示幅度偏移值，其范围是-1000~1000。 

返回类型 浮点型，单位 dB/GHz 

默认值 0 

菜单项 刻度> 常量 > 幅度坡度 

举例 :CALCulate1:MEASure1:OFFSet:MAGNitude:SLOPe 10 

:CALCulate1:MEASure1:OFFSet:MAGNitude:SLOPe? 

Return: 10 

 

3.12.4 高级 

3.12.4.1 命令列表 

格数 :DISPlay:WINDow<wnum>:Y[:SCALe]:DIVisions 

刻度类型 :DISPlay:WINDow<wnum>:TRACe<tnum>:Y[:SCALe]:TYPE 

对数刻度 Y 轴最大值 :DISPlay:WINDow<wnum>:TRACe<tnum>:Y[:SCALe]:LOG:MAXimize 

对数刻度 Y 轴最小值 :DISPlay:WINDow<wnum>:TRACe<tnum>:Y[:SCALe]:LOG:MINimize 

 

3.12.4.2 格数 

命令格式 :DISPlay:WINDow<wnum>:Y[:SCALe]:DIVisions <numeric> 

:DISPlay:WINDow<wnum>:Y[:SCALe]:DIVisions? 

说  明 设置或获取 Y 轴的格数。 

参数 <wnum>:={[1]-36}，表示测量窗口号，如果未指定，则<wnum>默认设置 1。 

<numeric>:表示 Y 轴的格数，其范围是 4到 30 之间的偶数。 

返回类型 整型 
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默认值 10 

菜单项 刻度> 高级> 格数 

举例 :DISPlay:WINDow1:Y:DIVisions 4 

:DISPlay:WINDow1:Y:DIVisions? 

Return: 4 

 

3.12.4.3 刻度类型 

命令格式 :DISPlay:WINDow<wnum>:TRACe<tnum>:Y[:SCALe]:TYPE <type> 

:DISPlay:WINDow<wnum>:TRACe<tnum>:Y[:SCALe]:TYPE? 

说  明 设置或获取刻度显示的类型。 

参数 <wnum>:={[1]-36}，表示测量窗口号，如果未指定，则<wnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

<type>:={LINear|LOG} 

LINear：线性刻度模式 

LOG：对数刻度模式 

返回类型 枚举 

默认值 LINear 

菜单项 刻度> 高级> 刻度类型 

举例 :DISPlay:WINDow1:TRACe1:Y:TYPE LOG 

:DISPlay:WINDow1:TRACe1:Y:TYPE? 

Return: LOG 

 

3.12.4.4 对数刻度 Y轴最大值 

命令格式 :DISPlay:WINDow<wnum>:TRACe<tnum>:Y[:SCALe]:LOG:MAXimize <numeric> 

:DISPlay:WINDow<wnum>:TRACe<tnum>:Y[:SCALe]:LOG:MAXimize? 

说  明 设置或获取对数刻度时 Y 轴最大值。 

参数 <wnum>:={[1]-36}，表示测量窗口号，如果未指定，则<wnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

<numeric>:表示对数刻度时 Y 轴最大值，10 的整数次幂。 

返回类型 浮点型  

默认值 10000 

菜单项 刻度> 高级> 最大值 

举例 :DISPlay:WINDow1:TRACe1:Y:LOG:MAXimize 1000 

:DISPlay:WINDow1:TRACe1:Y:LOG:MAXimize? 



 

 

Return: 1000 

 

3.12.4.5 对数刻度 Y轴最小值 

命令格式 :DISPlay:WINDow<wnum>:TRACe<tnum>:Y[:SCALe]:LOG:MINimize <numeric> 

:DISPlay:WINDow<wnum>:TRACe<tnum>:Y[:SCALe]:LOG:MINimize? 

说  明 设置或获取对数刻度时 Y 轴最小值。 

参数 <wnum>:={[1]-36}，表示测量窗口号，如果未指定，则<wnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

<numeric>:表示对数刻度时 Y 轴最小值，10 的整数次幂。 

返回类型 浮点型  

默认值 0.01 

菜单项 刻度> 高级> 最小值 

举例 :DISPlay:WINDow1:TRACe1:Y:LOG:MINimize 0.1 

:DISPlay:WINDow1:TRACe1:Y:LOG:MINimize? 

Return: 0.1 

 

3.13 Search 命令子系统 

3.13.1 搜索 

3.13.1.1 命令列表 

光标搜索类型 :CALCulate<cnum>:TRACe<tnum>:MARKer<mnum>:FUNCtion:TYPE 

执行搜索 :CALCulate<cnum>:TRACe<tnum>:MARKer<mnum>:FUNCtion:EXECute 

添加光标范围搜索 :CALCulate<cnum> [:SELected]:MARKer:FUNCtion:DOMain:ADD 

删除光标范围搜索 :CALCulate<cnum>[:SELected]:MARKer:FUNCtion:DOMain:DELete 

选择光标范围序号 :CALCulate<cnum>:TRACe<tnum>:MARKer<mnum>:FUNCtion:DOMain:NUMber 

光标搜索范围起始

值 

:CALCulate<cnum>:TRACe<tnum>:MARKer:FUNCtion:DOMain<dnum>:STARt 

光标搜索范围停止

值 

:CALCulate<cnum>:TRACe<tnum>:MARKer:FUNCtion:DOMain<dnum>:STOP 

跟踪状态 :CALCulate<cnum>:TRACe<tnum>:MARKer<mnum>:FUNCtion:TRACking 
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3.13.1.2 光标搜索类型 

命令格式 :CALCulate<cnum>[:SELected]:MARKer<mnum>:FUNCtion:TYPE <type> 

:CALCulate<cnum>[:SELected]:MARKer<mnum>:FUNCtion:TYPE? 

 

:CALCulate<cnum>:TRACe<tnum>:MARKer<mnum>:FUNCtion:TYPE <type> 

:CALCulate<cnum>:TRACe<tnum>:MARKer<mnum>:FUNCtion:TYPE? 

说明 设置或获取激活迹线光标的搜索类型 

设置或获取选择通道及迹线光标的搜索类型 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

<mnum>:={[1]-10}，表示光标编号，如果未指定，则<mnum>默认设置 1。 

<type>:={MAXimum|MINimum|PEAK|LPEak|RPEak|TARGet|LTARget|RTARget} 

返回类型 枚举 

默认值 无 

菜单项 搜索 > 最大值搜索/最小值搜索 

搜索 > 峰值搜索/搜索右峰值/搜索左峰值 

搜索 > 目标搜索/搜索右目标值/搜索左目标值 

举例 :CALCulate1:MARKer1:FUNCtion:TYPE RTARget 

:CALCulate1:MARKer1:FUNCtion:TYPE? 

Return: RTAR 

 

:CALCulate1:TRACe1:MARKer1:FUNCtion:TYPE PEAK 

:CALCulate1:TRACe1:MARKer1:FUNCtion:TYPE? 

Return: PEAK 

 

3.13.1.3 执行搜索 

命令格式 :CALCulate<cnum>[:SELected]:MARKer<mnum>:FUNCtion:EXECute 

:CALCulate<cnum>:TRACe<tnum>:MARKer<mnum>:FUNCtion:EXECute 

说明 设置或获取激活迹线开始执行搜索 

设置或获取所选通道及迹线开始执行搜索 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

<mnum>:={[1]-10}，表示光标编号，如果未指定，则<mnum>默认设置 1。 

返回类型 无 

默认值 无 



 

 

菜单项 搜索 > 最大值搜索/最小值搜索 

搜索 > 峰值搜索/搜索右峰值/搜索左峰值 

搜索 > 目标搜索/搜索右目标值/搜索左目标值 

举例 :CALCulate1:MARKer1:FUNCtion:TYPE MAXimum 

:CALCulate1:MARKer1:FUNCtion:EXECute 

:CALCulate1:TRACe1:MARKer1:FUNCtion:TYPE MINimum 

:CALCulate1:TRACe1:MARKer1:FUNCtion:EXECute 

 

3.13.1.4 添加光标范围搜索 

命令格式 :CALCulate<cnum> [:SELected]:MARKer:FUNCtion:DOMain:ADD 

说  明 添加选择通道活动迹线的活动光标的范围搜索 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

返回类型 无 

默认值 无 

菜单项 搜索 >范围 > 添加 

举例 :CALCulate1:MARKer:FUNCtion:DOMain:ADD 

 

3.13.1.5 删除光标范围搜索 

命令格式 :CALCulate<cnum>[:SELected]:MARKer:FUNCtion:DOMain:DELete <numeric> 

说  明 删除选择通道活动迹线的活动光标的范围搜索 

参数 
<cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<numeric>:表示光标搜索范围，其范围是 1~16。 

返回类型 无 

默认值 无 

菜单项 搜索 > 范围 > 删除 

举例 :CALCulate1:MARKer:FUNCtion:DOMain:DELete 1 

3.13.1.6 选择光标范围序号 

命令格式 :CALCulate<cnum>[:SELected]:MARKer<mnum>:FUNCtion:DOMain:NUMber 
<numeric> 

:CALCulate<cnum> [:SELected]:MARKer<mnum>:FUNCtion:DOMain:NUMber? 

:CALCulate<cnum>:TRACe<tnum>:MARKer<mnum>:FUNCtion:DOMain:NUMber 
<numeric> 

:CALCulate<cnum>:TRACe<tnum>:MARKer<mnum>:FUNCtion:DOMain:NUMber? 
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说明 选择范围搜索的序号（可设置多个搜索范围） 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

<mnum>:={[1]-10}，表示光标编号，如果未指定，则<mnum>默认设置 1。 

<numeric>:表示光标搜索范围，其范围是 1-16。 

返回类型 整型 

默认值 无 

菜单项 搜索 > 范围 

举例 :CALCulate1:TRACe1:MARKer1:FUNCtion:DOMain:NUMber 3 

:CALCulate1:TRACe1:MARKer1:FUNCtion:DOMain:NUMber? 

Return: 3 

 

:CALCulate1:MARKer:FUNCtion:DOMain:NUMber 2 

:CALCulate1:MARKer:FUNCtion:DOMain:NUMber? 

Return: 2 

 

3.13.1.7 光标搜索范围起始值 

命令格式 :CALCulate<cnum>[:SELected]:MARKer:FUNCtion:DOMain<dnum>}:STARt 
<numeric> 

:CALCulate<cnum>[:SELected]:MARKer:FUNCtion:DOMain<dnum>:STARt? 

 

:CALCulate<cnum>:TRACe<tnum>:MARKer:FUNCtion:DOMain<dnum>:STARt 
<numeric> 

:CALCulate<cnum>:TRACe<tnum>:MARKer:FUNCtion:DOMain<dnum>:STARt? 

说  明 设置或获取激活迹线记搜索范围起始值 

设置或获取所选通道及迹线记搜索范围起始值 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

<dnum>:={[1]-16},表示光标搜索范围的编号。 

<numeric>:表示搜索范围起始值。 

返回类型 浮点型 

默认值 无 

菜单项 搜索 > 起始 

举例 :CALCulate1:MARKer:FUNCtion:DOMain2:STARt 1e9 

:CALCulate1:MARKer:FUNCtion:DOMain2:STARt? 

Return: 1000000000 



 

 

 

:CALCulate1:TRACe1:MARKer:FUNCtion:DOMain2:STARt 2e9 

:CALCulate1:TRACe1:MARKer:FUNCtion:DOMain2:STARt? 

Return: 2000000000 

 

3.13.1.8 光标搜索范围停止值 

命令格式 :CALCulate<cnum>[:SELected]:MARKer:FUNCtion:DOMain<dnum>:STOP 
<numeric> 

:CALCulate<cnum>[:SELected]:MARKer:FUNCtion:DOMain<dnum>:STOP? 

:CALCulate<cnum>:TRACe<tnum>:MARKer:FUNCtion:DOMain<dnum>:STOP 
<numeric> 

:CALCulate<cnum>:TRACe<tnum>:MARKer:FUNCtion:DOMain<dnum>:STOP? 

说明 设置或获取激活迹线记搜索范围停止值 

设置或获取所选通道及迹线记搜索范围停止值 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

<dnum>:={[1]-16},表示光标搜索范围的编号。 

<numeric>:表示搜索范围停止值。 

返回类型 浮点型 

默认值 矢量网络分析仪的最大频率 

菜单项 搜索 > 终止 

举例 :CALCulate1:MARKer:FUNCtion:DOMain2:STOP 3e9 

:CALCulate1:MARKer:FUNCtion:DOMain2:STOP? 

Return: 3000000000 

 

:CALCulate1:TRACe1:MARKer:FUNCtion:DOMain2:STOP 4e9 

:CALCulate1:TRACe1:MARKer:FUNCtion:DOMain2:STOP? 

Return: 4000000000 

 

3.13.1.9 跟踪状态 

命令格式 :CALCulate<cnum>[:SELected]:MARKer<mnum>:FUNCtion:TRACking <bool> 

:CALCulate<cnum>[:SELected]:MARKer<mnum>:FUNCtion:TRACking? 

:CALCulate<cnum>:TRACe<tnum>:MARKer<mnum>:FUNCtion:TRACking 
<bool> 

:CALCulate<cnum>:TRACe<tnum>:MARKer<mnum>:FUNCtion:TRACking? 

说明 设置或获取激活迹线跟踪搜索的状态，开启/关闭标记搜索跟踪 

设置或获取选择通道及迹线跟踪搜索的状态，开启/关闭标记搜索跟踪 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 
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<mnum>:={[1]-10}，表示光标编号，如果未指定，则<mnum>默认设置 1。 

<bool>:= ON|OFF|1|0 

返回类型 Boolean (1=ON,0=OFF) 

默认值 OFF 

菜单项 搜索 > 跟踪 

举例 :CALCulate1:MARKer2:FUNCtion:TRACking ON 

:CALCulate1:MARKer2:FUNCtion:TRACking? 

Return: 1 

 

:CALCulate1:TRACe1:MARKer2:FUNCtion:TRACking OFF 

:CALCulate1:TRACe1:MARKer2:FUNCtion:TRACking? 

Return: 0 

 

3.13.2 峰值搜索 

3.13.2.1 命令列表 

光标峰值搜

索阀值 

:CALCulate<cnum>:MEASure<tnum>:MARKer<mnum>:FUNCtion:PEAK:THReshold 

光标峰值偏

离额定值 

:CALCulate<cnum>:TRACe<tnum>:MARKer<mnum>:FUNCtion:PEXCursion 

光标峰值搜

索极性 

:CALCulate<cnum>:TRACe<tnum>:MARKer<mnum>:FUNCtion:PPOLarity 

 

3.13.2.2 光标峰值搜索阀值 

命令格式 :CALCulate<cnum>:MEASure<tnum>:MARKer<mnum>:FUNCtion:PEAK: 

THReshold <numeric> 

:CALCulate<cnum>:MEASure<tnum>:MARKer<mnum>:FUNCtion:PEAK: 

THReshold? 

说明 设置或获取激活迹线峰值搜索阀值 

设置或获取选择通道及迹线峰值搜索阀值 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

<mnum>:={[1]-10}，表示光标编号，如果未指定，则<mnum>默认设置 1。 

<numeric>:表示峰值搜索阀值，其范围是-500dB~500dB。 

返回类型 浮点型 



 

 

默认值 -100dB 

菜单项 搜索 > 峰值搜索 > 阈值 

举例 :CALCulate1:MEASure1:MARKer2:FUNCtion:PEAK:THReshold -20 

:CALCulate1:MEASure1:MARKer2:FUNCtion:PEAK:THReshold? 

Return: -20 

 

3.13.2.3 光标峰值偏离额定值 

命令格式 :CALCulate<cnum>[:SELected]:MARKer<mnum>:FUNCtion:PEXCursion 
<numeric> 

:CALCulate<cnum>[:SELected]:MARKer<mnum>:FUNCtion:PEXCursion? 

:CALCulate<cnum>:TRACe<tnum>:MARKer<mnum>:FUNCtion:PEXCursion 
<numeric> 

:CALCulate<cnum>:TRACe<tnum>:MARKer<mnum>:FUNCtion:PEXCursion? 

说明 设置或获取激活迹线光标峰值偏移下限值 

设置或获取选择通道及迹线光标峰值偏移下限值 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

<mnum>:={[1]-10}，表示光标编号，如果未指定，则<mnum>默认设置 1。 

<numeric>:表示光标峰值偏移下限值，其范围是-500dB~500dB。 

返回类型 浮点型 

默认值 3dB 

菜单项 搜索 > 峰值搜索 > 偏离额定值 

举例 :CALCulate1:MARKer2:FUNCtion:PEXCursion 2 

:CALCulate1:MARKer2:FUNCtion:PEXCursion? 

Return: 2 

 

:CALCulate1:TRACe1:MARKer2:FUNCtion:PEXCursion 6 

:CALCulate1:TRACe1:MARKer2:FUNCtion:PEXCursion? 

Return: 6 

 

3.13.2.4 光标峰值搜索极性 

命令格式 :CALCulate<cnum>[:SELected]:MARKer<mnum>:FUNCtion:PPOLarity <type> 

:CALCulate<cnum>[:SELected]:MARKer<mnum>:FUNCtion:PPOLarity? 

:CALCulate<cnum>:TRACe<tnum>:MARKer<mnum>:FUNCtion:PPOLarity 
<type> 

:CALCulate<cnum>:TRACe<tnum>:MARKer<mnum>:FUNCtion:PPOLarity? 

说明 设置或获取激活迹线峰值搜索极性 

设置或获取选择通道及迹线峰值搜索极性 
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参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

<mnum>:={[1]-10}，表示光标编号，如果未指定，则<mnum>默认设置 1。 

<type>:={POSitive|NEGative|BOTH} 

返回类型 枚举 

默认值 POSitive 

菜单项 搜索 > 峰值搜索 > 峰值极性 

举例 :CALCulate1:MARKer2:FUNCtion:PPOLarity NEGative 

:CALCulate1:MARKer2:FUNCtion:PPOLarity? 

Return: NEG 

 

:CALCulate1:TRACe1:MARKer2:FUNCtion:PPOLarity BOTH 

:CALCulate1:TRACe1:MARKer2:FUNCtion:PPOLarity? 

Return: BOTH 

 

3.13.3 目标搜索 

3.13.3.1 命令列表 

目标搜索值 :CALCulate<cnum>:TRACe<tnum>:MARKer<mnum>:FUNCtion:TARGet 

目标值搜索转换类型 :CALCulate<cnum>:TRACe<tnum>:MARKer<mnum>:FUNCtion:TTRansition 

 

3.13.3.2 目标搜索值 

命令格式 :CALCulate<cnum>[:SELected]:MARKer<mnum>:FUNCtion:TARGet <numeric> 

:CALCulate<cnum>[:SELected]:MARKer<mnum>:FUNCtion:TARGet? 

:CALCulate<cnum>:TRACe<tnum>:MARKer<mnum>:FUNCtion:TARGet 
<numeric> 

:CALCulate<cnum>:TRACe<tnum>:MARKer<mnum>:FUNCtion:TARGet? 

说明 设置或获取激活迹线目标搜索值 

设置或获取选择通道及迹线目标搜索值 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

<mnum>:={[1]-10}，表示光标编号，如果未指定，则<mnum>默认设置 1。 

<numeric>:表示目标搜索值，其范围是-500dB~500dB。 

返回类型 浮点型 



 

 

默认值 0dB 

菜单项 搜索 > 目标搜索 > 目标值 

举例 :CALCulate1:MARKer2:FUNCtion:TARGet 1 

:CALCulate1:MARKer2:FUNCtion:TARGet? 

Return: 1 

 

:CALCulate1:TRACe1:MARKer2:FUNCtion:TARGet -3 

:CALCulate1:TRACe1:MARKer2:FUNCtion:TARGet? 

Return: -3 

 

3.13.3.3 目标值搜索转换类型 

命令格式 :CALCulate<cnum>[:SELected]:MARKer<mnum>:FUNCtion:TTRansition <type> 

:CALCulate<cnum>[:SELected]:MARKer<mnum>:FUNCtion:TTRansition? 

 

:CALCulate<cnum>:TRACe<tnum>:MARKer<mnum>:FUNCtion:TTRansition 
<type> 

:CALCulate<cnum>:TRACe<tnum>:MARKer<mnum>:FUNCtion:TTRansition? 

说明 设置或获取激活迹线目标搜索转换类型 

设置或获取选择通道及迹线目标搜索转换类型 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

<mnum>:={[1]-10}，表示光标编号，如果未指定，则<mnum>默认设置 1。 

<type>:={POSitive|NEGative|BOTH} 

返回类型 枚举 

默认值 POSitive 

菜单项 搜索 > 目标搜索 > 转换 

举例 :CALCulate1:MARKer2:FUNCtion:TTRansition NEGative 

:CALCulate1:MARKer2:FUNCtion:TTRansition? 

Return: NEG 

 

:CALCulate1:TRACe1:MARKer2:FUNCtion:TTRansition POSitive 

:CALCulate1:TRACe1:MARKer2:FUNCtion:TTRansition? 

Return: POS 

 

3.13.4 多峰值&多目标 

3.13.4.1 命令列表 

多峰值&多目标搜索类型 :CALCulate<cnum>:TRACe<tnum>:MARKer:FUNCtion:MULTi:TYPE 
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多峰值搜索阀值 :CALCulate<cnum>:TRACe<tnum>:MARKer:FUNCtion:MULTi:THReshold 

多峰值搜索偏离额定值 :CALCulate<cnum>:TRACe<tnum>:MARKer:FUNCtion:MULTi:PEXCursion 

多峰值搜索极性 :CALCulate<cnum>:TRACe<tnum>:MARKer:FUNCtion:MULTi:PPOLarity 

多目标搜索值 :CALCulate<cnum>:TRACe<tnum>:MARKer:FUNCtion:MULTi:TARGet 

多目标值搜索转换类型 :CALCulate<cnum>:TRACe<tnum>:MARKer:FUNCtion:MULTi:TTRansition 

 

3.13.4.2 多峰值&多目标搜索类型 

命令格式 :CALCulate<cnum>[:SELected]:MARKer:FUNCtion:MULTi:TYPE <type> 

:CALCulate<cnum>[:SELected]:MARKer:FUNCtion:MULTi:TYPE? 

 

:CALCulate<cnum>:TRACe<tnum>:MARKer:FUNCtion:MULTi:TYPE <type> 

:CALCulate<cnum>:TRACe<tnum>:MARKer:FUNCtion:MULTi:TYPE? 

说  明 设置或获取激活迹线多个光标的搜索类型 

设置或获取选择通道及迹线多个光标的搜索类型 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

<type>:={PEAK|TARGet|OFF} 

返回类型 枚举 

默认值 无 

菜单项 无 

举例 :CALCulate1:MARKer:FUNCtion:MULTi:TYPE PEAK 

:CALCulate1:MARKer:FUNCtion:MULTi:TYPE? 

Return: PEAK 

 

:CALCulate1:TRACe1:MARKer:FUNCtion:MULTi:TYPE TARGet 

:CALCulate1:TRACe1:MARKer:FUNCtion:MULTi:TYPE? 

Return: TARG 

 

3.13.4.3 多峰值搜索阀值 

命令格式 :CALCulate<cnum>[:SELected]:MARKer:FUNCtion:MULTi:THReshold 
<numeric> 

:CALCulate<cnum>[:SELected]:MARKer:FUNCtion:MULTi:THReshold? 

:CALCulate<cnum>:TRACe<tnum>:MARKer:FUNCtion:MULTi:THReshold 
<numeric> 

:CALCulate<cnum>:TRACe<tnum>:MARKer:FUNCtion:MULTi:THReshold? 

说明 设置或获取激活迹线跟踪多峰值搜索阀值 



 

 

设置或获取选择通道及迹线多峰值搜索阀值 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

<numeric>:表示阀值，其范围是-500dB~500dB。 

返回类型 浮点型 

默认值 -100 dB 

菜单项 搜索 > 多路峰值&目标值 > 峰值 阀值 

举例 :CALCulate1:MARKer:FUNCtion:MULTi:THReshold -20 

:CALCulate1:MARKer:FUNCtion:MULTi:THReshold? 

Return: -20 

 

:CALCulate1:TRACe1:MARKer:FUNCtion:MULTi:THReshold -30 

:CALCulate1:TRACe1:MARKer:FUNCtion:MULTi:THReshold? 

Return: -30 

 

3.13.4.4 多峰值搜索偏离额定值 

命令格式 :CALCulate<cnum>[:SELected]:MARKer:FUNCtion:MULTi:PEXCursion 
<numeric> 

:CALCulate<cnum>[:SELected]:MARKer:FUNCtion:MULTi:PEXCursion? 

 

:CALCulate<cnum>:TRACe<tnum>:MARKer:FUNCtion:MULTi:PEXCursion 
<numeric> 

:CALCulate<cnum>:TRACe<tnum>:MARKer:FUNCtion:MULTi:PEXCursion? 

说明 设置或获取激活迹线光标多峰值搜索偏移下限值 

设置或获取选择通道及迹线光标多峰值搜索偏移下限值 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

<numeric>:表示偏移下限值，其范围是-500dB~500dB。 

返回类型 浮点型 

默认值 3 dB 

菜单项 搜索 > 多路峰值&目标值 > 峰值 偏离额定值 

举例 :CALCulate1:MARKer:FUNCtion:MULTi:PEXCursion 2 

:CALCulate1:MARKer:FUNCtion:MULTi:PEXCursion? 

Return: 2 

 

:CALCulate1:TRACe1:MARKer:FUNCtion:MULTi:PEXCursion 6 

:CALCulate1:TRACe1:MARKer:FUNCtion:MULTi:PEXCursion? 

Return: 6 
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3.13.4.5 多峰值搜索极性 

命令格式 :CALCulate<cnum>[:SELected]:MARKer:FUNCtion:MULTi:PPOLarity <type> 

:CALCulate<cnum>[:SELected]:MARKer:FUNCtion:MULTi:PPOLarity? 

 

:CALCulate<cnum>:TRACe<tnum>:MARKer:FUNCtion:MULTi:PPOLarity <type> 

:CALCulate<cnum>:TRACe<tnum>:MARKer:FUNCtion:MULTi:PPOLarity? 

说明 设置或获取激活迹线多峰值搜索的极性 

设置或获取选择通道及迹线多峰值搜索的极性 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

<type>:={POSitive|NEGative|BOTH} 

返回类型 枚举 

默认值 POSitive 

菜单项 搜索 > 多路峰值&目标值 > 峰值 极性 

举例 :CALCulate1:MARKer:FUNCtion:MULTi:PPOLarity BOTH 

:CALCulate1:MARKer:FUNCtion:MULTi:PPOLarity? 

Return: BOTH 

 

:CALCulate1:TRACe1:MARKer:FUNCtion:MULTi:PPOLarity NEGative 

:CALCulate1:TRACe1:MARKer:FUNCtion:MULTi:PPOLarity? 

Return: NEG 

3.13.4.6 多目标搜索值 

命令格式 :CALCulate<cnum>[:SELected]:MARKer:FUNCtion:MULTi:TARGet <numeric> 

:CALCulate<cnum>[:SELected]:MARKer:FUNCtion:MULTi:TARGet? 

:CALCulate<cnum>:TRACe<tnum>:MARKer:FUNCtion:MULTi:TARGet 
<numeric> 

:CALCulate<cnum>:TRACe<tnum>:MARKer:FUNCtion:MULTi:TARGet? 

说明 设置或获取激活迹线多峰值搜索目标值 

设置或获取选择通道及迹线多峰值搜索目标值 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

<numeric>:表示目标值，其范围是-500dB~500dB。 

返回类型 浮点型 

默认值 0 dB 

菜单项 搜索 > 多路峰值&目标值 > 目标值设置  



 

 

举例 :CALCulate1:MARKer:FUNCtion:MULTi:TARGet -10 

:CALCulate1:MARKer:FUNCtion:MULTi:TARGet? 

Return: -10 

 

:CALCulate1:TRACe1:MARKer:FUNCtion:MULTi:TARGet -5 

:CALCulate1:TRACe1:MARKer:FUNCtion:MULTi:TARGet? 

Return: -5 

 

3.13.4.7 多目标值搜索转换类型 

命令格式 :CALCulate<cnum>[:SELected]:MARKer:FUNCtion:MULTi:TTRansition <type> 

:CALCulate<cnum>[:SELected]:MARKer:FUNCtion:MULTi:TTRansition? 

:CALCulate<cnum>:TRACe<tnum>:MARKer:FUNCtion:MULTi:TTRansition 
<type> 

:CALCulate<cnum>:TRACe<tnum>:MARKer:FUNCtion:MULTi:TTRansition? 

说  明 设置或获取激活迹线跟踪搜索状态 

设置或获取选择通道及迹线跟踪搜索状态 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

<type>:={POSitive|NEGative|BOTH} 

返回类型 枚举 

默认值 POSitive 

菜单项 搜索 > 多路峰值&目标值 > 转换 

举例 :CALCulate1:MARKer:FUNCtion:MULTi:TTRansition NEGative 

:CALCulate1:MARKer:FUNCtion:MULTi:TTRansition? 

Return: NEG 

 

:CALCulate1:TRACe1:MARKer:FUNCtion:MULTi:TTRansition POSitive 

:CALCulate1:TRACe1:MARKer:FUNCtion:MULTi:TTRansition? 

Return: POS 

 

3.13.5 带宽搜索 

3.13.5.1 命令列表 

带宽搜索结果显示状态 :CALCulate<cnum>:TRACe<tnum>:MARKer<mnum>:BWIDth[:STATe] 

带宽搜索的带宽参考类

型 

:CALCulate<cnum>:TRACe<tnum>:MARKer<mnum>:BWIDth:REF 

滤波器带通值 :CALCulate<cnum>:TRACe<tnum>:MARKer<mnum>:BWIDth:THReshold 
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查询带宽搜索结果 :CALCulate<cnum>:TRACe<tnum>:MARKer<mnum>:BWIDth:DATA? 

 

3.13.5.2 带宽搜索结果显示状态 

命令格式 :CALCulate<cnum>[:SELected]:MARKer<mnum>:BWIDth[:STATe] <bool> 

:CALCulate<cnum>[:SELected]:MARKer<mnum>:BWIDth[:STATe]? 

:CALCulate<cnum>:TRACe<tnum>:MARKer<mnum>:BWIDth[:STATe] <bool> 

:CALCulate<cnum>:TRACe<tnum>:MARKer<mnum>:BWIDth[:STATe]? 

说明 设置或获取激活迹线带宽测试结果显示的状态 

设置或获取所选通道及迹线带宽测试结果显示的状态 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

<mnum>:={[1]-10}，表示光标编号，如果未指定，则<mnum>默认设置 1。 

<bool>:= ON|OFF|1|0 

返回类型 Boolean (1=ON,0=OFF) 

默认值 OFF 

菜单项 搜索> 带宽搜索 > 带宽搜索 

举例 :CALCulate1:TRACe1:MARKer1 ON 

:CALCulate1:MARKer1:BWIDth ON 

:CALCulate1:MARKer1:BWIDth? 

Return: 1 

 

:CALCulate1:TRACe1:MARKer:BWIDth OFF 

:CALCulate1:TRACe1:MARKer:BWIDth? 

Return: 0 

 

3.13.5.3 带宽搜索的带宽参考类型 

命令格式 :CALCulate<cnum>[:SELected]:MARKer<mnum>:BWIDth:REF <type> 

:CALCulate<cnum>[:SELected]:MARKer<mnum>:BWIDth:REF? 

:CALCulate<cnum>:TRACe<tnum>:MARKer<mnum>:BWIDth:REF <type> 

:CALCulate<cnum>:TRACe<tnum>:MARKer<mnum>:BWIDth:REF? 

说  明 设置或获取所选通道及迹线带宽搜索的带宽参考类型。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

<mnum>:={[1]-10}，表示光标编号，如果未指定，则<mnum>默认设置 1。 

<type>:={MARKer|PEAK} 

返回类型 枚举 



 

 

默认值 PEAK 

菜单项 搜索> 带宽搜索 > 带宽参考 

举例 :CALCulate1:SELected:MARKer1:BWIDth:REF MARKer 

:CALCulate1:SELected:MARKer1:BWIDth:REF? 

Return :MARK 

:CALCulate1:TRACe1:MARKer1:BWIDth:REF PEAK 

:CALCulate1:TRACe1:MARKer1:BWIDth:REF? 

Return :PEAK 

 

3.13.5.4 滤波器带通值 

命令格式 :CALCulate<cnum> [:SELected]:MARKer<mnum>:BWIDth:THReshold 
<numeric> 

:CALCulate<cnum> [:SELected]:MARKer<mnum>:BWIDth:THReshold? 

:CALCulate<cnum>:TRACe<tnum>:MARKer<mnum>:BWIDth:THReshold 
<numeric> 

:CALCulate<cnum>:TRACe<tnum>:MARKer<mnum>:BWIDth:THReshold? 

说明 设置或获取激活迹线及标记的滤波器带通值 

设置或获取所选通道及迹线标记的滤波器带通值 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

<mnum>:={[1]-10}，表示光标编号，如果未指定，则<mnum>默认设置 1。 

<numeric>:表示滤波器带通值，其范围是-500~500。 

返回类型 浮点型 

默认值 -3 

菜单项 搜索> 带宽搜索 > 带宽电平 

举例 :CALCulate1:MARKer1:BWIDth:THReshold -3.5 

:CALCulate1:MARKer1:BWIDth:THReshold? 

Return: -3.5 

 

:CALCulate1:TRACe1:MARKer1:BWIDth:THReshold -6 

:CALCulate1:TRACe1:MARKer1:BWIDth:THReshold? 

Return: -6 

 

3.13.5.5 查询带宽搜索结果 

命令格式 :CALCulate<cnum>[:SELected]:MARKer<mnum>:BWIDth:DATA? 

:CALCulate<cnum>:TRACe<tnum>:MARKer<mnum>:BWIDth:DATA? 

说  明 设置或获取激活迹线标记 1~9 和参考标记的带宽搜索结果 

设置或获取所选通道及迹线标记 1~9和参考标记的带宽搜索结果 
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参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

<mnum>:={[1]-10}，表示光标编号，如果未指定，则<mnum>默认设置 1。 

返回类型 表示 4元素数组数据（带宽搜索结果）。 

数据（0）：带宽。 

数据（1）：2截止频点的中心点频率。  

数据（2）：Q 值。 

数据（3）：插入损耗。 

数组所有从 0开始。 

查询结果之前，先使能带宽搜索功能。 

默认值 无 

菜单项 无 

举例 :CALCulate1:MEASure1:MARKer3 ON 

:CALCulate1:MARKer:BWIDth ON 

:CALCulate1:MARKer3:BWIDth:DATA? 

:CALCulate1:TRACe1:MARKer3:BWIDth:DATA? 

Return: 254357919.225087,4162270498.174748,16.363833,-13.946911 

 

3.13.6 带阻搜索 

3.13.6.1 命令列表 

带阻滤波器搜索状态 :CALCulate<cnum>:TRACe<tnum>:MARKer<mnum>:NOTCh[:STATe] 

带阻搜索的带阻滤波参考类型 :CALCulate<cnum>:TRACe<tnum>:MARKer<mnum>:NOTCH:REF 

带阻滤波电平 :CALCulate<cnum>:TRACe<tnum>:MARKer<mnum>:NOTCh:THReshold 

查询带阻滤波搜索结果 :CALCulate<cnum>:TRACe<tnum>:MARKer<mnum>:NOTCh:DATA? 

 

3.13.6.2 带阻滤波器搜索状态 

命令格式 :CALCulate<cnum>[:SELected]:MARKer<mnum>:NOTCh[:STATe] <bool> 

:CALCulate<cnum>[:SELected]:MARKer<mnum>:NOTCh[:STATe]? 

:CALCulate<cnum>:TRACe<tnum>:MARKer<mnum>:NOTCh[:STATe] <bool> 

:CALCulate<cnum>:TRACe<tnum>:MARKer<mnum>:NOTCh[:STATe]? 

说  明 设置或获取激活迹线带阻滤波器搜索状态 

设置或获取选择通道带阻滤波器搜索状态 



 

 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

<mnum>:={[1]-10}，表示光标编号，如果未指定，则<mnum>默认设置 1。 

<bool>:= ON|OFF|1|0 

返回类型 Boolean (1=ON,0=OFF) 

默认值 OFF 

菜单项 搜索> 带阻搜索 > 带阻滤波搜索 

举例 :CALCulate1:MARKer2:NOTCh ON 

:CALCulate1:MARKer2:NOTCh? 

Return: 1 

 

:CALCulate1:TRACe1:MARKer2:NOTCh OFF 

:CALCulate1:TRACe1:MARKer2:NOTCh? 

Return: 0 

 

3.13.6.3 带阻搜索的带阻滤波参考类型 

命令格式 :CALCulate<cnum>[:SELected]:MARKer<mnum>:NOTCH:REF <type> 

:CALCulate<cnum>[:SELected]:MARKer<mnum>:NOTCH:REF? 

:CALCulate<cnum>:TRACe<tnum>:MARKer<mnum>:NOTCH:REF <type> 

:CALCulate<cnum>:TRACe<tnum>:MARKer<mnum>:NOTCH:REF? 

说明 设置或获取所选通道及迹线带阻搜索的带阻滤波参考类型。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

<mnum>:={[1]-10}，表示光标编号，如果未指定，则<mnum>默认设置 1。 

<type>:={MARKer|PEAK} 

返回类型 枚举 

默认值 PEAK 

菜单项 搜索> 带阻搜索 > 带阻滤波参考 

举例 :CALCulate1:SELected:MARKer1:NOTCH:REF MARKer 

:CALCulate1:SELected:MARKer1:NOTCH:REF? 

Return :MARK 

:CALCulate1:TRACe1:MARKer1:NOTCH:REF PEAK 

:CALCulate1:TRACe1:MARKer1:NOTCH:REF? 

Return :PEAK 

 

3.13.6.4 带阻滤波电平 

命令格式 :CALCulate<cnum>[:SELected]:MARKer<mnum>:NOTCh:THReshold <numeric> 
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:CALCulate<cnum>[:SELected]:MARKer<mnum>:NOTCh:THReshold? 

:CALCulate<cnum>:TRACe<tnum>:MARKer<mnum>:NOTCh:THReshold 
<numeric> 

:CALCulate<cnum>:TRACe<tnum>:MARKer<mnum>:NOTCh:THReshold? 

说明 设置或获取激活迹线带阻滤波电平 

设置或获取选择通道带阻滤波电平 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

<mnum>:={[1]-10}，表示光标编号，如果未指定，则<mnum>默认设置 1。 

<numeric>:表示带阻滤波电平，其范围是-500dB~500dB。 

返回类型 浮点型 

默认值 -3 dB 

菜单项 搜索> 带阻搜索 > 带阻滤波电平 

举例 :CALCulate1:MARKer2:NOTCh:THReshold -6 

:CALCulate1:MARKer2:NOTCh:THReshold? 

Return: -6 

 

:CALCulate1:TRACe1:MARKer2:NOTCh:THReshold -3 

:CALCulate1:TRACe1:MARKer2:NOTCh:THReshold? 

Return: -3 

 

3.13.6.5 查询带阻滤波搜索结果 

命令格式 :CALCulate<cnum>[:SELected]:MARKer<mnum>:NOTCh:DATA?  

:CALCulate<cnum>:TRACe<tnum>:MARKer<mnum>:NOTCh:DATA? 

说明 获取激活迹线带阻滤波搜索结果 

设置或获取选择通道带阻滤波搜索结果 

带阻滤波搜索仅与对数幅度格式结合使用 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

<mnum>:={[1]-10}，表示光标编号，如果未指定，则<mnum>默认设置 1。 

返回类型 数组数据 

 

表示 4元素的数组数据。n为 1到 NOP 之间的整数。 

Data[0]：带宽。 

Data[1]：低频率截止点和高频率截止点之间中点的频率。 



 

 

Data[2]：Q 值，中心频率与带宽之比。 

Data[3]：执行带宽/带阻滤波搜索时在中心频率位置处的测量值。 

数组索引从 0开始。 

默认值 无 

菜单项 无 

举例 :CALCulate1:MARKer2:NOTCh:DATA? 

:CALCulate1:TRACe1:MARKer2:NOTCh:DATA? 

 

 

3.14 Service命令子系统 

3.14.1 命令列表 

查询通道活动迹线 :SERVice:CHANnel<cnum>:TRACe:ACTive? 

查询活动通道 :SERVice:CHANnel:ACTive? 

查询通道上限数 :SERVice:CHANnel:COUNt? 

查询迹线上限数 :SERVice:CHANnel:TRACe:COUNt? 

查询端口上限数 :SERVice:PORT:COUNt? 

最大频率 :SERVice:SWEep:FREQency:MAXimum? 

最小频率 :SERVice:SWEep:FREQency:MINimum? 

查询扫描点数上限 :SERVice:SWEep:POINts? 

清除日志数据 :SERVice:LOGGing:CLEar 

系统错误信息查询 :SYSTem:ERRor? 

查询 10MHz外部参考信号输入 :SENSe:ROSCillator:SOURce? 

 

3.14.2 查询通道活动迹线 

命令格式 :SERVice:CHANnel<cnum>:TRACe:ACTive? 

说明 查询选择通道的当前活动迹线（选择通道需为活动通道）。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

返回类型 整型 



 

238                                                                                                                   矢量网络分析仪编程手册 

默认值 1 

菜单项 无 

举例 :SERVice:CHANnel1:TRACe:ACTive? 

 

3.14.3 查询活动通道 

命令格式 :SERVice:CHANnel:ACTive?  

说  明 查询当前的活动通道数。 

参数 无 

返回类型 整型 

默认值 1 

菜单项 无 

举例 :DISPlay:WINDow2:ACTivate 

:SERVice:CHANnel:ACTive? 

Return: 2 

 

3.14.4 查询通道上限数 

命令格式 :SERVice:CHANnel:COUNt? 

说  明 查询通道数的上限。 

参数 无 

返回类型 整型 

默认值 无 

菜单项 无 

举例 :SERVice:CHANnel:COUNt? 

Return: 256 

 

3.14.5 查询迹线上限数 

命令格式 :SERVice:CHANnel:TRACe:COUNt? 



 

 

说明 查询迹线数的上限。 

参数 无 

返回类型 整型 

默认值 无 

菜单项 无 

举例 :SERVice:CHANnel:TRACe:COUNt? 

Return: 256 

 

3.14.6 查询端口上限数 

命令格式 :SERVice:PORT:COUNt? 

说明 查询端口数的上限。 

参数 无 

返回类型 整型 

默认值 None 

菜单项 无 

举例 :SERVice:PORT:COUNt? 

 

3.14.7 最大频率 

命令格式 :SERVice:SWEep:FREQency:MAXimum? 

说明 查询最大设置频率。 

参数 无 

返回类型 浮点型，单位：Hz 

默认值 矢量网络分析仪的最大频率 

菜单项 无 

举例 :SERVice:SWEep:FREQency:MAXimum? 
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3.14.8 最小频率 

命令格式 :SERVice:SWEep:FREQency:MINimum? 

说明 查询最小设置频率。 

参数 无 

返回类型 浮点型，单位：Hz 

默认值 9 kHz 

菜单项 无 

举例 :SERVice:SWEep:FREQency:MINimum? 

 

3.14.9 查询扫描点数上限 

命令格式 :SERVice:SWEep:POINts? 

说明 查询扫描点数的上限。 

参数 无 

返回类型 整型 

默认值 20001 

菜单项 无 

举例 :SERVice:SWEep:POINts? 

 

3.14.10 清除日志数据 

命令格式 :SERVice:LOGGing:CLEar 

说明 清除记录日志的数据。 

参数 无 

返回类型 无 

默认值 无 

菜单项 无 

举例 :SERVice:LOGGing:CLEar 



 

 

 

3.14.11 系统错误信息查询 

命令格式 :SYSTem:ERRor? 

说明 查询系统报错信息，返回错误编号和错误信息（带有双引号("")的字符串）。 

参数 无 

返回类型 数组数据 

默认值 0 

菜单项 无 

举例 :SYSTem:ERRor? 

Return: -101, "Invalid character" 

 

3.14.12 查询 10MHz外部参考信号输入 

命令格式 :SENSe:ROSCillator:SOURce? 

说明 获取 10MHz外部参考信号输入是否接入。 

参数 无 

返回值 字符串 

"EXT"：已外接 10MHz参考信号输入。 

"INT"：未外接 10MHz 参考信号输入。 

默认值 无 

菜单项 屏幕底部第九个参数。 

举例 :SENSe:ROSCillator:SOURce? 

Return: INT 

 

3.15 Sweep 命令子系统 

3.15.1 命令列表 

通道扫描点数 :SENSe<cnum>:SWEep:POINts 

通道扫描类型 :SENSe<cnum>:SWEep:TYPE 
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通道扫描时间自动设置 :SENSe<cnum>:SWEep:TIME:AUTO 

通道扫描时间 :SENSe<cnum>:SWEep:TIME[:DATA] 

通道扫描延迟时间 :SENSe<cnum>:SWEep:DELay 

分段扫描表使能状态显示 :SENSe<cnum>:SEGMent:LIST:CONTrol:STATe 

X 轴点间距设置 :DISPlay:WINDow<wnum>:X:SPACing 

存储分段扫描表 :MMEMory:STORE:SEGMent 

加载分段扫描表 :MMEMory:LOAD:SEGMent 

分段扫描表端口中频带宽状态 :SENSe<cnum>:SEGMent:LIST:BWIDth:PORT:STATe 

分段扫描表端口中频带宽 :SENSe<cnum>:SEGMent:LIST:BWIDth:PORT<pnum>[:RESoluti
on] 

分段扫描表使能状态 :SENSe<cnum>:SEGMent:LIST:CONTrol:DATA 

分段扫描表功率显示状态 :SENSe<cnum>:SEGMent:LIST:POWer:PORT:STATe 

分段扫描表各频段端口功率 :SENSe<cnum>:SEGMent:LIST:POWer:PORT<pnum>[:LEVel][:I
MMediate][:AMPLitude] 

查询分段扫描表总扫描点数 :SENSe<cnum>:SEGMent:SWEep:POINts? 

查询分段扫描表总扫描时间 :SENSe<cnum>:SEGMent:SWEep:TIME[:DATA]? 

创建及查询分段扫描表 :SENSe<cnum>:SEGMent:DATA <Data> 

 

3.15.2 通道扫描点数 

命令格式 :SENSe<cnum>:SWEep:POINts <numeric> 

:SENSe<cnum>:SWEep:POINts? 

说  明 设置或获取选择通道的扫描点数。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<numeric>:表示扫描点数。 

返回类型 整型 

默认值 201 

菜单项 扫描 > 扫描点数 

举例 :SENSe1:SWEep:POINts 251 

:SENSe1:SWEep:POINts? 

Return: 251 

 



 

 

3.15.3 通道扫描类型 

命令格式 :SENSe<cnum>:SWEep:TYPE <type> 

:SENSe<cnum>:SWEep:TYPE? 

说  明 设置或获取选择通道的扫描类型。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<type>:={LINear|LOGarithmic|SEGMent|POWer|CW} 

"LINear"：设置扫描类型为线性扫描。 

"LOGarithmic"：设置扫描类型为对数扫描。 

"SEGMent"：设置扫描类型为分段式扫描。 

"POWer"：设置扫描类型为功率扫描。 

"CW"：设置扫描类型为 CW 扫描。 

返回类型 枚举 

默认值 LINear 

菜单项 扫描 > 扫描类型 

举例 :SENSe1:SWEep:TYPE SEGMent 

:SENSe1:SWEep:TYPE? 

Return: SEGM 

 

3.15.4 通道扫描时间自动设置 

命令格式 :SENSe<cnum>:SWEep:TIME:AUTO <bool> 

:SENSe<cnum>:SWEep:TIME:AUTO? 

说  明 设置或获取选择通道自动设置扫描时间的状态。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<bool>:= ON|OFF|1|0 

返回类型 Boolean (1=ON,0=OFF) 

默认值 ON 

菜单项 扫描 > 扫描模式 

举例 :SENSe1:SWEep:TIME:AUTO 0 

:SENSe1:SWEep:TIME:AUTO?  

Return: 0 
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3.15.5 通道扫描时间 

命令格式 :SENSe<cnum>:SWEep:TIME[:DATA] <numeric> 

:SENSe<cnum>:SWEep:TIME[:DATA]? 

说  明 设置或获取选择通道的扫描时间。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<numeric>:表示扫描时间。 

返回类型 浮点型，单位 s（秒） 

默认值 无 

菜单项 扫描 > 扫描时间 

举例 :SENSe1:SWEep:TIME 2 

:SENSe1:SWEep:TIME? 

Return: 2 

 

3.15.5.1 通道扫描延迟时间 

命令格式 :SENSe<cnum>:SWEep:DELay <numeric> 

:SENSe<cnum>:SWEep:DELay? 

说  明 设置或获取选择通道的扫描延迟时间。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<numeric>:表示扫描延迟时间。 

返回类型 浮点型，单位 s（秒） 

默认值 0 

菜单项 扫描 > 扫描延迟 

举例 :SENSe1:SWEep:DELay 1 

:SENSe1:SWEep:DELay? 

Return: 1 

 

3.15.6 分段扫描表使能状态显示 

命令格式 :SENSe<cnum>:SEGMent:LIST:CONTrol:STATe <bool> 

:SENSe<cnum>:SEGMent:LIST:CONTrol:STATe? 

说明 设置获取显示分段扫描表使能的状态。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<bool>:= ON|OFF|1|0 



 

 

返回类型 Boolean (1=ON,0=OFF) 

默认值 1 

菜单项 无 

举例 :SENSe1:SEGMent:LIST:CONTrol:STATe 0 

:SENSe1:SEGMent:LIST:CONTrol:STATe? 

Return: 0 

 

3.15.7 X轴点间距设置 

命令格式 :DISPlay:WINDow<wnum>:X:SPACing <type> 

:DISPlay:WINDow<wnum>:X:SPACing? 

说  明 设置或获取选择通道的分段扫描 X 轴点间距的排列方式 

参数 <wnum>:={[1]-36}，表示测量窗口号，如果未指定，则<wnum>默认设置 1。 

<type>:={LINear|OBASe} 

LINear：按频率线性排列 

OBASe：按频点顺序线性排列 

返回类型 枚举 

默认值 LINear 

菜单项 扫描 > 段扫描表 > 段扫描表… > X-Axis Point Spacing 

举例 :DISPlay:WINDow1:X:SPACing OBASe 

:DISPlay:WINDow1:X:SPACing? 

Return: OBAS 

 

3.15.8 存储分段扫描表 

命令格式 :MMEMory:STORE:SEGMent <string> 

说明 将活动迹线的分段扫描表存储到指定的 csv 文件中。如果已经存在与指定文件名相

同的文件，则会重写其内容。 

参数 <string>: 表示 csv文件，其范围少于 255个字符。 

返回类型 无 

默认值 无 

菜单项 扫描 > 段扫描表 > 段扫描表… > Save Table 
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举例 :MMEMory:STORE:SEGMent "local/test.csv" 

 

3.15.9 加载分段扫描表 

命令格式 :MMEMory:LOAD:SEGMent <string> 

说明 将指定的分段扫描表格文件加载到活动迹线的分段扫描表中。 

参数 <string>: 表示 csv文件，其范围少于 255个字符。 

返回类型 无 

默认值 无 

菜单项 扫描 > 段扫描表 > 段扫描表… > Load Table 

举例 :MMEMory:LOAD:SEGMent "local/test.csv" 

 

3.15.10 分段扫描表端口中频带宽状态 

命令格式 :SENSe<cnum>:SEGMent:LIST:BWIDth:PORT:STATe <bool> 

:SENSe<cnum>:SEGMent:LIST:BWIDth:PORT:STATe? 

说明 设置或获取分段扫描表的端口中频带宽功能状态。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<bool>:= ON|OFF|1|0 

返回类型 Boolean (1=ON,0=OFF) 

默认值 OFF 

菜单项 扫描 > 段扫描表 > 段扫描表设置 > IF Bandwidth Per Port 

举例 :SENSe1:SEGMent:LIST:BWIDth:PORT:STATe 1 

:SENSe1:SEGMent:LIST:BWIDth:PORT:STATe? 

Return: 1 

 

3.15.11 分段扫描表端口中频带宽 

命令格式 :SENSe<cnum>:SEGMent:LIST:BWIDth:PORT<pnum>[:RESolution] 
<value1>,<value2>,...,<valueN> 

:SENSe<cnum>:SEGMent:LIST:BWIDth:PORT<pnum>[:RESolution]? 

说明 设置或获取分段扫描表的各端口中频带宽数值。 



 

 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<pnum>:={[1]-4}，表示端口号。 

<value1>,<value2>,...,<valueN>:表示带宽数据数组，N 为第 N 个频率分段。 

返回类型 数值数组 

默认值 各频段及各端口默认为 10 kHz 

菜单项 扫描 > 段扫描表 > 段扫描表设置 

举例 :SENSe1:SEGMent:LIST:BWIDth:PORT1:RESolution 10e3,20e3,30e3 

:SENSe1:SEGMent:LIST:BWIDth:PORT1? 

Return: 1.000000000000e+04,2.000000000000e+04,3.000000000000e+04 

 

3.15.12 分段扫描表使能状态 

命令格式 :SENSe<cnum>:SEGMent:LIST:CONTrol:DATA <value1>,<value2>,...,<valueN> 

:SENSe<cnum>:SEGMent:LIST:CONTrol:DATA? 

说明 设置或获取分段扫描表的各频率分段的使能状态。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<value1>,<value2>,...,<valueN>:表示带宽数据数组，N 为第 N 个频率分段。value

值为 0或 1，代表开关状态。 

返回类型 数值数组 

默认值 各频段默认均为关闭状态 

菜单项 扫描 > 段扫描表 > 段扫描表设置 

举例 :SENSe1:SEGMent:LIST:CONTrol:DATA 1,1,0 

:SENSe1:SEGMent:LIST:CONTrol:DATA? 

Return: 1,1,0 

 

3.15.13 分段扫描表功率显示状态 

命令格式 :SENSe<cnum>:SEGMent:LIST:POWer:PORT:STATe <bool> 

:SENSe<cnum>:SEGMent:LIST:POWer:PORT:STATe? 

说明 设置获取扫描表功率显示的状态（当端口功率耦合打开时，此命令显示独立的功率

设置项，反之耦合关闭时，显示各端口的功率设置项）。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<bool>:= ON|OFF|1|0 
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返回类型 Boolean (1=ON,0=OFF) 

默认值 0 

菜单项 扫描 > 段扫描表 > 段扫描表设置 > Power Level 

举例 :SENSe1:SEGMent:LIST:POWer:PORT:STATe 1 

:SENSe1:SEGMent:LIST:POWer:PORT:STATe? 

Return: 1 

 

3.15.14 分段扫描表各频段端口功率 

命令格式 :SENSe<cnum>:SEGMent:LIST:POWer:PORT<pnum>[:LEVel][:IMMediate] 

[:AMPLitude] <value1>,<value2>,...,<valueN> 

:SENSe<cnum>:SEGMent:LIST:POWer:PORT<pnum>[:LEVel][:IMMediate] 

[:AMPLitude]? 

说明 设置获取扫描各频段及各端口功率值。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<pnum>:={[1]-4}，表示端口号。 

<value 1>,<value 2>,...,<valueN>:表示各端口功率值，各频段功率范围均为 -

55~20dB 之间。 

返回类型 数值数组 

默认值 各频段及各端口功率默认为 0dB。 

菜单项 扫描 > 段扫描表 > 段扫描表设置 

举例 :SOURce1:POWer:PORT:COUPle 1 

:SENSe1:SEGMent:DATA 5,0,0,1,0,0,3,9000,1e+06,21, 
-5,1e+09,2e+09,61,1,3e+09,4e+09,101,-5 

 

:SENSe1:SEGMent:LIST:POWer:PORT1 -10,-20,-15 

:SENSe1:SEGMent:LIST:POWer:PORT1? 

Return: -1.000000000000e+01,-2.000000000000e+01,-1.500000000000e+01 

 

:SOURce1:POWer:PORT:COUPle 0 

:SENSe1:SEGMent:LIST:POWer:PORT2? 

Return: -5.000000000000e+00,1.000000000000e+00,-5.000000000000e+00 

 

3.15.15 查询分段扫描表总扫描点数 

命令格式 :SENSe<cnum>:SEGMent:SWEep:POINts? 



 

 

说明 获取扫描表所有扫描的点数。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

返回类型 整型 

默认值 默认值为 21 

菜单项 扫描 > 段扫描表 > 段扫描表设置 

举例 :SENSe1:SEGMent:DATA 
5,0,0,0,0,0,3,9000,1e+06,21,1e+09,2e+09,61,3e+09,4e+09,101 

:SENSe1:SEGMent:SWEep:POINts? 

Return: 183 

 

3.15.16 查询分段扫描表总扫描时间 

命令格式 :SENSe<cnum>:SEGMent:SWEep:TIME[:DATA]? 

说  明 获取扫描表扫完所有频点需要的时间。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

返回类型 浮点型，单位 s（秒） 

默认值 无 

菜单项 扫描 > 段扫描表 > 段扫描表设置 

举例 :SENSe1:SEGMent:DATA 
5,0,0,0,0,1,3,9000,1e+06,21,1,1e+09,2e+09,61,5,3e+09,4e+09,101,10 

 

:SENSe1:SEGMent:SWEep:TIME? 

Return: 16 

 

3.15.17 创建及查询分段扫描表 

命令格式 :SENSe<cnum>:SEGMent:DATA <Data> 

:SENSe<cnum>:SEGMent:DATA? 

说  明 设置或获取分段扫描表。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<Data>:表示按下列顺序（针对于分段扫描表）排列的数组数据。此处 N 为分段数

（由<segm>指定），n是 1 到 N 之间的整数。  

数据 = {<buf>,<stim>,<ifbw>,<pow>,<del>,<swp>,<time>,<segm>, 

<star1>,<stop1>,<nop1>,<ifbw1>,<pow1>,<del 1>,<swp1>,<time1>,... , <star 
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n>,<stop n>,<nop n>,<ifbw n>,<pow n>,<del n>,<swp n>,<time n>,...., <star 
N>,<stop N>,<nop N>,<ifbw N>,<pow N>,<del N>,<swp N>,<time N>} 

 

以上数组中每个参数的详情如下： 

<buf>：始终指定为 5 

<stim>：激励设置模式 

0：用开始值/停止值指定 

1：用中间/宽度值指定 

 

<ifbw>：打开/关闭每个分段的 IF带宽设置。0：关闭，1：打开 

<pow>：打开/关闭每个分段的功率设置。0：关闭，1：打开 

<del>：打开/关闭每个分段的扫描延迟时间设置。0：关闭，1：打开 

<time>：打开/关闭每个分段的扫描模式设置。0：关闭，1：打开 

<segm>：分段数 

指定 1到 201之间的整数。 

 

<star n>：第 n个分段的开始值/中间值。 

<stop n>：第 n个分段的停止值/宽度值。 

<nop n>：第 n个分段的测量点数。 

<ifbw n>：当每个分段的 IF 带宽设置关闭（<ifbw>：0）时，无需第 n个分段的 IF

带宽。 

<pow n>：当每个分段的功率设置关闭（<pow>：0）时，无需第 n个分段的功率。 

<del n>：当每个分段的扫描延迟时间设置关闭（<del>：0）时，无需第 n 个分段的

扫描延迟时间。 

<time n> 当每个分段的扫描时间设置关闭（<time>：0）时，无需第 n个分段的扫

描时间。 

返回类型 数组 

默认值 5,0,0,0,0,0,1,100000,1e6,21 

菜单项 扫描 > 段扫描表 > 段扫描表设置 

举例 :SENSe1:SEGMent:DATA 5,0,0,0,0,0,2,9000,1e+06,21,1e+09,2e+09,61 

:SENSe1:SEGMent:DATA? 

Return: 5.000000000000e+00,0.000000000000e+00,0.000000000000e+00, 
0.000000000000e+00,0.000000000000e+00,0.000000000000e+00, 
2.000000000000e+00,9.000000000000e+03,1.000000000000e+06, 
2.100000000000e+01,1.000000000000e+09,2.000000000000e+09, 
6.100000000000e+01 



 

 

 

3.16 System 命令子系统 

3.16.1 系统 

3.16.1.1 命令列表 

系统时间显示 :DISPlay:CLOCk 

系统日期 :SYSTem:DATE 

系统时间 :SYSTem:TIME 

设置屏幕显示保存格式 :HCOPy:SDUMp:DATA:FORMat 

屏幕打印颜色 :HCOPy:IMAGe 

屏幕打印范围 :HCOPy:AREA 

保存屏幕显示到文件 :HCOPy:FILE 

查询显示图像输出数据 :HCOPy:SDUMp:DATA[:IMMediate]? 

FIFO 的状态 :SYSTem:FIFO[:STATe] 

清空 FIFO内存储的数据 :SYSTem:FIFO:DATA:CLEar 

查询 FIFO内存储数据的个数 :SYSTem:FIFO:DATA:COUNt? 

查询 FIFO内字节的个数 :SYSTem:FIFO:DATA:BYTe:COUNt? 

读取 FIFO内若干个字节 :SYSTem:FIFO:DATA:BYTe? 

读取 FIFO若干个数据 :SYSTem:FIFO:DATA? 

 

3.16.1.2 系统时间显示 

命令格式 :DISPlay:CLOCk <bool> 

:DISPlay:CLOCk? 

说明 这个命令开启/关闭仪器状态栏（在 LCD 显示器的右下角）的时钟显示。 

参数 <bool>:= ON|OFF|1|0 

返回类型 Boolean (1=ON,0=OFF) 

默认值 1 

菜单项 系统 > 时间日期 > Display Date Time 

举例 :DISPlay:CLOCk OFF 

:DISPlay:CLOCk? 

Return: 0 



 

252                                                                                                                   矢量网络分析仪编程手册 

 

3.16.1.3 系统日期 

命令格式 :SYSTem:DATE <string> 

:SYSTem:DATE? 

说明 设置系统内置时钟日期。 

参数 <string>: 表示时钟日期。 

指定 3元素数组数据（内置时钟的日期） 

数据（0）：设置年（1980~2099）。 

数据（1）：设置月（1~12）。 

数据（2）：设置日（1~31）。 

数组索引从 0开始。 

返回类型 数据数组 

默认值 无 

菜单项 系统 > 时间和日期 

举例 :SYSTem:DATE 2020,1,1 

:SYSTem:DATE? 

Return: 2020,01,01 

 

3.16.1.4 系统时间 

命令格式 :SYSTem:TIME <string> 

:SYSTem:TIME? 

说明 设置系统内置时钟时间。 

参数 <string>: 表示时钟时间。 

指定 3元素数组数据（内置时钟的日期） 

数据（0）：设置小时（基于 24小时）。 

数据（1）：设置分钟 （0~59）。 

数据（2）：设置秒    （0~59）。 

数组索引从 0开始。 

返回类型 数据数组 

默认值 无 

菜单项 系统 > 时间和日期 

举例 :SYSTem:TIME 10,30,40 

:SYSTem:TIME? 



 

 

Return: 10,30,40 

 

3.16.1.5 设置屏幕显示保存格式 

命令格式 :HCOPy:SDUMp:DATA:FORMat <type> 

:HCOPy:SDUMp:DATA:FORMat? 

说明 设置或查询屏幕显示保存的图片格式。 

参数 <type>:={JPG|BMP|PNG} 

返回类型 枚举 

默认值 PNG 

菜单项 无 

举例 :HCOPy:SDUMp:DATA:FORMat BMP 

:HCOPy:SDUMp:DATA:FORMat? 

Return :BMP 

 

3.16.1.6 屏幕打印颜色 

命令格式 :HCOPy:IMAGe <type> 

:HCOPy:IMAGe? 

说明 设置或查询屏幕显示截屏的打印颜色。 

参数 <type>:={NORMal|INVert} 

NORMal：截屏的打印颜色与显示颜色一致。 

INVert：截屏的打印颜色与显示颜色相反。 

返回类型 枚举 

默认值 NORMal 

菜单项 系统 > System > Screenshot Settings… 

举例 :HCOPy:IMAGe INVert 

:HCOPy:IMAGe? 

Return :INV 

 

3.16.1.7 屏幕打印范围 

命令格式 :HCOPy:AREA <type> 

:HCOPy:AREA? 

说明 设置或查询屏幕截图的范围。 

参数 <type>:={ALL|WINDow} 

ALL：截取整个屏幕； 

WINDow：只截取波形窗口区域（不包含工具栏，状态栏和菜单栏） 
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返回类型 枚举 

默认值 WINDow 

菜单项 系统 > 系统 > 截屏设置… 

举例 :HCOPy:AREA ALL 

:HCOPy:AREA? 

Return :ALL 

 

3.16.1.8 保存屏幕显示到文件 

命令格式 :HCOPy:FILE <string> 

:HCOPy:FILE? 

说明 将屏幕显示保存为本地文件或者外部存储设备文件。文件名要指定扩展名。 

参数 <string>:表示文件名。 

文件名小于 256个字符； 

文件扩展名支持：".bmp"，".jpg"，".png" 

.bmp:由于文件大，不建议使用； 

.jpg:由于质量差，不建议使用 

.png:推荐 

返回类型 无 

默认值 无 

菜单项 无 

举例 将屏幕显示以".jpg"文件格式保存到本地 local。 

:HCOPy:FILE "/local/myfile.jpg" 

将屏幕显示以".png"文件格式保存到外部 U 盘。 

:HCOPy:FILE "/U-disk0/myfile.png" 

 

3.16.1.9 查询显示图像输出数据 

命令格式 :HCOPy:SDUMp:DATA[:IMMediate]? 

说明 查询屏幕显示保存到外部文件时的图像数据。 

参数 无 

返回类型 二进制数据 

默认值 无 

菜单项 无 



 

 

举例 :HCOPy:SDUMp:DATA:IMMediate? 

Return: 
#73072054BM6\E0.\00\00\00\00\006\00\00\00(\00\00\00\00\05\00\00\s\03\00\00\
01\00\18\00\00\00\00\00\00\E0.\00\FE\11\00\00\EB\10\00\00\00\00\00\00\00\00\
00\00\E8\E9\E9\E8\E9\E9\E8\E9\E9\E8\E9\E9\E8\E9\E9\E8\E9\E9\E8\E9\E9\E8\
E9\E9\E8\E9\E9\E8\E9\E9\E8\E9\E9\E8\E9\E9\E8\E9\E9\E8\E9\E9\E8\E9\E9\E8
\E9\E9\E8\E9\E9\E8\E9\E9\E8\E9\E9\E8\E9\E9\E8\... 

 

3.16.1.10 FIFO的状态 

命令格式 
:SYSTem:FIFO[:STATe] <bool> 

:SYSTem:FIFO[:STATe]? 

说明 设置或问询 FIFO 的状态。 

参数 <bool>:=ON|OFF|1|0 

返回类型 Boolean (1=ON,0=OFF) 

默认值 OFF 

菜单项 无 

举例 :SYSTem:FIFO ON 

:SYSTem:FIFO? 

Return:1 

 

3.16.1.11 清空 FIFO内存储的数据 

命令格式 :SYSTem:FIFO:DATA:CLEar 

说明 清空 FIFO内存储的数据 

参数 无 

返回类型 无 

默认值 无 

菜单项 无 

举例 
:SYSTem:FIFO:DATA:CLEar 

 

3.16.1.12 查询 FIFO内存储数据的个数 

命令格式 :SYSTem:FIFO:DATA:COUNt? 

说明 查询 FIFO内存储数据的个数 

参数 无 

返回类型 整型 

默认值 
0 
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菜单项 无 

举例 :SYSTem:FIFO:DATA:COUNt? 

Return:0 

 

3.16.1.13 查询 FIFO内字节的个数 

命令格式 :SYSTem:FIFO:DATA:BYTe:COUNt? 

说明 查询 FIFO内字节的个数 

参数 无 

返回类型 整型 

默认值 0 

菜单项 无 

举例 :SYSTem:FIFO:DATA:BYTe:COUNt? 

Return:0 

 

3.16.1.14 读取 FIFO内若干个字节 

命令格式 :SYSTem:FIFO:DATA:BYTe? <numeric> 

说明 读取 FIFO 内若干个字节。以数组的形式返回，数组中每一个元素为 1 个字节，命令

中参数的有效范围是[1,min(FIFO 字节数,1.6e6)]，若 numeric 超过 FIFO 内字节数，

无法得到任何结果.FIFO 关闭时执行此命令无法得到任何结果. 

参数 <numeric>:表示字节数组，其范围是 1~1600000。 

返回类型 表示 NOB（Numbers of byte）的字节数组。n为 1到 NOB 之间的整数。 

元素 n-1：字节数组中第 n个字节。 

数组索引从 0开始。 

默认值 无 

菜单项 无 

举例 
:SYSTem:FIFO:DATA:BYTe? 1000 

 

3.16.1.15 读取 FIFO若干个数据 

命令格式 :SYSTem:FIFO:DATA? <numeric> 

说明 读取 FIFO 内若干个数据，以数组的形式返回，数组中的元素代表存储数据的实部或

虚部.命令中参数的有效范围是[1,min(FIFO 数据个数,1e5)]，若 numeric 超过 FIFO

内数据个数时，无法得到任何结果.FIFO关闭时执行此命令无法得到任何结果。 

参数 <numeric>:表示数组数据，其范围是 1~100000。 



 

 

返回类型 表示 NOP（Numbers of point）*2的数组数据。n为 1 到 NOP 之间的整数。 

数据（n*2-2）：第 n个存储数据（实部）。 

数据（n*2-1）：第 n个存储数据（虚部）。 

数组索引从 0开始。 

默认值 无 

菜单项 无 

举例 
:SYSTem:FIFO:DATA? 1000 

 

3.16.2 I/O设置 

3.16.2.1 命令列表 

DHCP 状态 :SYSTem:COMMunicate:LAN:TYPE 

IP 地址设置 :SYSTem:COMMunicate:LAN:IPADdress 

子网掩码设置 :SYSTem:COMMunicate:LAN:SMASk 

网关设置 :SYSTem:COMMunicate:LAN:GATeway 

GPIB 地址 :SYSTem:COMMunicate:GPIB:ADDRess 

BIAS 开关 :SYSTem:BIAS 

BIAS 电压 :SYSTem:BIAS:VOLT 

BIAS 输出端口 :SYSTem:BIAS:OUTPut:PORT 

GPS 开关 :SYSTem:GPS 

查询 GPS 信息 :SYSTem:GPS:INFO? 

 

3.16.2.2 DHCP状态 

命令格式 :SYSTem:COMMunicate:LAN:TYPE <type> 

:SYSTem:COMMunicate:LAN:TYPE? 

说明 设置或获取系统 IP 分配方式。 

参数 <type>:={STATIC|DHCP} 

返回类型 枚举 

默认值 STATIC 

菜单项 系统 > I/O 设置 > 网络设置 > DHCP 
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举例 :SYSTem:COMMunicate:LAN:TYPE DHCP 

:SYSTem:COMMunicate:LAN:TYPE? 

Return: DHCP 

 

3.16.2.3 IP地址设置 

命令格式 :SYSTem:COMMunicate:LAN:IPADdress <string> 

:SYSTem:COMMunicate:LAN:IPADdress? 

说明 设置或获取系统的 IP 地址。 

参数 <string>为带双引号的字符串，格式为“xxx.xxx.xxx.xxx"，且必须符合 IP 的设置规

范（0-255:0-255:0-255:0-255）。 

返回类型 string 

默认值 无 

菜单项 系统 > I/O 设置> 网络设置 > IP 地址 

举例 :SYSTem:COMMunicate:LAN:IPADdress "10.11.13.100" 

:SYSTem:COMMunicate:LAN:IPADdress? 

Return: "10.11.13.100" 

 

3.16.2.4 子网掩码设置 

命令格式 :SYSTem:COMMunicate:LAN:SMASk <string> 

:SYSTem:COMMunicate:LAN:SMASk? 

说明 设置或获取系统子网掩码。 

参数 <string>为带双引号的字符串，格式为“xxx.xxx.xxx.xxx"，且必须符合 IP 地址的网

卡规范（0-255:0-255:0-255:0-255） 

返回类型 子网掩码字符串 

默认值 无 

菜单项 系统 > I/O 设置> 网络设置 > 子网掩码 

举例 :SYSTem:COMMunicate:LAN:SMASk "255.255.255.0" 

:SYSTem:COMMunicate:LAN:SMASk? 

Return: "255.255.255.0" 

 

3.16.2.5 网关设置 

命令格式 :SYSTem:COMMunicate:LAN:GATeway <string> 

:SYSTem:COMMunicate:LAN:GATeway? 

说明 设置或获取网关。 



 

 

参数 <string>为带双引号的字符串，格式为“xxx.xxx.xxx.xxx"，且必须符合 IP 地址的网

卡规范（0-255:0-255:0-255:0-255） 

返回类型 网关字符串 

默认值 无 

菜单项 系统 > I/O 设置> 网络设置 > 网关 

举例 :SYSTem:COMMunicate:LAN:GATeway "10.11.13.1" 

:SYSTem:COMMunicate:LAN:GATeway? 

Return: "10.11.13.1" 

 

3.16.2.6 直流偏置（仅 SHN900A系列机型支持） 

3.16.2.6.1  BIAS 开关 

命令格式 :SYSTem:BIAS <bool> 

:SYSTem:BIAS? 

说明 设置或获取 BIAS 开关。 

参数 <bool>:= ON|OFF|1|0 

返回类型 Boolean (1=ON,0=OFF) 

默认值 0 

菜单项 系统 > I/O 设置 > 直流偏置 > 直流偏置使能 

举例 :SYSTem:BIAS 1 

:SYSTem:BIAS? 

Return: 1 

 

3.16.2.6.2  BIAS 电压 

命令格式 :SYSTem:BIAS:VOLT <numeric> 

:SYSTem:BIAS:VOLT? 

说明 设置或获取 BIAS 电压。 

参数 <numeric> :表示电压值，其范围是 12V~32V。 

返回类型 浮点型，单位 V 

默认值 12V 

菜单项 系统 > I/O 设置 >直流偏置 > 电压 

举例 :SYSTem:BIAS:VOLT 20 

:SYSTem:BIAS:VOLT? 

Return: 20 
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3.16.2.6.3  BIAS 输出端口 

命令格式 :SYSTem:BIAS:OUTPut:PORT <type> 

:SYSTem:BIAS:OUTPut:PORT? 

说明 设置或获取 BIAS 输出端口。 

参数 <type>:={BIAS|PORT1|PORT2} 

返回类型 枚举 

默认值 BIAS 

菜单项 系统 > I/O 设置 >直流偏置 > 直流输出口 

举例 :SYSTem:BIAS:OUTPut:PORT PORT2 

:SYSTem:BIAS:OUTPut:PORT? 

Return: PORT2 

 

3.16.2.7 GPIB地址 

命令格式 :SYSTem:COMMunicate:GPIB:ADDRess <numeric> 

:SYSTem:COMMunicate:GPIB:ADDRess? 

说明 设置或获取矢量网络分析仪的 GPIB 地址。 

参数 <numeric>:表示 GPIB 地址，其范围是 1~30。 

返回类型 整型 

默认值 18 

菜单项 系统 > I/O 设置 > GPIB 

举例 :SYSTem:COMMunicate:GPIB:ADDRess 7 

:SYSTem:COMMunicate:GPIB:ADDRess? 

Return: 7 

 

3.16.2.8 GPS接收（仅 SHN900A系列机型支持） 

3.16.2.8.1  GPS 开关 

命令格式 :SYSTem:GPS <bool> 

:SYSTem:GPS? 

说明 设置或获取 GPS 开关。 

参数 <bool>:= N|OFF|1|0 

返回类型 Boolean (1=ON,0=OFF) 

默认值 0 

菜单项 系统 > I/O 设置 > GPS 接收 



 

 

举例 :SYSTem:GPS 1 

:SYSTem:GPS? 

Return: 1 

 

3.16.2.8.2  查询 GPS 信息 

命令格式 :SYSTem:GPS:INFO? 

说明 获取 GPS 信息。 

参数 无 

返回类型 字符串 

默认值 无 

菜单项 无 

举例 :SYSTem:GPS:INFO? 

Return: $GPGGA,012447.099,,,,,0,0,,,M,,M,,*4C 

 

3.16.3 预置复位 

3.16.3.1 命令列表 

出厂设置复位 :SYSTem:PRESet 

复位选项 :SYSTem:PRESet:TYPE 

用户设置复位 :SYSTem:UPReset 

加载用户预设文件名 SYSTem:UPReset:LOAD[:FILE] 

上次设置复位 :SYSTem:LPReset 

上电启动选项 :SYSTem:PON:TYPE 

上电自启动状态 :SYSTem:PONLine[:STATe] 

恢复出厂 :SYSTem:FDEFault 

 

3.16.3.2 出厂设置复位 

命令格式 :SYSTem:PRESet 

说明 这个命令将 VNA 的设置状态预置为最初的出厂设置（默认状态）。 

参数 无 

返回类型 无 
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默认值 无 

菜单项 系统 > 预置复位 > 复位选项为"默认"，同时执行 

系统 > 预置复位 > 预置复位 

举例 :SYSTem:PRESet 

 

3.16.3.3 复位选项 

命令格式 :SYSTem:PRESet:TYPE <type> 

说  明 设置或获取系统预置复位的类型。 

参数 <type>:={DEFault|LAST|USER} 

返回类型 枚举 

默认值 无 

菜单项 系统 > 预置复位 > 复位选项 

举例 :SYSTem:PRESET:TYPE USER 

:SYSTem:PRESET:TYPE? 

Return: USER 

 

3.16.3.4 用户设置复位 

命令格式 :SYSTem:UPReset 

说  明 将系统的设置状态预置为用户预设的配置。 

参数 无 

返回类型 无 

默认值 无 

菜单项 
系统 > 预置复位 > 复位选项为"用户"，同时执行 

系统 > 预置复位 > 预置复位 

举例 :SYSTem:UPReset 

 

3.16.3.5 加载用户预设文件名 

命令格式 SYSTem:UPReset:LOAD[:FILE] <string> 

说明 设置系统用户预设的文件名。 

参数 <string>: 表示文件名。 



 

 

返回类型 无 

默认值 无 

菜单项 无 

举例 SYSTem:UPReset:LOAD "local/user_preset.sta" 

3.16.3.6 上次设置复位 

命令格式 :SYSTem:LPReset 

说明 这个命令将 VNA 的设置状态恢复为上一次软件关机前的设置。 

参数 无 

返回类型 无 

默认值 无 

菜单项 系统 > 预置复位 > 复位选项为"上一次"，同时执行 

系统 > 预置复位 > 预置复位 

举例 :SYSTem:LPReset 

 

3.16.3.7 上电启动选项 

命令格式 :SYSTem:PON:TYPE <type> 

:SYSTem:PON:TYPE? 

说明 设置或获取系统上电启动的设置类型。 

参数 <type>:={DEFault|LAST|USER} 

返回类型 枚举 

默认值 DEFault 

菜单项 系统 > 预置复位 > 开机选项 

举例 :SYSTem:PON:TYPE USER 

:SYSTem:PON:TYPE? 

Return: USER 

 

3.16.3.8 上电自启动状态 

命令格式 :SYSTem:PONLine[:STATe] <bool> 

:SYSTem:PONLine[:STATe]? 

说明 设置和查询设备的上电自启动状态。 

参数 <bool>:= ON|OFF|1|0 

返回类型 Boolean (1=ON,0=OFF) 
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默认值 0 

菜单项 系统 > 预置复位 > 上电自启动 

举例 :SYSTem:PONLine ON 

:SYSTem:PONLine? 

Return: 1 

 

3.16.3.9 恢复出厂 

命令格式 :SYSTem:FDEFault 

说明 将系统的设置状态恢复为出厂状态。 

参数 无 

返回类型 无 

默认值 无 

菜单项 系统 > 预置复位 > 恢复出厂设置 

举例 :SYSTem:FDEFault 

3.16.4 帮助 

3.16.4.1 命令列表 

消息通知开关 :DISPlay:MESSage:STATe 

功率检测开关 :DISPlay:MESSage:POWer:UNLevel 

背光状态 :SYSTem:BACKlight 

功率计产品信息 :SYSTem:COMMunicate:USB:PMETer:CATalog? 

 

3.16.4.2 消息通知开关 

命令格式 :DISPlay:MESSage:STATe <bool> 

:DISPlay:MESSage:STATe? 

说  明 打开或关闭消息通知。 

参数 <bool>:= ON|OFF|1|0 

返回类型 Boolean (1=ON,0=OFF) 

默认值 1 

菜单项 帮助 > 消息设置… > Enable Messages Display 



 

 

举例 :DISP:MESS:STAT 0 

:DISP:MESS:STAT? 

Return: 0 

 

3.16.4.3 功率检测开关 

命令格式 :DISPlay:MESSage:POWer:UNLevel <bool> 

:DISPlay:MESSage:POWer:UNLevel? 

说  明 打开或关闭功率检测。 

参数 <bool>:= ON|OFF|1|0 

返回类型 Boolean (1=ON,0=OFF) 

默认值 1 

菜单项 帮助 > 消息设置… > Enable Power Unlevel Detection 

举例 :DISPl:MESS:POW:UNL 0 

:DISPl:MESS:POW:UNL? 

Return: 0 

 

3.16.4.4 背光状态 

命令格式 :SYSTem:BACKlight <bool> 

:SYSTem:BACKlight? 

说明 设置或获取设备 LCD 背光状态。 

参数 <bool>:= ON|OFF|1|0 

返回类型 Boolean (1=ON,0=OFF) 

默认值 1 

菜单项 无 

举例 :SYSTem:BACKlight OFF 

:SYSTem:BACKlight? 

Return: 0 

 

3.16.4.5 功率计产品信息 

命令格式 :SYSTem:COMMunicate:USB:PMETer:CATalog? 

说明 查询产品所用功率计的设备信息。 

参数 无 

返回类型 包含产品产品型号及序列号等信息的字符串。 

默认值 无 

菜单项 无 
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举例 :SYSTem:COMMunicate:USB:PMETer:CATalog? 

 

 

3.16.5 蜂鸣器 

3.16.5.1 命令列表 

完成音测试 :SYSTem:BEEPer:COMPlete:IMMediate 

完成音开关状态 :SYSTem:BEEPer:COMPlete:STATe 

警告音测试 :SYSTem:BEEPer:WARNing:IMMediate 

警告音开关状态 :SYSTem:BEEPer:WARNing:STATe 

 

3.16.5.2 完成音测试 

命令格式 :SYSTem:BEEPer:COMPlete:IMMediate 

说明 这个命令发出蜂鸣以通知操作完成。 

参数 无 

返回类型 无 

默认值 无 

菜单项 系统 > 蜂鸣器 > 完成音测试 

举例 :SYSTem:BEEPer:COMPlete:IMMediate 

3.16.5.3 完成音开关状态 

命令格式 :SYSTem:BEEPer:COMPlete:STATe <bool> 

:SYSTem:BEEPer:COMPlete:STATe? 

说明 这个命令开启/关闭或返回通知操作完成的蜂鸣器状态。 

参数 <bool>:= ON|OFF|1|0 

返回类型 Boolean (1=ON,0=OFF) 

默认值 ON 

菜单项 系统 > 蜂鸣器 > 完成音开关 

举例 :SYSTem:BEEPer:COMPlete:STATe OFF 

:SYSTem:BEEPer:COMPlete:STATe? 

Return: 0 

 



 

 

3.16.5.4 警告音测试 

命令格式 :SYSTem:BEEPer:WARNing:IMMediate 

说明 这个命令发出蜂鸣通知警告/极限测试的结果。 

参数 无 

返回类型 无 

默认值 无 

菜单项 系统 > 蜂鸣器 > 警告音测试 

举例 :SYSTem:BEEPer:WARNing:IMMediate 

 

3.16.5.5 警告音开关状态 

命令格式 :SYSTem:BEEPer:WARNing:STATe <bool> 

:SYSTem:BEEPer:WARNing:STATe? 

说明 这个命令开启/关闭或返回通知警告/极限测试结果的蜂鸣器状态。 

参数 <bool>:= ON|OFF|1|0 

返回类型 Boolean (1=ON,0=OFF) 

默认值 ON 

菜单项 系统 > 蜂鸣器 > 警告音开关 

举例 :SYSTem:BEEPer:WARNing:STATe ON 

:SYSTem:BEEPer:WARNing:STATe? 

Return: 1 

 

3.17 Trigger 命令子系统 

3.17.1 命令列表 

通道触发模式 :SENSe<cnum>:SWEep:MODE 

重新启动触发 :ABORt 

连续初始化模式 :INITiate<cnum>:CONTinuous 

单次触发 :INITiate<cnum>[:IMMediate] 

触发源 :TRIGger[:SEQuence]:SOURce 

立即触发 :TRIGger[:SEQuence]:SINGle 
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立即触发 :TRIGger[:SEQuence][:IMMediate] 

触发有效范围 :TRIGger[:SEQuence]:SCOPe 

点点触发模式 :TRIGger[:SEQuence]:POINt 

外部触发输入极性 :TRIGger:SEQuence:EXTernal:SLOPe 

外部触发延迟时间 :TRIGger[:SEQuence]:EXTernal:DELay 

外部触发输出状态 :TRIGger:OUTPut:STATe 

外部触发生成脉冲极性 :TRIGger:OUTPut:POLarity 

触发位置 :TRIGger:OUTPut:POSition 

 

3.17.2 通道触发模式 

命令格式 
:SENSe<cnum>:SWEep:MODE <type> 

:SENSe<cnum>:SWEep:MODE? 

说明 设置或者查询指定通道的触发模式。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<type>:={HOLD|SINGLe|CONTinuous} 

HOLD：通道停止扫描触发。 

SINGLe：通道进行一次扫描触发，然后进入 HOLD 状态。 

CONTinuous：通道持续扫描触发。 

返回类型 字符串 

默认值 CONTinuous 

菜单项 触发 > 触发 

举例 :SENSe:SWEep:MODE HOLD 

:SENSe:SWEep:MODE? 

 

Return:HOLD 

 

3.17.3 重新启动触发 

命令格式 :ABORt 

说明 选择通道将重新触发并开始测量。 



 

 

参数 无 

返回类型 无 

默认值 无 

菜单项 触发 > 重启触发 

举例 :ABORt 

 

3.17.4 连续初始化模式 

命令格式 :INITiate<cnum>:CONTinuous <bool> 

:INITiate<cnum>:CONTinuous? 

说明 设置/获取连续初始化模式的状态。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<bool>:= ON|OFF|1|0 

真或开启：开启连续初始化模式。 

假或关闭：关闭连续初始化模式。 

返回类型 Boolean (1=ON,0=OFF) 

默认值 OFF 

菜单项 触发> 连续触发/触发保持 

举例 :INITiate1:CONTinuous 1 

:INITiate1:CONTinuous? 

Return: 1 

 

3.17.5 单次触发 

命令格式 :INITiate<cnum>[:IMMediate] 

说明 选择通道设置单次触发模式并开始测量。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

返回类型 无 

默认值 无 

菜单项 触发 > 单步 

举例 :INITiate1 
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3.17.6 触发源 

命令格式 :TRIGger[:SEQuence]:SOURce <type> 

:TRIGger[:SEQuence]:SOURce? 

说明 设置或获取触发源 

内部触发 

用内部触发自动生成连续触发。 

外部触发 

当通过外部触发连接器或处理器接口从外部输入触发信号时生产触发。 

手动触发 

执行前面板上的 Trigger > Trigger 按键操作时生成触发。 

总线触发 

执行 SCPI.IEEE4882.TRG 对象时生成触发 

参数 <type>:={INTernal|EXTernal|MANual|BUS} 

返回类型 枚举 

默认值 INTernal 

菜单项 触发 > 触发源 

举例 :TRIGger:SOURce EXTernal 

:TRIGger:SOURce? 

Return: EXT 

 

3.17.7 立即触发 

命令格式 
:TRIGger[:SEQuence]:SINGle 

:TRIG:SING 

说明 

触发系统为触发等待状态（即触发模式为 single 或 Continuous，且触发源为总线

触发或手动触发），发送该命令会立即生成触发并执行测量。该指令之后若用

*OPC?进行问询，直到等待触发扫描测量完成后*OPC？才会返回 1。具体示例参

见第四章“SCPI 示例样本程序”之“等待触发状态 OPC?”。 

参数 无 

返回类型 无 



 

 

默认值 无 

菜单项 无 

举例 

:TRIGger:SEQuence:SOURce BUS 

:TRIGger:SEQuence:SINGle 

*OPC? 

Return：1  #直到等待触发扫描测量完成后*OPC？才会返回 1。 

 

3.17.8 立即触发 

命令格式 :TRIGger[:SEQuence][:IMMediate] 

说明 

触发系统为触发等待状态（即触发模式为 single 或 Continuous，且触发源为总线

触发或手动触发），发送该命令会立即生成触发并执行测量。该指令之后若用

*OPC?进行问询，*OPC？会立即返回 1，表示该本条指令已经执行完毕。 

参数 无 

返回类型 无 

默认值 无 

菜单项 无 

举例 

:TRIGger:SEQuence:SOURce BUS 

:TRIGger:SEQuence:IMMediate 

*OPC? 

Return:1    #立即返回 1 

 

3.17.9 触发有效范围 

命令格式 :TRIGger[:SEQuence]:SCOPe <type> 

:TRIGger[:SEQuence]:SCOPe? 

说明 设置/获取触发生效的范围(当前或所有通道)。 

参数 <type>:={ALL|ACTive} 

返回类型 枚举 

默认值 ALL 

菜单项 触发 > 触发范围 

举例 :TRIGger:SCOPe ACTive 

:TRIGger:SCOPe? 
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Return: ACT 

 

3.17.10 点触发模式 

命令格式 :TRIGger[:SEQuence]:POINt <bool> 

:TRIGger[:SEQuence]:POINt? 

说明 开启或关闭点触发。 

参数 <bool>:= ON|OFF|1|0 

返回类型 Boolean (1=ON,0=OFF) 

默认值 OFF 

菜单项 触发> 触发设置 > 触发模式 

举例 :TRIGger:POINt 1 

:TRIGger:POINt? 

Return: 1 

 

3.17.11 外部触发输入极性 

命令格式 :TRIGger:SEQuence:EXTernal:SLOPe <type> 

:TRIGger:SEQuence:EXTernal:SLOPe? 

说明 设置/获取外部输入触发极性。 

参数 <type>:={POSitive|NEGative} 

返回类型 枚举 

默认值 POSitive 

菜单项 触发 > 触发设置 > 外部触发输入 

举例 :TRIGger:SEQuence:EXTernal:SLOPe NEGative 

:TRIGger:SEQuence:EXTernal:SLOPe? 

Return: NEG 

 

3.17.12 外部触发延迟时间 

命令格式 :TRIGger[:SEQuence]:EXTernal:DELay <numeric> 

:TRIGger[:SEQuence]:EXTernal:DELay? 

说明 设置/获取外部触发延迟时间。 



 

 

参数 <numeric>:表示外部触发延迟时间。 

返回类型 浮点型，单位 s（秒） 

默认值 0 

菜单项 触发 > 触发设置 > 触发延时 

举例 :TRIGger:EXTernal:DELay 1 

:TRIGger:EXTernal:DELay? 

Return: 1 

3.17.13 外部触发输出状态 

命令格式 :TRIGger:OUTPut:STATe <bool> 

:TRIGger:OUTPut:STATe? 

说  明 设置/获取外部触发输出的状态。 

参数 <bool>:= ON|OFF|1|0 

返回类型 Boolean (1=ON,0=OFF) 

默认值 0 

菜单项 触发 > 触发设置 > 外部触发输出 

举例 :TRIGger:OUTPut:STATe 1 

:TRIGger:OUTPut:STATe? 

Return: 1 

 

3.17.14 外部触发生成脉冲极性 

命令格式 :TRIGger:OUTPut:POLarity <type> 

:TRIGger:OUTPut:POLarity? 

说  明 设置/获取外部触发生成脉冲的极性。 

参数 <type>:={POSitive|NEGative} 

返回类型 枚举 

默认值 POSitive 

菜单项 触发 > 触发设置 > 极性 

举例 :TRIGger:OUTPut:POLarity NEGative 

:TRIGger:OUTPut:POLarity? 

Return: NEG 
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3.17.15 触发位置 

命令格式 :TRIGger:OUTPut:POSition <type> 

:TRIGger:OUTPut:POSition? 

说明 设置/获取外部触发输出端口的位置。 

参数 <type>:={AFTer|BEFore} 

返回类型 枚举 

默认值 AFTer 

菜单项 触发 > 触发设置 > 位置 

举例 :TRIGger:OUTPut:POSition BEFore 

:TRIGger:OUTPut:POSition? 

Return: BEF 

 

3.18 SWM命令子系统 

3.18.1 命令列表 

拓展端口启用状态 :SYSTem:EXTPort[:STATe] 

查询连接矩阵开关编号 :SYSTem:EXTPort:SMATrix:CATalog? 

查询所连接开关矩阵的型号 :SYSTem:EXTPort:SMATrix<num>:MODel? 

查询所连接开关矩阵的序列号 :SYSTem:EXTPort:SMATrix<num>:SERial? 

启动配置矩阵开关端口连接 :SYSTem:EXTPort:SMATrix:CONFigure:STARt 

放弃配置矩阵开关端口连接 :SYSTem:EXTPort:SMATrix:CONFigure:ABORt 

完成并应用矩阵开关端口连接 :SYSTem:EXTPort:SMATrix:CONFigure:END 

设置开关矩阵与 VNA 物理端口的 RF连接 :SYSTem:EXTPort:SMATrix:CONFigure:TVNA  

设置开关矩阵射频输入端口与 VNA 物理端口

连接 

:SYSTem:EXTPort:SMATrix<num>:CONFigure:M
VNA  

设置开关矩阵射频输出端口与 VNA 端口连接 :SYSTem:EXTPort:SMATrix<num>:CONFigure:M
TESt  

 

3.18.2 拓展端口启用状态 

命 令 格 :SYSTem:EXTPort[:STATe] <bool> 



 

 

式 :SYSTem:EXTPort[:STATe]? 

说明 设置或获取拓展端口的启用状态。 

参数 <bool>:= ON|OFF|1|0 

返回值 Boolean (1=ON,0=OFF) 

默认值 OFF 

菜单项 System > 外部端口 > 端口拓展使能 

举例 :SYSTem:EXTPort:STATe 1 

:SYSTem:EXTPort:STATe? 

 

Return 1 

 

3.18.3 查询连接矩阵开关编号 

命 令 格

式 

:SYSTem:EXTPort:SMATrix:CATalog? 

说明 查询当前 SNA 已连接的矩阵开关的编号。当连接多个开关矩阵时，返回值是包

含一逗号分割的开关矩阵编号列表。 

参数 无 

返回值 字符串 

默认值 无 

菜单项 无 

举例 如果 SNA 连接两个矩阵开关，则 

:SYSTem:EXTPort:SMATrix:CATalog? 

Return 1,2 

 

3.18.4 查询所连接开关矩阵的型号 

命 令 格

式 

:SYSTem:EXTPort:SMATrix<num>:MODel? 

说明 查询所连接的开关矩阵的型号。 

参数 <num>: 开关矩阵编号 

返回值 字符串 

默认值 无 
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菜单项 无 

举例 :SYSTem:EXTPort:SMATrix1:MODel? 

Return “SSM5124” 

 

3.18.5 查询所连接开关矩阵的序列号 

命 令 格

式 

:SYSTem:EXTPort:SMATrix<num>:SERial? 

说明 查询所连接的开关矩阵的序列号。 

参数 <num>: 开关矩阵编号。 

返回值 字符串 

默认值 无 

菜单项 无 

举例 :SYSTem:EXTPort:SMATrix1:SERial? 

Return “SSM5AAAX7R0003” 

 

3.18.6 启动配置矩阵开关端口连接 

命 令 格

式 

:SYSTem:EXTPort:SMATrix:CONFigure:STARt 

说明 启动手动 RF 连接配置。RF 连接配置包括 VNA,一组开关矩阵和 DUT 测试端口

之间的 RF 连接。 

该命令与“:SYSTem:EXTPort:SMATrix:CONFigure:END”成对使用，使得修

改后的配置生效。 

参数 无 

返回值 无 

默认值 无 

菜单项 无 

举例 #打开端口拓展功能，执行 VNA 端口和测试端口的默认分配。 

:SYSTem:EXTPort:STATe 1 

#开启手动 RF 连接配置 

:SYSTem:EXTPort:SMATrix:CONFigure:STARt 

#定义非默认矩阵-VNA 端口连接：矩阵端口 1 到 VNA 端口 2、矩阵端口 2 到 VNA



 

 

端口 4、矩阵端口 3 到 VNA 端口 1，以及矩阵端口 4 到 VNA 端口 3. 

:SYSTem:EXTPort:SMATrix1:CONFigure:MVNA 1,2,2,4,3,1,4,3 

#配置 4 个矩阵测试端口：矩阵测试端口 1 为测试端口 1，矩阵测试端口 7 为测试

端口 2，矩阵测试端口 11 为测试端口 3，矩阵测试端口 22 为测试端口 4. 

:SYSTem:EXTPort:SMATrix1:CONFigure:MTESt 1,1,7,2,11,3,22,4 

#应用手动射频连接配置 

:SYSTem:EXTPort:SMATrix:CONFigure:END 

 

3.18.7 放弃配置矩阵开关端口连接 

命 令 格

式 

:SYSTem:EXTPort:SMATrix:CONFigure:ABORt 

说明 取消矩阵开关端口的连接配置。即所进行的配备会被丢弃。 

参数 无 

返回值 无 

默认值 无 

菜单项 无 

举例 :SYSTem:EXTPort:SMATrix:CONFigure:ABORt 

 

3.18.8 完成并应用矩阵开关端口连接 

命 令 格

式 

:SYSTem:EXTPort:SMATrix:CONFigure:END 

说明 完成矩阵开关端口的配置连接。如果是有效配置，则会激活应用，否则，将返回错

误并丢弃新配置，保持先前的配置状态。 

参数 无 

返回值 无 

默认值 无 

菜单项 无 

举例 :SYSTem:EXTPort:SMATrix:CONFigure:END 
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3.18.9 设置开关矩阵与 VNA物理端口的 RF连接 

命 令 格

式 

:SYSTem:EXTPort:SMATrix:CONFigure:TVNA 
<testport1>,<VNAport1>[,<testport2>,<VNAport2> […]] 

说明 设置 VNA 物理端口与矩阵开关射频输出端口的连接，即将矩阵开关射频输出端口

直接分配给 VNA 物理端口。 

参数 <testport1>: 开关矩阵射频输出端口号，输出端口号必须从 1开始编号。 

<VNAport1>: VNA 物理端口号 

 

返回值 无 

默认值 无 

菜单项 无 

举例 将开关矩阵射频输出端口的 1，2，3，4分配给 VNA 物理端口 1,2,3,4 

:SYSTem:EXTPort:SMATrix:CONFigure:STARt 

:SYSTem:EXTPort:SMATrix:CONFigure:TVNA 1,1,2,2,3,3,4,4 

:SYSTem:EXTPort:SMATrix:CONFigure:END 

 

3.18.10 设置开关矩阵射频输入端口与 VNA物理端口连接 

命 令 格

式 

:SYSTem:EXTPort:SMATrix<num>:CONFigure:MVNA 
{<matrixVNAport>,<VNAPort>} 

说明 设置开关矩阵射频输入端口与 VNA 物理端口的连接，以逗号分隔的端口号列表形

式。 

参数 <num>：开关矩阵编号。 

<matrixVNAport>开关矩阵的射频输入端口号。 

<VNAPort>：VNA 物理端口号。 

返回值 无 

默认值 无 

菜单项 无 

举例 #打开端口拓展功能，执行 VNA 端口和测试端口的默认分配。 

:SYSTem:EXTPort:STATe 1 

#开启手动 RF 连接配置 

:SYSTem:EXTPort:SMATrix:CONFigure:STARt 



 

 

#定义非默认矩阵-VNA 端口连接：矩阵端口 1 到 VNA 端口 2、矩阵端口 2 到 VNA

端口 4、矩阵端口 3 到 VNA 端口 1，以及矩阵端口 4 到 VNA 端口 3. 

:SYSTem:EXTPort:SMATrix1:CONFigure:MVNA 1,2,2,4,3,1,4,3 

#配置 4 个矩阵测试端口：矩阵测试端口 1 为测试端口 1，矩阵测试端口 7 为测试

端口 2，矩阵测试端口 11 为测试端口 3，矩阵测试端口 22 为测试端口 4. 

:SYSTem:EXTPort:SMATrix1:CONFigure:MTESt 1,1,7,2,11,3,22,4 

#应用手动射频连接配置 

:SYSTem:EXTPort:SMATrix:CONFigure:END 

 

3.18.11 设置开关矩阵射频输出端口与 VNA端口连接 

命 令 格

式 

:SYSTem:EXTPort:SMATrix<num>:CONFigure:MTESt  

{<MatrixTestPort>,<Testport>} 

说明 设置矩阵开关射频输出端口与 VNA 物理端口的连接列表。 

参数 <num>：表示开关矩阵编号。 

<MatrixTestPort>：开关矩阵射频输出端口 

<Testport>：VNA 端口号，VNA 端口必须从 1开始编号。 

返回值 无 

默认值 无 

菜单项 无 

举例 #打开端口拓展功能，执行 VNA 端口和测试端口的默认分配。 

:SYSTem:EXTPort:STATe 1 

#开启手动 RF 连接配置 

:SYSTem:EXTPort:SMATrix:CONFigure:STARt 

#定义非默认矩阵-VNA 端口连接：矩阵端口 1 到 VNA 端口 2、矩阵端口 2 到 VNA

端口 4、矩阵端口 3 到 VNA 端口 1，以及矩阵端口 4 到 VNA 端口 3. 

:SYSTem:EXTPort:SMATrix1:CONFigure:MVNA 1,2,2,4,3,1,4,3 

#配置 4 个矩阵测试端口：矩阵测试端口 1 为测试端口 1，矩阵测试端口 7 为测试

端口 2，矩阵测试端口 11 为测试端口 3，矩阵测试端口 22 为测试端口 4. 

:SYSTem:EXTPort:SMATrix1:CONFigure:MTESt 1,1,7,2,11,3,22,4 

#应用手动射频连接配置 

:SYSTem:EXTPort:SMATrix:CONFigure:END 
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3.19 PM命令子系统(Option，SHN900A系列机型不支持) 

3.19.1 命令列表 

脉冲测量模式 :SENSe<cnum>:SWEep:PULSe:MODE 

脉冲测量源脉冲宽度 :SENSe<cnum>:SWEep:PULSe:PRIMary:WIDth 

脉冲测量源脉冲周期 :SENSe<cnum>:SWEep:PULSe:PRIMary:PERiod 

脉冲测量源脉冲频率 :SENSe<cnum>:SWEep:PULSe:PRIMary:FREQuency 

脉冲测量源脉冲延迟 :SENSe<cnum>:SWEep:PULSe:PRIMary:DELay 

脉冲测量全部接收机增益模式 :SENSe<cnum>:SWEep:PULse:GAIN:MODE 

脉冲测量指定接收机增益模式 :SENSe<cnum>:SWEep:PULse:RECeiver:GAIN:MODE 

脉冲测量接收机脉冲延迟 :SENSe<cnum>:PULSe:MEASurement:DELay 

自动选择脉冲包络模式下的扫描时间 :SENSe<cnum>:SWEep:PULSe:CWTime:[AUTO] 

自动选择源脉冲宽度与延迟 :SENSe<cnum>:SWEep:PULSe:TIMing:[AUTO] 

 

3.19.2 脉冲测量模式 

命令格式 :SENSe<cnum>:SWEep:PULSe:MODE <type> 

:SENSe<cnum>:SWEep:PULSe:MODE? 

说明 设置或获取脉冲测量模式。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<type>:={OFF|STD|PROFile}，表示脉冲测量模式。 

返回类型 枚举 

默认值 OFF 

菜单项 扫描 > 脉冲设置... > Pulse Measurement 

举例 :SENS:SWE:PULS:MODE STD 

:SENS:SWE:PULS:MODE? 

Return: STD 

 



 

 

3.19.3 脉冲测量源脉冲宽度 

命令格式 :SENSe<cnum>:SWEep:PULSe:PRIMary:WIDth <numeric> 

:SENSe<cnum>:SWEep:PULSe:PRIMary:WIDth? 

说明 设置或获取源脉冲的脉宽。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<numeric>:表示脉宽，其范围是 1us~1000s。 

返回类型 浮点型，单位秒 

默认值 200us 

菜单项 扫描 > 脉冲设置... > Pulse Timing> Pulse Width 

举例 :SENS:SWE:PULS:PRIM:WID 0.0005 

:SENS:SWE:PULS:PRIM:WID? 

Return: 0.0005 

 

3.19.4 脉冲测量源脉冲周期 

命令格式 :SENSe<cnum>:SWEep:PULSe:PRIMary:PERiod <numeric> 

:SENSe<cnum>:SWEep:PULSe:PRIMary:PERiod? 

说明 设置或获取源脉冲的周期。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<numeric>:表示周期，其范围是 1us~1000s。 

返回类型 浮点型，单位秒 

默认值 1ms 

菜单项 扫描 > 脉冲设置... > Pulse Timing> Pulse Period 

举例 :SENS:SWE:PULS:PRIM:PER 0.002 

:SENS:SWE:PULS:PRIM:PER? 

Return: 0.002 

 

3.19.5 脉冲测量源脉冲频率 

命令格式 :SENSe<cnum>:SWEep:PULSe:PRIMary:FREQuency <numeric> 

:SENSe<cnum>:SWEep:PULSe:PRIMary:FREQuency? 

说明 设置或获取源脉冲的频率。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 
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<numeric>:表示频率，其范围是(1m~1M)Hz。 

返回类型 浮点型，单位 Hz（赫兹） 

默认值 1kHz 

菜单项 扫描 > 脉冲设置... > Pulse Timing> Pulse Frequency 

举例 :SENS:SWE:PULS:PRIM:FREQ 100000 

:SENS:SWE:PULS:PRIM:FREQ? 

Return: 100000 

 

3.19.6 脉冲测量源脉冲延迟 

命令格式 :SENSe<cnum>:SWEep:PULSe:PRIMary:DELay <numeric> 

:SENSe<cnum>:SWEep:PULSe:PRIMary:DELay? 

说明 设置或获取源脉冲的延迟。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<numeric>:表示延迟时间，其范围是 1us~1000s。 

返回类型 浮点型，单位秒。 

默认值 200us 

菜单项 扫描 > 脉冲设置... > Pulse Timing> Pulse Delay 

举例 :SENS:SWE:PULS:PRIM:DEL 0.0004 

:SENS:SWE:PULS:PRIM:DEL? 

Return: 0.0004 

 

3.19.7 脉冲测量全部接收机增益模式 

命令格式 :SENSe<cnum>:SWEep:PULse:GAIN:MODE <type> 

说明 设置脉冲测量全部接收机的增益模式。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<type>:={LOW|MEDIum|HIGH}，表示接收机增益模式。 

返回类型 无 

默认值 无 

菜单项 扫描 > 脉冲设置... > Properties> Setting… 



 

 

举例 :SENS:SWE:PUL:GAIN:MODE HIGH 

 

3.19.8 脉冲测量指定接收机增益模式 

命令格式 :SENSe<cnum>:SWEep:PULse:RECeiver:GAIN:MODE <type1>,<type2> 

:SENSe<cnum>:SWEep:PULse:RECeiver:GAIN:MODE? <type1> 

说明 设置或获取指定接收机的增益模式。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<type1>:= {A|B|C|D|R1|R2|R3|R4}，表示接收机。 

<type2>:= {LOW|MEDIum|HIGH} ，表示接收机增益模式。 

返回类型 枚举 

默认值 LOW 

菜单项 扫描 > 脉冲设置... > Properties> Setting… 

举例 :SENS:SWEep:PULse:RECeiver:GAIN:MODE A,HIGH 

:SENS:SWEep:PULse:RECeiver:GAIN:MODE?  A 

Return: HIGH 

 

3.19.9 脉冲测量接收机脉冲延迟 

命令格式 :SENSe<cnum>:PULSe:MEASurement:DELay <numeric> 

:SENSe<cnum>:PULSe:MEASurement:DELay? 

说明 设置或获取接收机脉冲延迟。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<numeric>:表示脉冲时间，其范围是 1us~1000s。 

返回类型 浮点型，单位秒。 

默认值 309us 

菜单项 扫描 > 脉冲设置... > Measurement Timing> Measurement Delay 

举例 :SENS:PULSe:MEASurement:DELay 0.0004 

:SENS:PULSe:MEASurement:DELay? 

Return: 0.0004 
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3.19.10 自动选择脉冲包络模式下的扫描时间 

命令格式 :SENSe<cnum>:SWEep:PULSe:CWTime:[AUTO] <bool> 

:SENSe<cnum>:SWEep:PULSe:CWTime:[AUTO]? 

说  明 打开或关闭自动选择脉冲包络模式下的扫描时间选项。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<bool>:= ON|OFF|1|0 

返回类型 Boolean (1=ON,0=OFF) 

默认值 0 

菜单项 扫描 > 脉冲设置... > Properties > Autoselect Profile Sweep Time 

举例 :SENS:SWE:PULS:CWT 1 

:SENS:SWE:PULS:CWT? 

Return: 1 

 

3.19.11 自动选择源脉冲宽度与延迟 

命令格式 :SENSe<cnum>:SWEep:PULSe:TIMing:[AUTO] <bool> 

:SENSe<cnum>:SWEep:PULSe:TIMing:[AUTO]? 

说  明 打开或关闭自动选择源脉冲宽度与延迟。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<bool>:= ON|OFF|1|0 

返回类型 Boolean (1=ON,0=OFF) 

默认值 0 

菜单项 扫描 > 脉冲设置... > Measurement Timing> Autoselect Width and Delay 

举例 :SENS:SWE:PULS:CWT 1 

:SENS:SWE:PULS:CWT? 

Return: 1 

 

3.20 SA 命令子系统(Option) 

3.20.1 频谱分析 

3.20.1.1 命令列表 

打开 SA 功能 :CALCulate<cnum>:CUSTom:DEFine 



 

 

SA 测量模式 :CALCulate<cnum>:TRACe<tnum>:SA:MEASure 

带宽分辨率 :SENSe<cnum>:SA:BANDwidth[:RESolution] 

带宽分辨率模式 :SENSe<cnum>:SA:BANDwidth[:RESolution]:AUTO 

视频带宽 :SENSe<cnum>:SA:BANDwidth:VIDeo 

视频带宽模式 :SENSe<cnum>:SA:BANDwidth:VIDeo:AUTO 

RBW/VBW 比值 :SENSe<cnum>:SA:BANDwidth:VIDeo:RATio 

Span/RBW比值 :SENSe<cnum>:SA:FREQuency:SPAN:BANDwidth:RESolution:RATio 

平均类型 :SENSe<cnum>:SA:BANDwidth:VIDeo:AVER:TYPE 

镜像抑制类型 :SENSe<cnum>:SA:IMAGe:REJect 

检波类型 :SENSe<cnum>:TRACe<tnum>:SA:DETector[:FUNCtion] 

打开或关闭自动检波模式 :SENSe<cnum>:TRACe<tnum>:SA:DETector:AUTO 

通道及迹线的显示格式 :SENSe<cnum>:TRACe<tnum>:SA:TYPE 

设置获取迹线的显示状态 :SENSe<cnum>:TRACe<tnum>:SA:DISPlay[:STATe] 

设置或获取迹线的平均次数 :SENSe<cnum>:TRACe<tnum>:SA:AVERage:COUNt 

设置迹线运算 :CALCulate<cnum> [:SELected]:SA:MATH:FUNCtion 

设置迹线运算的输入 X 迹线 :CALCulate<cnum> [:SELected]:SA:MATH:X 

设置迹线运算的输入 Y 迹线 :CALCulate<cnum> [:SELected]:SA:MATH:Y 

设置迹线运算的对数偏移量 :CALCulate<cnum> [:SELected]:SA:MATH:OFFSet 

设置迹线运算的对数相减

的参考量 

:CALCulate<cnum> [:SELected]:SA:MATH:REFerence 

设置修正功能使能 :SENSe<cnum> [:SELected]:SA:CORRections [:STATe] 

设置子修正功能使能 :SENSe<cnum> [:SELected]:SA:CORRections:CSET<rnum>.[:STATe] 

子修正表添加修正项 :SENSe<cnum> [:SELected]:SA:CORRections:CSET<rnum>:ADD 

删除子修正中的修正项 :SENSe<cnum> [:SELected]:SA:CORRections:CSET<rnum>:POINt:DELete 

删除子修正中的所有修正项 :SENSe<cnum> [:SELected]:SA:CORRections:CSET<rnum>:DELete 

 

3.20.1.2 打开 SA功能 

命令格式 :CALCulate<cnum>:CUSTom:DEFine <string> 

说  明 打开选择通道迹线的 SA 功能及其测量项. 
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参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<string>= "SA"|"spectrum analyzer" 

返回类型 string 

默认值 无 

菜单项 测量 >模式 >Spaectrum Analyzer 

举例 :CALCulate1:CUSTom:DEFine "SA" 

 

3.20.1.3 SA测量模式 

命令格式 :CALCulate<cnum>[:SELected]:SA:MEASure <type> 

:CALCulate<cnum>[:SELected]:SA:MEASure? 

:CALCulate<cnum>:TRACe<tnum>:SA:MEASure <type> 

:CALCulate<cnum>:TRACe<tnum>:SA:MEASure? 

说  明 设置或获取选择通道及迹线的测量模式。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

<type>:={SA|CHPower|ACPR|OBW|TOI} 

SA：频谱分析测量 

ACPR：邻道功率比测量 

CHPower：信道功率测量 

OBW：占用带宽测量 

TOI：三阶交调 

返回类型 枚举 

默认值 SA 

菜单项 测量 > 模式 >SA> 测量 

举例 :CALCulate1:SELected:SA:MEASure OBW 

:CALCulate1:SELected:SA:MEASure? 

Return:OBW 

 

:CALCulate1:TRACe1:SA:MEASure ACPR 

:CALCulate1:TRACe1:SA:MEASure? 

Return:ACPR 

 

3.20.1.4 带宽分辨率 

命令格式 :SENSe<cnum>:SA:BANDwidth[:RESolution] <numeric> 

:SENSe<cnum>:SA:BANDwidth[:RESolution]? 



 

 

说明 设置或获取选择通道及迹线的带宽分辨率。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<numeric>:表示带宽分辨率，其范围是 10~1000000。 

返回类型 整型 

默认值 1MHz 

菜单项 平均/中频带宽 > 带宽 > 分辨率带宽 

举例 :CALCulate1:CUSTom:DEFine "SA" 

:SENSe1:SA:BANDwidth:RESolution 3000 

:SENSe1:SA:BANDwidth:RESolution? 

 

Return: 3000 

 

3.20.1.5 带宽分辨率模式 

命令格式 :SENSe<cnum>:SA:BANDwidth[:RESolution]:AUTO <bool> 

:SENSe<cnum>:SA:BANDwidth[:RESolution]:AUTO? 

说明 打开选择通道及迹线分辨率带宽 Auto 模式，或查询 Auto 模式开关状态。开启时，

根据 Span/RBW 比设置分辨率带宽。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<bool>:= ON|OFF|1|0 

返回类型 Boolean (1=ON,0=OFF) 

默认值 ON 

菜单项 平均/中频带宽 > 带宽 > 分辨率带宽模式 

举例 :CALCulate1:CUSTom:DEFine "SA" 

:SENSe1:SA:BANDwidth:RESolution:AUTO 0 

:SENSe1:SA:BANDwidth:RESolution:AUTO? 

 

Return: 0 

 

3.20.1.6 视频带宽 

命令格式 :SENSe<cnum>:SA:BANDwidth:VIDeo <numeric> 

:SENSe<cnum>:SA:BANDwidth:VIDeo? 

说明 设置或获取选择通道及迹线的视频带宽。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<numeric>:表示视频带宽，其范围是 10~1000000。 

返回类型 整型 
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默认值 1MHz 

菜单项 平均/中频带宽 > 带宽 > 视频带宽 

举例 :CALCulate1:CUSTom:DEFine "SA" 

:SENSe1:SA:BANDwidth:VIDeo 10000 

:SENSe1:SA:BANDwidth:VIDeo? 

 

Return: 10000 

 

3.20.1.7 视频带宽模式 

命令格式 :SENSe<cnum>:SA:BANDwidth:VIDeo:AUTO <bool> 

:SENSe<cnum>:SA:BANDwidth:VIDeo:AUTO? 

说  明 打开选择通道及迹线视频带宽 Auto 模式，或查询 Auto 模式开关状态。开启时，根

据 RBW/VBW比设置分辨率带宽。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<bool>:= ON|OFF|1|0 

返回类型 Boolean (1=ON,0=OFF) 

默认值 ON 

菜单项 平均/中频带宽 > 带宽 > 视频带宽模式 

举例 :CALCulate1:CUSTom:DEFine "SA" 

:SENSe1:SA:BANDwidth:VIDeo:AUTO 0 

:SENSe1:SA:BANDwidth:VIDeo:AUTO? 

 

Return: 0 

 

3.20.1.8 RBW/VBW 比值 

命令格式 :SENSe<cnum>:SA:BANDwidth:VIDeo:RATio <numeric> 

:SENSe<cnum>:SA:BANDwidth:VIDeo:RATio? 

说  明 设置或查询选择通道及迹线 RBW/VBW 的比值。 

参数 
<cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<numeric>:表示 RBW/VBW 的比值，其范围是 0.001~1000。 

返回类型 浮点数 

默认值 1 

菜单项 平均/中频带宽 > 带宽 > 分辨率带宽/视频带宽 

举例 :CALCulate1:CUSTom:DEFine "SA" 

:SENSe1:SA:BANDwidth:VIDeo:RATio 0.3 



 

 

:SENSe1:SA:BANDwidth:VIDeo:RATio? 

 

Return: 0.3 

 

3.20.1.9 Span/RBW比值 

命令格式 :SENSe<cnum>:SA:FREQuency:SPAN:BANDwidth:RESolution:RATio 
<numeric> 

:SENSe<cnum>:SA:FREQuency:SPAN:BANDwidth:RESolution:RATio? 

说明 设置或查询选择通道及迹线 Span/RBW 的比值。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<numeric>:表示 Span/RBW 的比值，其范围是 1~1000000。 

返回类型 整型 

默认值 1 

菜单项 平均/中频带宽 > 带宽 > 扫宽/分辨率带宽 

举例 :CALCulate1:CUSTom:DEFine "SA" 

:SENSe1:SA:BANDwidth:VIDeo:RATio 10 

:SENSe1:SA:BANDwidth:VIDeo:RATio? 

 

Return: 10 

 

 

3.20.1.10 平均类型 

命令格式 :SENSe<cnum>:SA:BANDwidth:VIDeo:AVER:TYPE <type> 

:SENSe<cnum>:SA:BANDwidth:VIDeo:AVER:TYPE? 

说  明 设置或查询选择通道及迹线的平均类型。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<type>:={Log|Power|Voltage} 

返回类型 枚举 

默认值 LOG 

菜单项 平均/中频带宽 > 带宽 > 平均类型 

举例 :CALCulate1:CUSTom:DEFine "SA" 

:SENSe1:SA:BANDwidth:VIDeo:AVER:TYPE Voltage 

:SENSe1:SA:BANDwidth:VIDeo:AVER:TYPE? 

 

Return: VOLT 
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3.20.1.11 镜像抑制类型 

命令格式 :SENSe<cnum>:SA:IMAGe:REJect <type> 

:SENSe<cnum>:SA:IMAGe:REJect? 

说明 设置或查询镜像抑制类型。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<type>:={None|Min|Normal|Better|Max} 

返回类型 枚举 

默认值 Min 

菜单项 扫描 > 频谱分析设置… > Advanced> Image Reject 

举例 :CALCulate1:CUSTom:DEFine "SA" 

:SENSe1:SA:IMAGe:REJect Max 

:SENSe1:SA:IMAGe:REJect? 

 

Return: MAX 

 

3.20.1.12 检波类型 

命令格式 :SENSe<cnum>[:SELected]:SA:DETector[:FUNCtion] <type> 

:SENSe<cnum>[:SELected]:SA:DETector[:FUNCtion]? 

:SENSe<cnum>:TRACe<tnum>:SA:DETector[:FUNCtion] <type> 

:SENSe<cnum>:TRACe<tnum>:SA:DETector[:FUNCtion]? 

说  明 设置或获取选择通道及迹线的检波类型。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

<type>:={NEGative|POSitive|SAMPle|AVERage|NORMAL} 

NEGative：负峰值检波 

POSitive：正峰值检波 

SAMPle：采样检波 

AVERage：平均检波 

NORMAL：标准检波 

返回类型 枚举 

默认值 NORMAL 

菜单项 数学 > 迹线 > 检波 

举例 :SENSe1:SELected:SA:DETector:FUNCtion POS 

:SENSe1:SELected:SA:DETector:FUNCtion? 

Return :POS 



 

 

:SENSe:TRACe1:SA:DETector:FUNCtion AVER 

:SENSe1:TRACe1:SA:DETector:FUNCtion? 

Return : AVER 

 

3.20.1.13 打开或关闭自动检波模式 

命令格式 :SENSe<cnum>[:SELected]:SA:DETector:AUTO <bool> 

:SENSe<cnum>[:SELected]:SA:DETector:AUTO? 

:SENSe<cnum>:TRACe<tnum>:SA:DETector:AUTO < bool > 

:SENSe<cnum>:TRACe<tnum>:SA:DETector:AUTO? 

说  明 打开或关闭选择通道及迹线自动检波模式，或读取自动检波模式的开关状态。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

<bool>:= ON|OFF|1|0 

返回类型 Boolean (1=ON,0=OFF) 

默认值 1 

菜单项 数学 > 迹线 > 自动检波 

举例 :SENSe1:SELected:SA:DETector:AUTO 1 

:SENSe1:SELected:SA:DETector:AUTO? 

Return :1 

:SENSe1:TRACe1:SA:DETector:AUTO 0 

:SENSe1:TRACe1:SA:DETector:AUTO? 

Return：0 

 

3.20.1.14 通道及迹线的显示格式 

命令格式 :SENSe<cnum>[:SELected]:SA:TYPE <type> 

:SENSe<cnum>[:SELected]:SA:TYPE? 

:SENSe<cnum>:TRACe<tnum>:SA:TYPE <type> 

:SENSe<cnum>:TRACe<tnum>:SA:TYPE? 

说  明 设置或获取选择通道及迹线的显示模式。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

<type>:={WRITe|MAXHold|MINHold|AVERage} 

WRITe：迹线为正常模式，更新数据 

MAXHold：显示迹线的最大值 

MINHold：显示迹线的最小值 

AVERage：平均 

返回类型 枚举 
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默认值 WRITe 

菜单项 数学 > 迹线 > 迹线类型 

举例 :SENSe1:SELected:SA:TYPE MAXHold 

:SENSe1:SELected:SA:TYPE? 

Return :MAXH 

:SENSe1:TRACe1:SA:TYPE MINHold 

:SENSe1:TRACe1:SA:TYPE? 

Return : MINH 

 

3.20.1.15 设置获取迹线的显示状态 

命令格式 :SENSe<cnum>[:SELected]:SA:DISPlay[:STATe] <type> 

:SENSe<cnum>[:SELected]:SA:DISPlay[:STATe]? 

:SENSe<cnum>:TRACe<tnum>:SA:DISPlay[:STATe] <type> 

:SENSe<cnum>:TRACe<tnum>:SA:DISPlay[:STATe]? 

说明 设置或获取选择通道及迹线的显示状态。 

参数 

<cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

<type>:={ACTI|VIEW|BLAN|BACK} 

返回类型 枚举 

默认值 ACTI 

菜单项 数学 > 迹线 > 状态 

举例 :SENSe1:SELected:SA:DISPlay:STATe VIEW 

:SENSe1:SELected:SA:DISPlay:STATe? 

Return:VIEW 

 

:SENSe1:TRACe1:SA:DISPlay:STATe ACTI 

:SENSe1:TRACe1:SA:DISPlay:STATe? 

Return:ACTI 

 

3.20.1.16 设置或获取迹线的平均次数 

命令格式 :SENSe<cnum>[:SELected]:SA:AVERage:COUNt <numeric> 

:SENSe<cnum>[:SELected]:SA:AVERage:COUNt? 

:SENSe<cnum>:TRACe<tnum>:SA:AVERage:COUNt <numeric> 

:SENSe<cnum>:TRACe<tnum>:SA:AVERage:COUNt? 

说明 设置或获取选择通道及迹线的平均次数。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。



 

 

<numeric>:表示平均次数，其范围是 1~1000。 

返回类型 整型 

默认值 16 

菜单项 数学 > 迹线 > 平均次数 

举例 :SENSe1:SELected:SA:AVERage:COUNt 32 

:SENSe1:SELected:SA:AVERage:COUNt? 

Return :32 

 

:SENSe1TRACe1:SA:AVERage:COUNt 128 

:SENSe1:TRACe1:SA:AVERage:COUNt? 

Return :128 

 

3.20.1.17 设置迹线运算 

命令格式 :CALCulate<cnum> [:SELected]:SA:MATH:FUNCtion <math_type> 

:CALCulate<cnum> [:SELected]:SA:MATH:FUNCtion? 

:CALCulate<cnum>:TRACe<tnum>:SA:MATH:FUNCtion <math type> 

:CALCulate<cnum>:TRACe<tnum>:SA:MATH:FUNCtion 

说明 设置 SA 模式下迹线运算的数学类型。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

<math type>={OFF|PDIF|PSUM|LOFF|LDIF} 

OFF: 关闭 

PDIF：功率相减 

PSUM：功率相加 

LDIF：对数相减 

LOFF：对数偏移 

返回类型 枚举 

默认值 OFF 

菜单项 数学 > 计算 > 计算函数 

举例 :CALCulate1:SELected:SA:MATH:FUNCtion LOFF 

:CALCulate1:SELected:SA:MATH:FUNCtion? 

Return :LOFF 

 

:CALCulate1:TRACe1:SA:MATH:FUNCtion PSUM 

:CALCulate1:TRACe1:SA:MATH:FUNCtion? 

Return:PSUM 
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3.20.1.18 设置迹线运算的输入 X迹线 

命令格式 :CALCulate<cnum> [:SELected]:SA:MATH:X <xnum> 

:CALCulate<cnum> [:SELected]:SA:MATH:X? 

:CALCulate<cnum>:TRACe<tnum>:SA:MATH:X <xnum> 

:CALCulate<cnum>:TRACe<tnum>:SA:MATH:X? 

说明 设置 SA 模式下迹线运算的输入 X 迹线。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

<xnum>:={[0]-256}，表示数学运算的输入迹线 X 

返回类型 整型 

默认值 0 

菜单项 数学 > 计算 > 输入 X 

举例 :CALCulate1:SELected:SA:MATH:X 3 

:CALCulate1:SELected:SA:MATH:X? 

Return :3 

 

:CALCulate1:TRACe1:SA:MATH:X 2 

:CALCulate1:TRACe1:SA:MATH:X? 

Return:2 

 

3.20.1.19 设置迹线运算的输入 Y迹线 

命令格式 :CALCulate<cnum> [:SELected]:SA:MATH:Y <ynum> 

:CALCulate<cnum> [:SELected]:SA:MATH:Y? 

:CALCulate<cnum>:TRACe<tnum>:SA:MATH:Y <ynum> 

:CALCulate<cnum>:TRACe<tnum>:SA:MATH:Y? 

说明 设置 SA 模式下迹线运算的输入 Y 迹线。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

<ynum>:={[0]-256}，表示数学运算的输入迹线 Y 

返回类型 整型 

默认值 0 

菜单项 数学 > 计算 > 输入 Y 

举例 :CALCulate1:SELected:SA:MATH:Y 3 

:CALCulate1:SELected:SA:MATH:Y? 

Return :3 

 



 

 

:CALCulate1:TRACe1:SA:MATH:Y 2 

:CALCulate1:TRACe1:SA:MATH:Y? 

Return:2 

 

3.20.1.20 设置迹线运算的对数偏移量 

命令格式 :CALCulate<cnum> [:SELected]:SA:MATH:OFFSet <offset> 

:CALCulate<cnum> [:SELected]:SA:MATH:OFFSet? 

:CALCulate<cnum>:TRACe<tnum>:SA:MATH:OFFSet < offset > 

:CALCulate<cnum>:TRACe<tnum>:SA:MATH:OFFSet? 

说明 设置 SA 模式下迹线运算的对数偏移的偏移量。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

<offset>:=[-100,100]，表示对数偏移的偏移量 

返回类型 浮点型 

默认值 0 

菜单项 数学 > 计算 > 偏移量 

举例 :CALCulate1:SELected:SA:MATH:OFFSet 50 

:CALCulate1:SELected:SA:MATH:OFFSet? 

Return :50 

 

:CALCulate1:TRACe1:SA:MATH:OFFSet 53.4 

:CALCulate1:TRACe1:SA:MATH:OFFSet? 

Return:53.4 

 

3.20.1.21 设置迹线运算的对数相减的参考量 

命令格式 :CALCulate<cnum> [:SELected]:SA:MATH:REFerence <ref> 

:CALCulate<cnum> [:SELected]:SA:MATH:REFerence? 

:CALCulate<cnum>:TRACe<tnum>:SA:MATH:REFerence < ref> 

:CALCulate<cnum>:TRACe<tnum>:SA:MATH:REFerence? 

说明 设置 SA 模式下迹线运算的对数相减的参考量。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

<ref>:=[-100,100]，表示对数相减的参考量 

返回类型 浮点型 

默认值 0 

菜单项 数学 > 计算 > 参考量 
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举例 :CALCulate1:SELected:SA:MATH:REFerence 100 

:CALCulate1:SELected:SA:MATH:REFerence? 

Return :100 

 

:CALCulate1:TRACe1:SA:MATH:REFerence 20.5 

:CALCulate1:TRACe1:SA:MATH:REFerence? 

Return:20.5 

 

3.20.1.22 设置修正功能使能 

命令格式 :SENSe<cnum> [:SELected]:SA:CORRections [:STATe] <enable> 

:SENSe<cnum> [:SELected]:SA:CORRections [:STATe]? 

:SENSe<cnum>:TRACe<tnum>:SA:CORRections [:STATe] < enable > 

:SENSe<cnum>:TRACe<tnum>:SA:CORRections [:STATe]? 

说明 设置 SA 模式下修正功能的使能状态 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

<enable>:= ON|OFF|1|0 

返回类型 布尔类型，Boolean (1=ON,0=OFF) 

默认值 0 

菜单项 刻度 > 修正 > 修正使能 

举例 :SENSe1:SELected:SA:CORRections:STATe ON 

:SENSe1:SELected:SA:CORRections:STATe? 

Return :1 

 

:SENSe1:TRACe1:SA:CORRections:STATe OFF 

:SENSe1:TRACe1:SA:CORRections:STATe? 

Return:0 

 

3.20.1.23 设置子修正功能使能 

命令格式 :SENSe<cnum> [:SELected]:SA:CORRections:CSET<rnum>.[:STATe] <enable> 

:SENSe<cnum> [:SELected]:SA:CORRections:CSET<rnum> [:STATe]? 

:SENSe<cnum>:TRACe<tnum>:SA:CORRections:CSET<rnum> [:STATe] <enable> 

:SENSe<cnum>:TRACe<tnum>:SA:CORRections:CSET<rnum> [:STATe]? 

说明 设置 SA 模式下子修正功能的使能情况 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

<rnum>:={[1]-6}，表示选中的子修正 

<enable>:= ON|OFF|1|0 



 

 

返回类型 布尔类型，Boolean (1=ON,0=OFF) 

默认值 0 

菜单项 刻度 > 修正 > 子修正使能 

举例 :SENSe1:SELected:SA:CORRections:CSET1:STATe ON 

:SENSe1:SELected:SA:CORRections:CSET1:STATe? 

Return :1 

 

:SENSe1:TRACe1:SA:CORRections:CSET1:STATe OFF 

:SENSe1:TRACe1:SA:CORRections:CSET1:STATe? 

Return:0 

 

3.20.1.24 子修正表添加修正项 

命令格式 :SENSe<cnum> [:SELected]:SA:CORRections:CSET<rnum>:ADD<freq> <value> 

:SENSe<cnum>:TRACe<tnum>:SA:CORRections:CSET<rnum>:ADD<freq> <value> 

说明 向子修正的修正表中添加修正项 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

<rnum>:={[1]-6}，表示选中的子修正 

<freq>: 设置频率值 

<value>:设置修正值 

返回类型 无 

默认值 无 

菜单项 刻度 > 修正 > 编辑修正项 

举例 :SENSe1:SELected:SA:CORRections:CSET1:ADD 9000000,10 

:SENSe1:TRACe1:SA:CORRections:CSET1:ADD 90000,10 

 

3.20.1.25 删除子修正中的修正项 

命令格式 :SENSe<cnum> [:SELected]:SA:CORRections:CSET<rnum>:POINt:DELete <point> 

:SENSe<cnum>:TRACe<tnum>:SA:CORRections:CSET<rnum>:POINt:DELete <point> 

说明 删除子修正中的修正项 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

<rnum>:={[1]-6}，表示选中的子修正 

<point> 表示第 i 行的修正项，i 从 0开始计数 

返回类型 无 
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默认值 无 

菜单项 刻度 > 修正 > 编辑修正项 

举例 :SENSe1:SELected:SA:CORRections:CSET1:POINt:DELete 3 

:SENSe1:TRACe1:SA:CORRections:CSET1:POINt:DELete 2 

 

3.20.1.26 删除子修正中的所有修正项 

命 令格式 :SENSe<cnum> [:SELected]:SA:CORRections:CSET<rnum>:DELete 

:SENSe<cnum>:TRACe<tnum>:SA:CORRections:CSET<rnum>:DELete 

说明 删除子修正中的所有修正项 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

<rnum>:={[1]-6}，表示选中的子修正 

返回类型 无 

默认值 无 

菜单项 刻度 > 修正 > 编辑修正项 

举例 :SENSe1:SELected:SA:CORRections:CSET1:DELete 

:SENSe1:TRACe1:SA:CORRections:CSET1:DELete 

 

 

 

3.20.2 信道功率 

3.20.2.1 命令列表 

信道功率测量的积分带宽 :CALCulate<cnum>:TRACe<tnum>:SA:CHPower:BWIDth:INTegration 

信道功率测量的扫宽功率 :CALCulate<cnum>:TRACe<tnum>:SA:CHPower:FREQuency:SPAN:POWer 

读取信道功率和信道功率谱密度 :CALCulate<cnum>:TRACe<tnum>:SA:CHPower? 

读取信信道功率 :CALCulate<cnum>:TRACe<tnum>:SA:CHPower:CHPower? 

读取信道功率谱密度 :CALCulate<cnum>:TRACe<tnum>:SA:CHPower:DENSity? 

 

3.20.2.2 信道功率测量的积分带宽 

命令格式 :CALCulate<cnum>[:SELected]:SA:CHPower:BWIDth:INTegration <numeric> 

:CALCulate<cnum>[:SELected]:SA:CHPower:BWIDth:INTegration? 



 

 

:CALCulate<cnum>:TRACe<tnum>:SA:CHPower:BWIDth:INTegration 
<numeric> 

:CALCulate<cnum>:TRACe<tnum>:SA:CHPower:BWIDth:INTegration? 

说明 设置或获取选择通道及迹线信道功率测量的积分带宽。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

<numeric>:表示积分带宽，其范围是 0至矢量网络分析仪的最大频率。 

返回类型 浮点型，单位 Hz 

默认值 2MHz 

菜单项 测量 > 信道功率 > 测量设置 > 积分带宽 

举例 :CALCulate1:SELected:SA:CHPower:BWIDth:INTegration 1e9 

:CALCulate1:SELected:SA:CHPower:BWIDth:INTegration? 

Return:1000000000 

 

:CALCulate1:TRACe1:SA:CHPower:BWIDth:INTegration 2e9 

:CALCulate1:TRACe1:SA:CHPower:BWIDth:INTegration? 

Return:2000000000 

 

3.20.2.3 信道功率测量的扫宽功率 

命令格式 :CALCulate<cnum>[:SELected]:SA:CHPower:FREQuency:SPAN:POWer 

:CALCulate<cnum>:TRACe<tnum>:SA:CHPower:FREQuency:SPAN:POWer 

说明 设置选择通道及迹线信道功率测量的扫宽值为积分带宽。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

返回类型 无 

默认值 无 

菜单项 测量 > 信道功率 > 测量设置 >扫宽功率 

举例 :CALCulate1:SELected:SA:CHPower:FREQuency:SPAN:POWer 

:CALCulate1:TRACe1:SA:CHPower:FREQuency:SPAN:POWer 

 

3.20.2.4 读取信道功率和信道功率谱密度 

命令格式 :CALCulate<cnum>[:SELected]:SA:CHPower? 

:CALCulate<cnum>:TRACe<tnum>:SA:CHPower? 

说明 读取选择通道及迹线信道功率测量的信道功率和信道功率谱密度。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 
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<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

返回类型 浮点型，信道功率单位 dBm 

浮点型，功率谱密度单位 dBm/Hz 

默认值 无 

菜单项 测量 > 信道功率 

举例 :CALCulate1:SELected:SA:CHPower? 

Return: -32.3329235931259,-125.343223549766 

 

:CALCulate1:TRACe1:SA:CHPower? 

Return: -32.3329235931259,-125.343223549766 

 

3.20.2.5 读取信信道功率 

命令格式 :CALCulate<cnum>[:SELected]:SA:CHPower:CHPower? 

:CALCulate<cnum>:TRACe<tnum>:SA:CHPower:CHPower? 

说明 读取选择通道及迹线信道功率测量的信道功率。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

返回类型 浮点型，信道功率单位 dBm 

默认值 无 

菜单项 SA> 测量> 信道功率 

举例 :CALCulate1:SELected:SA:CHPower:CHPower? 

Return：-32.0712381021238 

 

:CALCulate1:TRACe1:SA:CHPower:CHPower? 

Return：-32.0712381021238 

 

3.20.2.6 读取信道功率谱密度 

命令格式 :CALCulate<cnum>[:SELected]:SA:CHPower:DENSity? 

:CALCulate<cnum>:TRACe<tnum>:SA:CHPower:DENSity? 

说  明 读取选择通道及迹线信道功率测量的信道功率谱密度。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

返回类型 浮点型，功率谱密度单位 dBm/Hz 

默认值 无 



 

 

菜单项 测量 > 信道功率 

举例 :CALCulate1:SELected:SA:CHPower:DENSity? 

Return: -125.096780027723 

 

:CALCulate1:TRACe1:SA:CHPower:DENSity? 

Return: -125.096780027723 

 

3.20.3 邻道功率比 

3.20.3.1 命令列表 

ACPR 测量的主信道带宽 :CALCulate<cnum>:TRACe<tnum>:SA:ACPRatio:BWIDth:INTegration 

ACPR 测量的邻道带宽 :CALCulate<cnum>:TRACe<tnum>:SA:ACPRatio:OFFSet:BWIDth[:INTegration] 

ACPR 测量的邻道间隔 :CALCulate<cnum>:TRACe<tnum>:SA:ACPRatio:OFFSet[:FREQuency] 

读取 ACPR 的主信道功率 :CALCulate<cnum>[:SELected]:SA:ACPRatio:MAIN? 

读取 ACPR 的低频邻道功率

比 

:CALCulate<cnum>:TRACe<tnum>:SA:ACPRatio:LOWer? 

读取 ACPR 的低频邻道功率 :CALCulate<cnum>:TRACe<tnum>:SA:ACPRatio:LOWer:POWer? 

读取 ACPR 的高频邻道功率

比 

:CALCulate<cnum>:TRACe<tnum>:SA:ACPRatio:UPPer? 

读取 ACPR 的高频邻道功率 :CALCulate<cnum>:TRACe<tnum>:SA:ACPRatio:UPPer:POWer? 

 

3.20.3.2 ACPR测量的主信道带宽 

命令格式 :CALCulate<cnum>[:SELected]:SA:ACPRatio:BWIDth:INTegration <numeric> 

:CALCulate<cnum>[:SELected]:SA:ACPRatio:BWIDth:INTegration? 

:CALCulate<cnum>:TRACe<tnum>:SA:ACPRatio:BWIDth:INTegration 
<numeric> 

:CALCulate<cnum>:TRACe<tnum>:SA:ACPRatio:BWIDth:INTegration? 

说  明 设置或获取选择通道及迹线的 ACPR 测量的主信道带宽。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

<numeric>:表示主信道带宽，其范围是 0至矢量网络分析仪的最大频率。 

返回类型 浮点型，单位 Hz 

默认值 1MHz 

菜单项 测量 > 邻道功率比 > 测量设置 > 主信道带宽 
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举例 :CALCulate1:SELected:SA:ACPRatio:BWIDth:INTegration 1e9 

:CALCulate1:SELected:SA:ACPRatio:BWIDth:INTegration? 

Return: 1000000000 

 

:CALCulate1:TRACe1:SA:ACPRatio:BWIDth:INTegration 2e9 

:CALCulate1:TRACe1:SA:ACPRatio:BWIDth:INTegration? 

Return: 2000000000 

 

3.20.3.3 ACPR测量的邻道带宽 

命令格式 :CALCulate<cnum>[:SELected]:SA:ACPRatio:OFFSet:BWIDth[:INTegration] 
<numeric> 

:CALCulate<cnum>[:SELected]:SA:ACPRatio:OFFSet:BWIDth[:INTegration]? 

 

:CALCulate<cnum>:TRACe<tnum>:SA:ACPRatio:OFFSet:BWIDth[:INTegration] 
<numeric> 

:CALCulate<cnum>:TRACe<tnum>:SA:ACPRatio:OFFSet:BWIDth[:INTegration]? 

说  明 设置或获取选择通道及迹线 ACPR 测量的邻道带宽。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

<numeric>:表示邻道带宽，其范围是 0至矢量网络分析仪的最大频率。 

返回类型 浮点型，单位 Hz 

默认值 1MHz 

菜单项 测量 > 邻道功率比 > 测量设置 > 相邻信道带宽 

举例 :CALCulate1:SELected:SA:ACPRatio:OFFSet:BWIDth:INTegration 5e6 

:CALCulate1:SELected:SA:ACPRatio:OFFSet:BWIDth:INTegration? 

Return :5000000 

 

:CALCulate1:TRACe1:SA:ACPRatio:OFFSet:BWIDth:INTegration 3e6 

:CALCulate1:TRACe1:SA:ACPRatio:OFFSet:BWIDth:INTegration? 

Return :3000000 

 

3.20.3.4 ACPR测量的邻道间隔 

命令格式 :CALCulate<cnum>[:SELected]:SA:ACPRatio:OFFSet[:FREQuency] <numeric> 

:CALCulate<cnum>[:SELected]:SA:ACPRatio:OFFSet[:FREQuency] 

:CALCulate<cnum>:TRACe<tnum>:SA:ACPRatio:OFFSet[:FREQuency] 
<numeric> 

:CALCulate<cnum>:TRACe<tnum>:SA:ACPRatio:OFFSet[:FREQuency]? 

说明 设置或获取选择通道及迹线 ACPR 的邻道间隔。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 



 

 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

<numeric>:表示邻道间隔，其范围是 0 Hz~4.25GHz。 

返回类型 浮点型，单位 Hz 

默认值 3MHz 

菜单项 测量 > 邻道功率比 > 测量设置 > 邻道间隔 

举例 :CALCulate1:SELected:SA:ACPRatio:OFFSet:FREQuency 2e6 

:CALCulate1:SELected:SA:ACPRatio:OFFSet:FREQuency? 

Return: 2000000 

 

:CALCulate1:TRACe1:SA:ACPRatio:OFFSet:FREQuency 1e6 

:CALCulate1:TRACe1:SA:ACPRatio:OFFSet:FREQuency? 

Return: 1000000 

 

3.20.3.5 读取 ACPR的主信道功率 

命令格式 :CALCulate<cnum>[:SELected]:SA:ACPRatio:MAIN? 

:CALCulate<cnum>:TRACe<tnum>:SA:ACPRatio:MAIN? 

说明 读取选择通道及迹线 ACPR 测量的主信道功率。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

返回类型 浮点型，单位 dBm 

默认值 无 

菜单项 测量 > 邻道功率比 

举例 :CALCulate1:SELected:SA:ACPRatio:MAIN? 

Return : -66.460503383216 

:CALCulate1:TRACe1:SA:ACPRatio:MAIN? 

Return : -64.8677896852216 

 

3.20.3.6 读取 ACPR的低频邻道功率比 

命令格式 :CALCulate<cnum>[:SELected]:SA:ACPRatio:LOWer? 

:CALCulate<cnum>:TRACe<tnum>:SA:ACPRatio:LOWer? 

说明 读取选择通道及迹线 ACPR 测量的低频邻道功率比。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

返回类型 浮点型，单位 dBc 

默认值 无 



 

304                                                                                                                   矢量网络分析仪编程手册 

菜单项 测量 > 邻道功率比 

举例 :CALCulate1:SELected:SA:ACPRatio:LOWer? 

Return : -20.6055355636683 

 

:CALCulate1:TRACe1:SA:ACPRatio:LOWer? 

Return : -21.1571905607897 

 

3.20.3.7 读取 ACPR的低频邻道功率 

命令格式 :CALCulate<cnum>[:SELected]:SA:ACPRatio:LOWer:POWer? 

:CALCulate<cnum>:TRACe<tnum>:SA:ACPRatio:LOWer:POWer? 

说明 读取选择通道及迹线 ACPR 测量的低频邻道功率。 

参数 
<cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

返回类型 浮点数，单位 dBm 

默认值 无 

菜单项 测量 > 邻道功率比 

举例 :CALCulate1:SELected:SA:ACPRatio:LOWer:POWer? 

Return : -46.0127403678039 

 

:CALCulate1:TRACe1:SA:ACPRatio:LOWer:POWer? 

Return : -46.8181475071255 

 

3.20.3.8 读取 ACPR 的高频邻道功率比 

命令格式 :CALCulate<cnum>[:SELected]:SA:ACPRatio:UPPer? 

:CALCulate<cnum>:TRACe<tnum>:SA:ACPRatio:UPPer? 

说明 读取选择通道及迹线 ACPR 测量高频邻道功率比。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

返回类型 浮点数，单位 dBc 

默认值 无 

菜单项 测量 > 邻道功率比 

举例 :CALCulate1:SELected:SA:ACPRatio:UPPer? 

Return : -18.6108514488295 

 

:CALCulate1:TRACe1:SA:ACPRatio:UPPer? 

Return : -21.3324563909162 



 

 

 

3.20.3.9 读取 ACPR的高频邻道功率 

命令格式 :CALCulate<cnum>[:SELected]:SA:ACPRatio:UPPer:POWer? 

:CALCulate<cnum>:TRACe<tnum>:SA:ACPRatio:UPPer:POWer? 

说明 读取选择通道及迹线 ACPR 测量的高频邻道功率。 

参数 
<cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

返回类型 浮点数，单位 dBm 

默认值 无 

菜单项 测量 > 邻道功率比 

举例 :CALCulate1:SELected:SA:ACPRatio:UPPer:POWer? 

Return : -45.5211570718928 

 

:CALCulate1:TRACe1:SA:ACPRatio:UPPer:POWer? 

Return：-45.9642491121815 

 

3.20.4 占用带宽 

3.20.4.1 命令列表 

OBW的占用带宽百分比 :CALCulate<cnum>:TRACe<tnum>:SA:OBWidth:PERCent 

读取 OBW 的占用带宽和带宽中

心 

:CALCulate<cnum>:TRACe<tnum>:SA:OBWidth? 

读取 OBW的占用带宽 :CALCulate<cnum>:TRACe<tnum>:SA:OBWidth:OBWidth? 

读取 OBW的占用带宽中心 :CALCulate<cnum>:TRACe<tnum>:SA:OBWidth:CENTroid? 

读取 OBW的传输频率误差 :CALCulate<cnum>:TRACe<tnum>:SA:OBWidth:FERRor? 

 

3.20.4.2 OBW的占用带宽百分比 

命令格式 :CALCulate<cnum>[:SELected]:SA:OBWidth:PERCent <numeric> 

:CALCulate<cnum>[:SELected]:SA:OBWidth:PERCent? 

:CALCulate<cnum>:TRACe<tnum>:SA:OBWidth:PERCent <numeric> 

:CALCulate<cnum>:TRACe<tnum>:SA:OBWidth:PERCent? 

说明 设置或获取选择通道及迹线 OBW测量的占用带宽百分比。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 
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<numeric>:表示占用带宽百分比，其范围是 10~100。 

返回类型 浮点型 

默认值 99 

菜单项 测量 > 占用带宽 > 测量设置 > 占用带宽百分比 

举例 :CALCulate1:SELected:SA:OBWidth:PERCent 60 

:CALCulate1:SELected:SA:OBWidth:PERCent? 

Return :60 

 

:CALCulate1:TRACe1:SA:OBWidth:PERCent 30 

:CALCulate1:TRACe1:SA:OBWidth:PERCent? 

Return :30 

 

3.20.4.3 读取 OBW的占用带宽和带宽中心 

命令格式 :CALCulate<cnum>[:SELected]:SA:OBWidth? 

:CALCulate<cnum>:TRACe<tnum>:SA:OBWidth? 

说明 读取选择通道及迹线 OBW 测量的占用带宽和带宽中心。 

参数 
<cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

返回类型 浮点型，单位 Hz 

默认值 无 

菜单项 测量 > 占用带宽 

举例 :CALCulate1:SELected:SA:OBWidth? 

Return : 28580644.0096836,4249777822.00484 

 

:CALCulate1:TRACe1:SA:OBWidth? 

Return : 26997375.076252,4255988812.46187 

 

3.20.4.4 读取 OBW的占用带宽 

命令格式 :CALCulate<cnum>[:SELected]:SA:OBWidth:OBWidth? 

:CALCulate<cnum>:TRACe<tnum>:SA:OBWidth:OBWidth? 

说明 读取选择通道及迹线 OBW 测量的占用带宽。 

参数 
<cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

返回类型 浮点数，单位 Hz 

默认值 无 



 

 

菜单项 测量 > 占用带宽 

举例 :CALCulate1:SELected:SA:OBWidth:OBWidth? 

Return : 26715503.1180305 

 

:CALCulate1:TRACe1:SA:OBWidth:OBWidth? 

Return : 26997375.076252 

 

3.20.4.5 读取 OBW的占用带宽中心 

命令格式 :CALCulate<cnum>[:SELected]:SA:OBWidth:CENTroid? 

:CALCulate<cnum>:TRACe<tnum>:SA:OBWidth:CENTroid? 

说  明 读取选择通道及迹线 OBW 测量的占用带宽中心。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

返回类型 浮点型，单位 Hz 

默认值 无 

菜单项 测量 > 占用带宽 

举例 :CALCulate1:SELected:SA:OBWidth:CENTroid? 

Return : 4241182953.86024 

 

:CALCulate1:TRACe1:SA:OBWidth:CENTroid? 

Return：4252382501.60254 

 

3.20.4.6 读取 OBW的传输频率误差 

命令格式 :CALCulate<cnum>[:SELected]:SA:OBWidth:FERRor? 

:CALCulate<cnum>:TRACe<tnum>:SA:OBWidth:FERRor? 

说明 读取选择通道及迹线 OBW 测量的传输频率误差。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

返回类型 浮点数，单位 Hz 

默认值 无 

菜单项 测量 > 占用带宽 

举例 :CALCulate1:SELected:SA:OBWidth:FERRor? 

Return : 4223880936.89468 

 

:CALCulate1:TRACe1:SA:OBWidth:FERRor? 

Return : -46483.4618330002 
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3.20.5 三阶交调 

3.20.5.1 命令列表 

读取三阶交调测量结果 :CALCulate<cnum>:TRACe<tnum>:SA:TOI? 

读取三阶交调截止点 :CALCulate<tnum>:TRACe<tnum>:SA:TOI:IP3? 

 

3.20.5.2 读取三阶交调测量结果 

命令格式 :CALCulate<cnum> [:SELected]:SA:TOI? 

:CALCulate<cnum>:TRACe<tnum>:SA:TOI? 

说明 读取三阶互调失真的测量结果，并以科学计数形式返回以逗号间隔的下列值： 

低基频信号(Lower Tone)的频率(Hz)，幅度，高基频信号(Upper Tone)的频率

(Hz)，幅度，低频  TOI(Lower 3rd)的频率 (Hz)，幅度，三阶互调截止点

(Intercept)，高频 TOI(Upper 3rd)的频率(Hz)，幅度，三阶互调截止点(Intercept)。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

返回类型 浮点型 

默认值 无 

菜单项 Mean > 测量 > 三阶交调 

举例 :CALCulate1:TRACe1:SA:TOI? 

 

3.20.5.3 读取三阶交调截止点 

命令格式 :CALCulate<tnum>[:SELected]:SA:TOI:IP3? 

:CALCulate<tnum>:TRACe<tnum>:SA:TOI:IP3? 

说明 读取低频 TOI(Lower 3rd)和高频 TOI(Upper 3rd)的三阶互调截止点(Intercept)中的

较小值。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

返回类型 浮点型 

默认值 无 

菜单项 Mean > 测量 > 三阶交调 

举例 :CALCulate1:SELected:SA:TOI:IP3? 

 



 

 

Return -78.2445026767116 

 

3.20.6 载噪比 

3.20.6.1 命令列表 

CNR 测量的载波带宽 :CALCulate<cnum>:TRACe<tnum>:SA:CNRatio:CARRier:BWIDth 

CNR 测量的噪声带宽 :CALCulate<cnum>:TRACe<tnum>:SA:CNRatio:NOISe:BWIDth 

CNR 测量的频率偏移 :CALCulate<cnum>:TRACe<tnum>:SA:CNRatio:OFFSet[:FREQuency] 

CNR 测量的载波功率 :CALCulate<cnum>:TRACe<tnum>:SA:CNRatio:CARRier:POWer? 

CNR 测量的噪声功率 :CALCulate<cnum>:TRACe<tnum>:SA:CNRatio:NOISe:POWer? 

CNR 测量的载噪比 :CALCulate<cnum>:TRACe<tnum>:SA:CNRatio? 

 

3.20.6.2 CNR测量的载波带宽 

命令格式 :CALCulate<cnum>[:SELected]:SA:CNRatio:CARRier:BWIDth <freq> 

:CALCulate<cnum>[:SELected]:SA:CNRatio:CARRier:BWIDth? 

:CALCulate<cnum>:TRACe<tnum>:SA:CNRatio:CARRier:BWIDth <freq> 

:CALCulate<cnum>:TRACe<tnum>:SA:CNRatio:CARRier:BWIDth? 

说明 设置或获取选择通道及迹线 CNR 测量的载波带宽。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

<freq> 浮点型，单位 Hz。 

返回类型 浮点数，单位 Hz 

默认值 2MHz 

菜单项 Mean > 测量 > 载噪比 > 测量设置 >载波带宽 

举例 :CALCulate1:SELected:SA:CNRatio:CARRier:BWIDth 1e6 

:CALCulate1:SELected:SA:CNRatio:CARRier:BWIDth? 

Return: 1000000 

 

:CALCulate1:TRACe1:SA:CNRatio:CARRier:BWIDth 2e6 

:CALCulate1:TRACe1:SA:CNRatio:CARRier:BWIDth? 

Return: 2000000 

 

3.20.6.3 CNR测量的噪声带宽 

命令格式 :CALCulate<cnum>[:SELected]:SA:CNRatio:NOISe:BWIDth <freq> 

:CALCulate<cnum>[:SELected]:SA:CNRatio:NOISe:BWIDth? 
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:CALCulate<cnum>:TRACe<tnum>:SA:CNRatio:NOISe:BWIDth <freq> 

:CALCulate<cnum>:TRACe<tnum>:SA:CNRatio:NOISe:BWIDth? 

说明 设置或获取选择通道及迹线 CNR 测量的噪声带宽。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

<freq> 浮点型，单位 Hz。 

返回类型 浮点数，单位 Hz 

默认值 2MHz 

菜单项 Mean > 测量 > 载噪比 > 测量设置 >噪声带宽 

举例 :CALCulate1:SELected:SA:CNRatio:NOISe:BWIDth 1e6 

:CALCulate1:SELected:SA:CNRatio:NOISe:BWIDth? 

Return: 1000000 

 

:CALCulate1:TRACe1:SA:CNRatio:NOISe:BWIDth 2e6 

:CALCulate1:TRACe1:SA:CNRatio:NOISe:BWIDth? 

Return: 2000000 

 

3.20.6.4 CNR测量的频率偏移 

命令格式 :CALCulate<cnum>[:SELected]:SA:CNRatio:OFFSet[:FREQuency] <freq> 

:CALCulate<cnum>[:SELected]:SA:CNRatio:OFFSet[:FREQuency]? 

:CALCulate<cnum>:TRACe<tnum>:SA:CNRatio:OFFSet[:FREQuency] <freq> 

:CALCulate<cnum>:TRACe<tnum>SA:CNRatio:OFFSet[:FREQuency]? 

说  明 设置或获取选择通道及迹线 CNR 测量的载波与噪声中心频率间隔。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

<freq>:= 机器的最大扫宽范围 

返回类型 浮点型，单位 Hz。 

默认值 3MHz 

菜单项 Mean > 测量 > 载噪比 > 测量设置 >频率偏移 

举例 :CALCulate1:SELected:SA:CNRatio:OFFSet:FREQuency 1e6 



 

 

:CALCulate1:SELected:SA:CNRatio:OFFSet:FREQuency? 

Return: 1000000 

 

:CALCulate1:TRACe1:SA:CNRatio:OFFSet:FREQuency 2e6 

:CALCulate1:TRACe1:SA:CNRatio:OFFSet:FREQuency? 

Return: 2000000 

 

3.20.6.5 CNR测量的载波功率 

命令格式 :CALCulate<cnum>[:SELected]:SA:CNRatio:CARRier:POWer? 

:CALCulate<cnum>:TRACe<tnum>:SA:CNRatio:CARRier:POWer? 

说  明 获取选择通道及迹线 CNR 测量的载波功率。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

返回类型 浮点数，单位 dBm 

默认值 无 

菜单项 Mean > 测量 > 载噪比 >Carrier Power 

举例 :CALCulate1:SELected:SA:CNRatio:CARRier:POWer? 

Return: -65.4299219695216 

 

3.20.6.6 CNR测量的噪声功率 

命令格式 :CALCulate<cnum>[:SELected]:SA:CNRatio:NOISe:POWer? 

:CALCulate<cnum>:TRACe<tnum>:SA:CNRatio:NOISe:POWer? 

说  明 获取选择通道及迹线 CNR 测量的噪声功率。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

返回类型 浮点数，单位 dBm 

默认值 无 

菜单项 Mean > 测量 > 载噪比 >Noise Power 

举例 :CALCulate1:SELected:SA:CNRatio:NOISe:POWer? 

Return: -65.321863719616 

 

:CALCulate1:TRACe1:SA:CNRatio:NOISe:POWer? 

Return: -65.1136055327616 
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3.20.6.7 CNR测量的载噪比 

命令格式 :CALCulate<cnum>[:SELected]:SA:CNRatio? 

:CALCulate<cnum>:TRACe<tnum>:SA:CNRatio? 

说  明 获取选择通道及迹线 CNR 测量的噪声功率。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

返回类型 浮点数，单位 dBm 

默认值 无 

菜单项 Mean > 测量 > 载噪比 > Carrier Noise Ratio 

举例 :CALCulate1:SELected:SA:CNRatio? 

Return: 0.11582133533318 

 

:CALCulate1:TRACe1:SA:CNRatio? 

Return: -0.220832697601324 

 

3.20.7 频谱监测 

3.20.7.1 命令列表 

频谱监测长度 :CALCulate<cnum>:TRACe<tnum>:SA:SPECtrogram:SHOWlength 

频谱监测重新开始 :CALCulate<cnum>:TRACe<tnum>:SA:SPECtrogram:RESTart 

频谱监测运行状态 :CALCulate<cnum>:TRACe<tnum>:SA:SPECtrogram:PAUSe 

 

3.20.7.2 频谱监测长度 

命令格式 :CALCulate<cnum>[:SELected]:SA:SPECtrogram:SHOWlength <num> 

:CALCulate<cnum>[:SELected]:SA:SPECtrogram:SHOWlength? 

:CALCulate<cnum>:TRACe<tnum>:SA:SPECtrogram:SHOWlength <num> 

:CALCulate<cnum>:TRACe<tnum>:SA:SPECtrogram:SHOWlength? 

说  明 设置或获取选择通道及迹线 Spectrum Monitor 测量的监测长度。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 



 

 

<num>:=[10,800] 范围内的整数，单位无 

返回类型 整型 

默认值 175 

菜单项 Mean > 测量 > 频谱监测 >测量设置 >监测长度 

举例 :CALCulate1:SELected:SA:SPECtrogram:SHOWlength 200 

:CALCulate1:SELected:SA:SPECtrogram:SHOWlength? 

Return: 200 

 

:CALCulate1:TRACe1:SA:SPECtrogram:SHOWlength 300 

:CALCulate1:TRACe1:SA:SPECtrogram:SHOWlength? 

Return: 300 

 

3.20.7.3 频谱监测重新开始 

命令格式 :CALCulate<cnum>[:SELected]:SA:SPECtrogram:RESTart 

:CALCulate<cnum>:TRACe<tnum>:SA:SPECtrogram:RESTart 

说  明 Spectrum Monitor 测量重新开始 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

返回类型 无 

默认值 无 

菜单项 Mean > 测量 > 频谱监测 >测量设置 >重新开始 

举例 :CALCulate1:SELected:SA:SPECtrogram:RESTart 

:CALCulate1:TRACe1:SA:SPECtrogram:RESTart 

 

3.20.7.4 频谱监测运行状态 

命令格式 :CALCulate<cnum>[:SELected]:SA:SPECtrogram:PAUSe <bool> 

:CALCulate<cnum>[:SELected]:SA:SPECtrogram:PAUSe? 

:CALCulate<cnum>:TRACe<tnum>:SA:SPECtrogram:PAUSe <bool> 

:CALCulate<cnum>:TRACe<tnum>:SA:SPECtrogram:PAUSe? 

说  明 设置或获取选择通道及迹线频谱监测测量运行状态，1 为暂停状态，0 为运行状态。 
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参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

<bool>:={ON|OFF|1|0} 

返回类型 布尔型 

默认值 0 

菜单项 Mean > 测量 > 频谱监测 >测量设置 >频谱监测 

举例 :CALCulate1:SELected:SA:SPECtrogram:PAUSe 1 

:CALCulate1:SELected:SA:SPECtrogram:PAUSe? 

Return: 1 

 

:CALCulate1:TRACe1:SA:SPECtrogram:PAUSe 0 

:CALCulate1:TRACe1:SA:SPECtrogram:PAUSe? 

Return: 0 

 

3.20.8 源输出 

3.20.8.1 命令列表 

端口源的输出设置 :SENSe<cnum>:SA:SOURce<pnum>:STATe 

源的扫描类型 :SENSe<cnum>:SA:SOURce<pnum>:SWEep:TYPE 

源的 CW频率 :SENSe<cnum>:SA:SOURce<pnum>:FREQuency:CW 

源扫描的起始频率 :SENSe<cnum>:SA:SOURce<pnum>:FREQuency:STARt 

源扫描的终止频率 :SENSe<cnum>:SA:SOURce<pnum>:FREQuency:STOP 

源输出功率电平 :SENSe<cnum>:SA:SOURce<pnum>:POWer:VALue 

源输出的起始功率 :SENSe<cnum>:SA:SOURce<pnum>:POWer:STARt 

源输出的终止功率 :SENSe<cnum>:SA:SOURce<pnum>:POWer:STOP 

 

3.20.8.2 端口源的输出设置 

命令格式 :SENSe<cnum>:SA:SOURce<pnum>:STATe <bool> 

:SENSe<cnum>:SA:SOURce<pnum>:STATe? 

说明 打开或关闭端口源的输出，或查询源的输出的状态。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 



 

 

<pnum>:={[1]-4}，表示端口号。 

<bool>:= ON|OFF|1|0 

返回类型 布尔型 

默认值 Boolean (1=ON,0=OFF) 

菜单项 扫描 > SA Setup… > Source > State 

举例 :CALCulate1:CUSTom:DEFine "SA" 

:SENSe1:SA:SOURce1:STATe 1 

:SENSe1:SA:SOURce1:STATe? 

 

Return: 1 

 

3.20.8.3 源的扫描类型 

命令格式 :SENSe<cnum>:SA:SOURce<pnum>:SWEep:TYPE <type> 

:SENSe<cnum>:SA:SOURce<pnum>:SWEep:TYPE? 

说明 设置或问询端口信源的扫描类型。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<pnum>:={[1]-4}，表示端口号。 

<type>:={CW|LIN|POW|LFP} 

返回类型 字符 

默认值 CW 

菜单项 扫描 > SA Setup… > Source > Type > Sweep Type 

举例 :CALCulate1:CUSTom:DEFine "SA" 

:SENSe1:SA:SOURce1:SWEep:TYPE LIN 

:SENSe1:SA:SOURce1:SWEep:TYPE? 

 

Return: LIN 

 

3.20.8.4 源的 CW频率 

命令格式 :SENSe<cnum>:SA:SOURce<pnum>:FREQuency:CW <numeric> 

:SENSe<cnum>:SA:SOURce<pnum>:FREQuency:CW? 

说明 源扫描类型为 CW时，设置或查询 CW的频率。 

参数 

<cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<pnum>:={[1]-4}，表示网络端口号。 

<numeric>:表示 CW的频率。 

返回类型 浮点型，单位 Hz 
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默认值 1000000000 

菜单项 扫描 > SA Setup… > Source > Frequency >CW Frequency 

举例 :CALCulate1:CUSTom:DEFine "SA" 

:SENSe1:SA:SOURce1:FREQuency:CW 500000 

:SENSe1:SA:SOURce1:FREQuency:CW? 

 

Return: 500000 

 

3.20.8.5 源扫描的起始频率 

命令格式 :SENSe<cnum>:SA:SOURce<pnum>:FREQuency:STARt <numeric> 

:SENSe<cnum>:SA:SOURce<pnum>:FREQuency:STARt? 

说明 源扫描类型为线性扫描或线性+功率扫描时，设置或查询源扫描的起始频率。 

参数 

<cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<pnum>:={[1]-4}，表示网络端口号。 

<numeric>:表示起始频率。 

返回类型 浮点型，单位 Hz 

默认值 500000000 

菜单项 扫描 > SA Setup… > Source > Frequency > Start Frequency 

举例 :CALCulate1:CUSTom:DEFine "SA" 

:SENSe1:SA:SOURce1:SWEep:TYPE LIN 

:SENSe1:SA:SOURce1:FREQuency:STARt 600000 

:SENSe1:SA:SOURce1:FREQuency:STARt? 

Return: 600000 

 

3.20.8.6 源扫描的终止频率 

命令格式 :SENSe<cnum>:SA:SOURce<pnum>:FREQuency:STOP <numeric> 

:SENSe<cnum>:SA:SOURce<pnum>:FREQuency:STOP? 

说  明 源扫描类型为线性扫描或线性+功率扫描时，设置或查询源扫描的终止频率。 

参数 

<cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<pnum>:={[1]-4}，表示网络端口号。 

<numeric>:表示终止频率。 

返回类型 浮点型，单位 Hz 

默认值 500000000 

菜单项 扫描 > SA Setup… > Source > Frequency > Stop Frequency 



 

 

举例 :CALCulate1:CUSTom:DEFine "SA" 

:SENSe1:SA:SOURce1:SWEep:TYPE LIN 

:SENSe1:SA:SOURce1:FREQuency:STOP 900000 

:SENSe1:SA:SOURce1:FREQuency:STOP? 

 

Return: 900000 

 

3.20.8.7 源输出功率电平 

命令格式 :SENSe<cnum>:SA:SOURce<pnum>:POWer:VALue <numeric> 

:SENSe<cnum>:SA:SOURce<pnum>:POWer:VALue? 

说  明 源扫描类型为 CW或线性扫描时，设置或查询源输出的功率电平。 

参数 

<cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<pnum>:={[1]-4}，表示网络端口号。 

<numeric>:表示功率电平，其范围是-55~20 dBm。 

返回类型 浮点型 

默认值 0 

菜单项 扫描 > SA Setup… > Source > Power > Power Level 

举例 :CALCulate1:CUSTom:DEFine "SA" 

:SENSe1:SA:SOURce1:SWEep:TYPE CW 

:SENSe1:SA:SOURce1:POWer:VALue -5 

:SENSe1:SA:SOURce1:POWer:VALue? 

 

Return: -5 

 

3.20.8.8 源输出的起始功率 

命令格式 :SENSe<cnum>:SA:SOURce<pnum>:POWer:STARt <numeric> 

:SENSe<cnum>:SA:SOURce<pnum>:POWer:STARt? 

说  明 源扫描类型为功率扫描或线性+功率扫描时，设置或查询源输出的起始功率。 

参数 

<cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<pnum>:={[1]-4}，表示网络端口号。 

<numeric>:表示起始功率，其范围是-55~20 dBm。 

返回类型 浮点型 

默认值 -10 

菜单项 扫描 > SA Setup… > Source > Power > Start Power 

举例 :CALCulate1:CUSTom:DEFine "SA" 

:SENSe1:SA:SOURce1:SWEep:TYPE POW 
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:SENSe1:SA:SOURce1:POWer:STARt -7 

:SENSe1:SA:SOURce1:POWer:STARt? 

 

Return: -7 

 

3.20.8.9 源输出的终止功率 

命令格式 :SENSe<cnum>:SA:SOURce<pnum>:POWer:STOP <numeric> 

:SENSe<cnum>:SA:SOURce<pnum>:POWer:STOP? 

说  明 源扫描类型为功率扫描或线性+功率扫描时，设置或查询源输出的终止功率。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<pnum>:={[1]-4}，表示网络端口号。 

<numeric>:表示终止功率，其范围是-55~20 dBm。 

返回类型 浮点型 

默认值 0 

菜单项 扫描 > SA Setup… > Source > Power > Stop Power 

举例 :CALCulate1:CUSTom:DEFine "SA" 

:SENSe1:SA:SOURce1:SWEep:TYPE POW 

:SENSe1:SA:SOURce1:POWer:STOP 2 

:SENSe1:SA:SOURce1:POWer:STOP? 

 

Return: 2 

 

3.21 MIXER 命令子系统(Option，SHN900A系列机型不支持) 

3.21.1 扫描 

3.21.1.1 命令列表 

应用混频器设置 :SENSe<cnum>:MIXer:APPLy 

混频器频率计算 :SENSe<cnum>:MIXer:CALCulate 

混频器上一次设置 :SENSe<cnum>:MIXer:DISCard 

加载混频器设置 :SENSe<cnum>:MIXer:LOAD 

保存混频器设置 :SENSe<cnum>:MIXer:SAVE 

噪声抑制状态 :SENSe<cnum>:MIXer:AVOidspurs 

DUT 端口映射 :SENSe<cnum>:MIXer:PMAP 

查询 DUT 输入端口 :SENSe<cnum>:MIXer:PMAP:INPut? 



 

 

查询 DUT 输出端口 :SENSe<cnum>:MIXer:PMAP:OUTPut? 

执行上一次计算 :SENSe<cnum>:MIXer:RECalculate 

X 轴显示类型 :SENSe<cnum>:TRACe<tnum>:MIXer:XAXis <type> 

添加混频器段扫描表项 :SENSe<cnum>:MIXer:SEGMent<segnum>:ADD 

混频器段扫描表项状态 :SENSe<cnum>:MIXer:SEGMent<segnum>:STATe 

混频器段扫描表项数 :SENSe<cnum>:MIXer:SEGMent:COUNt? 

删除混频器段扫描表项 :SENSe<cnum>:MIXer:SEGMent<segnum>:DELete 

清空混频器段扫描表项 :SENSe<cnum>:MIXer:SEGMent:DELete:ALL 

混频器段扫描表项频率计算 :SENSe<cnum>:MIXer:SEGMent<segnum>:CALCulate 

混频器段扫描表项输入扫描模式 :SENSe<cnum>:MIXer:SEGMent<segnum>:INPut:FREQuency:MODE 

混频器段扫描表项输入固定频率 :SENSe<cnum>:MIXer:SEGMent<segnum>:INPut:FREQuency:FIXed 

混频器段扫描表项输入起始频率 :SENSe<cnum>:MIXer:SEGMent<segnum>:INPut:FREQuency:STARt 

混频器段扫描表项输入终止频率 :SENSe<cnum>:MIXer:SEGMent<segnum>:INPut:FREQuency:STOP 

混频器段扫描表项输入功率 :SENSe<cnum>:MIXer:SEGMent<segnum>:INPut:POWer 

混频器段扫描表项本振扫描模式 :SENSe<cnum>:MIXer:SEGMent<segnum>:LO:FREQuency:MODE 

混频器段扫描表项本振固定频率 :SENSe<cnum>:MIXer:SEGMent<segnum>:LO:FREQuency:FIXed 

混频器段扫描表项本振起始频率 :SENSe<cnum>:MIXer:SEGMent<segnum>:LO:FREQuency:STARt 

混频器段扫描表项本振终止频率 :SENSe<cnum>:MIXer:SEGMent<segnum>:LO:FREQuency:STOP 

混频器段扫描表项本振频率状态 :SENSe<cnum>:MIXer:SEGMent<segnum>:LO:FREQuency:ILTI 

混频器段扫描表项本振功率 :SENSe<cnum>:MIXer:SEGMent<segnum>:LO:POWer 

混频器段扫描表项输出扫描模式 :SENSe<cnum>:MIXer:SEGMent<segnum>:OUTPut:FREQuency:MODE 

混频器段扫描表项输出固定频率 :SENSe<cnum>:MIXer:SEGMent<segnum>:OUTPut:FREQuency:FIXed 

混频器段扫描表项输出起始频率 :SENSe<cnum>:MIXer:SEGMent<segnum>:OUTPut:FREQuency:STARt 

混频器段扫描表项输出终止频率 :SENSe<cnum>:MIXer:SEGMent<segnum>:OUTPut:FREQuency:STOP 

混频器段扫描表项输出频率计算方式 :SENSe<cnum>:MIXer:SEGMent<segnum>:OUTPut:FREQuency:SIDeband 

混频器段扫描表项输出功率 :SENSe<cnum>:MIXer:SEGMent<segnum>:OUTPut:POWer 

混频器段扫描表项扫描点数 :SENSe<cnum>:MIXer:SEGMent<segnum>:POINts 

混频器段扫描表项中频带宽 :SENSe<cnum>:MIXer:SEGMent<segnum>:BWIDth 

  

 

3.21.1.2 应用混频器设置 

命令格式 :SENSe<cnum>:MIXer:APPLy 
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说明 应用混频器设置并打开通道。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

返回类型 无 

默认值 无 

菜单项 扫描 > 混频器测量... > Apply 

举例 :SENS:MIX:APPL 

 

3.21.1.3 混频器频率计算 

命令格式 :SENSe<cnum>:MIXer:CALCulate <type> 

说明 计算混频器设置的输入、本振或输出频率。 

参数 
<cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<type>:={INPut|OUTPut|LO}，表示计算的端口。 

返回类型 无 

默认值 无 

菜单项 扫描 > 混频器测量... > Mixer Frequency > Calc 

举例 :SENS:MIX:CALC Output 

 

3.21.1.4 混频器上一次设置 

命令格式 :SENSe<cnum>:MIXer:DISCard 

说明 取消对转换器设置所做的更改并恢复到之前保存的设置。与混频器设置对话框上的

取消按钮相同。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

返回类型 无 

默认值 无 

菜单项 扫描 > 混频器测量... > Cancel 

举例 :SENS:MIX:DISC 

 

3.21.1.5 加载混频器设置 

命令格式 :SENSe<cnum>:MIXer:LOAD <string> 



 

 

说明 加载先前配置的混频器属性文件(.mxr)。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<string>:表示混频器属性(.mxr)文件的路径和名称。 

返回类型 无 

默认值 无 

菜单项 扫描 > 混频器测量... > Load… 

举例 :SENS:MIXer:LOAD "local/file.mxr" 

 

3.21.1.6 保存混频器设置 

命令格式 :SENSe<cnum>:MIXer:SAVE <string> 

说明 保存当前的混频器配置为(.mxr)文件。 

参数 
<cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<string>:表示混频器属性(.mxr)文件的路径和名称。 

返回类型 无 

默认值 无 

菜单项 扫描 > 混频器测量... > Save… 

举例 :SENS:MIXer:SAVE "local/file.mxr" 

 

3.21.1.7 噪声抑制状态 

命令格式 :SENSe<cnum>:MIXer:AVOidspurs <bool> 

:SENSe<cnum>:MIXer:AVOidspurs? 

说明 设置或获取噪声抑制的状态。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<bool>:= ON|OFF|1|0 

返回类型 Boolean (1=ON,0=OFF) 

默认值 OFF 

菜单项 校准 > 混频器校准  > 噪声抑制 

举例 :SENS:MIX:AVO ON 

:SENS:MIX:AVO? 

Return: 1 
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3.21.1.8 DUT端口映射 

命令格式 :SENSe<cnum>:MIXer:PMAP <pnum1>,<pnum2> 

说明 设置 DUT 与 SNA 相连接的输入和输出端口。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<pnum1>:={1~2}，输入端口号 

<pnum2>:={1~2}，输出端口号 

返回类型 无 

默认值 1,2 

菜单项 扫描 > 混频器测量... > Mixer Setup > Converter Model 

举例 :SENS:MIX:PMAP 2,1 

 

3.21.1.9 查询 DUT输入端口 

命令格式 :SENSe<cnum>:MIXer:PMAP:INPut? 

说明 获取 DUT 与 SNA 相连接的输入端口。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

返回类型 整型，输入端口号 

默认值 1 

菜单项 扫描 > 混频器测量... > Mixer Setup > Converter Model 

举例 :SENS:MIXer:PMAP:INPut? 

Return: 1 

 

3.21.1.10 查询 DUT输出端口 

命令格式 :SENSe<cnum>:MIXer:PMAP:OUTPut? 

说明 获取 DUT 与 SNA 相连接的输出端口。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

返回类型 整型，输出端口号 

默认值 2 

菜单项 扫描 > 混频器测量... > Mixer Setup > Converter Model 

举例 :SENS:MIXer:PMAP:OUTPut? 



 

 

Return: 2 

 

3.21.1.11 执行上一次计算 

命令格式 :SENSe<cnum>:MIXer:RECalculate 

说明 重复上次执行的计算，包括段表中的所有 ON（状态）段。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

返回类型 无 

默认值 无 

菜单项 无 

举例 :SENS:MIXer:RECalculate 

 

3.21.1.12 X轴显示类型 

命令格式 

:SENSe<cnum>[:SELected]:MIXer:XAXis <type> 

:SENSe<cnum>[:SELected]:MIXer: XAXis? 

:SENSe<cnum>:TRACe<tnum>:MIXer:XAXis <type> 

:SENSe<cnum>:TRACe<tnum>:MIXer: XAXis? 

说明 设置或获取混频器测量时 X 轴显示类型，矢量混频不允许设置。 

参数 

<cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

<type>:={INPUT|LO|OUTPUT} 

INPut: 混频器输入端口 

LO:  混频器本振端口 

OUTPut:  混频器输出端口 

返回类型 字符串 

默认值 INPut 

菜单项 扫描 > X 轴类型  

举例 

:SENS:MIX:XAX INPut 

:SENSe:MIXer:XAXis? 

Return: INPUT 

 

 

3.21.1.13 添加混频器段扫描表项 

命令格式 :SENSe<cnum>:MIXer:SEGMent<segnum>:ADD <numeric> 
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说明 在指定位置添加指定数量的混频器段扫描表项。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。

<segnum>:表示段扫描表编号，如果未指定，则<segnum>默认设置 1。段号必须

是连续的。如果在当前存在一个数字的地方添加一个新数字，则现有的段和后面的

段都加 1。 

<numeric>:表示需要添加的段的数量，添加后的段数小于段数上限 

返回类型 无 

默认值 无 

菜单项 
扫描 > 混频器测量... >Sweep > Segment Sweep 

扫描 > 混频器测量... >Mixer Frequency>Add 

举例 :SENS:MIXer:SEGM:ADD 2 

 

3.21.1.14 混频器段扫描表项状态 

命令格式 :SENSe<cnum>:MIXer:SEGMent<segnum>:STATe <bool> 

:SENSe<cnum>:MIXer:SEGMent<segnum>:STATe? 

说明 设置或获取指定段扫描表项的状态。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。

<segnum>:  表示段扫描表编号，如果未指定，则<segnum>默认设置 1。 

<bool>:= ON|OFF|1|0 

返回类型 Boolean (1=ON,0=OFF) 

默认值 OFF 

菜单项 扫描 > 混频器测量... > Sweep > Segment Sweep 

扫描 > 混频器测量... > Mixer Frequency > Segment Enable 

举例 :SENS:MIX:SEGM:STATe ON 

:SENS:MIX:SEGM:STATe? 

Return: 1 

 

 

3.21.1.15 混频器段扫描表项数 

命令格式 :SENSe<cnum>:MIXer:SEGMent:COUNt? 

说明 获取混频器的段扫描表数。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 



 

 

返回类型 整型 

默认值 无 

菜单项 扫描 > 混频器测量... > Sweep > Segment Sweep 

扫描 > 混频器测量... > Mixer Frequency > Segment 

举例 :SENS:MIXer:SEGM:COUN? 

Return: 1 

 

3.21.1.16 删除混频器段扫描表项 

命令格式 :SENSe<cnum>:MIXer:SEGMent<segnum>:DELete <numeric> 

说明 删除混频器指定位置指定数量的段扫描表项。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。

<segnum>:表示段扫描表编号，如果未指定，则 <segnum>默认设置 1。

<numeric>:表示要删除的段数，删除后的段数不小于 0。 

返回类型 无 

默认值 无 

菜单项 
扫描 > 混频器测量... > Sweep > Segment Sweep 

扫描 > 混频器测量... > Mixer Frequency > Delete 

举例 :SENS:MIXer:SEGM:DEL 1 

 

3.21.1.17 清空混频器段扫描表项 

命令格式 :SENSe<cnum>:MIXer:SEGMent:DELete:ALL 

说明 清空混频器段扫描表项。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

返回类型 无 

默认值 无 

菜单项 无 

举例 :SENS:MIX:SEGM:DEL:ALL 

 

3.21.1.18 混频器段扫描表项频率计算 

命令格式 :SENSe<cnum>:MIXer:SEGMent<segnum>:CALCulate <type> 
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说明 计算混频器指定段扫描表的输入、本振或输出频率。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<segnum>:表示段扫描表编号，如果未指定，则<segnum>默认设置 1。 

<type>:={INPut|OUTPut|LO}，表示计算的端口。 

返回类型 无 

默认值 无 

菜单项 
扫描 > 混频器测量... > Sweep > Segment Sweep 

扫描 > 混频器测量...  > Mixer Frequency> Calc 

举例 :SENS:MIXer:SEGM:CALCulate INPut 

 

3.21.1.19 混频器段扫描表项输入扫描模式 

命令格式 :SENSe<cnum>:MIXer:SEGMent<segnum>:INPut:FREQuency:MODE <type> 

:SENSe<cnum>:MIXer:SEGMent<segnum>:INPut:FREQuency:MODE? 

说明 设置或获取指定段扫描表项的输入扫描模式。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<segnum>:表示段扫描表编号，如果未指定，则<segnum>默认设置 1。 

<type>:={FIXed|SWEPt}，表示输入扫描模式。 

返回类型 枚举 

默认值 SWEPT 

菜单项 
扫描 > 混频器测量... > Sweep > Segment Sweep 

扫描 > 混频器测量... > Mixer Frequency> Input 

举例 :SENS:MIX:SEGM:INP:FREQ:MODE FIXED 

:SENS:MIX:SEGM:INP:FREQ:MODE? 

 

Return: FIXED 

 

3.21.1.20 混频器段扫描表项输入固定频率 

命令格式 :SENSe<cnum>:MIXer:SEGMent<segnum>:INPut:FREQuency:FIXed <numeric> 

:SENSe<cnum>:MIXer:SEGMent<segnum>:INPut:FREQuency:FIXed? 

说明 设置或获取指定段扫描表项的输入固定频率。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。

<segnum>:表示段扫描表编号，如果未指定，则 <segnum>默认设置 1。



 

 

<numeric>:表示输入固定频率，可选择 SNA 范围内的任何频率。 

返回类型 浮点型，单位 Hz（赫兹） 

默认值 无 

菜单项 扫描 > 混频器测量... > Sweep > Segment Sweep 

扫描 > 混频器测量... > Mixer Frequency>Input >Fixed 

举例 :SENS:MIX:SEGM:INP:FREQ:FIX 100000 

:SENS:MIX:SEGM:INP:FREQ:FIX? 

 

Return: 100000 

 

3.21.1.21 混频器段扫描表项输入起始频率 

命令格式 :SENSe<cnum>:MIXer:SEGMent<segnum>:INPut:FREQuency:STARt 
<numeric> 

:SENSe<cnum>:MIXer:SEGMent<segnum>:INPut:FREQuency:STARt? 

说明 设置或获取指定段扫描表项的输入起始频率。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。

<segnum>:表示段扫描表编号，如果未指定，则 <segnum>默认设置 1。

<numeric>:表示输入起始频率，可选择 SNA 范围内的任何频率。 

返回类型 浮点型，单位 Hz（赫兹） 

默认值 无 

菜单项 扫描 > 混频器测量... > Sweep > Segment Sweep 

扫描 > 混频器测量... > Mixer Frequency>Input >Start/Stop 

举例 :SENS:MIX:SEGM:INP:FREQ:STAR 100000 

:SENS:MIX:SEGM:INP:FREQ:STAR? 

 

Return: 100000 

 

3.21.1.22 混频器段扫描表项输入终止频率 

命令格式 :SENSe<cnum>:MIXer:SEGMent<segnum>:INPut:FREQuency:STOP <numeric> 

 

:SENSe<cnum>:MIXer:SEGMent<segnum>:INPut:FREQuency:STOP? 

说明 设置或获取指定段扫描表项的输入终止频率。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。

<segnum>:表示段扫描表编号，如果未指定，则 <segnum>默认设置 1。

<numeric>:表示输入终止频率，可选择 SNA 范围内的任何频率。 
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返回类型 浮点型，单位 Hz（赫兹） 

默认值 无 

菜单项 扫描 > 混频器测量... > Sweep > Segment Sweep 

扫描 > 混频器测量... > Mixer Frequency>Input >Start/Stop 

举例 :SENS:MIX:SEGM:INP:FREQ:STOP 100000 

:SENS:MIX:SEGM:INP:FREQ:STOP? 

 

Return: 100000 

 

3.21.1.23 混频器段扫描表项输入功率 

命令格式 :SENSe<cnum>:MIXer:SEGMent<segnum>:INPut:POWer <numeric> 

:SENSe<cnum>:MIXer:SEGMent<segnum>:INPut:POWer? 

说明 设置或获取指定段扫描表项的输入功率。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。

<segnum>:表示段扫描表编号，如果未指定，则 <segnum>默认设置 1。

<numeric>:表示输入功率电平值，其范围是-55dBm~20dBm。 

返回类型 浮点型，单位 dBm 

默认值 无 

菜单项 扫描 > 混频器测量... > Sweep > Segment Sweep 

扫描 > 混频器测量... > Mixer Frequency >Input Power 

举例 :SENS:MIX:SEGM:INP:POW 5 

:SENS:MIX:SEGM:INP:POW? 

 

Return: 5 

 

3.21.1.24 混频器段扫描表项本振扫描模式 

命令格式 :SENSe<cnum>:MIXer:SEGMent<segnum>:LO:FREQuency:MODE <type> 

:SENSe<cnum>:MIXer:SEGMent<segnum>:LO:FREQuency:MODE? 

说明 设置或获取指定段扫描表项的本振扫描模式。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<segnum>:表示段扫描表编号，如果未指定，则<segnum>默认设置 1。 

<type>:={FIXed|SWEPt}，表示本振扫描模式。 

返回类型 枚举 

默认值 FIXED 



 

 

菜单项 
扫描 > 混频器测量... > Sweep > Segment Sweep 

扫描 > 混频器测量... > Mixer Frequency>Local 

举例 :SENS:MIX:SEGM:LO:FREQ:MODE FIXED 

:SENS:MIX:SEGM:LO:FREQ:MODE? 

 

Return: FIXED 

 

3.21.1.25 混频器段扫描表项本振固定频率 

命令格式 :SENSe<cnum>:MIXer:SEGMent<segnum>:LO:FREQuency:FIXed <numeric> 

:SENSe<cnum>:MIXer:SEGMent<segnum>:LO:FREQuency:FIXed? 

说明 设置或获取指定段扫描表项的本振固定频率。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。

<segnum>:表示段扫描表编号，如果未指定，则 <segnum>默认设置 1。

<numeric>:表示本振固定频率，可选择 SNA 范围内的任何频率。 

返回类型 浮点型，单位 Hz（赫兹） 

默认值 无 

菜单项 扫描 > 混频器测量... > Sweep > Segment Sweep 

扫描 > 混频器测量... > Mixer Frequency>Local>Fixed 

举例 :SENS:MIX:SEGM:LO:FREQ:FIX 100000 

:SENS:MIX:SEGM:LO:FREQ:FIX? 

 

Return: 100000 

 

3.21.1.26 混频器段扫描表项本振起始频率 

命令格式 :SENSe<cnum>:MIXer:SEGMent<segnum>:LO:FREQuency:STARt <numeric> 

 

:SENSe<cnum>:MIXer:SEGMent<segnum>:LO:FREQuency:STARt? 

说明 设置或获取指定段扫描表项的本振起始频率。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。

<segnum>:表示段扫描表编号，如果未指定，则 <segnum>默认设置 1。

<numeric>:表示本振起始频率，可选择 SNA 范围内的任何频率。 

返回类型 浮点型，单位 Hz（赫兹） 

默认值 无 

菜单项 扫描 > 混频器测量... > Sweep > Segment Sweep 

扫描 > 混频器测量... > Mixer Frequency>Local>Start/Stop 
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举例 :SENS:MIX:SEGM:LO:FREQ:STARt 100000 

:SENS:MIX:SEGM:LO:FREQ:STARt? 

 

Return: 100000 

 

3.21.1.27 混频器段扫描表项本振终止频率 

命令格式 :SENSe<cnum>:MIXer:SEGMent<segnum>:LO:FREQuency:STOP <numeric> 

:SENSe<cnum>:MIXer:SEGMent<segnum>:LO:FREQuency:STOP? 

说明 设置或获取指定段扫描表项的本振终止频率。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。

<segnum>:表示段扫描表编号，如果未指定，则 <segnum>默认设置 1。

<numeric>:表示本振终止频率，可选择 SNA 范围内的任何频率。 

返回类型 浮点型，单位 Hz（赫兹） 

默认值 无 

菜单项 扫描 > 混频器测量... > Sweep > Segment Sweep 

扫描 > 混频器测量... > Mixer Frequency>Local>Start/Stop 

举例 :SENS:MIX:SEGM:LO:FREQ:STOP 100000 

:SENS:MIX:SEGM:LO:FREQ:STOP? 

 

Return: 100000 

 

3.21.1.28 混频器段扫描表项本振频率状态 

命令格式 :SENSe<cnum>:MIXer:SEGMent<segnum>:LO:FREQuency:ILTI <bool> 

:SENSe<cnum>:MIXer:SEGMent<segnum>:LO:FREQuency:ILTI? 

说明 设置或获取指定段扫描项表是输入频率大于本振频率或输入频率小于本振频率。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。

<segnum>:表示段扫描表编号，如果未指定，则<segnum>默认设置 1。 

<bool>:= ON|OFF|1|0 

返回类型 Boolean (1=ON,0=OFF) 

默认值 OFF 

菜单项 扫描 > 混频器测量... > Sweep > Segment Sweep 

扫描 > 混频器测量... > Mixer Frequency>Output>"-">Local>"Input > LO" 

举例 :SENS:MIX:SEGM:LO:FREQ:ILTI OFF 

:SENS:MIX:SEGM:LO:FREQ:ILTI? 

 



 

 

Return: 0 

 

3.21.1.29 混频器段扫描表项本振功率 

命令格式 :SENSe<cnum>:MIXer:SEGMent<segnum>:LO:POWer <numeric> 

:SENSe<cnum>:MIXer:SEGMent<segnum>:LO:POWer? 

说  明 设置或获取指定段扫描表项的本振功率。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。

<segnum>:表示段扫描表编号，如果未指定，则 <segnum>默认设置 1。

<numeric>:表示本振功率电平值，其范围是-55dBm~20dBm。 

返回类型 浮点型，单位 dBm 

默认值 无 

菜单项 扫描 > 混频器测量... > Sweep > Segment Sweep 

扫描 > 混频器测量... > Mixer Frequency>Local Power 

举例 :SENS:MIX:SEGM:LO:POW 5 

:SENS:MIX:SEGM:LO:POW? 

 

Return: 5 

 

3.21.1.30 混频器段扫描表项输出扫描模式 

命令格式 :SENSe<cnum>:MIXer:SEGMent<segnum>:OUTPut:FREQuency:MODE <type> 

:SENSe<cnum>:MIXer:SEGMent<segnum>:OUTPut:FREQuency:MODE? 

说明 设置或获取指定段扫描表项的输出扫描模式。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<segnum>:表示段扫描表编号，如果未指定，则<segnum>默认设置 1。 

<type>:={FIXed|SWEPt}，表示输出扫描模式。 

返回类型 枚举 

默认值 SWEPT 

菜单项 
扫描 > 混频器测量... > Sweep > Segment Sweep 

扫描 > 混频器测量... > Mixer Frequency>Output 

举例 :SENS:MIX:SEGM:OUTP:FREQ:MODE FIXED 

:SENS:MIX:SEGM:OUTP:FREQ:MODE? 

 

Return: FIXED 
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3.21.1.31 混频器段扫描表项输出固定频率 

命令格式 :SENSe<cnum>:MIXer:SEGMent<segnum>:OUTPut:FREQuency:FIXed 
<numeric> 

:SENSe<cnum>:MIXer:SEGMent<segnum>:OUTPut:FREQuency:FIXed? 

说明 设置或获取指定段扫描表项的输出固定频率。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。

<segnum>:表示段扫描表编号，如果未指定，则<segnum>默认设置 1。

<numeric>:表示输出固定频率，可选择 SNA 范围内的任何频率。 

返回类型 浮点型，单位 Hz（赫兹） 

默认值 无 

菜单项 扫描 > 混频器测量... > Sweep > Segment Sweep 

扫描 > 混频器测量... > Mixer Frequency>Output>Fixed 

举例 :SENS:MIX:SEGM:OUTP:FREQ:FIX 100000 

:SENS:MIX:SEGM:OUTP:FREQ:FIX? 

 

Return: 100000 

 

3.21.1.32 混频器段扫描表项输出起始频率 

命令格式 :SENSe<cnum>:MIXer:SEGMent<segnum>:OUTPut:FREQuency:STARt 
<numeric> 

:SENSe<cnum>:MIXer:SEGMent<segnum>:OUTPut:FREQuency:STARt? 

说明 设置或获取指定段扫描表项的输出起始频率。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。

<segnum>:表示段扫描表编号，如果未指定，则 <segnum>默认设置 1。

<numeric>:表示输出起始频率，可选择 SNA 范围内的任何频率。 

返回类型 浮点型，单位 Hz（赫兹） 

默认值 无 

菜单项 扫描 > 混频器测量... > Sweep > Segment Sweep 

扫描 > 混频器测量... > Mixer Frequency>Output>Start/Stop 

举例 :SENS:MIX:SEGM:OUTP:FREQ:STAR 100000 

:SENS:MIX:SEGM:OUTP:FREQ:STAR? 

 

Return: 100000 

 



 

 

3.21.1.33 混频器段扫描表项输出终止频率 

命令格式 :SENSe<cnum>:MIXer:SEGMent<segnum>:OUTPut:FREQuency:STOP 
<numeric> 

 

:SENSe<cnum>:MIXer:SEGMent<segnum>:OUTPut:FREQuency:STOP? 

说明 设置或获取指定段扫描表项的输出终止频率。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。

<segnum>:表示段扫描表编号，如果未指定，则 <segnum>默认设置 1。

<numeric>:表示输出终止频率，可选择 SNA 范围内的任何频率。 

返回类型 浮点型，单位 Hz（赫兹） 

默认值 无 

菜单项 扫描 > 混频器测量... > Sweep > Segment Sweep 

扫描 > 混频器测量... > Mixer Frequency>Output>Start/Stop 

举例 :SENS:MIX:SEGM:OUTP:FREQ:STOP 100000 

:SENS:MIX:SEGM:OUTP:FREQ:STOP? 

 

Return: 100000 

 

3.21.1.34 混频器段扫描表项输出频率计算方式 

命令格式 :SENSe<cnum>:MIXer:SEGMent<segnum>:OUTPut:FREQuency:SIDeband 
<type> 

:SENSe<cnum>:MIXer:SEGMent<segnum>:OUTPut:FREQuency:SIDeband? 

说明 设置或获取指定段扫描表项的输出频率的计算方式，输入与本振的和或差。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<segnum>:表示段扫描表编号，如果未指定，则<segnum>默认设置 1。 

<type>:={LOW|HIGH}，表示输出频率的计算方式。 

返回类型 枚举 

默认值 HIGH 

菜单项 
扫描 > 混频器测量... > Sweep > Segment Sweep 

扫描 > 混频器测量... > Mixer Frequency>Output 

举例 :SENS:MIX:SEGM:OUTP:FREQ:SID HIGH 

:SENS:MIX:SEGM:OUTP:FREQ:SID? 

 

Return: HIGH 
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3.21.1.35 混频器段扫描表项输出功率 

命令格式 :SENSe<cnum>:MIXer:SEGMent<segnum>:OUTPut:POWer <numeric> 

:SENSe<cnum>:MIXer:SEGMent<segnum>:OUTPut:POWer? 

说明 设置或获取指定段扫描表项的输出功率。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。

<segnum>:表示段扫描表编号，如果未指定，则 <segnum>默认设置 1。

<numeric>:表示输出功率电平值，其范围是-55dBm~20dBm。 

返回类型 浮点型，单位 dBm 

默认值 无 

菜单项 扫描 > 混频器测量... > Sweep > Segment Sweep 

扫描 > 混频器测量... > Mixer Frequency>Output Power 

举例 :SENS:MIX:SEGM:OUTP:POW 5 

:SENS:MIX:SEGM:OUTP:POW? 

 

Return: 5 

 

3.21.1.36 混频器段扫描表项扫描点数 

命令格式 :SENSe<cnum>:MIXer:SEGMent<segnum>:POINts <numeric> 

:SENSe<cnum>:MIXer:SEGMent<segnum>:POINts? 

说明 设置或获取指定段扫描表项的扫描点数。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。

<segnum>:表示段扫描表编号，如果未指定，则 <segnum>默认设置 1。

<numeric>:表示段扫描表项扫描点数。 

返回类型 整型 

默认值 21 

菜单项 扫描 > 混频器测量... > Sweep > Segment Sweep 

扫描 > 混频器测量... > Mixer Frequency>Sweep Point 

举例 :SENS:MIX:SEGM:POIN 21 

:SENS:MIX:SEGM:POIN? 

Return: 21 

 

3.21.1.37 混频器段扫描表项中频带宽 

命令格式 :SENSe<cnum>:MIXer:SEGMent<segnum>:BWIDth <numeric> 

:SENSe<cnum>:MIXer:SEGMent<segnum>:BWIDth? 



 

 

说明 设置或获取指定段扫描表的中频带宽。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。

<segnum>:表示段扫描表编号，如果未指定，则 <segnum>默认设置 1。

<numeric>:={1|2|3|4|5|6|7|10|15|20|30|40|50|70|100|150|200|300|400|500 

|700|1E3|1.5E3|2E3|3E3|4E3|5E3|7E3|10E3|15E3|20E3|30E3|40E3|50E3 

|70E3|100E3|150E3|200E3|300E3|400E3|500E3|700E3|1E6|1.5E6|2E6|3E6 

|4E6|5E6|7E6|10E6}，表示段的中频带宽，单位是 Hz。 

返回类型 浮点型，单位 Hz（赫兹） 

默认值 10kHz 

菜单项 扫描 > 混频器测量... > Sweep > Segment Sweep 

扫描 > 混频器测量... > Mixer Frequency>IF Bandwidth 

举例 :SENS:MIXer:SEGM:BWIDth 1000 

:SENS:MIXer:SEGM:BWIDth? 

Return: 1000 

 

3.21.2 混频输入 

3.21.2.1 命令列表 

混频器输入扫描模式 :SENSe<cnum>:MIXer:INPut:FREQuency:MODE 

混频器输入起始频率 :SENSe<cnum>:MIXer:INPut:FREQuency:STARt 

混频器输入终止频率 :SENSe<cnum>:MIXer:INPut:FREQuency:STOP 

混频器输入固定频率 :SENSe<cnum>:MIXer:INPut:FREQuency:FIXed 

混频器输入分频因子 :SENSe<cnum>:MIXer:INPut:FREQuency:DENominator 

混频器输入倍频因子 :SENSe<cnum>:MIXer:INPut:FREQuency:NUMerator 

混频器输入功率 :SENSe<cnum>:MIXer:INPut:POWer 

混频器输入功率 :SENSe<cnum>:MIXer:INPut:POWer:STARt 

混频器输入功率 :SENSe<cnum>:MIXer:INPut:POWer:STOP 

 

3.21.2.2 混频器输入扫描模式 

命令格式 :SENSe<cnum>:MIXer:INPut:FREQuency:MODE <type> 

:SENSe<cnum>:MIXer:INPut:FREQuency:MODE? 

说明 设置或获取输入扫描模式。 
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参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<type>:={FIXed|SWEPt}，表示输入扫描模式。 

返回类型 枚举 

默认值 SWEPT 

菜单项 扫描 > 混频器测量... > Mixer Frequency > Input 

举例 :SENS:MIX:INP:FREQ:MODE FIXED 

:SENSe:MIXer:INPut:FREQuency:MODE? 

Return: FIXED 

 

3.21.2.3 混频器输入起始频率 

命令格式 :SENSe<cnum>:MIXer:INPut:FREQuency:STARt <numeric> 

:SENSe<cnum>:MIXer:INPut:FREQuency:STARt? 

说明 设置或获取输入起始频率。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<numeric>:表示输入起始频率，可选择 SNA 范围内的任何频率。 

返回类型 浮点型，单位 Hz（赫兹） 

默认值 无 

菜单项 扫描 > 混频器测量... > Mixer Frequency > Input > Start/Stop 

举例 :SENS:MIX:INP:FREQ:STAR 100000 

:SENS:MIXer:INPut:FREQuency:STARt? 

Return: 100000 

 

3.21.2.4 混频器输入终止频率 

命令格式 :SENSe<cnum>:MIXer:INPut:FREQuency:STOP <numeric> 

:SENSe<cnum>:MIXer:INPut:FREQuency:STOP? 

说明 设置或获取输入终止频率。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<numeric>:表示输入终止频率，可选择 SNA 范围内的任何频率。 

返回类型 浮点型，单位 Hz（赫兹） 

默认值 无 

菜单项 扫描 > 混频器测量... > Mixer Frequency > Input > Start/Stop 

举例 :SENS:MIX:INP:FREQ:STOP 100000 

:SENS:MIXer:INPut:FREQuency:STOP? 



 

 

Return: 100000 

 

3.21.2.5 混频器输入固定频率 

命令格式 :SENSe<cnum>:MIXer:INPut:FREQuency:FIXed <numeric> 

:SENSe<cnum>:MIXer:INPut:FREQuency:FIXed? 

说明 设置或获取输入固定频率。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<numeric>:表示输入固定频率，可选择 SNA 范围内的任何频率。 

返回类型 浮点型，单位 Hz（赫兹） 

默认值 无 

菜单项 扫描 > 混频器测量... > Mixer Frequency > Input > Fixed 

举例 :SENS:MIX:INP:FREQ:FIX 100000 

:SENS:MIXer:INPut:FREQuency:FIXed? 

Return: 100000 

 

3.21.2.6 混频器输入分频因子 

命令格式 :SENSe<cnum>:MIXer:INPut:FREQuency:DENominator <numeric> 

:SENSe<cnum>:MIXer:INPut:FREQuency:DENominator? 

说明 设置或获取输入分频因子，矢量混频不允许设置。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<numeric>:表示输入分频因子，其范围为 1~100。 

返回类型 整型 

默认值 1 

菜单项 扫描 > 混频器测量... > Mixer Setup > Converter Model 

举例 :SENS:MIX:INP:FREQ:DEN 2 

:SENS:MIXer:INPut:FREQuency:DENominator? 

Return: 2 

 

3.21.2.7 混频器输入倍频因子 

命令格式 :SENSe<cnum>:MIXer:INPut:FREQuency:NUMerator <numeric> 

:SENSe<cnum>:MIXer:INPut:FREQuency:NUMerator? 

说明 设置或获取输入倍频因子，矢量混频不允许设置。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<numeric>:表示输入倍频因子，其范围为 1~100。 
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返回类型 整型 

默认值 无 

菜单项 扫描 > 混频器测量... > Mixer Setup > Converter Model 

举例 :SENS:MIX:INP:FREQ:NUM 2 

:SENS:MIXer:INPut:FREQuency:NUMerator? 

Return: 2 

 

3.21.2.8 混频器输入功率 

命令格式 :SENSe<cnum>:MIXer:INPut:POWer <numeric> 

:SENSe<cnum>:MIXer:INPut:POWer? 

说明 设置或获取输入功率。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<numeric>:表示输入功率电平值，其范围是-55dBm~20dBm。 

返回类型 浮点型，单位 dBm 

默认值 无 

菜单项 扫描 > 混频器测量... > Power > DUT Input Port > Power Level 

举例 :SENS:MIX:INP:POW 5 

:SENS:MIXer:INPut:POWer? 

Return: 5 

 

3.21.2.9 混频器输入起始功率 

命令格式 :SENSe<cnum>:MIXer:INPut:POWer:STARt <numeric> 

:SENSe<cnum>:MIXer:INPut:POWer:STARt? 

说明 设置或获取输入起始功率，只有在功率扫描模式下才有效 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<numeric>:表示输入起始功率电平值，其范围是-55dBm~20dBm。 

返回类型 浮点型，单位 dBm 

默认值 无 

菜单项 扫描 > 混频器测量... > Power > DUT Input Port Power Sweep> Start Power  

举例 :SENS:MIX:INP:POW:STAR 5 

:SENS:MIXer:INPut:POWer:STARt? 

Return: 5 

 



 

 

3.21.2.10 混频器输入终止功率 

命令格式 :SENSe<cnum>:MIXer:INPut:POWer:STOP<numeric> 

:SENSe<cnum>:MIXer:INPut:POWer:STOP? 

说明 设置或获取输入终止功率，只有在功率扫描模式下才有效 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<numeric>:表示输入终止功率电平值，其范围是-55dBm~20dBm。 

返回类型 浮点型，单位 dBm 

默认值 无 

菜单项 扫描 > 混频器测量... > Power > DUT Input Port Power Sweep> Stop Power  

举例 :SENS:MIX:INP:POW:STOP 5 

:SENS:MIXer:INPut:POWer:STOP? 

Return: 5 

 

3.21.3 混频本振 

3.21.3.1 命令列表 

本振源设备名称 :SENSe<cnum>:MIXer:LO:NAME 

混频器本振扫描模式 :SENSe<cnum>:MIXer:LO:FREQuency:MODE 

混频器本振起始频率 :SENSe<cnum>:MIXer:LO:FREQuency:STARt 

混频器本振终止频率 :SENSe<cnum>:MIXer:LO:FREQuency:STOP 

混频器本振固定频率 :SENSe<cnum>:MIXer:LO:FREQuency:FIXed 

混频器本振频率状态 :SENSe<cnum>:MIXer:LO:FREQuency:ILTI 

混频器本振分频因子 :SENSe<cnum>:MIXer:LO:FREQuency:DENominator 

混频器本振倍频因子 :SENSe<cnum>:MIXer:LO:FREQuency:NUMerator 

错误!未找到引用源。 :SENSe<cnum>:MIXer:LO:POWer 

混频器混频器本振起始功率 :SENSe<cnum>:MIXer:LO:POWer:STARt 

混频器混频器本振终止功率 :SENSe<cnum>:MIXer:LO:POWer:STOP 

 

3.21.3.2 本振源设备名称 

命令格式 :SENSe<cnum>:MIXer:LO:NAME <string> 

:SENSe<cnum>:MIXer:LO:NAME? 

说明 设置或获取混频器本振源设备名称。 
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参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<string>:表示可用的本振源设备名称。 

返回类型 字符串 

默认值 "Not Controlled" 

菜单项 扫描 > 混频器测量... > Sweep > Power Sweep > Converter Model > Local 

举例 :SENS:MIX:LO:NAME "Not Controlled" 

:SENS:MIXer:LO:NAME? 

Return: "Not Controlled " 

 

3.21.3.3 混频器本振扫描模式 

命令格式 :SENSe<cnum>:MIXer:LO:FREQuency:MODE <type> 

:SENSe<cnum>:MIXer:LO:FREQuency:MODE? 

说明 设置或获取本振扫描模式。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<type>:={FIXed|SWEPt}，表示本振扫描模式。 

返回类型 枚举 

默认值 FIXED 

菜单项 扫描 > 混频器测量... > Mixer Frequency > Local 

举例 :SENSe:MIX:LO:FREQ:MODE FIXED 

:SENSe:MIXer:LO:FREQuency:MODE? 

Return: FIXED 

 

3.21.3.4 混频器本振起始频率 

命令格式 :SENSe<cnum>:MIXer:LO:FREQuency:STARt <numeric> 

:SENSe<cnum>:MIXer:LO:FREQuency:STARt? 

说明 设置或获取本振起始频率。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<numeric>:表示本振起始频率，可选择 SNA 范围内的任何频率。 

返回类型 浮点型，单位 Hz（赫兹） 

默认值 无 

菜单项 扫描 > 混频器测量... > Mixer Frequency > Local > Start/Stop 

举例 :SENS:MIX:LO:FREQ:STAR 100000 

:SENS:MIXer:LO:FREQuency:STARt? 



 

 

Return: 100000 

 

3.21.3.5 混频器本振终止频率 

命令格式 :SENSe<cnum>:MIXer:LO:FREQuency:STOP <numeric> 

:SENSe<cnum>:MIXer:LO:FREQuency:STOP? 

说明 设置或获取本振终止频率。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<numeric>:表示本振终止频率，可选择 SNA 范围内的任何频率。 

返回类型 浮点型，单位 Hz（赫兹） 

默认值 无 

菜单项 扫描 > 混频器测量... > Mixer Frequency > Local > Start/Stop 

举例 :SENS:MIX:LO:FREQ:STOP 100000 

:SENS:MIXer:LO:FREQuency:STOP? 

Return: 100000 

 

3.21.3.6 混频器本振固定频率 

命令格式 :SENSe<cnum>:MIXer:LO:FREQuency:FIXed <numeric> 

:SENSe<cnum>:MIXer:LO:FREQuency:FIXed? 

说明 设置或获取本振固定频率。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<numeric>:表示本振固定频率，可选择 SNA 范围内的任何频率。 

返回类型 浮点型，单位 Hz（赫兹） 

默认值 无 

菜单项 扫描 > 混频器测量... > Mixer Frequency > Local > Fixed 

举例 :SENS:MIX:LO:FREQ:FIX 100000 

:SENS:MIXer:LO:FREQuency:FIX? 

Return: 100000 

 

3.21.3.7 混频器本振频率状态 

命令格式 :SENSe<cnum>:MIXer:LO:FREQuency:ILTI <bool> 

:SENSe<cnum>:MIXer:LO:FREQuency:ILTI? 

说明 设置或获取是输入频率大于本振频率或输入频率小于本振频率。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<bool>:= ON|OFF|1|0 
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返回类型 Boolean (1=ON,0=OFF) 

默认值 OFF 

菜单项 扫描 > 混频器测量... > Mixer Frequency > Output > "-" > Local > "Input > LO" 

举例 :SENS:MIX:LO:FREQ:ILTI OFF 

:SENS:MIXer:LO:FREQuency:ILTI? 

Return: 0 

 

3.21.3.8 混频器本振分频因子 

命令格式 :SENSe<cnum>:MIXer:LO:FREQuency:DENominator <numeric> 

:SENSe<cnum>:MIXer:LO:FREQuency:DENominator? 

说明 设置或获取本振分频因子，矢量混频不允许设置。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<numeric>:表示本振分频因子，其范围为 1~100。 

返回类型 整型 

默认值 1 

菜单项 扫描 > 混频器测量... > Mixer Setup> Converter Model 

举例 :SENS:MIX:LO:FREQ:DEN 2 

:SENS:MIXer:LO:FREQuency:DENominator? 

Return: 2 

 

3.21.3.9 混频器本振倍频因子 

命令格式 :SENSe<cnum>:MIXer:LO:FREQuency:NUMerator <numeric> 

:SENSe<cnum>:MIXer:LO:FREQuency:NUMerator? 

说明 设置或获取本振倍频因子，矢量混频不允许设置。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<numeric>:表示本振倍频因子，其范围为 1~100。 

返回类型 整型 

默认值 无 

菜单项 扫描 > 混频器测量... > Mixer Setup> Converter Model 

举例 :SENS:MIX:LO:FREQ:NUM 2 

:SENS:MIXer:LO:FREQuency:NUMerator? 

Return: 2 

 



 

 

3.21.3.10 混频器本振功率 

命令格式 :SENSe<cnum>:MIXer:LO:POWer <numeric> 

:SENSe<cnum>:MIXer:LO:POWer? 

说明 设置或获取本振功率。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<numeric>:表示本振功率电平值，其范围是-55dBm~20dBm。 

返回类型 浮点型，单位 dBm 

默认值 无 

菜单项 扫描 > 混频器测量... > Mixer Setup> Power Level 

举例 :SENS:MIX:LO:POW -5 

:SENS:MIXer:LO:POWer? 

Return: -5 

 

3.21.3.11 混频器本振起始功率 

命令格式 :SENSe<cnum>:MIXer:LO:POWer:STARt <numeric> 

:SENSe<cnum>:MIXer:LO:POWer:STARt? 

说明 设置或获取本振起始功率，只有功率扫描时有效。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<numeric>:表示本振起始功率电平值，其范围是-55dBm~20dBm。 

返回类型 浮点型，单位 dBm 

默认值 -10 dBm 

菜单项 扫描 > 混频器测量... > Sweep > Power Sweep 

扫描 > 混频器测量... > Mixer Setup> Local> Swpet Power>Start 

举例 :SENS:MIX:LO:POW:STAR -5 

:SENS:MIXer:LO:POWer:STARt? 

Return: -5 

 

3.21.3.12 混频器本振终止功率 

命令格式 :SENSe<cnum>:MIXer:LO:POWer:STOP <numeric> 

:SENSe<cnum>:MIXer:LO:POWer:STOP? 

说明 设置或获取本振终止功率，只有功率扫描时有效。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<numeric>:表示本振终止功率电平值，其范围是-55dBm~20dBm。 

返回类型 浮点型，单位 dBm 
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默认值 -10 dBm 

菜单项 扫描 > 混频器测量... > Sweep > Power Sweep 

扫描 > 混频器测量... > Mixer Setup> Local> Swpet Power>Stop 

举例 :SENS:MIX:LO:POW:STOP -5 

:SENS:MIXer:LO:POWer:STOP? 

Return: -5 

 

3.21.4 混频输出 

3.21.4.1 命令列表 

混频器输出扫描模式 :SENSe<cnum>:MIXer:OUTPut:FREQuency:MODE 

混频器输出起始频率 :SENSe<cnum>:MIXer:OUTPut:FREQuency:STARt 

混频器输出终止频率 :SENSe<cnum>:MIXer:OUTPut:FREQuency:STOP 

混频器输出固定频率 :SENSe<cnum>:MIXer:OUTPut:FREQuency:FIXed 

混频器输出频率计算方式 :SENSe<cnum>:MIXer:OUTPut:FREQuency:SIDeband 

混频器输入功率 :SENSe<cnum>:MIXer:OUTPut:POWer 

混频器输入功率 :SENSe<cnum>:MIXer:OUTPut:POWer:STARt 

混频器输入功率 :SENSe<cnum>:MIXer:OUTPut:POWer:STOP 

 

3.21.4.2 混频器输出扫描模式 

命令格式 :SENSe<cnum>:MIXer:OUTPut:FREQuency:MODE <type> 

:SENSe<cnum>:MIXer:OUTPut:FREQuency:MODE? 

说  明 设置或获取输出扫描模式。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<type>:={FIXed|SWEPt}，表示输出扫描模式。 

返回类型 枚举 

默认值 SWEPT 

菜单项 扫描 > 混频器测量... > Mixer Frequency > Output 

举例 :SENS:MIX:OUTP:FREQ:MODE FIXED 

:SENSe:MIXer:OUTPut:FREQuency:MODE? 

Return: FIXED 

 



 

 

3.21.4.3 混频器输出起始频率 

命令格式 :SENSe<cnum>:MIXer:OUTPut:FREQuency:STARt <numeric> 

:SENSe<cnum>:MIXer:OUTPut:FREQuency:STARt? 

说明 设置或获取输出起始频率。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<numeric>:表示输出起始频率，可选择 SNA 范围内的任何频率。 

返回类型 浮点型，单位 Hz（赫兹） 

默认值 无 

菜单项 扫描 > 混频器测量... > Mixer Frequency > Output > Start/Stop 

举例 :SENS:MIX:OUTP:FREQ:STAR 100000 

:SENS:MIXer:OUTPut:FREQuency:STARt? 

Return: 100000 

 

3.21.4.4 混频器输出终止频率 

命令格式 :SENSe<cnum>:MIXer:OUTPut:FREQuency:STOP <numeric> 

:SENSe<cnum>:MIXer:OUTPut:FREQuency:STOP? 

说明 设置或获取输出终止频率。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<numeric>:表示输出终止频率，可选择 SNA 范围内的任何频率。 

返回类型 浮点型，单位 Hz（赫兹） 

默认值 无 

菜单项 扫描 > 混频器测量... > Mixer Frequency > Output > Start/Stop 

举例 :SENS:MIX:OUTP:FREQ:STOP 100000 

:SENS:MIXer:OUTPut:FREQuency:STOP? 

Return: 100000 

 

3.21.4.5 混频器输出固定频率 

命令格式 :SENSe<cnum>:MIXer:OUTPut:FREQuency:FIXed <numeric> 

:SENSe<cnum>:MIXer:OUTPut:FREQuency:FIXed? 

说明 设置或获取输出固定频率。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<numeric>:表示输出固定频率，可选择 SNA 范围内的任何频率。 

返回类型 浮点型，单位 Hz（赫兹） 

默认值 无 
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菜单项 扫描 > 混频器测量... > Mixer Frequency > Output > Fixed 

举例 :SENS:MIX:OUTP:FREQ:FIX 100000 

:SENS:MIXer:OUTPut:FREQuency:FIX? 

Return: 100000 

 

3.21.4.6 混频器输出频率计算方式 

命令格式 :SENSe<cnum>:MIXer:OUTPut:FREQuency:SIDeband <type> 

:SENSe<cnum>:MIXer:OUTPut:FREQuency:SIDeband? 

说明 设置或获取输出频率的计算方式，输入与本振的和或差。 

使用该指令将输出频率的计算方式改为 LOW 时，默认输入信号频率>本振信号频

率。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<type>:={LOW|HIGH}，表示输出频率的计算方式。 

返回类型 枚举 

默认值 HIGH 

菜单项 扫描 > 混频器测量... > Mixer Frequency > Output 

举例 :SENS:MIX:OUTP:FREQ:SID HIGH 

:SENSe:MIXer:OUTPut:FREQuency:SIDeband? 

Return: HIGH 

 

3.21.4.7 混频器输出功率 

命令格式 :SENSe<cnum>:MIXer:OUTPut:POWer <numeric> 

:SENSe<cnum>:MIXer:OUTPut:POWer? 

说明 设置或获取输出功率，混频器反向测量时使用，与混频器输入端口功率不耦合时才

能设置，否则与输入端口功率保持一致。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<numeric>:表示输出功率电平值，其范围是-55dBm~20dBm。 

返回类型 浮点型，单位 dBm 

默认值 无 

菜单项 扫描 > 混频器测量... > Power > DUT Output Port > Power Level 

举例 :SENS:MIX:OUTP:POW 5 

:SENS:MIXer:OUTPut:POWer? 

Return: 5 

 



 

 

3.21.4.8 混频器输出起始功率 

命令格式 :SENSe<cnum>:MIXer:OUTPut:POWer:STARt <numeric> 

:SENSe<cnum>:MIXer:OUTPut:POWer:STARt? 

说明 设置或获取输出起始功率，混频器反向测量时使用，只有在功率扫描模式下才有

效，与混频器输入端口功率不耦合时才能设置，否则与输入端口起始功率保持一

致。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<numeric>:表示输出起始功率电平值，其范围是-55dBm~20dBm。 

返回类型 浮点型，单位 dBm 

默认值 无 

菜单项 扫描 > 混频器测量... > Power > DUT Output Port Power Sweep> Start Power  

举例 :SENS:MIX:OUTP:POW:STAR 5 

:SENS:MIXer:OUTPut:POWer:STARt? 

Return: 5 

 

3.21.4.9 混频器输出终止功率 

命令格式 :SENSe<cnum>:MIXer:OUTPut:POWer:STOP<numeric> 

:SENSe<cnum>:MIXer:OUTPut:POWer:STOP? 

说明 设置或获取输出终止功率，混频器反向测量时使用，只有在功率扫描模式下才有

效，与混频器输入端口功率不耦合时才能设置，否则与输入端口输出功率保持一

致。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<numeric>:表示输出起始功率电平值，其范围是-55dBm~20dBm。 

返回类型 浮点型，单位 dBm 

默认值 无 

菜单项 扫描 > 混频器测量... > Power > DUT Output Port Power Sweep> Stop Power  

举例 :SENS:MIX:OUTP:POW:STOP 5 

:SENS:MIXer:OUTPut:POWer:STOP? 

Return: 5 
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3.22 TDR 命令子系统(Option) 

3.22.1 Setup 

3.22.1.1 Basic 

3.22.1.1.1 命令列表 

TDR 启用状态 :CALCulate:TDR:STATe 

复位 TDR 状态 :SYSTem:TDR:PRESet 

被测器件拓扑 :CALCulate:DEVice 

时域激励电压 :CALCulate:ATRaces:TIME:STEP:AMPLitude 

测量 DUT 长度 :SENSe:DLENgth:AUTO:IMMediate 

DUT 长度值 :SENSe:DLENgth:DATA 

 

3.22.1.1.2 TDR 启用状态 

命令格式 :CALCulate:TDR:STATe <bool> 

:CALCulate:TDR:STATe? 

说明 设置或获取通道 TDR 启用状态。 

参数 <bool>:= ON|OFF|1|0 

返回值 Boolean (1=ON,0=OFF) 

默认值 OFF 

菜单项 数学 > TDR > TDR 

举例 :CALC:TDR:STAT ON 

:CALC:TDR:STAT? 

Return: 1 

 

3.22.1.1.3 复位 TDR 状态 

命令格式 :SYSTem:TDR:PRESet 

说明 恢复 TDR 选件至初始状态，校准数据将一并被清除。 

参数 无 

返回值 无 

默认值 无 



 

 

菜单项 设置 > 基础设置 > 复位 

举例 :SYST:TDR:PRES 

 

3.22.1.1.4 被测器件拓扑 

命令格式 :CALCulate:DEVice <type> 

:CALCulate:DEVice? 

说明 设置或获取 DUT 拓扑。 

参数 <type>:={SEND1|SEND2|DIF1|SEND4|DIF2} 

返回值 枚举 

默认值 SEND1 

菜单项 设置 > 基础设置 > DUT 拓扑 

举例 :CALC:DEV SEND2 

:CALC:DEV? 

Return: SEND2 

 

3.22.1.1.5 时域激励电压 

命令格式 :CALCulate:ATRaces:TIME:STEP:AMPLitude <numeric> 

:CALCulate:ATRaces:TIME:STEP:AMPLitude? 

说明 设置或获取当前通道激励电压值。 

参数 <numeric>:表示激励电压值，其范围是 0.001~5。 

返回值 浮点型，单位 V（Voltage） 

默认值 0.2 

菜单项 设置 > 基础设置> 激励幅值 

举例 :CALC:ATR:TIME:STEP:AMPL 0.5 

:CALC:ATR:TIME:STEP:AMPL? 

Return: 0.5 

 

3.22.1.1.6 测量 DUT 长度 

命令格式 :SENSe:DLENgth:AUTO:IMMediate 

说明 自动测量 DUT 长度。 

参数 无 

返回值 无 
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默认值 无 

菜单项 设置 > 基础设置> DUT 长度 > 自动 > 测量 

举例 :SENS:DLEN:AUTO:IMM 

 

3.22.1.1.7 DUT 长度值 

命令格式 :SENSe:DLENgth:DATA <numeric> 

:SENSe:DLENgth:DATA? 

说明 设置或获取 DUT 长度值。 

参数 <numeric>:表示 DUT 长度值。 

返回值 浮点型 

默认值 无 

菜单项 设置 > 基础设置> DUT 长度 

举例 :SENS:DLEN:DATA 6.26e-9 

:SENS:DLEN:DATA? 

Return: 6.26e-09 

 

 

3.22.1.2 Calibration 

3.22.1.2.1 命令列表 

端口延伸校准标准类型 :SENSe:CORRection:EXTension:AUTO:STANdard 

执行端口延伸校准 :SENSe:CORRection:EXTension:AUTO:IMMediate 

执行校准开路测量 :SENSe:CORRection:COLLection:DLComp:OPEN 

执行校准直通测量 :SENSe:CORRection:COLLection:DLComp:THRU 

执行校准负载测量 :SENSe:CORRection:COLLection:DLComp:LOAD 

保存校准数据 :SENSe:CORRection:COLLection:DLComp:SAVE 

 

3.22.1.2.2 端口延伸校准标准类型 

命令格式 :SENSe:CORRection:EXTension:AUTO:STANdard <type> 

:SENSe:CORRection:EXTension:AUTO:STANdard? 

说明 设置或获取端口延伸校准标准类型。 

参数 <type>:={OPEN|SHORt} 

返回值 枚举 



 

 

默认值 OPEN 

菜单项 设置 >基础设置> Deskew > 选项 > 标准类型 

设置 >基础设置> Deskew&Loss > 选项 > 标准类型 

举例 :SENS:CORR:EXT:AUTO:STAN SHOR 

:SENS:CORR:EXT:AUTO:STAN? 

Return: SHOR 

 

3.22.1.2.3 执行端口延伸校准 

命令格式 :SENSe:CORRection:EXTension:AUTO:IMMediate 

说明 立即执行端口延伸校准。 

参数 无 

返回值 无 

默认值 无 

菜单项 设置 > 基础设置> Deskew > Deskew 

举例 :SENS:CORR:EXT:AUTO:STAN SHOR 

:SENS:CORR:EXT:AUTO:IMM 

 

3.22.1.2.4 执行校准开路测量 

命令格式 :SENSe:CORRection:COLLection:DLComp:OPEN 

说明 立即执行 Deskew & Loss 校准流程中的开路测量校准。 

参数 无 

返回值 无 

默认值 无 

菜单项 设置 > 基础设置> Deskew&Loss > 测量 

举例 :SENS:CORR:COLL:DLC:OPEN 

:SENS:CORR:COLL:DLC:SAVE 

 

3.22.1.2.5 执行校准直通测量 

命令格式 :SENSe:CORRection:COLLection:DLComp:THRU 

说明 立即执行 Deskew & Loss 校准流程中的直通测量校准。 

参数 无 
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返回值 无 

默认值 无 

菜单项 设置 > 基础设置> Deskew&Loss > 测量 

举例 :SENS:CORR:COLL:DLC:THRU 

 

3.22.1.2.6 执行校准负载测量 

命令格式 :SENSe:CORRection:COLLection:DLComp:LOAD 

说明 立即执行 Deskew & Loss 校准流程中的负载测量校准。 

参数 无 

返回值 无 

默认值 无 

菜单项 设置 > 基础设置> Deskew&Loss > 负载 x 

举例 :SENS:CORR:COLL:DLC:LOAD 

 

3.22.1.2.7 保存校准数据 

命令格式 :SENSe:CORRection:COLLection:DLComp:SAVE 

说明 保存 Deskew & Loss 校准数据。 

参数 无 

返回值 无 

默认值 无 

菜单项 设置 > 基础设置> Deskew&Loss > 应用 

举例 :SENS:CORR:COLL:DLC:OPEN 

:SENS:CORR:COLL:DLC:THRU 

:SENS:CORR:COLL:DLC:LOAD 

:SENS:CORR:COLL:DLC:SAVE 

 

 

3.22.1.3 More functions 

3.22.1.3.1 命令列表 

系统阻抗 :SENSe:CORRection:RIMPedance 

介电常数 :SENSe:CORRection:DCONstant 



 

 

 

3.22.1.3.2 系统阻抗 

命令格式 :SENSe:CORRection:RIMPedance <numeric> 

:SENSe:CORRection:RIMPedance? 

说明 设置或获取系统阻抗值。 

参数 <numeric>:表示系统阻抗值。 

返回值 浮点型 

默认值 50 

菜单项 设置 > 更多功能 > 系统阻抗 

举例 :SENS:CORR:RIMP 75 

:SENS:CORR:RIMP? 

Return: 75 

 

3.22.1.3.3 介电常数 

命令格式 :SENSe:CORRection:DCONstant <numeric> 

:SENSe:CORRection:DCONstant? 

说明 设置或获取介电常数值。 

参数 <numeric>:表示介电常数值。 

返回值 浮点型 

默认值 1 

菜单项 设置 > 更多功能 > 介电常数  

举例 :SENS:CORR:DCON 2 

:SENS:CORR:DCON? 

Return: 2 

 
3.22.1.4 AvgBW 

3.22.1.4.1 命令列表 

扫描平均启用状态 :TRIGger:AVERage 

 

3.22.1.4.2 扫描平均启用状态 

命令格式 :TRIGger:AVERage <bool> 

:TRIGger:AVERage? 

说明 设置或获取扫描平均启用状态。 

参数 <bool>:= ON|OFF|1|0 
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返回值 Boolean (1=ON,0=OFF) 

默认值 OFF 

菜单项 设置 > 平均 > 平均 

举例 :TRIG:AVER ON 

:TRIG:AVER? 

Return: 1 

 

3.22.1.5 Advanced waveform 

3.22.1.5.1 命令列表 

注入抖动启用状态 :CALCulate:EYE:INPut:JITTer:STATe 

注入抖动类型 :CALCulate:EYE:INPut:JITTer:TYPE 

随机性抖动幅度 :CALCulate:EYE:INPut:JITTer:RANDom:MAGNitude 

周期性抖动频率 :CALCulate:EYE:INPut:JITTer:PERiodic:FREQuency 

周期性抖动幅度 :CALCulate:EYE:INPut:JITTer:PERiodic:MAGNitude 

去嵌入使能状态 :CALCulate:EMBed:STATe 

波形观察位置 :DISPlay:ATRaces:VIEW 

端口去嵌入 S2P 文件名 :CALCulate:EMBed:S2P:PORT<pnum>:DEEMbed:FILename 

端口去嵌入使能状态 :CALCulate:EMBed:S2P:PORT<pnum>:DEEMbed:STATe 

差分端口去嵌入文件名 :CALCulate:EMBed:S4P:DIFF<pnum>:FILename 

差分端口去嵌入使能状态 :CALCulate:EMBed:S4P:DIFF<pnum>:STATe 

预加重启用状态 :CALCulate:EMPHasis:STATe 

预加重跳变前一阶参数 :CALCulate:EMPHasis:CURSor:PRE1 

预加重跳变后一阶参数 :CALCulate:EMPHasis:CURSor:POST1 

预加重跳变后二阶参数 :CALCulate:EMPHasis:CURSor:POST2 

均衡启用状态 :CALCulate:EQUalization:STATe 

均衡器类型 :CALCulate:EQUalization:TYPE 

均衡直流增益 :CALCulate:EQUalization:CTLE:DC 

均衡零点频率 :CALCulate:EQUalization:CTLE:ZERO1 

均衡第一极点频率 :CALCulate:EQUalization:CTLE:POLE1 

均衡第二极点频率 :CALCulate:EQUalization:CTLE:POLE2 



 

 

均衡器文件 :CALCulate:EQUalization:FILename 

 

3.22.1.5.2 注入抖动启用状态 

命令格式 :CALCulate:EYE:INPut:JITTer:STATe <bool> 

:CALCulate:EYE:INPut:JITTer:STATe? 

说明 设置或获取抖动注入启用状态。 

参数 <bool>:= ON|OFF|1|0 

返回值 Boolean (1=ON,0=OFF) 

默认值 OFF 

菜单项 眼图 > 高级波形 > 抖动 > 启用 

举例 :CALC:EYE:INP:JITT:STAT ON 

:CALC:EYE:INP:JITT:STAT? 

Return: 1 

 

3.22.1.5.3 注入抖动类型 

命令格式 :CALCulate:EYE:INPut:JITTer:TYPE <type> 

:CALCulate:EYE:INPut:JITTer:TYPE? 

说明 设置或获取注入抖动类型。 

参数 <type>:={RANDom|PERiodic} 

返回值 枚举 

默认值 PERiodic 

菜单项 眼图 > 高级波形 > 抖动 > 类型> Random/Periodic 

举例 :CALC:EYE:INP:JITT:TYPE RAND 

:CALC:EYE:INP:JITT:TYPE? 

Return: RAND 

 

3.22.1.5.4 随机性抖动幅度 

命令格式 :CALCulate:EYE:INPut:JITTer:RANDom:MAGNitude <numeric> 

:CALCulate:EYE:INPut:JITTer:RANDom:MAGNitude? 

说明 设置或获取注入随机性抖动幅度值(均方根值)； 

参数单位为 UI(输入序列时钟周期) 

参数 <numeric>:表示随机性抖动幅度值(均方根值)，其范围是 0~0.25。 

返回值 浮点型 
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默认值 0 

菜单项 眼图 > 高级波形 > 抖动 > 随机性抖动 > 幅值 

举例 :CALC:EYE:INP:JITT:RAND:MAGN 0.2 

:CALC:EYE:INP:JITT:RAND:MAGN? 

Return: 0.2 

 

3.22.1.5.5 周期性抖动频率 

命令格式 :CALCulate:EYE:INPut:JITTer:PERiodic:FREQuency <numeric> 

:CALCulate:EYE:INPut:JITTer:PERiodic:FREQuency? 

说  明 设置或获取注入周期性抖动频率值。 

参数 <numeric>:表示周期性抖动频率值，其范围是 0~2MHz。 

返回值 浮点型，单位 Hz 

默认值 500kHz 

菜单项 眼图 > 高级波形 > 抖动 > 周期性抖动 > 频率 

举例 :CALC:EYE:INP:JITT:PER:FREQ 10E3 

:CALC:EYE:INP:JITT:PER:FREQ? 

Return: 10000 

 

3.22.1.5.6 周期性抖动幅度 

命令格式 :CALCulate:EYE:INPut:JITTer:PERiodic:MAGNitude <numeric> 

:CALCulate:EYE:INPut:JITTer:PERiodic:MAGNitude? 

说明 设置或获取注入周期性抖动幅度值(峰峰值)； 

参数单位为 UI(输入序列时钟周期) 

参数 <numeric>:表示周期性抖动幅度值(峰峰值)，其范围是 0~1。 

返回值 浮点型 

默认值 0 

菜单项 眼图 > 高级波形 > 抖动 > 周期性抖动 > 幅值 

举例 :CALC:EYE:INP:JITT:PER:MAGN 0.2 

:CALC:EYE:INP:JITT:PER:MAGN? 

Return: 0.2 

 

3.22.1.5.7 去嵌入使能状态 

命令格式 :CALCulate:EMBed:STATe <bool> 

:CALCulate:EMBed:STATe? 



 

 

说明 设置或获取去嵌入使能状态。 

参数 <bool>:= ON|OFF|1|0 

返回值 Boolean (1=ON,0=OFF) 

默认值 OFF 

菜单项 设置 > 高级波形 > 去嵌 > 使能 

举例 :CALC:EMB:STAT ON 

:CALC:EMB:STAT? 

Return: 1 

 

3.22.1.5.8 波形观察位置 

命令格式 :DISPlay:ATRaces:VIEW <type> 

:DISPlay:ATRaces:VIEW? 

说明 设置或获取当前通道传输波形的取样位置,可显示输出端激励波形及接收端响应波

形。 

参数 <type>:={STIMulus|RESPonse} 

返回值 枚举 

默认值 RESPonse 

菜单项 设置 > 高级波形 > 预加重/均衡 > 观察点 

举例 :DISP:ATR:VIEW STIMulus 

:DISP:ATR:VIEW? 

Return: STIM 

 

3.22.1.5.9 端口去嵌入 S2P 文件名 

命令格式 :CALCulate:EMBed:S2P:PORT<pnum>:DEEMbed:FILename <string> 

:CALCulate:EMBed:S2P:PORT<pnum>:DEEMbed:FILename? 

说明 设置或获取端口去嵌 S2P 文件名。 

参数 <pnum>:={[1]|2|3|4}，表示端口号。 

<string>:表示 S2P 文件名。 

返回值 字符串 

默认值 无 

菜单项 设置 > 高级波形 > 去嵌 > 加载 

举例 :CALC:EMB:S2P:PORT1:DEEM:FIL "local/file.s2p" 

:CALC:EMB:S2P:PORT1:DEEM:FIL? 
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Return: local/file.s2p 

 

3.22.1.5.10 端口去嵌入使能状态 

命令格式 :CALCulate:EMBed:S2P:PORT<pnum>:DEEMbed:STATe <bool> 

:CALCulate:EMBed:S2P:PORT<pnum>:DEEMbed:STATe? 

说明 设置或获取端口去嵌入使能状态。 

参数 
<pnum>:={[1]|2|3|4}，表示端口号。 

<bool>:= ON|OFF|1|0 

返回值 Boolean (1=ON,0=OFF) 

默认值 OFF 

菜单项 设置 > 高级波形 > 去嵌 > 选择端口 > 使能 

举例 :CALC:EMB:S2P:PORT1:DEEM:STAT ON 

:CALC:EMB:S2P:PORT1:DEEM:STAT? 

Return: 1 

 

3.22.1.5.11 差分端口去嵌入文件名 

命令格式 :CALCulate:EMBed:S4P:DIFF<pnum>:FILename <string> 

:CALCulate:EMBed:S4P:DIFF<pnum>:FILename? 

说明 设置或获取差分端口去嵌文件名。 

参数 <pnum>:={[1]|2}，表示差分端口号。 

<string>:表示差分端口去嵌文件名。 

返回值 字符串 

默认值 无 

菜单项 设置 > 高级波形 > 去嵌 > 加载 

举例 :CALC:EMB:S4P:DIFF1:FIL "local/file.s4p" 

:CALC:EMB:S4P:DIFF1:FIL? 

Return: local/file.s4p 

 

3.22.1.5.12 差分端口去嵌入使能状态 

命令格式 :CALCulate:EMBed:S4P:DIFF<pnum>:STATe <bool> 

:CALCulate:EMBed:S4P:DIFF<pnum>:STATe? 

说明 设置或获取差分端口去嵌入使能状态。 

参数 <pnum>:={[1]|2}，表示差分端口号。 

<bool>:= ON|OFF|1|0 



 

 

返回值 Boolean (1=ON,0=OFF) 

默认值 OFF 

菜单项 设置 > 高级波形 > 去嵌 > 选择端口 > 使能 

举例 :CALC:EMB:S4P:DIFF1:STAT ON 

:CALC:EMB:S4P:DIFF1:STAT? 

Return: 1 

 

3.22.1.5.13 预加重启用状态 

命令格式 :CALCulate:EMPHasis:STATe <bool> 

:CALCulate:EMPHasis:STATe? 

说明 设置或获取预加重启用状态。 

参数 <bool>:= ON|OFF|1|0 

返回值 Boolean (1=ON,0=OFF) 

默认值 OFF 

菜单项 设置 > 高级波形 > 预加重 > 启用 

举例 :CALC:EMPH:STAT ON 

:CALC:EMPH:STAT? 

Return: 1 

 

3.22.1.5.14 预加重跳变前一阶参数 

命令格式 :CALCulate:EMPHasis:CURSor:PRE1 <numeric> 

:CALCulate:EMPHasis:CURSor:PRE1? 

说明 设置或获取预加重跳变前第 1比特幅度参数。 

参数 <numeric>:表示幅度参数，其范围是-20~20 dB。 

返回值 浮点型，单位 dB 

默认值 0 dB 

菜单项 设置 > 高级波形 > 预加重 > Pre Cursor 

举例 :CALC:EMPH:CURS:PRE1 3 

:CALC:EMPH:CURS:PRE1? 

Return: 3 

 

3.22.1.5.15 预加重跳变后一阶参数 

命令格式 :CALCulate:EMPHasis:CURSor:POST1 <numeric> 

:CALCulate:EMPHasis:CURSor:POST1? 



 

360                                                                                                                   矢量网络分析仪编程手册 

说明 设置或获取预加重跳变后第 1比特幅度参数。 

参数 <numeric>:表示幅度参数，其范围是-20~20 dB。 

返回值 浮点型，单位 dB 

默认值 -3.5 dB 

菜单项 设置 > 高级波形 > 预加重 > Post 1 Cursor 

举例 :CALC:EMPH:CURS:POST1 3 

:CALC:EMPH:CURS:POST1? 

Return: 3 

3.22.1.5.16 预加重跳变后二阶参数 

命令格式 :CALCulate:EMPHasis:CURSor:POST2 <numeric> 

:CALCulate:EMPHasis:CURSor:POST2? 

说明 设置或获取预加重跳变后第 2比特幅度参数。 

参数 <numeric>:表示幅度参数，其范围是-20~20 dB。 

返回值 浮点型，单位 dB 

默认值 0 dB 

菜单项 设置 > 高级波形 > 预加重 > Post 2 Cursor 

举例 :CALC:EMPH:CURS:POST2 3 

:CALC:EMPH:CURS:POST2? 

Return: 3 

 

3.22.1.5.17 均衡启用状态 

命令格式 :CALCulate:EQUalization:STATe <bool> 

:CALCulate:EQUalization:STATe? 

说明 设置或获取均衡器启用状态。 

参数 <bool>:= ON|OFF|1|0 

返回值 Boolean (1=ON,0=OFF) 

默认值 OFF 

菜单项 设置 > 高级波形 > 均衡 > 启用 

举例 :CALC:EQU:STAT ON 

:CALC:EQU:STAT? 

Return: 1 

 



 

 

3.22.1.5.18 均衡器类型 

命令格式 :CALCulate:EQUalization:TYPE <type> 

:CALCulate:EQUalization:TYPE? 

说明 设置或获取均衡器类型。 

参数 <type>:={EQUation|USER} 

返回值 字符串 

默认值 EQUation 

菜单项 设置 > 高级波形 > 均衡 > 类型 

举例 :CALC:EQU:TYPE USER 

:CALC:EQU:TYPE? 

Return: USER 

 

3.22.1.5.19 均衡直流增益 

命令格式 :CALCulate:EQUalization:CTLE:DC <numeric> 

:CALCulate:EQUalization:CTLE:DC? 

说明 设置或获取均衡器直流增益值。 

参数 <numeric>:表示直流增益值，其范围是 0~10。 

返回值 浮点型 

默认值 0.667 

菜单项 设置 > 高级波形 > 均衡 > 直流增益 

举例 :CALC:EQU:CTLE:DC 0.5 

:CALC:EQU:CTLE:DC? 

Return: 0.5 

 

3.22.1.5.20 均衡零点频率 

命令格式 :CALCulate:EQUalization:CTLE:ZERO1 <numeric> 

:CALCulate:EQUalization:CTLE:ZERO1? 

说明 设置或获取均衡器零点频率值。 

参数 <numeric>:表示频率值，其范围是 0~20GHz。 

返回值 浮点型，单位 Hz 

默认值 650MHz 

菜单项 设置 > 高级波形 > 均衡 > Zero Freq 

举例 :CALC:EQU:CTLE:ZERO1 7.5E8 
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:CALC:EQU:CTLE:ZERO1? 

Return: 750000000 

 

3.22.1.5.21 均衡第一极点频率 

命令格式 :CALCulate:EQUalization:CTLE:POLE1 <numeric> 

:CALCulate:EQUalization:CTLE:POLE1? 

说明 设置或获取均衡器第一个极点频率值。 

参数 <numeric>:表示频率值，其范围是 0~20GHz。 

返回值 浮点型，单位 Hz 

默认值 1.95GHz 

菜单项 设置 > 高级波形 > 均衡 > Pole 1 Freq 

举例 :CALC:EQU:CTLE:POLE1 2.5E9 

:CALC:EQU:CTLE:POLE1? 

Return: 2500000000 

 

3.22.1.5.22 均衡第二极点频率 

命令格式 :CALCulate:EQUalization:CTLE:POLE2 <numeric> 

:CALCulate:EQUalization:CTLE:POLE2? 

说明 设置或获取均衡器第二个极点频率值。 

参数 <numeric>:表示频率值，其范围是 0~20GHz。 

返回值 浮点型，单位 Hz 

默认值 5GHz 

菜单项 设置 > 高级波形 > 均衡 > Pole 2 Freq 

举例 :CALC:EQU:CTLE:POLE2 3E9 

:CALC:EQU:CTLE:POLE2? 

Return: 3000000000 

 

3.22.1.5.23 均衡器文件 

命令格式 :CALCulate:EQUalization:FILename <string> 

:CALCulate:EQUalization:FILename? 

说明 设置或获取指定均衡器特性的用户文件名。 

参数 <string>:表示用户文件名。 

返回值 字符串 



 

 

默认值 无 

菜单项 设置 > 高级波形 > 均衡 > 文件 > 加载 

举例 :CALC:EQU:FIL "local/equalizer.csv" 

:CALC:EQU:FIL? 

Return: local/equalizer.csv 

 

3.22.1.6 Hot TDR 

3.22.1.6.1 命令列表 

启用 Hot TDR 模式 :SENSe:SPURious:AVOid:IMMediate 

查询 Hot TDR 状态 :SENSe:SPURious:STATe? 

干扰数据率 :SENSe:SPURious:INPut:DRATe 

查询干扰状态 :SENSe:SPURious:AVOid:STATe? 

 

3.22.1.6.2 启用 Hot TDR 模式 

命令格式 :SENSe:SPURious:AVOid:IMMediate 

说明 立即搜寻排除干扰信号的频率设置，以启用 Hot TDR 模式。 

参数 无 

返回值 无 

默认值 无 

菜单项 设置 > Hot TDR > 排除干扰 

举例 :SENS:SPUR:AVO:IMM 

 

3.22.1.6.3 查询 Hot TDR 状态 

命令格式 :SENSe:SPURious:STATe? 

说明 获取 Hot TDR 模式启用状态。 

打开 Hot TDR 模式用:SENSe:SPURious:AVOid:IMMediate 命令，关闭 Hot TDR

模式用:SYSTem:PRESet 命令。 

参数 无 

返回值 布尔型 

默认值 OFF 

菜单项 无 
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举例 :SENS:SPUR:STAT? 

 

3.22.1.6.4 干扰数据率 

命令格式 :SENSe:SPURious:INPut:DRATe <numeric> 

:SENSe:SPURious:INPut:DRATe? 

说明 设置或获取 Hot TDR 干扰信号数据率。 

参数 <numeric>:表示干扰信号数据率，其范围是 20Mb/s~ 2.4Gb/s。 

返回值 浮点型，单位 b/s 

默认值 1Gb/s 

菜单项 设置 > Hot TDR > 数据率 

举例 :SENS:SPUR:INP:DRAT 2e9 

:SENS:SPUR:INP:DRAT? 

Return: 2000000000 

 

3.22.1.6.5 查询干扰状态 

命令格式 :SENSe:SPURious:AVOid:STATe? 

说明 查询排除干扰扫描是否发现干扰信号。 

当执行:SENS:SPURious:AVOid:IMMediate 成功时， 

:SENSe:SPURious:AVOid:STATe?查询为 1（ON）， 

当执行:SENS:SPURious:AVOid:IMMediate 但没有找到干扰时， 

:SENSe:SPURious:AVOid:STATe?查询为 0（OFF）。 

参数 无 

返回值 布尔型 

默认值 OFF 

菜单项 无 

举例 :SENS:SPUR:AVO:STAT? 

 



 

 

3.22.2 TDR/TDT 

3.22.2.1 Parameters 

3.22.2.1.1 命令列表 

迹线数据格式 :CALCulate:TRACe<tnum>:FORMat 

时域激励类型 :CALCulate:TRACe<tnum>:TIME:STIMulus 

时域激励冲激宽度 :CALCulate:TRACe<tnum>:TIME:IMPulse:WIDTh 

时域激励上升时间类型 :CALCulate:TRACe<tnum>:TIME:STEP:RTIMe:THReshold 

时域激励上升时间 :CALCulate:TRACe<tnum>:TIME:STEP:RTIMe:DATA 

失配掩蔽补偿启用状态 :CALCulate:TRACe<tnum>:CONVersion:PEELing:STATe 

 

3.22.2.1.2 迹线数据格式 

命令格式 :CALCulate:TRACe<tnum>:FORMat <type> 

:CALCulate:TRACe<tnum>:FORMat? 

说明 设置或获取迹线数据格式。 

参数 <tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

<type>:={MLOGarithmic|MLINear|PHASe|GDELay|SCOMplex|POLar|SWR 

|REAL|IMAGinary|UPHase|PPHase|ISMITh|TLOGarithmic|TLINear|TREAL| 
IMPedance|VOLT} 

返回值 枚举 

默认值 因选择的迹线而异 

菜单项 TDR/TDT > 测量参数 > 数据格式 

举例 :CALC:TRAC1:FORM VOLT 

:CALC:TRAC1:FORM? 

 

Return: VOLT 

 

3.22.2.1.3 时域激励类型 

命令格式 :CALCulate:TRACe<tnum>:TIME:STIMulus <type> 

:CALCulate:TRACe<tnum>:TIME:STIMulus? 

说明 设置或获取 TDR 时域变换激励类型。 

参数 
<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

<type>:={LPSTep|LPIMpulse} 

返回值 枚举 
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默认值 LPSTep 

菜单项 TDR/TDT > 测量参数 > 激励 

举例 :CALC:TRAC1:TIME:STIM LPIMpulse 

:CALC:TRAC1:TIME:STIM? 

Return: LPIM 

 

3.22.2.1.4 时域激励冲激宽度 

命令格式 :CALCulate:TRACe<tnum>:TIME:IMPulse:WIDTh <numeric> 

:CALCulate:TRACe<tnum>:TIME:IMPulse:WIDTh? 

说明 设置或获取 TDR 时域冲激响应变换的激励冲激宽度，它将被用于计算时域变换时采

用的 Kaiser 窗函数。 

参数 
<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

<numeric>:表示激励冲激宽度。 

返回值 浮点型，单位 s（秒） 

默认值 无 

菜单项 TDR/TDT > 测量参数 > 冲激宽度 

举例 :CALC:TRAC1:TIME:IMP:WIDT 4.7E-11 

:CALC:TRAC1:TIME:IMP:WIDT? 

Return: 7.09810588235294e-11 

 

3.22.2.1.5 时域激励上升时间类型 

命令格式 :CALCulate:TRACe<tnum>:TIME:STEP:RTIMe:THReshold <type> 

:CALCulate:TRACe<tnum>:TIME:STEP:RTIMe:THReshold? 

说明 设置或获取 TDR 时域阶跃响应变换的激励上升时间类型。 

参数 
<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

<type>:={T1_9|T2_8} 

返回值 枚举 

默认值 T1_9 

菜单项 TDR/TDT > 测量参数 > 上升时间 

举例 :CALC:TRAC1:TIME:STEP:RTIM:THR T2_8 

:CALC:TRAC1:TIME:STEP:RTIM:THR? 

Return: T2_8 

 



 

 

3.22.2.1.6 时域激励上升时间 

命令格式 :CALCulate:TRACe<tnum>:TIME:STEP:RTIMe:DATA <numeric> 

:CALCulate:TRACe<tnum>:TIME:STEP:RTIMe:DATA? 

说明 设置或获取 TDR 时域阶跃响应变换的激励上升时间，它将被用于计算时域变换时采

用的 Kaiser 窗函数。 

参数 <tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

<numeric>:表示激励上升时间。 

返回值 浮点型，单位 s（秒） 

默认值 无 

菜单项 TDR/TDT > 测量参数 > 上升时间 

举例 :CALC:TRAC1:TIME:STEP:RTIM:DATA 4.7E-11 

:CALC:TRAC1:TIME:STEP:RTIM:DATA? 

Return: 5.24995058823529e-11 

3.22.2.1.7 失配掩蔽补偿启用状态 

命令格式 :CALCulate:TRACe<tnum>:CONVersion:PEELing:STATe <bool> 

:CALCulate:TRACe<tnum>:CONVersion:PEELing:STATe? 

说明 设置或获取失配掩蔽补偿模式启用状态。 

参数 <tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

<bool>:= ON|OFF|1|0 

返回值 Boolean (1=ON,0=OFF) 

默认值 OFF 

菜单项 TDR/TDT > 测量参数 > 掩蔽补偿 

举例 :CALC:TRAC1:CONV:PEEL:STAT ON 

:CALC:TRAC1:CONV:PEEL:STAT? 

Return: 1 

 
3.22.2.2 Scale 

3.22.2.2.1 命令列表 

所有迹线自动缩放 :DISPlay:ATRaces:SCALe:AUTO 

迹线水平参考位置 :DISPlay:ATRaces:SCALe:RPOSition 

迹线横坐标刻度值 :DISPlay:TRACe<tnum>:X:SCALe:PDIVision 

迹线横坐标参考值 :DISPlay:TRACe<tnum>:X:SCALe:RLEVel 

迹线横坐标自动配置 :DISPlay:TRACe<tnum>:X:SCALe:AUTO 
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迹线纵坐标刻度值 :DISPlay:TRACe<tnum>:Y:SCALe:PDIVision 

迹线纵坐标参考值 :DISPlay:TRACe<tnum>:Y:SCALe:RLEVel 

迹线纵坐标自动配置 :DISPlay:TRACe<tnum>:Y:SCALe:AUTO 

时域耦合状态 :CALCulate:ATRaces:TIME:COUPle 

 

3.22.2.2.2 所有迹线自动缩放 

命令格式 :DISPlay:ATRaces:SCALe:AUTO 

说明 为当前通道所有迹线自动配置参考值及刻度值。 

参数 无 

返回值 无 

默认值 无 

菜单项 TDR/TDT > 自动缩放 > 所有迹线 

举例 :DISP:ATR:SCAL:AUTO 

 

3.22.2.2.3 迹线水平参考位置 

命令格式 :DISPlay:ATRaces:SCALe:RPOSition <type> 

:DISPlay:ATRaces:SCALe:RPOSition? 

说明 设置或获取横坐标参考位置。 

参数 <type>:={LEFT|CENTer} 

返回值 枚举 

默认值 LEFT 

菜单项 TDR/TDT > 横坐标 > 参考位置按钮 

举例 :DISP:ATR:SCAL:RPOSition CENT 

:DISP:ATR:SCAL:RPOSition? 

Return: CENT 

 

3.22.2.2.4 迹线横坐标刻度值 

命令格式 :DISPlay:TRACe<tnum>:X:SCALe:PDIVision <numeric> 

:DISPlay:TRACe<tnum>:X:SCALe:PDIVision? 

说明 设置或获取迹线横坐标刻度值。 

参数 <tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 



 

 

<numeric>:表示横坐标刻度值。 

返回值 浮点型，单位 s（秒） 

默认值 无 

菜单项 TDR/TDT > 水平 > 刻度值 

举例 :DISP:TRAC1:X:SCAL:PDIV 1E-9 

:DISP:TRAC1:X:SCAL:PDIV? 

Return: 1e-09 

 

3.22.2.2.5 迹线横坐标参考值 

命令格式 :DISPlay:TRACe<tnum>:X:SCALe:RLEVel <numeric> 

:DISPlay:TRACe<tnum>:X:SCALe:RLEVel? 

说明 设置或获取迹线横坐标参考值。 

参数 <tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

<numeric>:表示横坐标参考值。 

返回值 浮点型 

默认值 无 

菜单项 TDR/TDT > 水平 > 参考值 

举例 :DISP:TRAC1:X:SCAL:RLEV 2E-8 

:DISP:TRAC1:X:SCAL:RLEV? 

Return: 2e-08 

 

3.22.2.2.6 迹线横坐标自动配置 

命令格式 :DISPlay:TRACe<tnum>:X:SCALe:AUTO 

说明 为迹线自动配置横坐标参考值和刻度值。 

参数 <tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

返回值 无 

默认值 无 

菜单项 TDR/TDT > 自动缩放 > X 

举例 :DISP:TRAC1:X:SCAL:AUTO 

 

3.22.2.2.7 迹线纵坐标刻度值 

命令格式 :DISPlay:TRACe<tnum>:Y:SCALe:PDIVision <numeric> 

:DISPlay:TRACe<tnum>:Y:SCALe:PDIVision? 
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说明 设置或获取迹线纵坐标刻度值。 

参数 
<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

<numeric>:表示纵坐标刻度值。 

返回值 浮点型 

默认值 无 

菜单项 TDR/TDT > 垂直 > 刻度值 

举例 :DISP:TRAC1:Y:SCAL:PDIV 10 

:DISP:TRAC1:Y:SCAL:PDIV? 

Return: 10 

 

3.22.2.2.8 迹线纵坐标参考值 

命令格式 :DISPlay:TRACe<tnum>:Y:SCALe:RLEVel <numeric> 

:DISPlay:TRACe<tnum>:Y:SCALe:RLEVel? 

说明 设置或获取迹线纵坐标参考值。 

参数 <tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

<numeric>:表示纵坐标参考值。 

返回值 浮点型 

默认值 无 

菜单项 TDR/TDT > 垂直> 参考值 

举例 :DISP:TRAC1:Y:SCAL:RLEV 20 

:DISP:TRAC1:Y:SCAL:RLEV? 

Return: 20 

 

3.22.2.2.9 迹线纵坐标自动配置 

命令格式 :DISPlay:TRACe<tnum>:Y:SCALe:AUTO 

说明 为迹线自动配置纵坐标参考值和刻度值。 

参数 <tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

返回值 无 

默认值 无 

菜单项 TDR/TDT > 自动缩放 > Y 

举例 :DISP:TRAC1:Y:SCAL:AUTO 

 



 

 

3.22.2.2.10 时域耦合状态 

命令格式 :CALCulate:ATRaces:TIME:COUPle <bool> 

:CALCulate:ATRaces:TIME:COUPle? 

说明 设置或获取迹线时域耦合的状态。 

参数 <bool>:= ON|OFF|1|0 

返回值 Boolean (1=ON,0=OFF) 

默认值 ON 

菜单项 TDR/TDT > 迹线控制 > 耦合 > 时域 

举例 :CALC:ATR:TIME:COUP OFF 

:CALC:ATR:TIME:COUP? 

Return: 0 

 
3.22.2.3 Marker 

3.22.2.3.1 命令列表 

选择激活光标 :CALCulate:TRACe<tnum>:AMARkers:ACTive 

参考光标启用状态 :CALCulate:TRACe<tnum>:MARKer<mnum>:REFerence:STATe 

光标耦合状态 :CALCulate:ATRaces:MARKer:COUPle 

 

3.22.2.3.2 选择激活光标 

命令格式 :CALCulate:TRACe<tnum>:AMARkers:ACTive <numeric> 

:CALCulate:TRACe<tnum>:AMARkers:ACTive? 

说明 设置或获取当前活动光标。 

参数 <tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

<numeric>:表示当前活动光标编号。 

返回值 整型 

默认值 无 

菜单项 TDR/TDT > Marker 

举例 :CALC:TRAC1:AMAR:ACT 3 

:CALC:TRAC1:AMAR:ACT? 

Return: 3 

 

3.22.2.3.3 参考光标启用状态 

命令格式 :CALCulate:TRACe<tnum>:MARKer<mnum>:REFerence:STATe <bool> 

:CALCulate:TRACe<tnum>:MARKer<mnum>:REFerence:STATe? 
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说明 设置或获取迹线上参考光标启用状态。 

参数 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

<mnum>:={[1]-10}，表示光标编号，如果未指定，则<mnum>默认设置 1。 

<bool>:= ON|OFF|1|0 

返回值 Boolean (1=ON,0=OFF) 

默认值 OFF 

菜单项 TDR/TDT > 光标 > 参考光标 

举例 :CALC:TRAC1:MARK1:REF:STAT ON 

:CALC:TRAC1:MARK1:REF:STAT? 

 

Return: 1 

 

3.22.2.3.4 光标耦合状态 

命令格式 :CALCulate:ATRaces:MARKer:COUPle <bool> 

:CALCulate:ATRaces:MARKer:COUPle? 

说明 设置或获取迹线光标耦合的状态。 

参数 <bool>:= ON|OFF|1|0 

返回值 Boolean (1=ON,0=OFF) 

默认值 ON 

菜单项 TDR/TDT > 迹线控制 > 耦合 > 光标 

举例 :CALC:ATR:MARK:COUP OFF 

:CALC:ATR:MARK:COUP? 

Return: 0 

 
3.22.2.4 Search 

3.22.2.4.1 命令列表 

上升时间搜索类型 :CALCulate:TRACe<tnum>:TTIMe:THReshold 

上升时间搜索启用状态 :CALCulate:TRACe<tnum>:TTIMe:STATe 

查询上升时间搜索结果 :CALCulate:TRACe<tnum>:TTIMe:DATA? 

查询上升时间差值搜索结果 :CALCulate:TRACe<tnum>:DTIMe:DATA? 

上升时间差搜索目标位置 :CALCulate:TRACe<tnum>:DTIMe:POSition 

上升时间差搜索启用状态 :CALCulate:TRACe<tnum>:DTIMe:STATe 

上升时间差搜索对比迹线 :CALCulate:TRACe<tnum>:DTIMe:TARGet 



 

 

 

3.22.2.4.2 上升时间搜索类型 

命令格式 :CALCulate:TRACe<tnum>:TTIMe:THReshold <type> 

:CALCulate:TRACe<tnum>:TTIMe:THReshold? 

说明 设置或获取 TDR 上升时间搜索类型。 

参数 <tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

<type>:={T1_9|T2_8} 

返回值 枚举 

默认值 T1_9 

菜单项 TDR/TDT > 光标搜索 > 上升时间(10%-90%)/上升时间(20%-80%) 

举例 :CALC:TRAC1:TTIM:THR T2_8 

:CALC:TRAC1:TTIM:THR? 

 

Return: T2_8 

 

3.22.2.4.3 上升时间搜索启用状态 

命令格式 :CALCulate:TRACe<tnum>:TTIMe:STATe <bool> 

:CALCulate:TRACe<tnum>:TTIMe:STATe? 

说明 设置或获取 TDR 上升时间搜索启用状态。 

参数 <tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

<bool>:= ON|OFF|1|0 

返回值 Boolean (1=ON,0=OFF) 

默认值 OFF 

菜单项 TDR/TDT > 光标搜索 > 上升时间(10%-90%)/上升时间(20%-80%) 

举例 :CALC:TRAC1:TTIM:STAT ON 

:CALC:TRAC1:TTIM:STAT? 

 

Return: 1 

 

3.22.2.4.4 查询上升时间搜索结果 

命令格式 :CALCulate:TRACe<tnum>:TTIMe:DATA? 

说明 获取 TDR 上升时间搜索结果。 

参数 <tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

返回值 浮点型，单位 s（秒） 
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默认值 无 

菜单项 无 

举例 :CALC:TRAC1:TTIM:DATA? 

 

3.22.2.4.5 查询上升时间差值搜索结果 

命令格式 :CALCulate:TRACe<tnum>:DTIMe:DATA? 

说明 获取 TDR 上升时间差值搜索结果。 

参数 <tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

返回值 浮点型，单位 s（秒） 

默认值 无 

菜单项 无 

举例 :CALC:TRAC1:DTIM:DATA? 

 

3.22.2.4.6 上升时间差搜索目标位置 

命令格式 :CALCulate:TRACe<tnum>:DTIMe:POSition <numeric> 

:CALCulate:TRACe<tnum>:DTIMe:POSition? 

说明 设置或获取 TDR 上升时间差值搜索目标位置。 

参数 
<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

<numeric>:表示目标位置，其范围是 0~100。 

返回值 浮点型，单位% 

默认值 50 

菜单项 TDR/TDT > 光标搜索 > 上升时间差... > 目标位置(%) 

举例 :CALC:TRAC1:DTIM:POS 20 

:CALC:TRAC1:DTIM:POS? 

Return: 20 

 

3.22.2.4.7 上升时间差搜索启用状态 

命令格式 :CALCulate:TRACe<tnum>:DTIMe:STATe <bool> 

:CALCulate:TRACe<tnum>:DTIMe:STATe? 

说明 设置或获取 TDR 上升时间差值搜索启用状态。 

参数 <tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

<bool>:= ON|OFF|1|0 



 

 

返回值 Boolean (1=ON,0=OFF) 

默认值 OFF 

菜单项 TDR/TDT > 光标搜索 > 上升时间差... > 启用 

举例 :CALC:TRAC1:DTIM:STAT ON 

:CALC:TRAC1:DTIM:STAT? 

 

Return: 1 

 

3.22.2.4.8 上升时间差搜索对比迹线 

命令格式 :CALCulate:TRACe<tnum>:DTIMe:TARGet <numeric> 

:CALCulate:TRACe<tnum>:DTIMe:TARGet? 

说明 设置或获取 TDR 上升时间差值搜索对比迹线。 

参数 <tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

<numeric>:表示对比迹线编号。 

返回值 整型 

默认值 因选择的迹线而异 

菜单项 TDR/TDT > 光标搜索 > 上升时间差... > 对比 

举例 :CALC:TRAC1:DTIM:TARG 5 

:CALC:TRAC1:DTIM:TARG? 

 

Return: 5 

 
3.22.2.5 Gating 

3.22.2.5.1 命令列表 

时域门控起始位置 :CALCulate:TRACe<tnum>:GATE:STARt 

时域门控终止位置 :CALCulate:TRACe<tnum>:GATE:STOP 

时域门控启用状态 :CALCulate:TRACe<tnum>:GATE:STATe 

时域门控类型 :CALCulate:TRACe<tnum>:GATE:TYPE 

 

3.22.2.5.2 时域门控起始位置 

命令格式 :CALCulate:TRACe<tnum>:GATE:STARt <numeric> 

:CALCulate:TRACe<tnum>:GATE:STARt? 

说明 设置或获取迹线时域门控起始位置值。 

参数 <tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 
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<numeric>:表示起始位置值。 

返回值 浮点型，单位 s（秒） 

默认值 无 

菜单项 TDR/TDT > 门控 > 起始值 

举例 :CALC:TRAC1:GATE:STAR 2E-9 

:CALC:TRAC1:GATE:STAR? 

 

Return: 2e-09 

 

3.22.2.5.3 时域门控终止位置 

命令格式 :CALCulate:TRACe<tnum>:GATE:STOP <numeric> 

:CALCulate:TRACe<tnum>:GATE:STOP? 

说明 设置或获取迹线时域门控终止位置值。 

参数 <tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

<numeric>:表示终止位置值。 

返回值 浮点型，单位 s（秒） 

默认值 无 

菜单项 TDR/TDT > 门控> 终止值 

举例 :CALC:TRAC1:GATE:STOP 6E-9 

:CALC:TRAC1:GATE:STOP? 

 

Return: 6e-09 

 

3.22.2.5.4 时域门控启用状态 

命令格式 :CALCulate:TRACe<tnum>:GATE:STATe <bool> 

:CALCulate:TRACe<tnum>:GATE:STATe? 

说明 设置或获取迹线时域门控启用状态。 

参数 
<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

<bool>:= ON|OFF|1|0 

返回值 Boolean (1=ON,0=OFF) 

默认值 OFF 

菜单项 TDR/TDT > 门控> 启用门控 

举例 :CALC:TRAC1:GATE:STAT ON 

:CALC:TRAC1:GATE:STAT? 



 

 

 

Return: 1 

 

3.22.2.5.5 时域门控类型 

命令格式 :CALCulate:TRACe<tnum>:GATE:TYPE <type> 

:CALCulate:TRACe<tnum>:GATE:TYPE? 

说明 设置或获取迹线时域门控类型。 

参数 
<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

<type>:={BPASs|NOTCh} 

返回值 枚举 

默认值 BPASs 

菜单项 TDR/TDT > 门控> 类型> 带阻/带宽 

举例 :CALC:TRAC1:GATE:TYPE NOTC 

:CALC:TRAC1:GATE:TYPE? 

 

Return: NOTC 

 
3.22.2.6 Memory 

3.22.2.6.1 命令列表 

迹线显示方式 :DISPlay:TRACe<tnum>:DMEMory:TYPE 

 

3.22.2.6.2 迹线显示方式 

命令格式 :DISPlay:TRACe<tnum>:DMEMory:TYPE <type> 

:DISPlay:TRACe<tnum>:DMEMory:TYPE? 

说明 设置或获取数据迹线和内存迹线的显示方式。 

参数 
<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

<type>:={OFF|DATA|MEMory|DMEMory} 

返回值 枚举 

默认值 DATA 

菜单项 TDR/TDT > 数据/内存 > 关闭/数据/内存/数据&内存 

举例 :DISP:TRAC1:DMEM:TYPE DMEMory 

:DISP:TRAC1:DMEM:TYPE? 

Return: DMEM 
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3.22.2.7 Trace Control 

3.22.2.7.1 命令列表 

查询迹线数量 :CALCulate:ATRaces:COUNt? 

选择激活迹线 :CALCulate:ATRaces:ACTive 

迹线测量参数 :CALCulate:TRACe<tnum>:PARameter 

迹线自动配置 :CALCulate:ALLocate 

扫描触发状态 :TRIGger:MODE 

 

3.22.2.7.2 查询迹线数量 

命令格式 :CALCulate:ATRaces:COUNt? 

说明 查询当前通道迹线数量。 

参数 无 

返回值 整型 

默认值 因 DUT 拓扑而异 

菜单项 无 

举例 :CALC:ATR:COUN? 

 

3.22.2.7.3 选择激活迹线 

命令格式 :CALCulate:ATRaces:ACTive <numeric> 

:CALCulate:ATRaces:ACTive? 

说明 设置或获取当前通道活动迹线。 

参数 <numeric>:表示活动迹线编号。 

返回值 整型 

默认值 无 

菜单项 TDR/TDT > 迹线 

举例 :CALC:ATR:ACT 6 

:CALC:ATR:ACT? 

Return: 6 

 

3.22.2.7.4 迹线测量参数 

命令格式 :CALCulate:TRACe<tnum>:PARameter <string> 



 

 

:CALCulate:TRACe<tnum>:PARameter? 

说明 设置或获取迹线测量参数。 

参数 <tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

<string>:Txy|Tddxy|Tdcxy|Tcdxy|Tccxy|Sxy|Sddxy|Sdcxy|Scdxy|Sccxy, 

x=1~4, y=1~4 

返回值 字符串 

默认值 因迹线和 DUT 拓扑而异 

菜单项 TDR/TDT > 测量参数 

举例 :CALC:TRAC2:PAR T11 

:CALC:TRAC2:PAR? 

 

Return: T11 

 

3.22.2.7.5 迹线自动配置 

命令格式 :CALCulate:ALLocate <type> 

说明 为当前通道自动配置迹线及其测量参数、数据格式。 

参数 <type>:={SPARameters|TPARameters|MIXed} 

返回值 无 

默认值 MIXed 

菜单项 TDR/TDT > 迹线控制 > 配置 > 频域/时域/混合 

举例 :CALC:ALL SPAR 

 

3.22.2.7.6 扫描触发状态 

命令格式 :TRIGger:MODE <type> 

:TRIGger:MODE? 

说明 设置或获取扫描触发状态。 

参数 <type>:={HOLD|SINGle|RUN} 

返回值 枚举 

默认值 RUN 

菜单项 TDR/TDT > 连续扫描 / 停止/单次 

举例 :TRIG:MODE HOLD 

:TRIG:MODE? 

Return: HOLD 
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3.22.2.8 DC 

3.22.2.8.1 命令列表 

TDR 自动直流外推模式 :CALCulate:TRACe<tnum>:DCSParam:AUTO 

TDR 自定义直流外推值 :CALCulate:TRACe<tnum>:DCSParam 

TDR 直流外推值配置为手动值 :CALCulate:TRACe<tnum>:DCSParam:EXTRapolate 

 

3.22.2.8.2 TDR 自动直流外推模式 

命令格式 :CALCulate:TRACe<tnum>:DCSParam:AUTO <bool> 

:CALCulate:TRACe<tnum>:DCSParam:AUTO? 

说明 设置或获取所选迹线 TDR 自动直流外推模式。 

参数 
<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

<bool>:= ON|OFF|1|0 

返回类型 Boolean (1=ON,0=OFF) 

默认值 ON 

菜单项 TDR/TDT >DC>Auto Extrapolate 

举例 :CALCulate:TRACe1:DCSParam:AUTO OFF 

:CALCulate:TRACe1:DCSParam:AUTO? 

Return :0 

 

3.22.2.8.3 TDR 自定义直流外推值 

命令格式 :CALCulate:TRACe<tnum>:DCSParam <numeric> 

:CALCulate:TRACe<tnum>:DCSParam? 

说明 设置或获取所选迹线 TDR 自定义直流外推值。 

参数 <tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

<numeric>:表示直流外推值，其范围是-1E15~1E15。 

返回类型 Float 

默认值 1 

菜单项 TDR/TDT >DC> Manual Entry 

举例 :CALCulate:TRACe1:DCSParam 10 

:CALCulate:TRACe1:DCSParam? 

Return:10 



 

 

3.22.2.8.4 TDR 直流外推值配置为手动值 

命令格式 :CALCulate:TRACe<tnum>:DCSParam:EXTRapolate 

说明 设置迹线 TDR 模式下，关闭自动外推,获取最近一次数据的外推计算值,将外推值配置

到手动值。 

参数 <tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

返回类型 无 

默认值 无 

菜单项 TDR/TDT >DC> Extrapolate 

举例 :CALCulate:TRACe1:DCSParam:EXTRapolate 

 

3.22.3 Eye/Mask 

3.22.3.1 Stimulus 

3.22.3.1.1 命令列表 

眼图模式启用状态 :CALCulate:EYE:STATe 

绘制眼图 :CALCulate:EYE:EXECute 

中止绘制眼图 :CALCulate:EYE: ABORt 

眼图输入序列类型 :CALCulate:EYE:INPut:BPATtern:TYPE 

加载用户序列文件 :MMEMory:LOAD:EYE:BPATtern 

眼图输入序列长度 :CALCulate:EYE:INPut:BPATtern:LENGth 

眼图输入序列数据率 :CALCulate:EYE:INPut:DRATe 

输入序列高电平电压 :CALCulate:EYE:INPut:OLEVel 

输入序列低电平电压 :CALCulate:EYE:INPut:ZLEVel 

输入序列上升时间类型 :CALCulate:EYE:INPut:RTIMe:THReshold 

输入序列上升时间 :CALCulate:EYE:INPut:RTIMe:DATA 

眼图统计显示下限 :CALCulate:EYE:INPut:JITTer:DLIMit 

 

3.22.3.1.2 眼图模式启用状态 

命令格式 :CALCulate:EYE:STATe <bool> 

:CALCulate:EYE:STATe? 
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说明 设置或获取眼图模式启用状态。 

参数 <bool>:= ON|OFF|1|0 

返回值 Boolean (1=ON,0=OFF) 

默认值 OFF 

菜单项 无 

举例 :CALC:EYE:STAT OFF 

:CALC:EYE:STAT? 

 

3.22.3.1.3 绘制眼图 

命令格式 :CALCulate:EYE:EXECute 

说明 按当前配置开始绘制眼图。 

参数 无 

返回值 无 

默认值 无 

菜单项 眼图 > 启动 > 绘制 

举例 :CALC:EYE:EXEC 

 

3.22.3.1.4 中止绘制眼图 

命令格式 :CALCulate:EYE:ABORt 

说明 立即中止绘制眼图。 

参数 无 

返回值 无 

默认值 无 

菜单项 眼图 > 启动 > 中止 

举例 :CALC:EYE:ABOR 

 

3.22.3.1.5 眼图输入序列类型 

命令格式 :CALCulate:EYE:INPut:BPATtern:TYPE <type> 

:CALCulate:EYE:INPut:BPATtern:TYPE? 

说明 设置或获取眼图输入序列类型。 



 

 

参数 <type>:={PRBS|K285|USER|STAT} 

返回值 枚举 

默认值 PBRS 

菜单项 眼图 > 激励 > 类型 

举例 :CALC:EYE:INP:BPAT:TYPE K285 

:CALC:EYE:INP:BPAT:TYPE? 

Return: K285 

 

3.22.3.1.6 加载用户序列文件 

命令格式 :MMEMory:LOAD:EYE:BPATtern <string> 

说明 加载用户序列文件。 

参数 <string>:表示用户序列 txt文件。 

返回值 无 

默认值 无 

菜单项 眼图 > 激励 > 用户序列 > 加载 

举例 :MMEM:LOAD:EYE:BPAT "local/userbit.txt" 

 

3.22.3.1.7 眼图输入序列长度 

命令格式 :CALCulate:EYE:INPut:BPATtern:LENGth <numeric> 

:CALCulate:EYE:INPut:BPATtern:LENGth? 

说明 设置或获取眼图输入 PRBS 序列长度； 

参数作为底数 2的指数计算序列长度 

参数 <numeric>:表示 PRBS 序列长度，其范围是 3，5，7，9，11，13，15。 

返回值 离散型 

默认值 7 

菜单项 眼图 > 激励 > 长度 

举例 :CALC:EYE:INP:BPAT:LENG 3 

:CALC:EYE:INP:BPAT:LENG? 

Return: 3 

 

3.22.3.1.8 眼图输入序列数据率 

命令格式 :CALCulate:EYE:INPut:DRATe <numeric> 

:CALCulate:EYE:INPut:DRATe? 
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说明 设置或获取眼图输入序列数据率。 

参数 <numeric>:表示数据率，其范围是 100Mb/s ~ 2.4Gb/s。 

返回值 浮点型，单位 b/s（bits/second） 

默认值 1Gb/s 

菜单项 眼图 > 激励 > 数据率 

举例 :CALC:EYE:INP:DRAT 1.2E9 

:CALC:EYE:INP:DRAT? 

Return: 1200000000 

 

3.22.3.1.9 输入序列高电平电压 

命令格式 :CALCulate:EYE:INPut:OLEVel <numeric> 

:CALCulate:EYE:INPut:OLEVel? 

说明 设置或获取眼图输入序列逻辑 1电平电压值。 

参数 <numeric>:表示电压值，其范围是-5 ~ 5 V。 

返回值 浮点型，单位 V（Voltage） 

默认值 0.2 

菜单项 眼图 > 激励 > 逻辑 1电平 

举例 :CALC:EYE:INP:OLEV -0.2 

:CALC:EYE:INP:OLEV? 

Return: -0.2 

 

3.22.3.1.10 输入序列低电平电压 

命令格式 :CALCulate:EYE:INPut:ZLEVel <numeric> 

:CALCulate:EYE:INPut:ZLEVel? 

说明 设置或获取眼图输入序列逻辑 0电平电压值。 

参数 <numeric>:表示电压值，其范围是-5 ~ 5 V。 

返回值 浮点型，单位 V（Voltage） 

默认值 0 

菜单项 眼图 > 激励 > 逻辑 0电平 

举例 :CALC:EYE:INP:ZLEV 0.5 

:CALC:EYE:INP:ZLEV? 

Return: 0.5 

 



 

 

3.22.3.1.11 输入序列上升时间类型 

命令格式 :CALCulate:EYE:INPut:RTIMe:THReshold <type> 

:CALCulate:EYE:INPut:RTIMe:THReshold? 

说明 设置或获取眼图输入序列的上升时间类型。 

参数 <type>:={T1_9|T2_8} 

返回值 枚举 

默认值 T1_9 

菜单项 眼图 > 激励 > 上升时间 

举例 :CALC:EYE:INP:RTIM:THR T2_8 

:CALC:EYE:INP:RTIM:THR? 

Return: T2_8 

 

3.22.3.1.12 输入序列上升时间 

命令格式 :CALCulate:EYE:INPut:RTIMe:DATA <numeric> 

:CALCulate:EYE:INPut:RTIMe:DATA? 

说明 设置或获取眼图输入序列上升时间值。 

参数 <numeric>:表示上升时间值，其范围因输入数据率而异。 

返回值 浮点数，单位 s（秒） 

默认值 因输入数据率而异 

菜单项 眼图 > 激励 > 上升时间 

举例 :CALC:EYE:INP:RTIM:DATA 90e-12 

:CALC:EYE:INP:RTIM:DATA? 

Return: 9e-11 

 

3.22.3.1.13 眼图统计显示下限 

命令格式 :CALCulate:EYE:INPut:JITTer:DLIMit <numeric> 

:CALCulate:EYE:INPut:JITTer:DLIMit? 

说明 设置或获取统计眼图显示概率下限值。 

参数 <numeric>:表示概率下限值，其范围是 0~1。 

返回值 浮点型 

默认值 1E-8 

菜单项 眼图 > 高级波形 > 抖动 > 显示极限 

举例 :CALC:EYE:INP:JITT:DLIM 10E-10 

:CALC:EYE:INP:JITT:DLIM? 
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Return: 1e-09 

 
3.22.3.2 Result 

3.22.3.2.1 命令列表 

眼图数据显示状态 :CALCulate:EYE:RESults:DISPlay:STATe 

眼图分析上升时间类型 :CALCulate:EYE:RESults:THReshold 

 

3.22.3.2.2 眼图数据显示状态 

命令格式 :CALCulate:EYE:RESults:DISPlay:STATe <bool> 

:CALCulate:EYE:RESults:DISPlay:STATe? 

说明 设置或获取在眼图上标注分析数据显示状态。 

参数 <bool>:= ON|OFF|1|0 

返回值 Boolean (1=ON,0=OFF) 

默认值 ON 

菜单项 眼图 > 结果 > 标注 

举例 :CALC:EYE:RES:DISP:STAT OFF 

:CALC:EYE:RES:DISP:STAT? 

Return: 0 

 

3.22.3.2.3 眼图分析上升时间类型 

命令格式 :CALCulate:EYE:RESults:THReshold <type> 

:CALCulate:EYE:RESults:THReshold? 

说明 设置或获取眼图分析所得上升时间类型。 

参数 <type>:={T1_9|T2_8} 

返回值 枚举 

默认值 T1_9 

菜单项 眼图 > 结果 > 上升时间定义 

举例 :CALC:EYE:RES:THR T2_8 

:CALC:EYE:RES:THR? 

Return: T2_8 

 
3.22.3.3 Scale 

3.22.3.3.1 命令列表 

眼图自动缩放 :DISPlay:EYE:Y:SCALe:AUTO 



 

 

眼图手动设置刻度 :DISPlay:EYE:Y:SCALe:MANual 

眼图刻度值 :DISPlay:EYE:Y:SCALe:PDIVision 

眼图参考值 :DISPlay:EYE:Y:SCALe:RLEVel 

模板测试启用状态 :CALCulate:EYE:MASK:STATe 

查询模板测试结果 :CALCulate:EYE:MASK:FAIL? 

查询眼图分析数据 :CALCulate:EYE:RESults:DATA? 

加载模板文件 :MMEMory:LOAD:EYE:MASK 

 

3.22.3.3.2 眼图自动缩放 

命令格式 :DISPlay:EYE:Y:SCALe:AUTO 

说明 眼图采用自动缩放方式显示。 

参数 无 

返回值 无 

默认值 无 

菜单项 眼图 > 刻度/模板 > 自动缩放 

举例 :DISP:EYE:Y:SCAL:AUTO 

 

3.22.3.3.3 眼图手动设置刻度 

命令格式 :DISPlay:EYE:Y:SCALe:MANual 

说明 眼图采用手动设置的参考值和刻度值显示。 

参数 无 

返回值 无 

默认值 无 

菜单项 眼图 > 刻度/模板 > 手动设置 

举例 :DISP:EYE:Y:SCAL:MAN 

 

3.22.3.3.4 眼图刻度值 

命令格式 :DISPlay:EYE:Y:SCALe:PDIVision <numeric> 

:DISPlay:EYE:Y:SCALe:PDIVision? 

说明 设置或获取眼图手动设置的刻度值。 
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参数 <numeric>:表示刻度值。 

返回值 浮点型，单位 V（Voltage） 

默认值 133mV 

菜单项 眼图 > 刻度/模板 > 刻度 

举例 :DISP:EYE:Y:SCAL:PDIV 300E-03 

:DISP:EYE:Y:SCAL:PDIV? 

Return: 0.3 

 

3.22.3.3.5 眼图参考值 

命令格式 :DISPlay:EYE:Y:SCALe:RLEVel <numeric> 

:DISPlay:EYE:Y:SCALe:RLEVel? 

说明 设置或获取眼图手动设置的参考值。 

参数 <numeric>:表示参考值。 

返回值 浮点型，单位 V（Voltage） 

默认值 0 

菜单项 眼图 > 刻度/模板 > 参考值 

举例 :DISP:EYE:Y:SCAL:RLEV 0.5 

:DISP:EYE:Y:SCAL:RLEV? 

Return: 0.5 

 

3.22.3.3.6 模板测试启用状态 

命令格式 :CALCulate:EYE:MASK:STATe <bool> 

:CALCulate:EYE:MASK:STATe? 

说明 设置或获取眼图模板测试启用状态。 

参数 <bool>:= ON|OFF|1|0 

返回值 Boolean (1=ON,0=OFF) 

默认值 OFF 

菜单项 眼图 > 刻度/模板 > 模板测试 

举例 :CALC:EYE:MASK:STAT ON 

:CALC:EYE:MASK:STAT? 

Return: 1 

 



 

 

3.22.3.3.7 查询模板测试结果 

命令格式 :CALCulate:EYE:MASK:FAIL? 

说明 获取眼图模板测试结果。 

参数 无 

返回值 布尔型 

默认值 无 

菜单项 无 

举例 :CALC:EYE:MASK:FAIL? 

 

3.22.3.3.8 查询眼图分析数据 

命令格式 :CALCulate:EYE:RESults:DATA? 

说明 获取眼图分析数据结果。 

参数 无 

返回值 字符串 

默认值 无 

菜单项 眼图 > 结果 

举例 :CALC:EYE:RES:DATA? 

 

3.22.3.3.9 加载模板文件 

命令格式 :MMEMory:LOAD:EYE:MASK <string> 

说明 从文件中加载眼图测试模板。 

参数 <string>:表示测试模板 msk 文件。 

返回值 无 

默认值 无 

菜单项 眼图 > 刻度/模板 > 模板 > 使用用户定义的模板 > 加载 

举例 :MMEM:LOAD:EYE:MASK "local/usermask.msk" 
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3.23 CAT命令子系统（仅 SHN900A系列机型支持） 

3.23.1 命令列表 

起始频率 :SENSe<cnum>:CAT:FREQuency:STARt 

终止频率 :SENSe<cnum>:CAT:FREQuency:STOP 

起始距离 :CALCulate<cnum>:CAT:TRANsform:DISTance:STARt 

终止距离 :CALCulate<cnum>:CAT:TRANsform:DISTance:STOP 

单位类型 :CALCulate<cnum>:CAT:TRANsform:DISTance:UNIT 

线损 :SENSe<cnum>:CAT:CORRection:LOSS:COAX 

时域激励类型 :CALCulate<cnum>:TRACe<tnum>:CAT:TRANsform:STIMulus:TYPE 

时域带通的窗函数类型 :CALCulate<cnum>:TRACe<tnum>:DTF:TRANsform:WINDow 

Kaiser窗设置 :CALCulate<cnum>:TRACe<tnum>:CAT:WINDow:BETA 

时域门控起始距离 :CALCulate<cnum>:TRACe<tnum>:TDR:GATE:DISTance:STARt 

时域门控终止距离 :CALCulate<cnum>:TRACe<tnum>:TDR:GATE:DISTance:STOP 

 

3.23.2 起始频率 

命令格式 :SENSe<cnum>:CAT:FREQuency:STARt <numeric> 

:SENSe<cnum>:CAT:FREQuency:STARt? 

说明 设置或获取 CAT模式下选择通道的起始频率。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<numeric>:表示起始频率。 

返回类型 浮点型，单位 Hz 

默认值 1MHz 

菜单项 频率/距离 > 起始频率 

举例 :SENSe1:CAT:FREQuency:STARt 100e3 

:SENSe1:CAT:FREQuency:STARt? 

Return: 100000 

 



 

 

3.23.3 终止频率 

命令格式 :SENSe<cnum>:CAT:FREQuency:STOP <numeric> 

:SENSe<cnum>:CAT:FREQuency:STOP? 

说明 设置或获取 CAT模式下选择通道的终止频率。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<numeric>:表示终止频率。 

返回类型 浮点型，单位 Hz 

默认值 200MHz 

菜单项 频率/距离 > 终止频率 

举例 :SENSe1:CAT:FREQuency:STOP 1e9 

:SENSe1:CAT:FREQuency:STOP? 

Return: 1000000000 

 

3.23.4 起始距离 

命令格式 :CALCulate<cnum>:CAT:TRANsform:DISTance:STARt <numeric> 

:CALCulate<cnum>:CAT:TRANsform:DISTance:STARt? 

说明 设置或获取 DTF/TDR 测量的起始距离。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<numeric>:表示起始距离，其范围是 0~最大测量距离。 

返回值 浮点型 

默认值 0 m 

菜单项 频率/距离 > 起始距离 

举例 :CALCulate1:CAT:TRANsform:DISTance:STARt 1.26 

:CALCulate1:CAT:TRANsform:DISTance:STARt? 

Return: 1.26 

 

3.23.5 终止距离 

命令格式 :CALCulate<cnum>:CAT:TRANsform:DISTance:STOP <numeric> 

:CALCulate<cnum>:CAT:TRANsform:DISTance:STOP? 

说明 设置或获取 DTF/TDR 测量的终止距离。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 
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<numeric>:表示终止距离，其范围是 0~最大测量距离。 

返回值 浮点型 

默认值 100 m 

菜单项 频率/距离 > 终止距离 

举例 :CALCulate1:CAT:TRANsform:DISTance:STOP 3.26 

:CALCulate1:CAT:TRANsform:DISTance:STOP? 

Return: 3.26 

 

3.23.6 单位类型 

命令格式 :CALCulate<cnum>:CAT:TRANsform:DISTance:UNIT <type> 

:CALCulate<cnum>:CAT:TRANsform:DISTance:UNIT? 

说明 设置或获取 DTF/TDR 测量距离显示单位。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<type>:={METer|FEET|INCH} 

返回值 枚举 

默认值 METer 

菜单项 频率/距离 > 单位 

举例 :CALCulate1:CAT:TRANsform:DISTance:UNIT FEET 

:CALCulate1:CAT:TRANsform:DISTance:UNIT? 

Return: FEET 

 

3.23.7 线损 

命令格式 :SENSe<cnum>:CAT:CORRection:LOSS:COAX <numeric> 

:SENSe<cnum>:CAT:CORRection:LOSS:COAX? 

说明 设置或获取 DTF/TDR 测量的线损。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<numeric>:表示线损值，单位 dB/m。 

返回值 浮点型，单位 dB/m 

默认值 0dB/m 

菜单项 测量 > 测量设置 > 线损 

举例 :SENSe1:CAT:CORRection:LOSS:COAX 1.5 

:SENSe1:CAT:CORRection:LOSS:COAX? 



 

 

Return: 1.5 

 

3.23.8 时域激励类型 

命令格式 :CALCulate<cnum>:TRACe<tnum>:CAT:TRANsform:STIMulus:TYPE  
<type> 

:CALCulate<cnum>:TRACe<tnum>:CAT:TRANsform:STIMulus:TYPE? 

说明 设置或获取 DTF 测量的激励类型。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

<type>:={BPASs|LPASs} 

返回值 枚举 

默认值 LPASs 

菜单项 测量 > 测量设置 > 激励类型 

举例 :CALCulate1:TRACe1:CAT:TRANsform:STIMulus:TYPE BPASs 

:CALCulate1:TRACe1:CAT:TRANsform:STIMulus:TYPE? 

Return: BPAS 

 
 

3.23.9 时域带通的窗函数类型 

命令格式 :CALCulate<cnum>:TRACe<tnum>:DTF:TRANsform:WINDow <type> 

:CALCulate<cnum>:TRACe<tnum>:DTF:TRANsform:WINDow? 

说明 设置或获取 DTF 测量加窗。 

注：激励为带通模式才能自定义窗类型。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

<type>:={OFF|KAISer|HAMMing} 

返回值 枚举 

默认值 OFF 

菜单项 测量 > Distance to Fault > 测量设置> DTF 窗口 

举例 :CALCulate1:TRACe1:DTF:TRANsform:WINDow HAMMing 

:CALCulate1:TRACe1:DTF:TRANsform:WINDow? 

Return: HAMM 
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3.23.10 Kaiser窗设置 

命令格式 :CALCulate<cnum>:TRACe<tnum>:CAT:WINDow:BETA <numeric> 

:CALCulate<cnum>:TRACe<tnum>:CAT:WINDow:BETA? 

说明 设置 DTF/TDR 测量的 Kaiser 窗 Beta值。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

<numeric>:表示 Kaiser窗 Beta值，其范围是 0~13。 

返回值 浮点型 

默认值 6 

菜单项 测量 > DTF/TDR > 测量设置> Kaiser Beta 

举例 :CALCulate1:TRACe1:CAT:WINDow:BETA 3.4 

:CALCulate1:TRACe1:CAT:WINDow:BETA? 

Return: 3.4 

 

3.23.11 时域门控起始距离 

命令格式 :CALCulate<cnum>:TRACe<tnum>:TDR:GATE:DISTance:STARt <numeric> 

:CALCulate<cnum>:TRACe<tnum>:TDR:GATE:DISTance:STARt? 

说明 设置或获取 TDR 测量的时域功能选通开始距离。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

<numeric>:表示选通开始距离，其范围是 0~最大测量距离。 

返回值 浮点型 

默认值 0 m 

菜单项 测量> TDR> 测量设置 > 时域 > 开始 

举例 :CALCulate1:TRACe1:TDR:GATE:DISTance:STARt 2.0 

:CALCulate1:TRACe1:TDR:GATE:DISTance:STARt? 

Return: 2 

 

3.23.12 时域门控终止距离 

命令格式 :CALCulate<cnum>:TRACe<tnum>:TDR:GATE:DISTance:STOP <numeric> 

:CALCulate<cnum>:TRACe<tnum>:TDR:GATE:DISTance:STOP? 



 

 

说明 设置或获取 TDR 测量的时域功能选通终止距离 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<tnum>:={[1]-256}，表示测量迹线号，如果未指定，则<tnum>默认设置 1。 

<numeric>:表示选通终止距离，其范围是 0~最大测量距离。 

返回值 浮点型 

默认值 100 m 

菜单项 测量> TDR> 测量设置 > 时域 > 终止 

举例 :CALCulate1:TRACe1:TDR:GATE:DISTance:STOP 51.2 

:CALCulate1:TRACe1:TDR:GATE:DISTance:STOP? 

Return: 51.2 

 

3.24 MT命令子系统(Option，SHN900A系列机型不支持) 

3.24.1 命令列表 

样品高度 :CALCulate<cnum>:MATerial:SAMPle:HEIGht 

样品长度 :CALCulate<cnum>:MATerial:SAMPle:LENGth 

样品到校准面的距离 :CALCulate<cnum>:MATerial:DISTance 

初始化波导参数 :CALCulate<cnum>:MATerial:WAVeguide:INIt 

查询波导信息 :CALCulate<cnum>:MATerial:WAVeguide:CATalog? 

波导高度 :CALCulate<cnum>:MATerial:WAVeguide:HEIGht 

       波导宽度 :CALCulate<cnum>:MATerial:WAVeguide:WIDTh 

波导长度       :CALCulate<cnum>:MATerial:WAVeguide:LENGth 

空气间隙修正       :CALCulate<cnum>:MATerial:GAP:CORRection 

测量模型 :CALCulate<cnum>:MATerial:MODel 

计算类型 :CALCulate<cnum>:MATerial:DIRection 

介电常数估计值 :CALCulate<cnum>:MATerial:ESTimate:EPSilon 

材料测量的端口 :SENSe<cnum>:MATerial:PMAP 
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3.24.2 样品高度 

  命令格式 :CALCulate<cnum>:MATerial:SAMPle:HEIGht <numeric> 

:CALCulate<cnum>:MATerial:SAMPle:HEIGht? 

  说明 设置或获取选择通道的样品高度。 

  参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<numeric>:表示样品高度。 

  返回类型 浮点型，单位 m 

  默认值 0m 

  菜单项 测量 > 测量设置 > 测量设置 > Waveguide Gap Correction > Small Width Of  

Sample 

  举例 :CALCulate1:MATerial:SAMPle:HEIGht 3 

:CALCulate1:MATerial:SAMPle:HEIGht? 

Return: 3 

 

3.24.3 样品长度 

  命令格式 :CALCulate<cnum>:MATerial:SAMPle:LENGth <numeric> 

:CALCulate<cnum>:MATerial:SAMPle:LENGth? 

  说明 设置或获取选择通道的样品长度。 

  参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<numeric>:表示样品长度。 

  返回类型 浮点型，单位 m 

  默认值 10mm 

  菜单项 测量 > 测量设置 > 测量设置 > Sample Holder > Sample Thickness 

  举例 :CALCulate1:MATerial:SAMPle:LENGth 0.05  

:CALCulate1:MATerial:SAMPle:LENGth? 

Return: 0.05 

 

3.24.4 样品到校准面的距离 

  命令格式 :CALCulate<cnum>:MATerial:DISTance <numeric> 

:CALCulate<cnum>:MATerial:DISTance? 

  说明 设置或获取选择通道的样品到校准面的距离。 



 

 

  参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<numeric>:表示样品到校准面的距离。 

  返回类型 浮点型，单位 m 

  默认值 0m 

  菜单项 测量 > 测量设置 > 测量设置 > Sample Holder > Distance To Sample 

  举例 :CALCulate1:MATerial:DISTance 0.7 

:CALCulate1:MATerial:DISTance? 

Return: 0.7 

 

3.24.5 初始化波导参数 

  命令格式 :CALCulate<cnum>:MATerial:WAVeguide:INIt <type> 

  说明 根据波导类型初始化波导相关参数， 初始化的参数有 Start Freq、Stop Freq、  

Cutoff Frequency、Waveguide Width、Small Width Of Waveguide。 

  参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<type>:={X|P|K|Q|R|U|V|W} 

  返回类型 枚举 

  默认值 无 

  菜单项 测量 > 测量设置 > 测量设置 > Preset > Lookup… > Lookup Table 

  举例 :CALCulate1:MATerial:WAVeguide:INIt X 

 

3.24.6 查询波导信息 

  命令格式 :CALCulate<cnum>:MATerial:WAVeguide:CATalog? 

  说明 查询材料测量保存的所有波导信息。 

  参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

  返回类型 字符串 

  默认值 "X,P,K,R,Q,U,V,W" 

  菜单项 测量 > 测量设置 > 测量设置 > Preset > Lookup… > Lookup Table 

  举例 :CALCulate1:MATerial:WAVeguide:CATalog? 

Return: "X,P,K,R,Q,U,V,W" 
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3.24.7 波导高度 

  命令格式 :CALCulate<cnum>:MATerial:WAVeguide:HEIGht <numeric> 

:CALCulate<cnum>:MATerial:WAVeguide:HEIGht? 

  说明 设置或获取选择通道的波导高度。 

  参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<numeric>:表示波导高度。 

  返回类型 浮点型，单位 m 

  默认值 0m 

  菜单项 测量 > 测量设置 > 测量设置 > Waveguide Gap Correction > Small Width Of  

Waveguide 

  举例 :CALCulate1:MATerial:WAVeguide:HEIGht 0.1 

:CALCulate1:MATerial:WAVeguide:HEIGht? 

Return: 0.1 

 

3.24.8 波导宽度 

  命令格式 :CALCulate<cnum>:MATerial:WAVeguide:WIDTh <numeric> 

:CALCulate<cnum>:MATerial:WAVeguide:WIDTh? 

  说明 设置或获取选择通道的波导宽度。 

  参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<numeric>:表示波导宽度。 

  返回类型 浮点型，单位 m 

  默认值 20mm 

  菜单项 测量 > 测量设置 > 测量设置 > Sample Holder > Waveguide > Waveguide Width 

  举例 :CALCulate1:MATerial:WAVeguide:WIDTh 0.3 

:CALCulate1:MATerial:WAVeguide:WIDTh? 

Return: 0.3 

 

3.24.9 波导长度 

  命令格式 :CALCulate<cnum>:MATerial:WAVeguide:LENGth <numeric> 

:CALCulate<cnum>:MATerial:WAVeguide:LENGth? 

  说明 设置或获取选择通道的波导长度。 



 

 

  参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<numeric>:表示波导长度。 

  返回类型 浮点型，单位 m 

  默认值 100mm 

  菜单项 测量 > 测量设置 > 测量设置 > Sample Holder > Sample Holder Length 

  举例 :CALCulate1:MATerial:WAVeguide:LENGth 0.4 

:CALCulate1:MATerial:WAVeguide:LENGth? 

Return: 0.4 

 

3.24.10 空气间隙修正 

  命令格式 :CALCulate<cnum>:MATerial:GAP:CORRection <bool> 

:CALCulate<cnum>:MATerial:GAP:CORRection? 

  说明 设置或获取选择通道的波导空气间隙修正状态。 

  参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<bool>:= ON|OFF|1|0 

  返回类型 Boolean (1=ON,0=OFF) 

  默认值 0 

  菜单项 测量 > 测量设置 > 测量设置 > Waveguide Gap Correction > Correction On 

  举例 :CALCulate1:MATerial:GAP:CORRection ON 

:CALCulate1:MATerial:GAP:CORRection? 

Return: 1 

 

3.24.11 测量模型 

  命令格式 :CALCulate<cnum>:MATerial:MODel <type> 

:CALCulate<cnum>:MATerial:MODel? 

  说明 设置或获取选择通道的测量模型。 

  参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<type>:={NRW|NIST|FNRW} 

  返回类型 枚举 

  默认值 NIST 

  菜单项 测量 > 测量设置 > 测量设置 > Measurement Model > Measurement Model 

  举例 :CALCulate1:MATerial:MODel NRW 
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:CALCulate1:MATerial:MODel? 

Return: NRW 

 

3.24.12 计算类型 

  命令格式 :CALCulate<cnum>:MATerial:DIRection <type> 

:CALCulate<cnum>:MATerial:DIRection? 

  说明 设置或获取选择通道的计算类型。 

  参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<type>:={AVG|FWD|REV} 

  返回类型 枚举 

  默认值 AVG 

  菜单项 测量 > 测量设置 > 测量设置 > Measurement Model > Calculate Type 

  举例 :CALCulate1:MATerial:DIRection FWD 

:CALCulate1:MATerial:DIRection? 

Return: FWD 

 

3.24.13 介电常数估计值 

  命令格式 :CALCulate<cnum>:MATerial:ESTimate:EPSilon <numeric1>,<numeric2> 

:CALCulate<cnum>:MATerial:ESTimate:EPSilon? 

  说明 测量模型为 Ref/Tran ε Precision 时，设置或获取介电常数估计值。 

  参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<numeric1>:表示介电常数实部值，浮点型。 

<numeric2>:表示介电常数虚部值，浮点型。 

  返回类型 数据数组 

  默认值 1,0 

  菜单项 测量 > 测量设置 > 测量设置 > Measurement Model > Ref/Tran ε Precision >  

Permittivity 

  举例 :CALCulate1:MATerial:ESTimate:EPSilon 3,4 

:CALCulate1:MATerial:ESTimate:EPSilon? 

Return: 3.000000000000e+00,4.000000000000e+00 

 



 

 

3.24.14 材料测量的端口 

 命令格式 :SENSe<cnum>:MATerial:PMAP <pnum1>,<pnum2> 

:SENSe<cnum>:MATerial:PMAP? 

 说明 设置或获取材料测量的前向端口和反向端口。 

 参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<pnum1>:={1|2|3|4}，表示 1st Port 号。 

<pnum2>:={1|2|3|4}，表示 2nd Port 号。 

<pnum1>和<pnum2>值不能相同。 

 返回类型 数据数组 

 默认值 1,2 

 菜单项 测量 > 测量设置 > 测量设置 > Preset > Select Ports 

 举例 

:SENSe1:MATerial:PMAP 3,2 

:SENSe1:MATerial:PMAP? 

Return: 3,2 

 

3.25 GC命令子系统(Option，SHN900A系列机型不支持) 

3.25.1 频率 

3.25.1.1 命令列表 

数据采集模式 :SENSe<cnum>:GCSetup:AMODe 

频率扫描点数 :SENSe<cnum>:GCSetup:SWEep:FREQuency:POINts 

 

3.25.1.2 数据采集模式 

命令格式 
:SENSe<cnum>:GCSetup:AMODe <type> 

:SENSe<cnum>:GCSetup:AMODe? 

说明 设置或获取选择通道的数据采集模式。 

参数 

<cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<type>:={SMARtsweep|FPOWer|PFREQuency}，表示脉冲测量模式。 

SMARtsweep：智能扫描 

FPOWer：每个功率点进行频率扫描 

PFREQuency：每个频率点进行功率扫描 

返回类型 枚举 
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默认值 SMAR 

菜单项 扫描 > GC Setup... > Frequency > Data Acquisition Mode 

举例 

:SENS:GCS:AMOD FPOW 

:SENS:GCS:AMOD? 

Return: FPOW 

 

3.25.1.3 频率扫描点数 

命令格式 
:SENSe<cnum>:GCSetup:SWEep:FREQuency:POINts <numeric> 

:SENSe<cnum>:GCSetup:SWEep:FREQuency:POINts? 

说明 设置或获取选择通道的频率扫描点数。 

参数 
<cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<numeric>:表示频率扫描点数，其范围是 10~20001。 

返回类型 整型 

默认值 201 

菜单项 扫描 > GC Setup... > Frequency > Frequency Setting >  Frequency Points 

举例 

:SENS:GCS:SWE:FREQ:POIN 10 

:SENS:GCS:SWE:FREQ:POIN? 

Return: 10 

 

3.25.2 功率 

3.25.2.1 命令列表 

DUT端口映射 :SENSe<cnum>:GCSetup:PMAP 

输入端口 :SENSe<cnum>:GCSetup:PMAP:INPut? 

输出端口 :SENSe<cnum>:GCSetup:PMAP:OUTPut? 

线性输入功率 :SENSe<cnum>:GCSetup:POWer:LINear:INPut:LEVel 

反向输出功率 :SENSe<cnum>:GCSetup:POWer:REVerse:LEVel 

功率扫描点数 :SENSe<cnum>:GCSetup:SWEep:POWer:POINts 

起始功率 :SENSe<cnum>:GCSetup:POWer:STARt:LEVel 

终止功率 :SENSe<cnum>:GCSetup:POWer:STOP:LEVel 

 

3.25.2.2 DUT端口映射 

命令格式 :SENSe<cnum>:GCSetup:PMAP <pnum1>,<pnum2> 



 

 

说明 设置选择通道的 DUT与 SNA 连接的输入和输出端口。 

参数 

<cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<pnum1>:VNA 连接 DUT 输入端的端口号。 

<pnum2>: VNA 连接 DUT 输入端的端口号。 

返回类型 无 

默认值 1,2 

菜单项 扫描 > GC Setup... > Power > Port Setting >  Input Port / Output Port 

举例 :SENS:GCS:PMAP 2,1 

 

3.25.2.3 输入端口 

命令格式 :SENSe<cnum>:GCSetup:PMAP:INPut? 

说明 获取选择通道的连接 DUT 输入端的端口号。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

返回类型 整型 

默认值 1 

菜单项 扫描 > GC Setup... > Power > Port Setting >  Input Port 

举例 
:SENS:GCS:PMAP:INP? 

Return: 1 

 

3.25.2.4 输出端口 

命令格式 :SENSe<cnum>:GCSetup:PMAP:OUTPut? 

说明 获取选择通道的连接 DUT 输出端的端口号。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

返回类型 整型 

默认值 2 

菜单项 扫描 > GC Setup... > Power > Port Setting >  Output Port 

举例 
:SENS:GCS:PMAP:OUTP? 

Return: 2 

 

3.25.2.5 线性输入功率 

命令格式 
:SENSe<cnum>:GCSetup:POWer:LINear:INPut:LEVel <numeric> 

:SENSe<cnum>:GCSetup:POWer:LINear:INPut:LEVel? 

说明 设置或获取线性输入功率。 
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参数 
<cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<numeric>:表示线性输入功率，可选择 SNA 范围内的任何功率。 

返回类型 浮点型，单位 dBm 

默认值 -20 

菜单项 扫描 > GC Setup... > Power > Port Setting >  Linear Input Power  

举例 

:SENS:GCS:POW:LIN:INP:LEV 0 

:SENS:GCS:POW:LIN:INP:LEV? 

Return: 0 

 

3.25.2.6 反向输出功率 

命令格式 
:SENSe<cnum>:GCSetup:POWer:REVerse:LEVel <numeric> 

:SENSe<cnum>:GCSetup:POWer:REVerse:LEVel? 

说明 设置或获取反向功率。 

参数 
<cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<numeric>:表示反向功率，可选择 SNA 范围内的任何功率。 

返回类型 浮点型，单位 dBm 

默认值 -20 

菜单项 扫描 > GC Setup... > Power > Port Setting >  Reverse Output Power  

举例 

:SENS:GCS:POW:REV:LEV 0 

:SENS:GCS:POW:REV:LEV? 

Return: 0 

 

3.25.2.7 功率扫描点数 

命令格式 
:SENSe<cnum>:GCSetup:SWEep:POWer:POINts <numeric> 

:SENSe<cnum>:GCSetup:SWEep:POWer:POINts? 

说明 设置或获取选择通道的功率扫描点数。 

参数 
<cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<numeric>:表示功率扫描点数，其范围是 10~20001。 

返回类型 整型 

默认值 21 

菜单项 扫描 > GC Setup... > Power > Power Setting > Power Points  

举例 

:SENS:GCS:SWE:POW:POIN 10 

:SENS:GCS:SWE:POW:POIN? 

Return: 10 



 

 

 

3.25.2.8 起始功率 

命令格式 
:SENSe<cnum>:GCSetup:POWer:STARt:LEVel <numeric> 

:SENSe<cnum>:GCSetup:POWer:STARt:LEVel? 

说明 设置或获取起始功率。 

参数 
<cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<numeric>:表示起始功率，可选择 SNA 范围内的任何功率。 

返回类型 浮点型，单位 dBm 

默认值 -10 

菜单项 扫描 > GC Setup... > Power > Power Setting > Start(Min) Power  

举例 

:SENS:GCS:POW:STAR:LEV 0 

:SENS:GCS:POW:STAR:LEV? 

Return: 0 

 

3.25.2.9 终止功率 

命令格式 
:SENSe<cnum>:GCSetup:POWer:STOP:LEVel <numeric> 

:SENSe<cnum>:GCSetup:POWer:STOP:LEVel? 

说明 设置或获取终止功率。 

参数 
<cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<numeric>:表示终止功率，可选择 SNA 范围内的任何功率。 

返回类型 浮点型，单位 dBm 

默认值 0 

菜单项 扫描 > GC Setup... > Power > Power Setting > Stop(Max) Power  

举例 

:SENS:GCS:POW:STOP:LEV 0 

:SENS:GCS:POW:STOP:LEV? 

Return: 0 

 

3.25.3 压缩 

3.25.3.1 命令列表 

压缩参考方式 :SENSe<cnum>:GCSetup:COMPression:ALGorithm 

回退值 :SENSe<cnum>:GCSetup:COMPression:BACKoff:LEVel 

Delta X :SENSe<cnum>:GCSetup:COMPression:DELTa:X 

Delta Y :SENSe<cnum>:GCSetup:COMPression:DELTa:Y 

插值功能状态 :SENSe<cnum>:GCSetup:COMPression:INTerpolation 
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压缩值 :SENSe<cnum>:GCSetup:COMPression:LEVel 

饱和压缩下的压缩值 :SENSe<cnum>:GCSetup:COMPression:SATuration:LEVel 

扫描结束功率状态 :SENSe<cnum>:GCSetup:EOSoperation 

安全模式状态 :SENSe<cnum>:GCSetup:SAFE:ENABle 

安全模式粗步进 :SENSe<cnum>:GCSetup:SAFE:CPADjustment 

安全模式精步进 :SENSe<cnum>:GCSetup:SAFE:FPADjustment 

安全模式安全值 :SENSe<cnum>:GCSetup:SAFE:FTHReshold 

安全模式门限值 :SENSe<cnum>:GCSetup:SAFE:MLimit 

最大迭代次数 :SENSe<cnum>:GCSetup:SMARt:MITerations 

显示迭代功能状态 :SENSe<cnum>:GCSetup:SMARt:SITerations 

扫描间隔时间 :SENSe<cnum>:GCSetup:SMARt:STIMe 

容差 :SENSe<cnum>:GCSetup:SMARt:TOLerance 

 

3.25.3.2 压缩参考方式 

命令格式 
:SENSe<cnum>:GCSetup:COMPression:ALGorithm <type> 

:SENSe<cnum>:GCSetup:COMPression:ALGorithm? 

说明 设置或获取选择通道的增益压缩的压缩方式。 

参数 

<cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<type>:={CFLG|CFMG|BACKoff|XYCOM|SAT}，表示压缩方式。 

CFLG：线性增益压缩 

CFMG：最大增益压缩 

BACKoff：回退压缩 

XYCOM：XY 压缩 

SAT：饱和点压缩 

返回类型 枚举 

默认值 CFLG 

菜单项 扫描 > GC Setup... > Compression > Compression Method  

举例 

:SENS:GCS:COMP:ALG XYCOM 

:SENS:GCS:COMP:ALG? 

Return: XYCOM 

 



 

 

3.25.3.3 回退值 

命令格式 
:SENSe<cnum>:GCSetup:COMPression:BACKoff:LEVel <numeric> 

:SENSe<cnum>:GCSetup:COMPression:BACKoff:LEVel? 

说明 设置或获取回退压缩模式下的回退值。 

参数 
<cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<numeric>:表示回退值。 

返回类型 浮点型，单位 dB 

默认值 10 

菜单项 扫描 > GC Setup... > Compression > Compression Method > Back Off  

举例 

:SENS:GCS:COMP:BACK:LEVEL 10 

:SENS:GCS:COMP:BACK:LEVEL? 

Return: 10 

 
3.25.3.4 Delta X 

命令格式 
:SENSe<cnum>:GCSetup:COMPression:DELTa:X <numeric> 

:SENSe<cnum>:GCSetup:COMPression:DELTa:X? 

说明 设置或获取 XY 压缩模式下的 X 值。 

参数 
<cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<numeric>:表示横轴差值。 

返回类型 浮点型，单位 dB 

默认值 10 

菜单项 扫描 > GC Setup... > Compression > Compression Method > Delta X  

举例 

:SENS:GCS:COMP:DELT:X 10 

:SENS:GCS:COMP:DELT:X? 

Return: 10 

 
3.25.3.5 Delta Y 

命令格式 
:SENSe<cnum>:GCSetup:COMPression:DELTa:Y <numeric> 

:SENSe<cnum>:GCSetup:COMPression:DELTa:Y? 

说明 设置或获取 XY 压缩模式下的 Y 值。 

参数 
<cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<numeric>:表示纵轴差值。 

返回类型 浮点型，单位 dB 

默认值 9 

菜单项 扫描 > GC Setup... > Compression > Compression Method > Delta Y  
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举例 

:SENS:GCS:COMP:DELT:Y 9 

:SENS:GCS:COMP:DELT:Y? 

Return: 9 

 

3.25.3.6 插值功能状态 

命令格式 
:SENSe<cnum>:GCSetup:COMPression:INTerpolation <bool> 

:SENSe<cnum>:GCSetup:COMPression:INTerpolation? 

说明 设置或获取选择通道的插值功能状态。 

参数 
<cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<bool>:= ON|OFF|1|0 

返回类型 Boolean (1=ON,0=OFF) 

默认值 0 

菜单项 
扫描  > GC Setup... > Compression > 2D Sweep > Compression Point 

Interpolation  

举例 

:SENS:GCS:COMP:INT 1 

:SENS:GCS:COMP:INT? 

Return: 1 

 

3.25.3.7 压缩值 

命令格式 
:SENSe<cnum>:GCSetup:COMPression:LEVel <numeric> 

:SENSe<cnum>:GCSetup:COMPression:LEVel? 

说明 设置或获取选择通道的压缩点的压缩值。 

参数 
<cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<numeric>:表示压缩点的压缩值。 

返回类型 浮点型，单位 dB 

默认值 1 

菜单项 扫描 > GC Setup... > Compression > Compression Method > Level  

举例 

:SENS:GCS:COMP:LEV 1 

:SENS:GCS:COMP:LEV? 

Return: 1 

 

3.25.3.8 饱和压缩下的压缩值 

命令格式 
:SENSe<cnum>:GCSetup:COMPression:SATuration:LEVel <numeric> 

:SENSe<cnum>:GCSetup:COMPression:SATuration:LEVel? 

说明 设置或获取选择通道的压缩点的压缩值(饱和压缩模式)。 

参数 
<cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<numeric>:表示压缩点的压缩值(饱和压缩模式)。 



 

 

返回类型 浮点型，单位 dB 

默认值 1 

菜单项 扫描 > GC Setup... > Compression > Compression Method > Level  

举例 

:SENS:GCS:COMP:SAT:LEV 1 

:SENS:GCS:COMP:SAT:LEV? 

Return: 1 

 

3.25.3.9 扫描结束功率状态 

命令格式 
:SENSe<cnum>:GCSetup:EOSoperation <type> 

:SENSe<cnum>:GCSetup:EOSoperation? 

说明 设置或获取选择通道的扫描结束时的功率。 

参数 

<cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<type>:={DEFault|STANdard|POFF|PSTArt|PSTOp}，表示扫描结束时功率。 

DEFault：VNA 默认功率值(同标准) 

STANdard：VNA 默认功率值 

POFF：关闭功率 

PSTArt：扫描开始功率 

PSTOp：扫描结束功率 

返回类型 枚举 

默认值 DEFault 

菜单项 扫描 > GC Setup... > Compression > End of Sweep Condition  

举例 

:SENS:GCS:EOS POFF 

:SENS:GCS:EOS? 

Return: POFF 

 

3.25.3.10 安全模式状态 

命令格式 
:SENSe<cnum>:GCSetup:SAFE:ENABle <bool> 

:SENSe<cnum>:GCSetup:SAFE:ENABle? 

说明 设置或获取选择通道的安全模式的状态。 

参数 
<cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<bool>:= ON|OFF|1|0 

返回类型 Boolean (1=ON,0=OFF) 

默认值 0 

菜单项 扫描 > GC Setup... > Compression > Smart Sweep > Safe Mode… > Safe Mode 
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举例 

:SENS:GCS:SAFE:ENAB 1 

:SENS:GCS:SAFE:ENAB? 

Return: 1 

 

3.25.3.11 安全模式粗步进 

命令格式 
:SENSe<cnum>:GCSetup:SAFE:CPADjustment <numeric> 

:SENSe<cnum>:GCSetup:SAFE:CPADjustment? 

说明 设置或获取选择通道的粗步进值。 

参数 
<cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<numeric>:表示粗步进值。 

返回类型 浮点型，单位 dB 

默认值 3 

菜单项 
扫描 > GC Setup... > Compression > Smart Sweep > Safe Mode… > Coarse 

Increment 

举例 

:SENS:GCS:SAFE:CPAD 1 

:SENS:GCS:SAFE:CPAD? 

Return: 1 

 

3.25.3.12 安全模式精步进 

命令格式 
:SENSe<cnum>:GCSetup:SAFE:FPADjustment <numeric> 

:SENSe<cnum>:GCSetup:SAFE:FPADjustment? 

说明 设置或获取选择通道的精步进值。 

参数 
<cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<numeric>:表示精步进值。 

返回类型 浮点型，单位 dB 

默认值 1 

菜单项 
扫描  > GC Setup... > Compression > Smart Sweep > Safe Mode… > Fine 

Increment 

举例 

:SENS:GCS:SAFE:FPAD 0.5 

:SENS:GCS:SAFE:FPAD? 

Return: 0.5 

 

3.25.3.13 安全模式安全值 

命令格式 
:SENSe<cnum>:GCSetup:SAFE:FTHReshold <numeric> 

:SENSe<cnum>:GCSetup:SAFE:FTHReshold? 

说明 设置或获取选择通道的安全模式的安全值。 

参数 <cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 



 

 

<numeric>:表示安全值。 

返回类型 浮点型，单位 dB 

默认值 0.5 

菜单项 
扫描  > GC Setup... > Compression > Smart Sweep > Safe Mode… > Fine 

Threshold 

举例 

:SENS:GCS:SAFE:FTHR 1 

:SENS:GCS:SAFE:FTHR? 

Return: 1 

 

3.25.3.14 安全模式门限值 

命令格式 
:SENSe<cnum>:GCSetup:SAFE:MLimit <numeric> 

:SENSe<cnum>:GCSetup:SAFE:MLimit? 

说明 设置或获取选择通道的安全模式下的最大输出功率。 

参数 
<cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<numeric>:表示最大输出功率。 

返回类型 浮点型，单位 dBm 

默认值 30 

菜单项 
扫描 > GC Setup... > Compression > Smart Sweep > Safe Mode… > Max Output 

Power 

举例 

:SENS:GCS:SAFE:ML 20 

:SENS:GCS:SAFE:ML? 

Return: 20 

 

3.25.3.15 最大迭代次数 

命令格式 
:SENSe<cnum>:GCSetup:SMARt:MITerations <numeric> 

:SENSe<cnum>:GCSetup:SMARt:MITerations? 

说明 设置或获取选择通道的智能扫描的最大迭代次数。 

参数 
<cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<numeric>:表示最大迭代次数。 

返回类型 整型 

默认值 20 

菜单项 扫描 > GC Setup... > Compression > Smart Sweep > Maximum Iterations  

举例 

:SENS:GCS:SMAR:MIT 10 

:SENS:GCS:SMAR:MIT? 

Return: 10 
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3.25.3.16 显示迭代功能状态 

命令格式 
:SENSe<cnum>:GCSetup:SMARt:SITerations <bool> 

:SENSe<cnum>:GCSetup:SMARt:SITerations? 

说明 设置或获取选择通道的显示迭代功能是否开启。 

参数 
<cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<bool>:= ON|OFF|1|0 

返回类型 Boolean (1=ON,0=OFF) 

默认值 0 

菜单项 扫描 > GC Setup... > Compression > Smart Sweep > Show Iterations  

举例 

:SENS:GCS:SMAR:SIT 1 

:SENS:GCS:SMAR:SIT? 

Return: 1 

 

3.25.3.17 扫描间隔时间 

命令格式 
:SENSe<cnum>:GCSetup:SMARt:STIMe <numeric> 

:SENSe<cnum>:GCSetup:SMARt:STIMe? 

说明 设置或获取选择通道的每次扫描之间的等待时间。 

参数 
<cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<numeric>:表示间隔时间。 

返回类型 浮点型，单位 s 

默认值 0 

菜单项 扫描 > GC Setup... > Compression > Settling Time 

举例 

:SENS:GCS:SMAR:STIM 1 

:SENS:GCS:SMAR:STIM? 

Return: 1 

 

3.25.3.18 容差 

命令格式 
:SENSe<cnum>:GCSetup:SMARt:TOLerance <numeric> 

:SENSe<cnum>:GCSetup:SMARt:TOLerance? 

说明 设置或获取选择通道的测量压缩点时容许的误差。 

参数 
<cnum>:={[1]-256}，表示测量通道号，如果未指定，则<cnum>默认设置 1。 

<numeric>:表示容差值。 

返回类型 浮点型，单位 dB 

默认值 0.05 



 

 

菜单项 扫描 > GC Setup... > Compression > Smart Sweep > Tolerance 

举例 

:SENS:GCS:SMAR:TOL 0.1 

:SENS:GCS:SMAR:TOL? 

Return: 0.1 
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4. SCPI示例样本程序 

4.1 使用 SCPI切换测量模式 

 
""" 
This example program shows how to use SCPI command to Switch Measurement Mode. 
The following program does the following: 
    1,Preset SNA 
    2,Switch Measurement Mode 
To run this program, you need : 
    An established USB interface or LAN connection 
""" 
import pyvisa 
# Change this variable to the address of your instrument 
VISA_ADDRESS = 'TCPIP0::10.11.13.234::INSTR' 
# Create a connection (dev) to the instrument 
resourceManager = pyvisa.ResourceManager() 
SNA = resourceManager.open_resource(VISA_ADDRESS) 
# Preset the SNA 
SNA.write(':SYSTem:PRESet') 
# Switch Measurement Mode to SMM, measurement mode include:VNA/SA/SMM 
SNA.write(':CALCulate1:INSTrument SMM') 

 

4.2 使用 SCPI指令的创建通道、窗口和测量 

""" 
This example program explains how to use SCPI command to create windows, channels and 
measurements. 
 
The following program does the following: 
 
    1,Presets SNA 
    2,Create a new window and a new channel 
    3,Create Measurements for each channel 
    4,Change frequency ranges for each channel 
    5,Select active trace 
    6,Turn marker 1 ON for each measurement 
 
To run this program, you need : 
    An established USB interface or LAN connection 
""" 
import pyvisa 

 
# Change this variable to the address of your instrument 
VISA_ADDRESS = 'TCPIP0::10.11.13.234::INSTR' 
# Create a connection (dev) to the instrument 
resourceManager = pyvisa.ResourceManager() 
SNA = resourceManager.open_resource(VISA_ADDRESS) 
 
# preset the SNA 
SNA.write(':SYSTem:PRESet') 



 

 

 
# Create a new window and a new channel 
SNA.write(':DISPlay:ADD:FUNCtion:EXECute WIN_CH_TRC') 
 
# Create Measurements for each channel,Parameters that can be set include:S-
Params/Balanced/Receiver/Wave/Ratio 
SNA.write(':CALCulate1:PARameter1:DEFine S12') 
SNA.write(':CALCulate2:PARameter2:DEFine S12') 
 
# Set channel 1 start frequency to 1GHz and stop frequency to 3 GHz 
SNA.write(':SENSe1:FREQuency:STARt 1e9') 
SNA.write(':SENSe1:FREQuency:STOP 3e9') 
 
# Set channel 2 start frequency to 2GHz and stop frequency to 4 GHz 
SNA.write(':SENSe2:FREQuency:STARt 2e9') 
SNA.write(':SENSe2:FREQuency:STOP 4e9') 
 
# Select active trace 
SNA.write(':CALCulate1:PARameter1:SELect') 
 
# Turn marker 1 ON for each measurement 
SNA.write(':CALCulate1:TRACe1:MARKer1:ACTivate') 
SNA.write(':CALCulate2:TRACe2:MARKer1:ACTivate') 

 

4.3 使用 SCPI指令设置扫描参数 

 

""" 
This Python program sets up sweep parameters on the Channel 1 measurement. 
To run this program, you need : 
    An established USB interface or LAN connection  
""" 
 
import pyvisa 
 
#Change this variable to the address of your instrument 
VISA_ADDRESS = 'TCPIP0::10.11.13.219::INSTR' 
 
#Create a connection (dev) to the instrument 
resourceManager = pyvisa.ResourceManager() 
SNA = resourceManager.open_resource(VISA_ADDRESS) 
#preset the SNA 
SNA.write(':SYSTem:PRESet') 
 
#Select the measurement 
SNA.write('CALCulate1:PARameter1:DEFine S21') 
 
#Set formate type to smith 
SNA.write(':CALCulate1:TRACe1:FORMat SMITh') 
 
#Set start frequency to 1GHz and stop frequency to 5 GHz 
SNA.write(':SENSe1:FREQuency:STARt 1e9') 
SNA.write(':SENSe1:FREQuency:STOP 5e9') 
 
#Set IF Bandwidth to 1500 
SNA.write(':SENSe1:BANDwidth 15e3') 
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#Set number of points to 251 
SNA.write(':SENSe1:SWEep:POINts 251') 
 
#Set the channel triggers indefinitely 
SNA.write(':SENSe:SWEep:MODE CONTinuous') 

 

4.4 等待触发状态 OPC? 

 
""" 
The example program demonstrates how to use the :TRIG:SING command to start a sweep 
(measurement) cycle, then 
uses the *OPC command to wait until the measurement cycle is completed, then prints a message 
The following program does the following: 
    1.Presets SNA 
    2,Turn on continuous initiation mode for the channel 
    3,Set the trigger source to Bus Trigger 
    4,Trigger the instrument to start a sweep cycle 
    5,Execute the *OPC? command 
To run this program, you need : 
    An established USB interface or LAN connection 
""" 
 
import pyvisa 
# Change this variable to the address of your instrument 
VISA_ADDRESS = 'TCPIP0::10.11.22.64::INSTR' 
# Create a connection (dev) to the instrument 
resourceManager = pyvisa.ResourceManager() 
SNA = resourceManager.open_resource(VISA_ADDRESS) 
# preset the SNA 
SNA.write(':SYSTem:PRESet') 
# Turn on continuous initiation mode for the channel 
SNA.write(':INITiate 1:CONTinuous 1') 
# Set the trigger source to Bus Trigger 
SNA.write(':TRIGger:SEQuence:SOURce BUS') 
# Trigger the instrument to start a sweep cycle 
SNA.write(':TRIGger:SEQuence:SINGle') 
# Execute the *OPC? command and wait until the command returns 1 (the measurement cycle is 
completed). 
flag = SNA.query('*OPC?') 
if flag.replace("\n", "") == '1': 
    print(f'the measurement is completed') 

 

4.5 读取和写入 ASCII格式的数据 

""" 
This example program shows how to store data in ASCII format and put it back. 
 
The following program does the following: 
 
    1,Preset the SNA 
    2,Create a Measurements 
    3,Set the channel trigger mode to single 
    4,Execute the *OPC? command 
    5,Set data format to ASCII 



 

 

    6,Read trace data 
    7,Preset the SNA again 
    8,Set data format to ASCII 
    9,Write data in ASCII format 
 
To run this program, you need : 
    An established USB interface or LAN connection 
""" 
import pyvisa 
 
# Change this variable to the address of your instrument 
VISA_ADDRESS = 'TCPIP0::10.11.22.64::INSTR' 
# Create a connection (dev) to the instrument 
resourceManager = pyvisa.ResourceManager() 
SNA = resourceManager.open_resource(VISA_ADDRESS) 
 
# preset the SNA 
SNA.write(':SYSTem:PRESet') 
 
# Create a Measurements 
SNA.write(':CALCulate1:PARameter1:DEFine S21') 
 
# Set the trigger source to Bus Trigger 
SNA.write(':TRIGger:SEQuence:SOURce BUS') 
 
# Trigger the instrument to start a sweep cycle 
SNA.write(':TRIGger:SEQuence:SINGle') 
 
# Execute the *OPC? command and wait until the command returns 1 (the measurement cycle is 
completed). 
while True: 
    if int(SNA.query('*OPC?'))==1: 
        break 
 
# Set data format to ASCII 
SNA.write(':FORMat:DATA ASC') 
 
# Read trace data 
fdata = SNA.query_ascii_values(':CALCulate1:DATA:FDATa?') 
 
# Preset the SNA again 
SNA.write(':SYSTem:PRESet') 
 
# Set data format to ASCII 
SNA.write(':FORMat:DATA ASC') 
 
# Write data in ASCII format 
SNA.write_ascii_values(':CALCulate1:DATA:FDATa ', fdata) 

 

4.6 读取和写入二进制(IEEE 32)格式的数据 

""" 
This example program shows how to store data in binary(IEEE 32) format and put it back. 
 
The following program does the following: 
 
    1,Preset the SNA 
    2,Create a Measurements 
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    3,Set the channel trigger mode to single 
    4,Execute the *OPC? command 
    5,Set data format to IEEE 32-bit floating-point binary 
    6,Read trace data  
    7,Preset the SNA again 
    8,Set data format to IEEE 32-bit floating-point binary 
    9,Write data in IEEE 32-bit floating-point binary format 
 
 
To run this program, you need : 
    An established USB interface or LAN connection 
""" 
import pyvisa 
# Change this variable to the address of your instrument 
VISA_ADDRESS = 'TCPIP0::10.11.22.64::INSTR' 
# Create a connection (dev) to the instrument 
resourceManager = pyvisa.ResourceManager() 
SNA = resourceManager.open_resource(VISA_ADDRESS) 
 
# preset the SNA 
SNA.write(':SYSTem:PRESet') 
 
# Create a Measurements 
SNA.write(':CALCulate1:PARameter1:DEFine S21') 
 
# Set the trigger source to Bus Trigger 
SNA.write(':TRIGger:SEQuence:SOURce BUS') 
 
# Trigger the instrument to start a sweep cycle 
SNA.write(':TRIGger:SEQuence:SINGle') 
 
# Execute the *OPC? command and wait until the command returns 1 (the measurement cycle is 
completed). 
while True: 
    if int(SNA.query('*OPC?'))==1: 
        break 
 
# Set data format to IEEE 32-bit floating-point binary 
SNA.write(':FORMat:DATA REAL32') 
 
# Read trace data 
fdata = SNA.query_binary_values(':CALCulate1:DATA:FDATa?', datatype='f') 
 
# Preset the SNA again 
SNA.write(':SYSTem:PRESet') 
 
# Set data format to IEEE 32-bit floating-point binary 
SNA.write(':FORMat:DATA REAL32') 
 
# Write data in IEEE 32-bit floating-point binary format 
SNA.write_binary_values(':CALCulate1:DATA:FDATa ', fdata, datatype='f') 

 

4.7 读取和写入二进制(IEEE 64)格式的数据 

""" 
This example program shows how to store data in binary(IEEE 64) format and put it back. 
 



 

 

The following program does the following: 
 
    1,Preset the SNA 
    2,Create a Measurements 
    3,Set the channel trigger mode to single 
    4,Execute the *OPC? command 
    5,Set data format to IEEE 64-bit floating-point binary 
    6,Read trace data  
    7,Preset the SNA again 
    8,Set data format to IEEE 64-bit floating-point binary 
    9,Write data in IEEE 64-bit floating-point binary format 
To run this program, you need : 
    An established USB interface or LAN connection 
""" 
import pyvisa 
 
# Change this variable to the address of your instrument 
VISA_ADDRESS = 'TCPIP0::10.11.22.64::INSTR' 
# Create a connection (dev) to the instrument 
resourceManager = pyvisa.ResourceManager() 
SNA = resourceManager.open_resource(VISA_ADDRESS) 
 
# preset the SNA 
SNA.write(':SYSTem:PRESet') 
 
# Create a Measurements 
SNA.write(':CALCulate1:PARameter1:DEFine S21') 
 
# Set the trigger source to Bus Trigger 
SNA.write(':TRIGger:SEQuence:SOURce BUS') 
 
# Trigger the instrument to start a sweep cycle 
SNA.write(':TRIGger:SEQuence:SINGle') 
 
# Execute the *OPC? command and wait until the command returns 1 (the measurement cycle is 
completed). 
while True: 
    if int(SNA.query('*OPC?'))==1: 
        break 
 
# Set data format to IEEE 64-bit floating-point binary 
SNA.write(':FORMat:DATA REAL') 
 
# Read trace data 
fdata = SNA.query_binary_values(':CALCulate1:DATA:FDATa?', datatype='d') 
 
# Preset the SNA again 
SNA.write(':SYSTem:PRESet') 
 
# Set data format to IEEE 64-bit floating-point binary 
SNA.write(':FORMat:DATA REAL') 
 
# Write data in IEEE 64-bit floating-point binary format 
SNA.write_binary_values(':CALCulate1:DATA:FDATa ', fdata, datatype='d') 
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4.8 带宽搜索 

 
""" 
This example program shows how to use SCPI command to do a bandwidth search. 
 
The following program does the following: 
 
    1,Preset SNA 
    2,Create a Measurements to S21 
    3,Change channel frequency ranges 
    4,Set number of points  
    5,Auto scales the Trace 
    6,Create a marker 
    7,Set BW Ref to Peak 
    8,Set BW Level 
    9,Enable Bandwidth Search 
    10,Read bandwidth search results and print them out 
 
To run this program, you need : 
    An established USB interface or LAN connection 
""" 
import pyvisa 
# Change this variable to the address of your instrument 
VISA_ADDRESS = 'TCPIP0::10.11.22.64::INSTR' 
# Create a connection (dev) to the instrument 
resourceManager = pyvisa.ResourceManager() 
SNA = resourceManager.open_resource(VISA_ADDRESS) 
 
# preset the SNA 
SNA.write(':SYSTem:PRESet') 
 
#Create a Measurements to S21 
SNA.write(':CALCulate1:PARameter1:DEFine S21') 
 
# Set channel start frequency to 1GHz and stop frequency to 6GHz 
SNA.write(':SENSe1:FREQuency:STARt 1e9') 
SNA.write(':SENSe1:FREQuency:STOP 6e9') 
 
# Set number of points 11 
SNA.write(':SENSe1:SWEep:POINts 11') 
 
# Auto scales the Trace 
SNA.write(':DISPlay:WINDow1:TRACe1:Y:AUTO') 
 
# Create a marker 
SNA.write(':CALCulate1:TRACe1:MARKer1:ACTivate') 
 
# Set BW Ref to Peak 
SNA.write(':CALCulate1:SELected:MARKer1:BWIDth:REF MARKer') 
 
# Set BW Level -3.5 
SNA.write(':CALCulate1:TRACe1:MARKer1:BWIDth:THReshold -3.5') 
 
# Enable BandWidth Search 
SNA.write(':CALCulate1:MARKer:BWIDth ON') 
 
# Read bandwidth search results and print them out 



 

 

bandwidth = SNA.query(':CALCulate1:MARKer1:BWIDth:DATA?') 
bandwidth_value = list(map(float, bandwidth.split(','))) 
print(f'Bandwidth search results : BW:{bandwidth_value[0]},Center 
freq:{bandwidth_value[1]},Q:{bandwidth_value[2]},Loss:{bandwidth_value[3]}') 

 

4.9 峰值搜索 

""" 
This example program shows how to use Marker command to perform maximum peak search. 
 
The following program does the following: 
 
    1,Preset SNA 
    2,Change channel frequency ranges 
    3,Create a marker 
    4,Perform maximum search 
    5,Read the X-axis and Y-axis values of the maximum value cursor 
 
To run this program, you need : 
    An established USB interface or LAN connection 
""" 
import pyvisa 
# Change this variable to the address of your instrument 
VISA_ADDRESS = 'TCPIP0::10.11.22.64::INSTR' 
# Create a connection (dev) to the instrument 
resourceManager = pyvisa.ResourceManager() 
SNA = resourceManager.open_resource(VISA_ADDRESS) 
 
# preset the SNA 
SNA.write(':SYSTem:PRESet') 
 
# Set channel start frequency to 100MHz and stop frequency to 200MHz 
SNA.write(':SENSe1:FREQuency:STARt 1e6') 
SNA.write(':SENSe1:FREQuency:STOP 2e6') 
 
# Create a marker 
SNA.write(':CALCulate1:TRACe1:MARKer1:ACTivate') 
 
# Perform maximum search,before sending the execution command, you need to set the search mode to 
maximum search 
SNA.write(':CALCulate1:TRACe1:MARKer1:FUNCtion:TYPE MAXimum') 
SNA.write(':CALCulate1:TRACe1:MARKer1:FUNCtion:EXECute') 
 
# Read the X-axis and Y-axis values of the maximum value cursor 
x_value = SNA.query(':CALCulate1:MARKer1:X?') 
y_value = SNA.query(':CALCulate1:TRACe1:MARKer1:Y?') 

 

4.10 保存文件 

""" 
This example program shows how to use SCPI command to save and recall files.    
 
The following program does the following: 
 
    1,Preset the SNA 
    2,Create a Measurements 
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    3,Change channel frequency ranges 
    4,Set number of points  
    5,Save file 
    6,Preset the SNA again 
    7,Recall the file 
 
To run this program, you need : 
    An established USB interface or LAN connection 
""" 
import pyvisa 
# Change this variable to the address of your instrument 
VISA_ADDRESS = 'TCPIP0::10.11.22.64::INSTR' 
# Create a connection (dev) to the instrument 
resourceManager = pyvisa.ResourceManager() 
SNA = resourceManager.open_resource(VISA_ADDRESS) 
 
# preset the SNA 
SNA.write(':SYSTem:PRESet') 
 
# Create a Measurements to S21 
SNA.write(':CALCulate1:PARameter1:DEFine S21') 
 
# Set channel start frequency to 1GHz and stop frequency to 6GHz 
SNA.write(':SENSe1:FREQuency:STARt 1e9') 
SNA.write(':SENSe1:FREQuency:STOP 6e9') 
 
# Set number of points 100 
SNA.write(':SENSe1:SWEep:POINts 100') 
 
# Save file,file type include:CSA files,STA files,CSV files,CAl files and SnP files,example using CSA files 
SNA.write(':MMEMory:STORE "local/test.csa"') 
 
# preset the SNA again 
SNA.write(':SYSTem:PRESet') 
 
# Recall saved CSV file 
SNA.write(':MMEMory:LOAD "local/test.csa"') 

 

4.11 文件传输 

""" 
The following Python examples transfer files to and from a remote PC using the MMEM:TRANsfer 
command. 
 
The following program does the following: 
    1,Open file to be stored on local computer. Creates file if not already existing 
    2,Query SNA default saved files 
    3,Transferring SNA file data to computer files 
    4,Read PC file data 
    5,Transferring computer file data to SNA files 
 
To run this program, you need : 
    An established USB interface or LAN connection  
""" 
 
import pyvisa 
 



 

 

# Change this variable to the address of your instrument 
VISA_ADDRESS = 'TCPIP0::10.11.22.53::INSTR' 
 
# Create a connection (dev) to the instrument 
resourceManager = pyvisa.ResourceManager() 
SNA = resourceManager.open_resource(VISA_ADDRESS) 
 
# ==================Transferring from the SNA to the remote PC===================== 
# Open file to be stored on local computer. Creates file if not already existing 
pc_file = open("D:\sna_to_pc.csv", 'wb') 
 
# Analyzer has file 'sna.csv' in default directory. 
# The default directory is where the VNA saves files to on default 
data_binary = SNA.query_binary_values(f'MMEMory:TRANsfer? "/local/sna.csv"', datatype='B', 
container=bytearray, is_big_endian=False) 
 
# Now save the file locally to pc.csv 
pc_file.write(data_binary) 
pc_file.close() 
 
# ==================Transferring from the remote PC to the SNA ===================== 
 
# PC Local file to be transferred 
pc_file = open("D:\pc.csv", 'rb') 
 
# Store file content into variable 
# Data to be transferred to analyzer file 'pc_to_sna.csv' in default directory. 
data_binary = pc_file.read() 
SNA.write_binary_values(f':MMEMory:TRANsfer "/local/pc_to_sna.csv",', data_binary, datatype='B', 
is_big_endian=False) 
pc_file.close() 
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